Welcome ............................................................................................................................................................... 1
About Online Help ............................................................................................................................................... 1
Attributions & Copyrights ................................................................................................................................ 1
Get Started .......................................................................................................................................................... 23
Get Started with Dell Data Security .................................................................................................................... 23
Log In ............................................................................................................................................................... 23
Log Out ............................................................................................................................................................ 23
Dashboard ........................................................................................................................................................ 24
Start Services ................................................................................................................................................... 26
Stop Services ................................................................................................................................................... 27
Change Superadmin Password ............................................................................................................................ 27
Components ........................................................................................................................................................ 29
Architecture Drawings ..................................................................................................................................... 29
  Architecture with Manager .............................................................................................................................. 29
  Architecture with Encryption Enterprise for Windows/Manager ................................................................ 29
Default Port Values ......................................................................................................................................... 29
Proxy Servers ................................................................................................................................................... 30
  Types of Proxy Servers .................................................................................................................................. 30
Policy Proxy ..................................................................................................................................................... 32
  Time Slotting ................................................................................................................................................... 32
  Polling ........................................................................................................................................................... 32
  Poll Triggers .................................................................................................................................................. 32
  Failed Poll Attempts ..................................................................................................................................... 32
  General Information .................................................................................................................................... 32
Navigate the Dell Server ..................................................................................................................................... 33
Navigation .......................................................................................................................................................... 33
  Dashboard ...................................................................................................................................................... 33
  Populations .................................................................................................................................................... 33
  Reporting ..................................................................................................................................................... 33
  Management ................................................................................................................................................ 33
Masthead Icons ................................................................................................................................................ 33
Disconnected Mode .......................................................................................................................................... 33
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Activation</td>
<td>34</td>
</tr>
<tr>
<td>Management Console</td>
<td>34</td>
</tr>
<tr>
<td>Functionality</td>
<td>34</td>
</tr>
<tr>
<td>Dashboard</td>
<td>34</td>
</tr>
<tr>
<td>Notifications List</td>
<td>35</td>
</tr>
<tr>
<td>Notification Types</td>
<td>37</td>
</tr>
<tr>
<td>Priority Levels</td>
<td>38</td>
</tr>
<tr>
<td>Endpoint Protection Status</td>
<td>38</td>
</tr>
<tr>
<td>Protection Status</td>
<td>38</td>
</tr>
<tr>
<td>Threat Protection Status</td>
<td>39</td>
</tr>
<tr>
<td>Threat Protection Status for Severity Level</td>
<td>39</td>
</tr>
<tr>
<td>Advanced Threat Prevention Events</td>
<td>39</td>
</tr>
<tr>
<td>Advanced Threats by Priority</td>
<td>40</td>
</tr>
<tr>
<td>Advanced Threat Prevention Classifications</td>
<td>42</td>
</tr>
<tr>
<td>Type of Threat</td>
<td>42</td>
</tr>
<tr>
<td>Score</td>
<td>44</td>
</tr>
<tr>
<td>File Type</td>
<td>44</td>
</tr>
<tr>
<td>Priority Level</td>
<td>45</td>
</tr>
<tr>
<td>Advanced Threats Top Ten</td>
<td>45</td>
</tr>
<tr>
<td>Endpoint Protection History</td>
<td>45</td>
</tr>
<tr>
<td>Endpoint Inventory History</td>
<td>45</td>
</tr>
<tr>
<td>Summary Statistics</td>
<td>45</td>
</tr>
<tr>
<td>Endpoint OS Report</td>
<td>46</td>
</tr>
<tr>
<td>Platform Report</td>
<td>46</td>
</tr>
<tr>
<td>Populations</td>
<td>46</td>
</tr>
<tr>
<td>Populations</td>
<td>46</td>
</tr>
<tr>
<td>Enterprise</td>
<td>47</td>
</tr>
<tr>
<td>View or Modify Enterprise Policies</td>
<td>47</td>
</tr>
<tr>
<td>View Threat Events</td>
<td>47</td>
</tr>
<tr>
<td>Manage Enterprise Advanced Threats</td>
<td>48</td>
</tr>
<tr>
<td>Advanced Threats tab</td>
<td>48</td>
</tr>
<tr>
<td>Advanced Threat Events tab</td>
<td>48</td>
</tr>
<tr>
<td>Domains</td>
<td>49</td>
</tr>
</tbody>
</table>
Domains .................................................................................................................................................... 49
  Add a Domain ........................................................................................................................................ 49
Users .......................................................................................................................................................... 49
  Add a User by Domain ........................................................................................................................... 49
User Groups .............................................................................................................................................. 50
  Add a User Group .................................................................................................................................. 50
  Add Non-Domain Users .......................................................................................................................... 51
  View or Modify Domain Policies and Information .................................................................................... 51
Domain Details & Actions .......................................................................................................................... 51
Domain Members ....................................................................................................................................... 52
Domain Settings ......................................................................................................................................... 52
Domain Key Server .................................................................................................................................. 53
User Groups .............................................................................................................................................. 53
  Add a User Group .................................................................................................................................. 53
  Remove User Groups ............................................................................................................................. 54
  Find User Groups .................................................................................................................................. 54
  View or Modify User Group Policies and Information ............................................................................... 54
VDI User Policies ........................................................................................................................................ 55
  Policy and Configuration Requirements for VDI Users ........................................................................... 55
User Group Details & Actions .................................................................................................................... 56
User Group Members .................................................................................................................................. 56
  Add Users to the Group ........................................................................................................................... 57
  Remove Users from the Group ................................................................................................................ 57
User Group Admin ....................................................................................................................................... 57
  Edit Group Priority .................................................................................................................................. 58
  Edit Endpoint Group Priority .................................................................................................................. 58
  Edit User Group Priority ........................................................................................................................ 58
Assign or Modify Administrator Roles ...................................................................................................... 59
View Reconciliation Date ............................................................................................................................ 60
View Policy Proxy State ............................................................................................................................... 60
Users .......................................................................................................................................................... 60
  Add a User by Domain ........................................................................................................................... 60
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Users</td>
<td>61</td>
</tr>
<tr>
<td>Find Users</td>
<td>61</td>
</tr>
<tr>
<td>Deactivate/Suspend Users</td>
<td>61</td>
</tr>
<tr>
<td>Reinstates Suspend Users</td>
<td>62</td>
</tr>
<tr>
<td>View or Modify User Policies and Information</td>
<td>62</td>
</tr>
<tr>
<td>User Details &amp; Actions</td>
<td>63</td>
</tr>
<tr>
<td>User Endpoints</td>
<td>63</td>
</tr>
<tr>
<td>User Groups</td>
<td>64</td>
</tr>
<tr>
<td>User Admin</td>
<td>65</td>
</tr>
<tr>
<td>View Reconciliation Date</td>
<td>65</td>
</tr>
<tr>
<td>View Policy Proxy State</td>
<td>65</td>
</tr>
<tr>
<td>Issue a User Decryption Policy</td>
<td>65</td>
</tr>
<tr>
<td>Endpoint Groups</td>
<td>66</td>
</tr>
<tr>
<td>Types of Endpoint Groups</td>
<td>66</td>
</tr>
<tr>
<td>Add an Endpoint Group</td>
<td>66</td>
</tr>
<tr>
<td>Remove an Endpoint Group</td>
<td>67</td>
</tr>
<tr>
<td>Modify an Endpoint Group</td>
<td>67</td>
</tr>
<tr>
<td>VDI Endpoint Groups</td>
<td>67</td>
</tr>
<tr>
<td>Policy and Configuration Requirements for VDI Endpoint Groups</td>
<td>67</td>
</tr>
<tr>
<td>Persistent vs. Non-Persistent VDI</td>
<td>68</td>
</tr>
<tr>
<td>Endpoint Groups Specification</td>
<td>69</td>
</tr>
<tr>
<td>Endpoint Group Specification</td>
<td>69</td>
</tr>
<tr>
<td>Operators and Expressions</td>
<td>70</td>
</tr>
<tr>
<td>Working with Complex Queries</td>
<td>71</td>
</tr>
<tr>
<td>Examples</td>
<td>71</td>
</tr>
<tr>
<td>Edit Group Priority</td>
<td>72</td>
</tr>
<tr>
<td>Edit Endpoint Group Priority</td>
<td>72</td>
</tr>
<tr>
<td>Edit User Group Priority</td>
<td>73</td>
</tr>
<tr>
<td>View Endpoints in an Endpoint Group</td>
<td>73</td>
</tr>
<tr>
<td>View or Modify Endpoint Group Policies and Information</td>
<td>74</td>
</tr>
<tr>
<td>Endpoint Group Details &amp; Actions</td>
<td>74</td>
</tr>
<tr>
<td>Endpoint Group Members</td>
<td>75</td>
</tr>
<tr>
<td>Add Endpoints to an Admin-Defined Endpoint Group</td>
<td>75</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Commands for Self-Encrypting Drives</td>
<td>91</td>
</tr>
<tr>
<td>Priority of Commands for Self-Encrypting Drives</td>
<td>91</td>
</tr>
<tr>
<td>Allow PBA Login Bypass</td>
<td>92</td>
</tr>
<tr>
<td>Unlock a Self-Encrypting Drive</td>
<td>92</td>
</tr>
<tr>
<td>Remove Users from Endpoint with Self-Encrypting Drive</td>
<td>93</td>
</tr>
<tr>
<td>Lock a Self-Encrypting Drive</td>
<td>93</td>
</tr>
<tr>
<td>Send Wipe Command to Self-Encrypting Drive</td>
<td>93</td>
</tr>
<tr>
<td>Set the Dell Server Connection Retry Interval</td>
<td>94</td>
</tr>
<tr>
<td>Administrators</td>
<td>94</td>
</tr>
<tr>
<td>Assign or Modify Administrator Roles</td>
<td>94</td>
</tr>
<tr>
<td>Administrator Roles</td>
<td>95</td>
</tr>
<tr>
<td>Delegate Administrator Rights</td>
<td>98</td>
</tr>
<tr>
<td>Reporting</td>
<td>99</td>
</tr>
<tr>
<td>Manage Reports</td>
<td>99</td>
</tr>
<tr>
<td>View or Modify an Existing Report</td>
<td>100</td>
</tr>
<tr>
<td>Create a New Report</td>
<td>100</td>
</tr>
<tr>
<td>View Report</td>
<td>100</td>
</tr>
<tr>
<td>Query using Search and More… to filter</td>
<td>101</td>
</tr>
<tr>
<td>Export File</td>
<td>102</td>
</tr>
<tr>
<td>Add Schedule</td>
<td>102</td>
</tr>
<tr>
<td>Compliance Reporter</td>
<td>102</td>
</tr>
<tr>
<td>Data Guardian Audit Events</td>
<td>103</td>
</tr>
<tr>
<td>Map visualization</td>
<td>103</td>
</tr>
<tr>
<td>Audit Event Options and Filters</td>
<td>103</td>
</tr>
<tr>
<td>Options in the Columns Menu</td>
<td>105</td>
</tr>
<tr>
<td>Protected Office Document or Basic File Protection audit events (Windows, Mac, mobile, web portal, CASB)</td>
<td>106</td>
</tr>
<tr>
<td>Examples of Map Visualization and Column Filters</td>
<td>110</td>
</tr>
<tr>
<td>Example of drilling in at the map level</td>
<td>111</td>
</tr>
<tr>
<td>Get Started with Data Guardian Audit Events</td>
<td>111</td>
</tr>
<tr>
<td>Audit Protected Office Documents</td>
<td>111</td>
</tr>
<tr>
<td>Audit Cloud Encryption (Mac or mobile)</td>
<td>113</td>
</tr>
<tr>
<td>Default Monikers and Columns</td>
<td>113</td>
</tr>
</tbody>
</table>
EU General Data Protection Regulation (GDPR) ................................. 113
View Audit Events (Geolocation) .......................................................... 113
Event Data ..................................................................................... 114
Export Events to a SIEM/Syslog Server ............................................. 114
Export Audit Events with TLS/SSL over TCP ................................. 115
Advanced Threat Prevention Syslog Event Types .......................... 116
Advanced Threat Prevention Syslog IP Addresses ........................ 119
Management ............................................................................. 120
Commit Policies ...................................................................... 120
Log Analyzer .......................................................................... 120
Recovery .................................................................................. 121
  Recover Data - Encryption External Media Authentication Failure .................................................................. 121
  Encryption External Media Recovery for User “Removed” from Database .................................................. 124
  Enable Federated Key Recovery ................................................................. 124
  Recover Data - BitLocker Manager ...................................................... 125
  Recover Endpoint ........................................................................ 125
    Windows Recovery .................................................................... 125
    SED Recovery ....................................................................... 125
    Encryption External Media Recovery .......................................... 125
    Mac Recovery ..................................................................... 125
License Management .................................................................... 126
  License Management ............................................................... 126
    Upload Client Access Licenses ...................................................... 126
    View or Add License Notifications .............................................. 126
    Client Access License (CAL) Information .................................. 126
      Licensing ........................................................................ 126
    Upload Client Access Licenses ...................................................... 127
Services Management .................................................................. 128
  Services Management ............................................................... 128
    Provision or Recover Advanced Threat Prevention Service ................................................................. 128
      Provision service ...................................................................... 128
      Recover service ...................................................................... 128
    Enroll for Advanced Threat Prevention Agent Auto Updates ................................................................. 129
      Receive agent auto updates .......................................................... 129
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop receiving agent auto updates</td>
<td>129</td>
</tr>
<tr>
<td>Events Management - Export Audit Events to a SIEM Server</td>
<td>129</td>
</tr>
<tr>
<td>Product Notifications</td>
<td>129</td>
</tr>
<tr>
<td>Receive product notifications</td>
<td>129</td>
</tr>
<tr>
<td>Stop receiving product notifications</td>
<td>130</td>
</tr>
<tr>
<td>Enable Data Guardian Access Groups</td>
<td>130</td>
</tr>
<tr>
<td>Notification Management</td>
<td>130</td>
</tr>
<tr>
<td>Enable SMTP Server for Email Notifications</td>
<td>131</td>
</tr>
<tr>
<td>Product Notifications</td>
<td>131</td>
</tr>
<tr>
<td>Receive product notifications</td>
<td>131</td>
</tr>
<tr>
<td>Stop receiving product notifications</td>
<td>131</td>
</tr>
<tr>
<td>Data Guardian Management</td>
<td>131</td>
</tr>
<tr>
<td>Registration Access</td>
<td>131</td>
</tr>
<tr>
<td>Key Request</td>
<td>132</td>
</tr>
<tr>
<td>Key Revocation</td>
<td>133</td>
</tr>
<tr>
<td>Key Management</td>
<td>133</td>
</tr>
<tr>
<td>Web Portal</td>
<td>133</td>
</tr>
<tr>
<td>Change Superadmin Password</td>
<td>134</td>
</tr>
<tr>
<td>Change Account Lockout Settings</td>
<td>134</td>
</tr>
<tr>
<td>Downloads</td>
<td>134</td>
</tr>
<tr>
<td>Endpoint Software</td>
<td>134</td>
</tr>
<tr>
<td>Manage Policies</td>
<td>137</td>
</tr>
<tr>
<td>Manage Security Policies</td>
<td>137</td>
</tr>
<tr>
<td>Localize Policies Displayed on the Endpoint Computer</td>
<td>138</td>
</tr>
<tr>
<td>Localizable Policies</td>
<td>139</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>142</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>142</td>
</tr>
<tr>
<td>Variables</td>
<td>151</td>
</tr>
<tr>
<td>%CSIDL:name%</td>
<td>151</td>
</tr>
<tr>
<td>%HKCU:regpath%</td>
<td>152</td>
</tr>
<tr>
<td>%HKLM:regpath%</td>
<td>152</td>
</tr>
<tr>
<td>%ENV:envname%</td>
<td>153</td>
</tr>
<tr>
<td>%%</td>
<td>153</td>
</tr>
</tbody>
</table>
Security Management Server v10.2.7 AdminHelp

Windows Policies that Require Reboot ................................................................. 153
Windows Policies that Require Logoff ................................................................. 153
Advanced Windows Encryption ........................................................................... 153
Variables ............................................................................................................. 183
%CSIDL:name% .................................................................................................... 183
%HKCU:regpath% ................................................................................................ 185
%HKLM:regpath% ................................................................................................ 185
%ENV:envname% ............................................................................................... 185
% ....................................................................................................................... 185
Windows Policies that Require Reboot ................................................................. 185
Windows Policies that Require Logoff ................................................................. 185
Encryption Rules ................................................................................................ 185
Protected Directories .......................................................................................... 185
Modifiers - What they are and what they do ...................................................... 186
Using the Override Modifier ............................................................................... 186
Encrypting/Not Encrypting Extensions ............................................................... 186
Examples of Extension Inclusions/Exclusion .................................................... 186
Encrypting/Not Encrypting Directories ............................................................... 187
Examples of folder inclusion/exclusion ............................................................. 187
Sub-directories and Precedence of Directives .................................................... 187
Example of sub-directories ............................................................................... 187
Example 1 of competing directives: ................................................................. 187
Example 2 of competing directives: ................................................................. 188
Example 3 of competing directives: ................................................................. 188
Environment Variables, KNOWNFOLDERID constants, and CSIDL ................. 188
Application Data Encryption (ADE) .................................................................... 190
Example Policies for Common/User Key Encryption ........................................ 190
System Data Encryption (SDE) ........................................................................... 190
Encryption Rules for SDE Encryption ............................................................... 191
Protection of SystemRoot .................................................................................. 191
Encryption Rules for Encryption External Media .............................................. 191
What Happens When Policies Tie .................................................................... 191
Encryption Rules for Generic Drive Statements .............................................. 191
Remove System Data Encryption (SDE) ............................................................ 192
Table of Contents

Authentication ............................................................................................................................................... 192

Authentication ........................................................................................................................................... 192
Advanced Authentication ........................................................................................................................... 193

Threat Prevention ......................................................................................................................................... 199

Threat Prevention ...................................................................................................................................... 199
Advanced Threat Prevention ..................................................................................................................... 203
Client Firewall Settings and Rules .................................................................................................................. 233
Client Firewall Rules ............................................................................................................................... 233

Client Firewall Options ........................................................................................................................... 233

Policies Set by Application Control ........................................................................................................ 238

Advanced Threat Events tab fields and filters ............................................................................................ 239

Manage Enterprise Advanced Threats - Protection ..................................................................................... 239
Threats ....................................................................................................................................................... 239
File Details .................................................................................................................................................. 241
Script Control Table ..................................................................................................................................... 241

Manage Enterprise Advanced Threats - Agents ............................................................................................ 242

Manage Enterprise Advanced Threats - Certificate ..................................................................................... 242

Manage Enterprise Advanced Threats - Cylance Score and Threat Model Updates .................................. 243
Threat Model Updates ................................................................................................................................ 243

Manage Enterprise Advanced Threats - Global List .................................................................................. 244
Global Quarantine ........................................................................................................................................ 244
Safe .............................................................................................................................................................. 245
Unassigned ................................................................................................................................................. 246

Manage Enterprise Advanced Threats - Options ......................................................................................... 247

Threat Data Report ..................................................................................................................................... 247

Export Data .................................................................................................................................................. 247

Advanced Threat Prevention Classifications ............................................................................................... 248

Enable Compatibility Mode for Memory Protection ...................................................................................... 248

Disconnected Mode Policy Examples ......................................................................................................... 249
Global Allow policy example ...................................................................................................................... 249
Quarantine List and Safe List policy examples .............................................................................................. 252

Threat Protection Policy Overview ............................................................................................................ 253
Configurable Actions - After Threat is Detected ....................................................................................... 254
Reputation Service Sensitivity policies ........................................................................................................ 254
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Access Groups</td>
<td>283</td>
</tr>
<tr>
<td>Legacy policies for Data Guardian</td>
<td>283</td>
</tr>
<tr>
<td>Legacy Policies for Data Guardian's Opt-in Mode</td>
<td>283</td>
</tr>
<tr>
<td>Windows: Additional Office menu options for Data Guardian v2.7 and earlier</td>
<td>283</td>
</tr>
<tr>
<td>Windows: Additional Office menu options on Windows for Data Guardian v2.7 and earlier</td>
<td>284</td>
</tr>
<tr>
<td>Windows: Additional policies</td>
<td>284</td>
</tr>
<tr>
<td>Legacy Policies for Data Guardian's Force-Protected Mode</td>
<td>284</td>
</tr>
<tr>
<td>Windows: Additional Office menu options for Data Guardian v2.7 and earlier</td>
<td>285</td>
</tr>
<tr>
<td>Windows: Additional Office menu options on Windows for Data Guardian v2.7 and earlier</td>
<td>285</td>
</tr>
<tr>
<td>Windows: Additional policies</td>
<td>285</td>
</tr>
<tr>
<td>Set Policies to Protect Documents in Mobile Devices</td>
<td>286</td>
</tr>
<tr>
<td>Set Protected Office Document Policies</td>
<td>286</td>
</tr>
<tr>
<td>Set Policies to Protect Documents on the Web Portal</td>
<td>286</td>
</tr>
<tr>
<td>Set Protected Office Document Policies</td>
<td>286</td>
</tr>
<tr>
<td>Configure Content Based Protection for Data Guardian's Opt-in mode</td>
<td>287</td>
</tr>
<tr>
<td>Modify a Content-Based Rule</td>
<td>287</td>
</tr>
<tr>
<td>Content-Based Rule Name and Priority</td>
<td>288</td>
</tr>
<tr>
<td>Actions</td>
<td>289</td>
</tr>
<tr>
<td>Rules</td>
<td>289</td>
</tr>
<tr>
<td>Elements</td>
<td>289</td>
</tr>
<tr>
<td>Add an Enterprise-Specific Rule Name or Tag Element</td>
<td>290</td>
</tr>
<tr>
<td>Create a Rule Name</td>
<td>290</td>
</tr>
<tr>
<td>Create an Element</td>
<td>290</td>
</tr>
<tr>
<td>View Audit Event Reports</td>
<td>291</td>
</tr>
<tr>
<td>Set TITUS classification (Opt-in mode)</td>
<td>291</td>
</tr>
<tr>
<td>Configure TITUS to encrypt files</td>
<td>291</td>
</tr>
<tr>
<td>Configure TITUS to encrypt macro-enabled documents</td>
<td>292</td>
</tr>
<tr>
<td>Use Data Guardian with Cloud Encryption</td>
<td>292</td>
</tr>
<tr>
<td>Windows 2.3 and earlier or Mac 2.8 and earlier</td>
<td>293</td>
</tr>
<tr>
<td>Enable Both Cloud Encryption and Protected Office Documents (Windows 2.3 and earlier)</td>
<td>293</td>
</tr>
<tr>
<td>Cloud Profile Update</td>
<td>293</td>
</tr>
<tr>
<td>Configure Access Groups</td>
<td>294</td>
</tr>
<tr>
<td>Set up Access Groups</td>
<td>294</td>
</tr>
<tr>
<td>Enterprise does not yet have Data Guardian</td>
<td>295</td>
</tr>
</tbody>
</table>
Security Management Server v10.2.7 AdminHelp

Enterprise has Data Guardian Installed ................................................................. 295
Configure Access Groups .............................................................................. 296
Disable Auto access for swept files (Windows and Mac) ...................................... 296
Removable Media Encryption ........................................................................... 298
Removable Media Encryption........................................................................... 298
Removable Media Policies that Require Logoff .................................................... 301
Advanced Removable Media Encryption ................................................................. 301
Removable Media Policies that Require Logoff .................................................... 309
Mac Encryption ................................................................................................. 309
Mac Encryption................................................................................................. 310
Advanced Mac Encryption .................................................................................... 312
Port Control ........................................................................................................ 313
Port Control ........................................................................................................ 313
Advanced Port Control .......................................................................................... 314
Global Settings .................................................................................................. 315
Advanced Global Settings ..................................................................................... 317
Welcome

About Online Help

Version: 10.2.7

Attributions & Copyrights

Dell, EMC, and other trademarks are trademarks of Dell Inc. or its subsidiaries. Other trademarks may be trademarks of their respective owners.

Protected by one or more U.S. Patents, including: Number 7665125; Number 7437752; and Number 7665118.

The software described is furnished under a license agreement and may be used only in accordance with the terms of the agreement.

Third Party Software

I. OpenSSL License - Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

A. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

B. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

C. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)".

D. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

E. Products derived from this software may not be called "OpenSSL" * nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

F. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)" THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and non-commercial use as long as the following conditions are adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

a. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
b. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
c. All advertising materials mentioning features or use of this software must display the following acknowledgement:

   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related.
d. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement:

   "This product includes software written by Tim Hudson (tjh@cryptsoft.com)" THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence].

II. Portions of this product use Commons IO, Commons DBCP, and Commons LANG. You may obtain a copy of the licenses at http://www.apache.org/licenses/LICENSE-2.0.
III. Portions of this product use OrientDB. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

IV. Portions of this product use Apache Wink. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

V. Portions of this product use Jackson JSON. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

VI. Portions of this product use Jetty. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

VII. Portions of this product use ActiveMQ. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

VIII. Portions of this product use jasypt. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

IX. Portions of this product make use of zlib. You may obtain a copy of the license at http://www.zlib.net/zlib_license.html.

/* zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.7, May 2nd, 2012
* Copyright (C) 1995-2012 Jean-loup Gailly and Mark Adler
* This software is provided 'as-is', without any express or implied warranty.
* In no event will the authors be held liable for any damages arising from the
* use of this software. Permission is granted to anyone to use this software for any purpose, including
* commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:
*
A. The origin of this software must not be misrepresented; you must not claim that you wrote the original
* software. If you use this software in a product, an acknowledgment in the product documentation would be
* appreciated but is not required.

B. Altered source versions must be plainly marked as such, and must not be misrepresented as being the
* original software.

C. This notice may not be removed or altered from any source distribution. Jean-loup Gailly Mark Adler
* jloup@gzip.org madler@alumni.caltech.edu.

X. Portions of this product make use of Apache Tomcat (www.apache.org). You may obtain a copy of
* the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XI. Portions of this product make use of Apache Commons HttpClient. You may obtain a copy of the
* license at http://opensource.org/licenses/apache2.0.

XII. Portions of this product make use of log4net. You may obtain a copy of the license at

XIII. Portions of this product make use of MVVM Light Toolkit. You may obtain a copy of the license at
* http://mvvmlight.codeplex.com/license.

XIV. Portions of this product make use of Apache JDBCLog, Apache Software Foundation. You may
* obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XV. Portions of this product make use of Apache Log4J, Apache Software Foundation. You may obtain
* a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XVI. Portions of this product make use of Apache Struts, Apache Software Foundation. You may obtain
* a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XVII. Portions of this product make use of Struts2. You may obtain a copy of the license at
* http://www.apache.org/licenses/LICENSE-2.0.

XVIII. Portions of this product make use of Struts Beanutils, Apache Software Foundation. You may
* obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.
Welcome

XIX. Portions of this product make use of Struts Digester, Apache Software Foundation. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XX. Portions of this product make use of Apache xmlrpc, Apache Software Foundation. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.


XXIV. Portions of this product make use of Groovy. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.html.


XXVI. Portions of this product make use of Spring.net Application Framework. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.html.


XXVIII. Portions of this product make use of Xalan. You may obtain a copy of the license at http://xml.apache.org/xalan-j/.

XXIX. Portions of this product make use of FreeMarker. You may obtain a copy of the license at http://freemarker.sourceforge.net/docs/app_license.html.

XXX. Portions of this product make use of Velocity. You may obtain a copy of the license at http://velocity.apache.org/.

XXXI. Portions of this product make use of MSV. You may obtain a copy of the license at http://opensource.org/licenses/apache2.0.

XXXII. Portions of this product make use of FLIB. You may obtain a copy of the license at http://opensource.org/licenses/artistic-license.html.

XXXIII. Portions of this product makes use of libraries developed by Boost (http://www.boost.org/users/license.html), under the following license: Boost Software License - Version 1.0 - August 17th, 2003.

XXXIV. Portions of this product make use of ANTLR. You may obtain a copy of the license at http://antlr.org/license.html.

XXXV. Portions of this product make use of BIRT. You may obtain a copy of the license at http://www.eclipse.org/org/documents/epl-v10.php.

XXXVI. Portions of this product make use of the getopt function, Copyright © 1987-2002 The Regents of the University of California. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

A. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

B. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
C. Neither the names of the copyright holders nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

XXXVII. Portions of this product make use of the SHA-2 algorithm, Copyright © 2002, Dr. Brian Gladman (brg@gladman.me.uk), Worcester, UK. All rights reserved.

A. LICENSE TERMS

The free distribution and use of this software in both source and binary form is allowed (with or without changes) provided that:

1. Distributions of this source code include the above copyright notice, this list of conditions and the following disclaimer;

2. Distributions in binary form include the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other associated materials;

3. The copyright holder's name is not used to endorse products built using this software without specific written permission.

DISCLAIMER

This software is provided "as is" with no explicit or implied warranties in respect of its properties, including, but not limited to, correctness and/or fitness for purpose.

XXXVIII. Portions of this product make use of STLport. A copy of the license may be obtained at http://www.stlport.org/doc/license.html.

A. License Agreement:

Boris Fomitchev grants Licensee a non-exclusive, non-transferable, royalty-free license to use STLport and its documentation without fee.

By downloading, using, or copying STLport or any portion thereof, Licensee agrees to abide by the intellectual property laws and all other applicable laws of the United States of America, and to all of the terms and conditions of this Agreement.

Licensee shall maintain the following copyright and permission notices on STLport sources and its documentation unchanged:

Copyright 1999,2000 Boris Fomitchev

This material is provided "as is", with absolutely no warranty expressed or implied. Any use is at your own risk.

Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.

The Licensee may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
The Licensee may distribute original or modified STLport sources, provided that:

- The conditions indicated in the above permission notice are met;
- The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:

Copyright 1994 Hewlett-Packard Company - Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Copyright 1996,97 Silicon Graphics Computer Systems, Inc. - Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Copyright 1997 Moscow Center for SPARC Technology - Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC Technology makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

XXXIX. Portions of this product make use of The Legion of Bouncy Castle Software. Copyright (c) 2000 - 2016 The Legion Of The Bouncy Castle. You may obtain a copy of the license at http://www.bouncycastle.org/licence.html.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Note: Our license is an adaptation of the MIT X11 License and should be read as such.

License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
XL. Portions of this product make use of ResizableLib. You may obtain a copy of the license at http://opensource.org/licenses/artistic-license-1.0.

XLI. Portions of this product make use of Spring Framework. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XLII. Portions of this product use $File:

A. LEGAL NOTICE,v 1.15 2006/05/03 18:48:33 christos Exp $. Copyright (c) Ian F. Darwin 1986, 1987, 1989, 1990, 1991, 1992, 1994, 1995. Software written by Ian F. Darwin and others; maintained 1994-Christos Zoulas. This software is not subject to any export provision of the United States Department of Commerce, and may be exported to any country or planet. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice immediately at the beginning of the file, without modification, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

XLIII. Portions of this product use UFSD – Paragon NTFS for Windows Driver based on Paragon Universal File System Driver (UFSD) Technology. Copyright (C) 2008 Paragon Technologie GmbH. All rights reserved. This software is provided 'as-is', without any express or implied warranty.

XLIV. Portions of this product use JDBC drivers - licensed from DataDirect Technologies.

XLV. Portions of this product make use of DIMime, available at http://www.zeitungsjunge.de/delphi/mime/.

XLVI. Portions of this product make use of RSA Security Inc. PKCS #11 Crypto Token Interface (Cryptoki).

XLVII. This software uses following 3rd party libraries:

1. urwid

Copyright (C) 2004-2012 Ian Ward

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it is useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Welcome

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

1. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

"Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

You may convey a Combined Work under terms of your choice that, taken together, effectively
do not restrict modification of the portions of the Library contained in the Combined Work and
reverse engineering for debugging such modifications, if you also do each of the following:

   a) Give prominent notice with each copy of the Combined Work that the Library is used in it
      and that the Library and its use are covered by this License.

   b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

   c) For a Combined Work that displays copyright notices during execution, include the
      copyright notice for the Library among these notices, as well as a reference directing the user
      to the copies of the GNU GPL and this license document.

   d) Do one of the following:

      0) Convey the Minimal Corresponding Source under the terms of this License, and the
         Corresponding Application Code in a form suitable for, and under terms that permit, the
         user to recombine or relink the Application with a modified version of the Linked Version
         to produce a modified Combined Work, in the manner specified by section 6 of the GNU
         GPL for conveying Corresponding Source.

      1) Use a suitable shared library mechanism for linking with the Library. A suitable
         mechanism is one that (a) uses at run time a copy of the Library already present on the
         user's computer system, and (b) will operate properly with a modified version of the
         Library that is interface-compatible with the Linked Version.

   e) Provide Installation Information, but only if you would otherwise be required to provide
      such information under section 6 of the GNU GPL, and only to the extent that such
      information is necessary to install and execute a modified version of the Combined Work
      produced by recombining or relinking the Application with a modified version of the Linked
      Version. (If you use option 4d0, the Installation Information must accompany the Minimal
      Corresponding Source and Corresponding Application Code. If you use option 4d1, you must
      provide the Installation Information in the manner specified by section 6 of the GNU GPL for
      conveying Corresponding Source.)


   You may place library facilities that are a work based on the Library side by side in a single
   library together with other library facilities that are not Applications and are not covered by this
   License, and convey such a combined library under terms of your choice, if you do both of the
   following:

      a) Accompany the combined library with a copy of the same work based on the Library,
         uncombined with any other library facilities, conveyed under the terms of this License.

      b) Give prominent notice with the combined library that part of it is a work based on the
         Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

   The Free Software Foundation may publish revised and/or new versions of the GNU Lesser
   General Public License from time to time. Such new versions is similar in spirit to the present
   version, but may differ in detail to address new problems or concerns.

   Each version is given a distinguishing version number. If the Library as you received it specifies
   that a certain numbered version of the GNU Lesser General Public License "or any later version"
   applies to it, you have the option of following the terms and conditions either of that published
   version or of any later version published by the Free Software Foundation. If the Library as you
   received it does not specify a version number of the GNU Lesser General Public License, you
   may choose any version of the GNU Lesser General Public License ever published by the Free
   Software Foundation.
If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

XLVIII. Portions of this product use DropNet. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XLIX. Portions of this product use Hardcodet WPF NotifyIcon 1.0.8. You may obtain a copy of the license at http://www.codeproject.com/info/cpol10.aspx.

L. Portions of this product use MahApps.Metro 1.2.4.0. You may obtain a copy of the license at http://opensource.org/licenses/ms-pl.

LI. Portions of this product use Microsoft Practices Enterprise Library 6.0.1304.0. You may obtain a copy of the license at http://opensource.org/licenses/ms-pl.

LII. Portions of this product use Microsoft Practices Prism 4.1. You may obtain a copy of the license at http://opensource.org/licenses/ms-pl.

LIII. Portions of this product use Microsoft Practices Unity 2.1. You may obtain a copy of the license at http://opensource.org/licenses/ms-pl.

LIV. Portions of this product use RestSharp 105.2.3. You may obtain a copy of the license at https://github.com/restsharp/RestSharp/blob/master/LICENSE.txt.

Copyright 2009 RestSharp

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License.

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

LV. Portions of this product use System.Data.SQLite 1.0.102.0. You may obtain a copy of the copyright statement at http://www.sqlite.org/copyright.html.

LVI. Portions of this product use android-passwordsafe 0.6.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LVII. Portions of this product use Dropbox.NET 3.4.0. You may obtain a copy of the license at https://github.com/dropbox/dropbox-sdk-dotnet/blob/master/LICENSE.


The MIT License (MIT)

Copyright (c) 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"); to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.


LX. Portions of this product use Prism Core 6.1. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.


LXII. Portions of this product use Unity 4.0.1. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXIII. Portions of this product use the Dropbox Android SDK 1.6.3. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

LXIV. Portions of this product use the Dropbox json_simple-1.1.jar. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

LXV. Portions of this product use the Box Android Library V2. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXVI. Portions of this product use the Box Java Library V2. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXVII. Portions of this product use Apache HttpClient Cache 4.2.5. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXVIII. Portions of this product use Apache HttpClient 4.2.5. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXIX. Portions of this product use Apache HttpCore 4.2.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXX. Portions of this product use Apache HttpClient Mime 4.2.5. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXI. Portions of this product use Apache Commons IO 2.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXII. Portions of this product use Apache Commons Lang 2.6. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.


LXXIV. Portions of this product use EasyMock 3.1. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXV. Portions of this product use Jackson Databind 2.4.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXVI. Portions of this product use Jackson Core 2.4.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.
LXXVII. Portions of this product use Jackson Annotations 2.4.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXVIII. Portions of this product use Apache Maven Wagon 2.2. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXIX. Portions of this product use Scribe OAuth Library 1.3.0. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

LXXX. Portions of this product use JSON Web Token Support for the JVM 0.6.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXI. Portions of this product use OneDrive SDK Android 1.2.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

LXXXII. Portions of this product use Microsoft Services MSA Auth 0.8.4. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXIII. Portions of this product use Adal 1.1.7. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXIV. Portions of this product use Google API Client Library for Java with Android Platform Extensions and GSON Extensions 1.20.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXV. Portions of this product use Google Drive API V3 Rev 170 1.22.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXVI. Portions of this product use Backport Util Concurrent 3.1. You may obtain a copy of the license at https://creativecommons.org/publicdomain/zero/1.0.

LXXXVII. Portions of this product use Apache Commons Logging 1.1.3. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.


LXXXIX. Portions of this product use kSOAP2 3.4.0. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

XC. Portions of this product use FindBugs Jsr305. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XCI. Portions of this product use Google Gson 2.3.1. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XCII. Portions of this product use Hockey SDK 3.0.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

XCIII. Portions of this product use Picasso 2.5.2. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XCIV. Portions of this product use Circular Floating Action Menu Library 1.0.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

XCV. Portions of this product use Apache Commons Codec 1.8. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XCVI. Portions of this product use Apache Commons Compress 1.1. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

XCVII. Portions of this product use One Password App Extension 1.8. You may obtain a copy of the license at http://opensource.org/licenses/MIT.
XCVIII. Portions of this product use Azure Active Directory Authentication Library 1.2.9. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

XCIX. Portions of this product use AF Networking 2.6.3. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

C. Portions of this product use Box iOS SDK 1.0.11. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

Cl. Portions of this product use CT Assets Picker Controller 2.9.5. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

ClI. Portions of this product use Google API Objective C Client 1.0.422. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

ClII. Portions of this product use Google GTM HTTP Fetcher 1.0.141. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

ClIV. Portions of this product use Google GTM OAuth 2 1.0.126. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

CV. Portions of this product use Hockey SDK iOS 3.8.6. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CVI. Portions of this product use libextobjc 0.4.1. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CVII. Portions of this product use libPhoneNumber iOS 0.8.11. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

CVIII. Portions of this product use MBProgressHUD 0.9.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CIX. Portions of this product use MBProgressHUD 0.9.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CX. Portions of this product use OneDrive SDK iOS 1.1.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXI. Portions of this product use RNCryptor 3.0.1. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXII. Portions of this product use SSZipArchive 1.1. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXIII. Portions of this product use SVProgressHUD 2.0.2. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXIV. Portions of this product use WEPopover 1.0.0. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXV. Portions of this product use XMLDictionary. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXVI. Portions of this product use NHNetworkTime 1.7. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

CXVII. Portions of this product use the Dropbox iOS SDK. You may obtain a copy of the license at http://opensource.org/licenses/MIT.

CXVIII. Portions of this product use Flurry iOS SDK 5.3.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.
CXIX. Portions of this product make use of the Mono and the Mono runtime, under MIT, BSD, and Apache licenses. You may obtain a copy of the licenses at http://www.mono-project.com/docs/faq/licensing/.

Copyright 2018 Microsoft

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

---

Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---

Copyright 2018 Microsoft

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

CXX. Portions of this product make use of the Mono .NET assemblies under MIT and BSD licenses. You may obtain a copy of the licenses at https://mit-license.org/ and https://opensource.org/licenses/BSD-3-Clause.

The MIT License (MIT)

Copyright © 2018 Microsoft

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

---

The BSD License

Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CXXI. Portions of this product make use of mkbundle in Mono under GNU LESSER GENERAL PUBLIC LICENSE v3. You may obtain a copy of the license at https://www.gnu.org/licenses/lgpl.txt.

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.
   The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:
   a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.
   b. Accompany the object code with a copy of the GNU GPL and this license document.

   You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:
   a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.
   b. Accompany the Combined Work with a copy of the GNU GPL and this license document.
   c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.
   d. Do one of the following:
      0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.
      1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.
      e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)

   You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
   a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this License.
b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

CXXII. Portions of this product make use of minizip, memcheck.h, freebsd-dwarf.h, freebsd-elf_common.h, freebsd-elf64.h, freebsd-elf32.h, bsearch.c, w32file-unix-glob.c, and w32file-unix-glob.h in Mono under BSD license. You may obtain a copy of the license at https://opensource.org/licenses/BSD-3-Clause.

The BSD License

Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CXXIII. Portions of this product make use of RabbitMQ.Client in Mono under dual license in Apache v2 and Mozilla Public License 1.1. You may obtain a copy of the licenses at http://www.apache.org/licenses/LICENSE-2.0 and https://www.mozilla.org/MPL/.
License Information:

Copyright (c) 1999 - 2017 Dell Inc. All rights reserved.

This software and associated documentation (if any) is furnished under a license and may only be used or copied in accordance with the terms of the license.

Dell elects to use only the Apache license for any software where a choice of Apache v2, and Mozilla Public License 1.1 license versions are made available with the language indicating that Apache v2, and Mozilla Public License 1.1 "or any later version may be used, or where a choice of which version of the Apache v2, and Mozilla Public License 1.1" is applied is unspecified.

CXXIV. Portions of this product make use of Compat.ICSharpCode.SharpZipLib and ICSharpCode.SharpZipLib in Mono under GNU LESSER GENERAL PUBLIC LICENSE v3. You may obtain a copy of the license at https://www.gnu.org/licenses/lgpl.txt, although the full text is available below.

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

1. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

2. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.
3. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.

5. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)
   You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
   a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this License.
   b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

7. Revised Versions of the GNU Lesser General Public License.
   The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
   Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.
   If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

---

Classpath is distributed under the terms of the GNU General Public License with the following clarification and special exception.

Linking this library statically or dynamically with other modules is making a combined work based on this library. Thus, the terms and conditions of the GNU General Public License cover the whole combination.

As a special exception, the copyright holders of this library give you permission to link this library with independent modules to produce an executable, regardless of the license terms of these independent modules, and to copy and distribute the resulting executable under terms of your choice, provided that you also meet, for each linked independent module, the terms and conditions of the license of that module. An independent module is a module which is not derived from or based on this library. If you modify this library, you may extend this exception to your version of the library, but you are not obligated to do so. If you do not wish to do so, delete this exception statement from your version.

As such, it can be used to run, create and distribute a large class of applications and applets. When GNU Classpath is used unmodified as the core class library for a virtual machine, compiler for the java language, or for a program written in the java programming language it does not affect the licensing for distributing those programs directly.

Source code for this component can be found at http://opensource.dell.com.

CXXV. Portions of this product make use of TimeZoneInfo.Android.cs in Mono under Apache License, Version 2.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0

Copyright 2018 Microsoft
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License.

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

CXXVI. Portions of Advanced Threat Prevention are licensed under GNU LESSER GENERAL PUBLIC LICENSE v3. You may obtain a copy of the license at https://www.gnu.org/licenses/lgpl.txt or request information at www.cylance.com.
Get Started

Get Started with Dell Data Security

- Once your environment has been configured in the Server Configuration Tool, ensure that Dell services are started.
- Log in to the Management Console.
- Add Client Access Licenses, as needed.
- Add domains from your directory server.
- If you require that users receive non-default policies upon activation, modify policies at the appropriate level.
- Add groups and users, as necessary.
- Assign administrators, as necessary.
- Deploy clients.

Log In

To perform a given administrative procedure, an administrator must first log in to the Management Console using an appropriate Dell administrator account.

The Dell Server installs with a default super administrator user name (superadmin) and password (changeit) that you can use to add additional Dell administrator accounts.

1. Open a supported browser and type http://<server.domain.com>:8443/webui/login.
2. If you are logging in for the first time, in the Username, enter superadmin. In the Password, enter changeit. If you are not logging in for the first time, enter your user name in one of the formats listed below. In Password, enter <your_case-sensitive_password>.
   - user@domain.com (preferred format)
   - sAMAccountName, such as jsmith
   - <DOMAIN>\<Username> - You must specify your domain name as an alias to use this format. For more information, refer to Add Domains.
3. Click Sign in.

To log out, see Log Out.

Log Out

If you are an account administrator and make changes to your own account, you must log out and log back in to see the results.

- Click the gear icon in the top right corner of the Management Console and select Log out from the menu.
Dashboard

The dashboard displays an overview of status information for your enterprise. Access more detailed information directly from the dashboard by clicking its statistics, graphs, and chart legends.

In the top right, select the **Widgets** menu to add or remove the following widgets:

- Notifications
- Protection Status
- Threat
- Protection History
- Inventory History
- Summary Statistics

The images below reflect what may be seen in the dashboard, depending on widgets enabled.

Click an area below to view a description of the detail accessible by clicking the same area in the dashboard.

---

**Notifications**

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>Priority</th>
<th>Date</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Knowledge Base</td>
<td>Low</td>
<td>2/29/16 3:00 PM</td>
<td>KB-01 n.tory goes here</td>
</tr>
<tr>
<td>2</td>
<td>Knowledge Base</td>
<td>Low</td>
<td>2/29/16 3:02 PM</td>
<td>KB-02 summary goes here</td>
</tr>
<tr>
<td>3</td>
<td>Update</td>
<td>Low</td>
<td>2/29/16 3:04 PM</td>
<td>Cloud Profile Update v1.2.0.415</td>
</tr>
<tr>
<td>4</td>
<td>Config</td>
<td>High</td>
<td>2/29/16 3:06 PM</td>
<td>VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>5</td>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 2:27 PM</td>
<td>KB-1234. Portuguese VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>6</td>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 2:27 PM</td>
<td>KB-1234. VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>7</td>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 4:48 PM</td>
<td>KB-1234. VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>8</td>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 4:48 PM</td>
<td>KB-1234. Portuguese VE server 9.2 OpenSSL config update</td>
</tr>
</tbody>
</table>

---

**Endpoint Protection Status**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Protected</th>
<th>Not Protected</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>6 (29%)</td>
<td>15 (71%)</td>
<td>21</td>
</tr>
<tr>
<td>Mac</td>
<td>0 (N/A)</td>
<td>0 (N/A)</td>
<td>0</td>
</tr>
<tr>
<td>Mobile Devices</td>
<td>0 (N/A)</td>
<td>0 (N/A)</td>
<td>0</td>
</tr>
<tr>
<td>All</td>
<td>6 (29%)</td>
<td>15 (71%)</td>
<td>21</td>
</tr>
</tbody>
</table>

---

**Threat Protection Status**

<table>
<thead>
<tr>
<th>Threat Level</th>
<th>Time Frame (Days)</th>
<th>Critical</th>
<th>Major</th>
<th>Minor</th>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>10</td>
<td>20</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>
An Advanced Threat Prevention event is not necessarily a threat. An event is generated when a recognized file or program is quarantined, safe listed, or waived. Threats are a category of events that are newly detected as potentially unsafe files or programs and require guided remediation.
Get Started

Start the following Services:

- Dell Compatibility Server
- Dell Compliance Reporter
- Dell Console Web Services
- Dell Core Server
- Dell Device Server
- Dell Key Server
- Dell Message Broker
- Dell Policy Proxy
- Dell Security Server

From the Service Panel:

1. Click **Start > Run**. Type `services.msc` and click **OK**.
2. In the Services (Local) window, highlight *Dell Compatibility Server*. Right-click the entry and select **Start**.
3. Continue in the manner above until all Dell Services are started.
4. Close the Services window.

To stop Services, see Stop Services.

Stop Services

You may find it necessary to shut down the Services to run backups or perform other system maintenance. While the Server is down, the Policy Proxy cannot poll the Server, which means that it cannot pick up updated security policies, or activate/reactivate endpoints.

Stop the following Services:
- Dell Compatibility Server
- Dell Compliance Reporter
- Dell Console Web Services
- Dell Core Server
- Dell Device Server
- Dell Key Server
- Dell Message Broker
- Dell Policy Proxy
- Dell Security Server

From the Service Panel:
1. Click Start > Run. Type services.msc and click OK.
2. In the Services (Local) window, highlight Dell Compatibility Server. Right-click the entry and select Stop.
3. Continue in the manner above until all Dell Services are stopped.
4. Close the Services window.

To start Services, see Start Services.

Change Superadmin Password

1. In the masthead at the top of the screen, click the gear icon and select Change superadmin password.
2. Enter the current password.
3. Enter the new password.

The new password must be at least 6 characters, contain at least one capital letter and one of these characters: ~@#$%^*()|?!{}[].
4. Confirm the new password.
5. Click **Update**.

After three failed login attempts, the superadmin account is locked for five minutes. To change these settings, see [Set or Change Account Lockout Settings](#).
Components
Architecture Drawings

Architecture with Manager

Architecture with Encryption Enterprise for Windows/Manager

Default Port Values
Internal:
Active Directory communication: TCP/389
Email communication (optional): 25

To Front End (if needed):
Communication from external Policy Proxy to Message Broker: TCP/61616 and STOMP/61613
Communication to Back End Security Server: HTTPS/8443
Communication to Back End Core Server: HTTPS/8888 and 9000
Communication to RMI ports - 1099
Communication to Back End Device Server: HTTP(S)/8443 - If your Dell Server is v7.7 or later. If your Dell Server is pre-v7.7, HTTP(S)/8081.
Message Broker: TCP/61616 and STOMP/61613 (closed or, if configured for DMZ, 61613 is open)

External (if needed):
SQL Database: TCP/1433
LDAP: TCP/389/636 (local domain controller), TCP/3268/3269 (global catalog), TCP/135/49125+ (RPC)
Compatibility Server: TCP/1099
Compliance Reporter: HTTP(S)/8084 (automatically configured at installation)
Core Server: HTTPS/8888 and 9000 (8888 is automatically configured at installation)
Device Server: HTTP(S)/8081 - If your Dell Server is pre-v7.7/8443 - If your Dell Server is v7.7 or later
Key Server: TCP/8050
Policy Proxy: TCP/8000
Security Server: HTTPS/8443
Client authentication: HTTPS/8449 (If using Dell Encryption on a server operating system)
Management Console: HTTPS/8443
Client communication if using Advanced Threat Prevention: HTTPS/TCP/443
Beacon server if using Data Guardian: HTTP/8446

Proxy Servers
The proxy server installation, implementation, and deployment are fast and easy. The proxy server is a simplified web server with a single web application.

Types of Proxy Servers
- Security Server (defaults to 8443)
- Core Server (defaults to 8888)
- Device Server (defaults to 8081) see Note
Note: The purpose of Device Server proxy is to support legacy Encryption clients (pre-v8.0) that communicate with port 8081. Newer Encryption clients (v8.0 and later) are configured by the client installer to communicate with the Security Server (or Security Server proxy) on port 8443. The full Device Server is not installed in v8.1. The Device Server proxy forwards all communications to the Security Server behind the firewall.
Policy Proxy

Policy Proxy serves as intermediary between Dell Server and Encryption client, delivering information from each to the other.

Time Slotting

To prevent Dell Server traffic jams, Policy Proxies use a time slotting mechanism that allows them to independently choose well-distributed time slots for communicating with the Dell Server.

Polling

On every poll, the endpoint authenticates, checks for policy updates, and uploads inventory. A successful authentication is required for the process to begin.

Poll Triggers

A user must be logged in to poll. On the next user login, another poll occurs. The poll information needed is only available per user, and when that user is logged in.

Other times a poll occurs:

- Immediately upon login, after encryption keys are unlocked.
- When a network status update is signaled by the operating system (cable plugged in, wireless network connected, VPN becomes active).
- When the polling period elapses, as specified by policy.

Failed Poll Attempts

Policy Proxy poll attempts are based on a timer. When a poll attempt fails, the timer is reset. The length of time set for the next attempt is based on when the attempt failed. If the device misses a poll when powered off, the timer is triggered when the device is next powered on.

If the poll attempt failed while making the attempt, the time is set to one tenth the policy value for the polling interval. For example, if the polling interval is 100 minutes, then the next interval after a failed attempt is 10 minutes. If it fails again, the next interval is still 10 minutes. The interval remains 10 minutes until a successful poll, after which it returns to 100 minute intervals.

General Information

- Policy Proxy is generally installed on only a few computers.
- Creates inventory information for the Dell Server.
- Passes on to the Dell Server device inventory it receives when the Encryption client successfully retrieves policies.
- Securely distributes security policies and encryption keys to devices via the network when contacted.
- May be in your DMZ.
- Always belongs to a group. By default, all Policy Proxies belong to the same group.
Navigate the Dell Server

Navigation

The Management Console is a central control center that the administrator can use to deploy and monitor security for the organization. It consists of security and configuration settings that are applied through policy to groups called Populations.

The menu pane allows access to the following:

Dashboard

The Management Console opens to the dashboard. The dashboard provides graphs and statistics on endpoints and threat protection as well as summary statistics on populations and operating systems.

Populations

A population is a grouping for which security policies, settings, and actions can be configured. For example, security policies can be applied at the Enterprise, Domain, User Group, User, Endpoint Group, and Endpoint levels. See Populations. See Manage Security Policies.

Reporting

Reporting menu items provide reports on the protection state of the environment and endpoints, deployment issues that require action, and devices within the network. Create and manage reports with the Manage Reports tool or by launching Compliance Reporter. This menu allows you to collect, view, and export audit events to a SIEM server.

Management

Commit policies, manage licenses, services, alerts, and Data Guardian external users.

Masthead Icons

The following icons display on the masthead:

1. Logged in user - The user icon and name of the user that is currently logged on.
2. Gear icon - From the gear icon, you can Change the Superadmin Password, view information about the Dell Server, get Dell ProSupport contact information, and log out.
3. Question mark icon - Open a help topic that explains the current screen in the Management Console.

Disconnected Mode

Disconnected mode allows a Dell Server to manage Advanced Threat Prevention endpoints without client connection to the Internet or external network. Disconnected mode also allows the Dell Server to manage clients without Internet connection or a provisioned and hosted Advanced Threat Prevention service. The Dell Server captures all event and threat data in Disconnected mode.
To determine if a Dell Server is running in Disconnected mode, click the gear icon at the top right of the Management Console and select About. The About screen indicates that a Dell Server is in Disconnected mode, below the Dell Server version.

Disconnected mode is different than a standard connected installation of Dell Server in the following ways.

**Client Activation**

An install token is generated when the administrator uploads an Advanced Threat Prevention license, which allows the Advanced Threat Prevention client to activate.

**Management Console**

The following items are **not available** in the Management Console when Dell Server is running in Disconnected mode:

- The following areas specific to Advanced Threat Prevention: Advanced Threats by Priority, (Advanced Threat) Events by Classification, Advanced Threats Top Ten, and Advanced Threat Prevention Events.
- Enterprise > Advanced Threats tab, which provides a dynamic display of detailed events information for the entire enterprise, including a list of the devices on which events occurred and any actions taken on those devices for those events.
- (Left navigation pane) Services Management, which allows enabling of the Advanced Threat Prevention service and product notifications enrollment.

The following item **is available** to the Management Console when Dell Server is running in Disconnected mode:

- Enterprise > Advanced Threat Events tab, which list events information for the entire enterprise based on information available in the Dell Server, even when running in Disconnected mode.

**Functionality**

The following functionality is **not available** in the Management Console when Dell Server is running in Disconnected mode:

- Security Management Server upgrade, update, and migration
- Security Management Server Virtual auto update - an update must be done manually
- Cloud profile update
- Advanced Threat Prevention auto update
- Upload of Unsafe or Abnormal Executable files for Advanced Threat Prevention analysis
- Advanced Threat Prevention file upload and log file upload

The following functionality differs:

- The Dell Server sends the Global Safe List, Quarantine List, and Safe List to client computers.
- The Global Safe List is imported to the Dell Server through the Global Allow policy. For more information, see the Global Allow policy.
- The Quarantine List is imported through Quarantine List policy. For more information, see the Quarantine List policy.
- The Safe List is imported through Safe List policy. For more information, see the Safe List policy.

**Dashboard**
Dashboard

The dashboard displays an overview of status information for your enterprise. Access more detailed information directly from the dashboard by clicking its statistics, graphs, and chart legends.

In the top right, select the **Widgets** menu to add or remove the following widgets:

- Notifications
- Protection Status
- Threat
- Protection History
- Inventory History
- Summary Statistics

The images below reflect what may be seen in the dashboard, depending on widgets enabled.

Click an area below to view a description of the detail accessible by clicking the same area in the dashboard.

---

### Notifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Priority</th>
<th>Date</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Base</td>
<td>Low</td>
<td>2/28/16 3:00 PM</td>
<td>KB-01 summary goes here</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Low</td>
<td>2/28/16 3:02 PM</td>
<td>KB-02 summary goes here</td>
</tr>
<tr>
<td>Update</td>
<td>High</td>
<td>2/28/16 3:04 PM</td>
<td>Cloud Profile Update ver 9.2.0.415</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 2:27 PM</td>
<td>KB-1234. Portuguese VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 2:27 PM</td>
<td>KB-1234. VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 4:48 PM</td>
<td>KB-1234. VE server 9.2 OpenSSL config update</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Medium</td>
<td>3/10/16 4:48 PM</td>
<td>KB-1234. Portuguese VE server 9.2 OpenSSL config update</td>
</tr>
</tbody>
</table>

---

### Endpoint Protection Status

<table>
<thead>
<tr>
<th>Platforms</th>
<th>Protected</th>
<th>Not Protected</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>6 (30%)</td>
<td>15 (70%)</td>
<td>21</td>
</tr>
<tr>
<td>Mac</td>
<td>0 (N/A)</td>
<td>0 (N/A)</td>
<td>0</td>
</tr>
<tr>
<td>Mobile Devices</td>
<td>0 (N/A)</td>
<td>0 (N/A)</td>
<td>0</td>
</tr>
<tr>
<td>All</td>
<td>6 (30%)</td>
<td>15 (70%)</td>
<td>21</td>
</tr>
</tbody>
</table>

---

### Threat Protection Status

- Critical: 10
- Major: 30
- Minor: 10
- Warning: 10

---
An Advanced Threat Prevention event is not necessarily a threat. An event is generated when a recognized file or program is quarantined, safe listed, or waived. Threats are a category of events that are newly detected as potentially unsafe files or programs and require guided remediation.
Notifications List

The notifications list provides a configurable summary of news, alerts, and events to display on the dashboard or to be sent as email notifications. For more information, see Dashboard Field Descriptions and Notification Management.

Notification Types

Select the notification types to include in the list. Notifications of the remaining types are hidden.

Types include:

- **Update** - News of upcoming product updates. To view and receive product updates, you must enroll to receive them. Select Services Management > Product Notifications, click On, then click Save Preferences.

- **Config** - News about configuration changes.

- **Knowledge Base** - Summaries and links to knowledge base articles with in-depth technical information such as work arounds and configuration methods.

- **License** - Alerts when your volume license is low, or when your client access license count has been exceeded.

- **Announcement** - News of upcoming releases and new products.

- **Threat Protection** - A threat alert from Advanced Threat Prevention.

- **Advanced Threat Event** - An event detected by Advanced Threat Prevention. The summary contains a listing of Critical, Major, Minor, Caution, and Information events, with links to more detailed information.
**Threat Event** - An event detected by Threat Protection.

**Certificate** - Certificate expiration notification.

**Server Exceptions** - A Dell Server communication issue is impacting deliveries of the following notifications: Threat Protection, Update, Config, Knowledge Base, and Announcement.

After selecting one or more types, click in the neutral space above the list to apply the selections.

Select **Clear selected items** to reset the selections in this list.

**Priority Levels**

Notification priority levels are not related to priority levels displayed on the dashboard other than in the notifications area.

Priorities are Critical, High, Medium, and Low. These priority levels are only relative to one another within a type of notification.

Select the priority levels of notifications to include in the dashboard notifications area or email notifications lists. Notifications of the remaining priority levels are not included in the dashboard or email notifications lists.

In the dashboard, after selecting one or more priority levels, click in the neutral space above the list to apply selections.

Select **Clear selected items** to reset the selections in this drop down list. All notifications will display (unless filtered elsewhere).

**Endpoint Protection Status**

In the Endpoint Protection Status section of the dashboard, view endpoint status by platform: Windows, Mac, Mobile Devices, and All Platforms with a numeric value and bar chart that shows the numbers of protected and unprotected endpoints. A pie chart representing total protected and unprotected endpoints displays on the left.

Click a value to display a list of the endpoints represented in the value.

**Protection Status**

To access this page, click a link in the dashboard's Endpoint Protection Status graph. Click a specific platform type or All. The page provides protection details on the endpoints within that platform.

**Platform** - Windows, Mac, Mobile Devices, All, Protected, or Not Protected

**Endpoint ID** - Value that uniquely identifies the endpoint.

**Protected** - A green check mark indicates the endpoint is protected. The protection status of a Windows workstation is derived from the current encryption policies and encryption states of the Encryption client users, as well as the current device encryption policy and state of the endpoint. On the dashboard's Endpoint Protection Status graph, select endpoints by platform, protected endpoints, non-protected endpoints, or all endpoints. See Protected.

**Shield Inventory Received** - The date and time that the inventory was received and placed in the queue.

**Shield Inventory Processed** - The date and time that the inventory was picked up from the queue and processed. *(Note: If the server is under load, the Processed and Received times may be different, but usually they are the same.)*
Agent Inventory Received - The date and time that the inventory was received and placed in the queue.

Agent Inventory Processed - The date and time that the inventory was picked up from the queue and processed (Note: If the Dell Server is under load, the Processed and Received times may be different, but usually they are the same.)

Shield - If encryption is installed on the endpoint, an icon displays.

Manager (Windows only) - If installed on the endpoint, an icon displays. This includes endpoints with activated PBA, SED, or BitLocker Manager.

Threat Protection Status

Threat Protection monitors the network for viruses, spyware, unwanted programs, suspicious communications through the firewall, and unsafe websites and downloads.

The Threat Protection Status pane shows threats by category: Critical, Major, Minor, and Caution. Each category is listed in a colored bar chart with a numerical value for the corresponding number of threats found during the time frame.

The time frame is selectable, in days: 1, 7, 14, 30, 60, and 90 days.

Click a Threat Category value to display a detailed list of threats included in the category.

Threat Protection Status for Severity Level

To access this page, click a value on the dashboard's Threat Protection Status graph.

This page provides a detailed view of threats based on individual severity levels and devices that have a threat within that severity level. The columns list the specific counts for each type of threat event on a device.

List of severity levels - Select a another option from the list (Critical, Major, Minor, Caution, Information). Critical is the most dangerous threat to the endpoint, and Information is a notification of an event that is unlikely to harm the endpoint.

List of days - Select a time frame option: 1, 7, 14, 30, 60, and 90 days.

Platform - The platform type

Device ID - Value that uniquely identifies the target device. Click a link to view information about that endpoint.

Event Count columns - For each device, lists the number for each of the following threat events:

Malware/Exploit - Includes counts for viruses, spyware, and unwanted programs. This could be exploited buffer overflows that seek to execute arbitrary code on a device or attempts to exploit browser vulnerabilities. Counts may include malware that executes from within memory space.

Web Filter - Includes threats related to web browsing and downloads.

Web Protection - Includes threats related to web browsing and downloads.

Firewall - Includes suspicious communications related to incoming or outgoing traffic and any attacks.

Uncategorized - Lists the number of threats that do not belong in other event counts.

Advanced Threat Prevention Events
The Advanced Threat Prevention Events pane displays a time line of Advanced Threat events over the course of a month, by file type as assigned by Advanced Threat Prevention.

Click a file type for details of the events of that type.

File types include:

- **Unsafe** - A suspicious file with a high score (-60 to -100) likely to be malware
- **Abnormal** - A suspicious file with a lower score (-1 to -59) less likely to be malware
- **Quarantined** - A file that is moved from its original location, stored in the Quarantine folder, and prevented from executing on a specific device.
- **Waived** - A file allowed to execute on a specific device.
- **Cleared** - A file that has been cleared within the organization. Cleared files include files that are Waived, added to the Safe list, and deleted from the Quarantine folder on a device.

For more detail about events, see [Advanced Threat Prevention Classifications](#) and [Advanced Threats Top Ten](#)

### Advanced Threats by Priority

Advanced Threats by Priority classifies suspicious files by priority levels of High, Medium, and Low. This prioritization helps administrators determine which threats and devices to address first. To view a list of threats with the corresponding priority level, click a value in **Advanced Threats by Priority** on the dashboard.

Files are analyzed for the following attributes:

- The file has a Cylance score greater than 80.
  
  A score is assigned to each file that is deemed Abnormal or Unsafe. The score represents the confidence level that the file is malware. The higher the number, the greater the confidence.

- The file is currently running.

- The file has been run previously.

- The file is set to auto run.

- The file is detected by Execution Control.

Files are prioritized based on the number of the above attributes it has:

- Low = 0-1 attributes
- Medium = 2-3 attributes
- High = 4-5 attributes

As an example, following is the analysis of three threats:

### Threat 1

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Attribute Value</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylance score</td>
<td>90</td>
<td>+1</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute Value</td>
<td>Score</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------</td>
<td>-------</td>
</tr>
<tr>
<td>Currently running on any device</td>
<td>True</td>
<td>+1</td>
</tr>
<tr>
<td>Ever run on any device</td>
<td>True</td>
<td>+1</td>
</tr>
<tr>
<td>Set to auto run on any device</td>
<td>True</td>
<td>+1</td>
</tr>
<tr>
<td>Detected by Execution Control</td>
<td>False</td>
<td>+0</td>
</tr>
</tbody>
</table>

Total score 5: High Priority

**Threat 2**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Attribute Value</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylance score</td>
<td>20</td>
<td>+0</td>
</tr>
<tr>
<td>Currently running on any device</td>
<td>True</td>
<td>+1</td>
</tr>
<tr>
<td>Ever run on any device</td>
<td>False</td>
<td>+0</td>
</tr>
<tr>
<td>Set to auto run on any device</td>
<td>True</td>
<td>+1</td>
</tr>
<tr>
<td>Detected by Execution Control</td>
<td>False</td>
<td>+0</td>
</tr>
</tbody>
</table>

Total score 2: Medium Priority

**Threat 3**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Attribute Value</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylance score</td>
<td>20</td>
<td>+0</td>
</tr>
<tr>
<td>Currently running on any device</td>
<td>False</td>
<td>+0</td>
</tr>
<tr>
<td>Ever run on any device</td>
<td>False</td>
<td>+0</td>
</tr>
</tbody>
</table>
**Navigate the Dell Server**

<table>
<thead>
<tr>
<th>Set to auto run on any device</th>
<th>False</th>
<th>+0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detected by Execution Control</td>
<td>True</td>
<td>+5</td>
</tr>
</tbody>
</table>

**Total score** 5: High Priority

**Advanced Threat Prevention Classifications**

Advanced Threat Prevention can provide details on the static and dynamic characteristics of files. This allows administrators to not only block threats, but also to understand threat behavior to further mitigate or respond to threats.

**Type of Threat**

Threats are classified by the type of threat - Malware, Dual Use, and Potentially Unwanted Program.

**Malware**

If the file is identified as a piece of malware, the file should be removed or quarantined as soon as possible. Verified malware can be further subclassified as one of the following:

<table>
<thead>
<tr>
<th>Subclass</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backdoor</td>
<td>Malware that provides unauthorized access to a system, bypassing security measures.</td>
<td>Back Orifice, Eleanor</td>
</tr>
<tr>
<td>Bot</td>
<td>Malware that connects to a central Command and Control (C&amp;C) botnet server.</td>
<td>QBot, Koobface</td>
</tr>
<tr>
<td>Downloader</td>
<td>Malware that downloads data to the host system.</td>
<td>Staged-Downloader</td>
</tr>
<tr>
<td>Dropper</td>
<td>Malware that installs other malware on a system.</td>
<td></td>
</tr>
<tr>
<td>Exploit</td>
<td>Malware that attacks a specific vulnerability on the system.</td>
<td></td>
</tr>
<tr>
<td>FakeAlert</td>
<td>Malware that masquerades as legitimate security software to trick the user into fixing fake security problems at a price.</td>
<td>Fake AV White Paper</td>
</tr>
<tr>
<td>Generic</td>
<td>Any malware that does not fit into an existing category.</td>
<td></td>
</tr>
<tr>
<td>InfoStealer</td>
<td>Malware that records login credentials and/or other sensitive information.</td>
<td>Snifula</td>
</tr>
<tr>
<td>Ransom</td>
<td>Malware that restricts access to system or files and demands payment for removal of restriction, thereby holding the system for ransom.</td>
<td>CryptoLocker, CryptoWall</td>
</tr>
<tr>
<td>Remnant</td>
<td>Any file that has malware remnants post removal attempts.</td>
<td>TDL, Zero Access Rootkit</td>
</tr>
<tr>
<td>Rootkit</td>
<td>Malware that enables access to a computer while protecting itself or other files to avoid detection and/or</td>
<td></td>
</tr>
</tbody>
</table>
removal by administrators or security technologies.

<table>
<thead>
<tr>
<th>Trojan</th>
<th>Malware that disguises itself as a legitimate program or file.</th>
<th>Zeus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus</td>
<td>Malware that propagates by inserting or appending itself to other files.</td>
<td>Sality, Virut</td>
</tr>
<tr>
<td>Worm</td>
<td>Malware that propagates by copying itself to another device.</td>
<td>Code Red, Stuxnet</td>
</tr>
</tbody>
</table>

**Dual Use**

Dual Use indicates the file can be used for malicious and non-malicious purposes. Caution should be used when allowing the use of these files in your organization. For example, while PsExec can be a useful tool for executing processes on another system, that same benefit can be used to execute malicious files on another system.

<table>
<thead>
<tr>
<th>Subclass</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crack</td>
<td>Technologies that can alter (or crack) another application to bypass licensing limitations or Digital Rights Management protection (DRM).</td>
<td>l0phtcrack, Cain &amp; Abel</td>
</tr>
<tr>
<td>Generic</td>
<td>Any Dual Use tool that does not fit into an existing category.</td>
<td></td>
</tr>
<tr>
<td>KeyGen</td>
<td>Technologies which can generate or recover/reveal product keys that can be used to bypass Digital Rights Management (DRM) or licensing protection of software and other digital media. Technologies that track a user's online activities without awareness of the user by logging and possibly transmitting logs of one or more of the following:</td>
<td></td>
</tr>
</tbody>
</table>
| MonitoringTool | • user keystrokes  
        |                                                             |                |
|               | • email messages  
        |                                                             | Veriato 360, Referog Keylogger |
|               | • chat and instant messaging  
        |                                                             |                |
|               | • web browsing activity  
        |                                                             |                |
|               | • screenshot captures  
        |                                                             |                |
|               | • application usage  
        |                                                             |                |
| Pass Crack   | Technologies that can reveal a password or other sensitive user credentials either by cryptographically reversing passwords or by revealing stored passwords. Technologies that can access another system remotely and administer commands on the remote system, or monitor user activities without user notification or consent. |                |
| RemoteAccess | Programs that offer administrative features but can be used to facilitate attacks or intrusions.         | Putty, PsExec, TeamViewer |
| Tool         |                                                                                                         | Nmap, Nessus, P0f |

**Potentially Unwanted Programs**
The file has been identified as a **Potentially Unwanted Program**. This indicates that the program may be unwanted, despite the possibility that users consented to download it. Some PUPs may be permitted to run on a limited set of systems in your organization (EX. A VNC application allowed to run on domain administrator devices). A Dell Server administrator can choose to waive or block PUPs on a per device basis or globally quarantine or safelist based on company policies. Depending on how much analysis can be performed against a PUP, further subclassification may be possible. Those subclasses are shown below and will aid an administrator in determining whether a particular PUP should be blocked or allowed to run:

<table>
<thead>
<tr>
<th>Subclass</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adware</td>
<td>Technologies that provide annoying advertisements (example: pop-ups) or provide bundled third-party add-ons when installing an application. This usually occurs without adequate notification to the user about the nature or presence of the add-on, control over installation, control over use, or the ability to fully uninstall the add-on.</td>
<td>Gator, Adware Info</td>
</tr>
<tr>
<td>Corrupt</td>
<td>Any executable that is malformed and unable to run.</td>
<td>Steam Games, League of Legends</td>
</tr>
<tr>
<td>Game</td>
<td>Technologies that create an interactive environment with which a player can play.</td>
<td>Steam Games, League of Legends</td>
</tr>
<tr>
<td>Generic</td>
<td>Any PUP that does not fit into an existing category.</td>
<td>Cobalt Strike, MetaSp0it</td>
</tr>
<tr>
<td>HackingTool</td>
<td>Technologies that are designed to assist hacking attempts.</td>
<td>Turbo</td>
</tr>
<tr>
<td>Portable Application</td>
<td>Program designed to run on a computer independently, without needing installation.</td>
<td>AutoIT, py2exe</td>
</tr>
<tr>
<td>Scripting Tool</td>
<td>Any script that can run as if it were an executable.</td>
<td>Nasdaq Toolbar, Bring Me Sports</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Technologies that place additional buttons or input fields on-screen.</td>
<td></td>
</tr>
</tbody>
</table>

**Score**

A **Score** is assigned to each file. Negative scores, from -1 to -100 denote files that are deemed Abnormal or Unsafe. The score represents the confidence level that the file is malware. The higher the negative number, the greater the confidence.

**File Type**

The file is assigned a type, based on the score.

**File Types:**

- **Unsafe**: A file with a score ranging from -60 to -100. An Unsafe file is one in which the Advanced Threat Prevention agent finds attributes that greatly resemble malware.
- **Abnormal**: A file with a score ranging from -1 to -59. An Abnormal file has a few malware attributes but fewer than an unsafe file, thus is less likely to be malware.
Note: Occasionally, a file may be classified as Unsafe or Abnormal even though the score displayed doesn’t match the range for the classification. This could result from updated findings or additional file analysis after the initial detection. For the most up-to-date analysis, enable Auto Upload in the Device Policy.

Priority Level

The file is given a priority level. The priority level helps administrators determine which threats and devices to address first. For more information, see Advanced Threats by Priority.

Advanced Threats Top Ten

Click Threats to view the threats found on the largest number of devices.

- Click a threat to display additional information about the threat. Details display on a new page.

Click Devices to view a list of devices that have the largest number of threats.

- Click a device to display additional information about the device. Details display on a new page.

Endpoint Protection History

This graph gives a time line snapshot of the past 90 days of the total number of endpoints that are protected and total number that are not protected. This graph is especially useful during initial deployment, when moving toward complete protection.

The green bars represent the total number of protected endpoints. The red bars represent the total number of endpoints that are not protected.

Endpoint Inventory History

This graph gives a time line snapshot of the past 90 days of the total number of endpoints that have communicated with and sent inventory to the Dell Server and the total number that have not sent inventory.

Summary Statistics

Summary Statistics provides a breakdown of the following:

- Domains
- User groups
- Endpoint groups
- AD users
- Local users
- Endpoints
- Protected
- Not protected
- Shields
- Managers
- Modified policies

Summary Statistics provides a breakdown of endpoints by platform, with a link to a detailed report for the selected platform:

- Windows
- Mac
- Mobile device
- All

**Endpoint OS Report**

To access this page, click a platform link on the dashboard's Summary Statistics. If you click All and the Platform Report page opens, click view in the OS Report column.

OS/Version - Operating system name and version as reported in the endpoint's inventory

Count - Number of endpoints or devices

Shielded - Number of encrypted endpoints for that OS and version

Unshielded - Number of endpoints for that OS and version that are not encrypted

Platform Report - Click view for a report on all the platforms

Endpoint List - Click the icon to navigate to the Endpoints page and the list of endpoints for that OS and version

**Platform Report**

To access this page, click All on the dashboard's Summary Statistics. If you click a specific platform link and access the Endpoint OS Report page, click view in the Platform Report column.

Platform - Windows or Mac

Count - Number of endpoints or devices Platform Report for that platform

Shielded - Number of encrypted endpoints for that platform

Unshielded - Number of endpoints for that platform that are not encrypted

OS Report - Click view for a report based on each operating system/version for that platform

Endpoint List - Click the icon to navigate to the Endpoints page and the list of endpoints for that platform

**Populations**

A population is a grouping for which policies, settings, and actions can be configured.

To access a Populations page, click Populations in the left pane and select a Population. For example, Populations > Enterprise.

Tabs available on each Populations page provide information, allow you to edit details of the Population, and provide configuration options for that Population. The table lists the tabs available for each Population.
To access the tabs for each Population:

- **Enterprise** - Click **Populations > Enterprise**.
- Populations other than Enterprise - Click a Population link, then search for or click a Domain, User Group, User, Endpoint Group, Endpoint, or Administrator link.

The tabs available for an administrator may vary, depending on the role.

### Enterprise

**View or Modify Enterprise Policies**

To view or modify Enterprise policies, follow these steps:

1. In the left pane, click **Populations > Enterprise**.
2. Click the **Security Policies** tab.
3. Select the technology group, such as *Windows Encryption*, or policy group, such as *Policy-Based Encryption*, to view or modify.

**View Threat Events**

Threats are categorized as Malware/Exploit, Web Filter, Firewall, or Uncategorized events. The list of threat events can be sorted by any of the column headers. You can view threat events for the entire enterprise or for a specific endpoint. To view threat events of a specific endpoint, from the Enterprise Threat Events tab, select the endpoint's device in the Device ID column.

To view threat events in the enterprise, follow these steps:

1. In the left pane, click **Populations > Enterprise**.
2. Click the **Threat Events** tab.
3. Select the desired severity level and time period to display events.

To view threat events on a specific endpoint, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Search or select a hostname, then the **Threat Events** tab.

**Manage Enterprise Advanced Threats**

**Advanced Threats tab**

If the Advanced Threat Prevention service is provisioned and licenses are available, the Advanced Threats tab provides a dynamic display of detailed events information for the entire enterprise, including a list of the devices on which events occurred and any actions taken on those devices for those events. For information about provisioning the service, see [Provision Advanced Threat Prevention Service](#).

To access the Enterprise Advanced Threats tab, follow these steps:

1. In the left pane, click **Populations > Enterprise**.
2. Select the **Advanced Threats** tab.

Information about events, devices, and actions are organized on the following tabs:

- **Protection** - Lists potentially harmful files and scripts and details about them, including the devices on which the files and scripts are found.
- **Agents** - Provides information about devices running the Advanced Threat Prevention client as well as the option to export the information or remove devices from the list.
- **Global List** - Lists files in the Global Quarantine and Safe list and provides the option to move files to these lists.
- **Options** - Provides a way to integrate with Security Information Event Management (SIEM) software using the Syslog feature as well as export Advanced Threat data.
- **Certificate** - Allows certificate upload. After upload, certificates display on the Global List tab and can be Safe listed.

Tables on the tabs can be organized in these ways:

- Add or remove columns from the table - Click the arrow next to any column header, select **Columns**, then select the columns you want to display. Clear the check box of columns to hide.
- Sort the data - Click a column header.
- Group by a column - Drag the column header up, until it turns green.
- Filter based on data of one column - click the down-arrow on any column to display the context menu, and select **Filter**.

**Advanced Threat Events tab**

The Advanced Threat Events tab displays information about events for the entire enterprise based on information available in the Dell Server.

The tab displays if the Advanced Threat Prevention service is provisioned and licenses are available.

To export data from the Advanced Threat Events tab, click **Export** and select Excel or CSV file format.

**Note:** Excel files are limited to 65,000 rows. CSV files have no size limit.

For a list of fields and filters on the tab, see [Advanced Threat Events tab fields and filters](#).
Domains

On the Domains page, you can add a domain or search and select a domain to View or Modify Domain Information.

Add a Domain

To add a Domain, follow these steps:

1. In the left pane, click Populations > Domains.
2. On the Domains page, click Add.
3. Complete the fields on the Add Domains page.
   - **Domain DNS Suffix** - Enter the fully qualified host name or the computer name and domain portion of the hostname (for example, `<computer_name>.<domainname>.com`) for the enterprise directory server.
   - **Port** - Enter a port for the directory server. If you do not specify a port, the default port of 389 is used. The secure port, 636, uses an SSL connection instead of clear text. Global catalog ports are 3268 (clear-text) and 3269 (secure).
   - **Distinguished Name** - Populated when you tab from the completed Host Name field or refresh the URL. If necessary, correct the entry to reflect the domain (for example, DC=domainname, DC=com).
   - **User Name** - Enter a user name with rights for the domain to read and run queries on the enterprise directory server. The format must be UPN, such as user@domain.com.
   - **Password** - Enter a password with rights for the domain to read and run queries on the enterprise directory server.
4. In the Domain Alias area, enter the domain name or other alias and click Add. It is recommended that you add a pre-Windows 2000 domain name as an alias. You may enter any UPN suffixes that are allowed for the domain and are configured in the enterprise directory server.
   - A Domain Alias is a mapping the Dell Server uses to select which domains to search to locate users that might match the suffix in the UPN.
5. Click Add Domain.

Users

Users are added through reconciliation. Reconciliation is the automated process the Dell Server uses to compare user data in the Dell Server database with user data in the enterprise directory server and update the Dell Server database when necessary.

In the left pane, click Populations > Users and then click a user name, to view details about the user. Click the arrow next to a User Name to view the Common Name, sAM Account Name, and User Principal Name.

Add a User by Domain

1. In the left pane, click Populations > Users.
2. On the Users page, click **Add Users by Domain**.
3. In the Add Users by Domain dialog, select a domain from the pull-down list.
4. In **Full name**, enter the exact text for the user name or use the wildcard character (*).
5. Select Common Name, Universal Principal Name, or sAMAccountName from the list.

   A Common Name, Universal Principal Name, and sAMAccountName must be defined in the enterprise directory server for every user. If a user is a member of a domain or group but does not display in the domain or group members list in the Management Console, ensure that all three names are properly defined for the user in the enterprise directory server.

6. Click **Search**. Depending on the size, this may take a few minutes to populate.

   If the query is too large, a dialog prompts you to revise the query.
7. Select users from the directory user list to add to the Domain. The user names are added to the field below the list.
8. Click X to remove the user name or click Add.

**User Groups**

Add a user group, edit **User Group priority**, or search and select a user group to **View or Modify User Group Policies and Information**.

**Add a User Group**

1. In the left pane, click **Populations > User Groups**.
2. On the User Groups page, click **Add**.
3. Select the type of User Group from the list: **Active Directory User Group** or **ADMIN-DEFINED User Group**

   **Note:** If adding user groups for Access Groups, see **Set up Access Groups**.
4. Select a domain from the list.
5. For Active Directory User Groups, follow these steps:
   a. Enter the exact text for the group name or use the wildcard character (*).
   b. Click **Search**. Depending on the size, this may take a few minutes to populate.
   c. Select a group from the list to add to the domain. The group name is added to the field below the list.
   Click the X in the group name to remove the group name.
   d. Click **Add**.
6. For **ADMIN-DEFINED User Groups**, follow these steps:
   a. Enter the exact text for the group name or use the wildcard character (*).
   b. Enter a description for the group.
   c. Click **Add Group**.

**Notes:**
Universal security groups are only supported for domains that connect through the Global Catalog port.

Nested groups are not supported.

Add Non-Domain Users

To add non-domain users, the non-domain activation feature can be enabled by contacting Dell ProSupport and requesting instructions.

View or Modify Domain Policies and Information

1. In the left pane, click Populations > Domains.
2. Search or select the appropriate Domain Name to display Domain Detail.
   When you click a Domain, the Domain Detail page displays.
3. Click the tab that corresponds with the action to perform:
   Details & Actions - To view properties of the Domain, click Details & Actions
   Members - To view, add, or modify information for groups and users within the domain. For instructions on how to perform these tasks, refer to the appropriate topic:
   Add Users to Domain
   Add User Groups
   View or Modify User Information
   View or Modify User Group Information
   Settings - To configure LDAP settings for the domain, click Settings. Refer to Add Domains for instructions.
   Key Server - To configure components for use with Kerberos Authentication/Authorization, click Key Server. See Domain Key Server for instructions.

Domain Details & Actions

The Domain Details & Actions tab lists the properties of a domain.

To access the Domain Details & Actions tab, follow these steps:
1. In the left pane, click Populations > Domains.
2. Search or select a Domain Name, then the Details & Actions tab.

Details displayed on the Domain Details & Actions tab:
Domain Name - Name of the domain server. This should match the domain name in the title of the page.
Location - The location (path) of the domain within the enterprise structure. This information is derived from the fully qualified hostname or the computer name and domain portion of the hostname entered when the domain was added. Example: /com/enterpriseserver
LDAP Url - URL to the active directory. This field is populated after adding the domain. The information is derived from the completed hostname.

Example - LDAP://domainname.com:portnumber/DC=domainname,DC=com

To configure LDAP settings for the domain, click the **Settings** tab.

Status - Describes the health of the domain server (Good, Fair, Poor).

**Domain Members**

This page allows you to view, add, or modify information for groups and users within the domain.

To access the Domain Members tab, follow these steps:

1. In the left pane, click **Populations > Domains**.
2. Search or select a Domain Name, then the **Members** tab.

From this tab, you can perform these actions:

- **Add Users to Domain** - Allows you to add users by domain
- **Add Group** - Allows you to add a user group by domain

Select to view the following information about groups & users, users only, or groups only:

- **User/Group** - Each user or user group in the domain. Click an entry to view details.
- **Distinguished Name**
  - CN is the common name, either a user or group name.
  - OU is the organizational unit name, for example, Dallas.
  - DC are domain components, for example, DC=Organization, DC=com
- **Common Name** - For a user, the user name; for a group, the group name
- **User** - Column displays a green checkmark
- **Group** - Column displays a green checkmark

**Domain Settings**

This page allows you to configure or modify LDAP settings for the Domain.

To access the Domain Settings tab, follow these steps:

1. In the left pane, click **Populations > Domains**.
2. Search or select a Domain Name, then the **Settings** tab.

On the Domain Settings tab, you can view this information:

- **Directory URL** - Lists the current URL for the enterprise directory server. If you modify the settings, click **Refresh URL**.
- **Host Name** - The fully qualified hostname or the computer name and domain portion of the hostname (for example, <computer_name>,<domainname>.com) for the enterprise directory server.
- **Port** - The port for the directory server. If you do not specify a port, the default port of 389 is used. The secure port, 636, uses an SSL connection instead of clear text. Global catalog ports are 3268 (clear-
text) and 3269 (secure).

Distinguished Name - This field is populated when you tab from the completed hostname or refresh the URL. If necessary, correct the entry to reflect the domain (for example, DC=domainname, DC=com).

Secure LDAP - Select this check box for LDAPS.

User Name - The user name with rights to read and run queries on the enterprise directory server. The format must be UPN, such as user@domain.com.

Password - Enter a password with rights to read and run queries on the enterprise directory server.

Alias - A mapping that the Dell Server uses to select which domains to search to locate users that might match the suffix in the UPN. The domain name or other alias. It is recommended that you add a pre-Windows 2000 domain name as an alias. You may enter any UPN suffixes that are allowed for the domain and are configured in the enterprise directory server.

Click Add, and the entry populates the field below.

Select an alias in the list, and click Remove Selected.

Update Domain - Click to update changes.

Domain Key Server

This page allows you to view or modify components for use with Kerberos Authentication/Authorization.

Account - Enter an account name.

Click Add Account, and the entry populates the field below.

Select an account in the list, and click Remove Selected.

To access the Domain Key Server tab, follow these steps:

1. In the left pane, click Populations > Domains.
2. Search or select a Domain Name, then the Key Server tab.

User Groups

Add a User Group

Add a user group, edit User Group priority, or search and select a user group to View or Modify User Group Policies and Information.

Add a User Group

1. In the left pane, click Populations > User Groups.
2. On the User Groups page, click Add.
3. Select the type of User Group from the list: Active Directory User Group or ADMIN-DEFINED User Group

Note: If adding user groups for Access Groups, see Set_up_Access_Groups.
4. Select a domain from the list.
5. For Active Directory User Groups, follow these steps:
   a. Enter the exact text for the group name or use the wildcard character (*).
b. Click **Search**. Depending on the size, this may take a few minutes to populate.

c. Select a group from the list to add to the domain. The group name is added to the field below the list.

Click the X in the group name to remove the group name.

d. Click **Add**.

6. For ADMIN-DEFINED User Groups, follow these steps:

   a. Enter the exact text for the group name or use the wildcard character (*).
   b. Enter a description for the group.
   c. Click **Add Group**.

**Notes:**

Universal security groups are only supported for domains that connect through the Global Catalog port.

Nested groups are not supported.

### Remove User Groups

1. In the left pane, click **Populations > User Groups**.
2. Click a group name link or enter a filter to search for available groups. The wildcard character (*) is supported.
3. Select a row to highlight it.
4. At the top, click **Delete**.

As another option, click a group name link and select the Details & Actions tab. Click **Remove Group**.

If you remove a user group that has administrative privileges and later re-add the group, it remains an Administrator Group.

### Find User Groups

1. In the left pane, click **Populations > User Groups**.
2. Enter a filter to search for available Groups. The wildcard character (*) is supported.
3. Click **Search**.

A Group or list of Groups displays, based on the search filter.

### View or Modify User Group Policies and Information

1. In the left pane, click **Populations > User Groups**.
2. Search or select the appropriate group name to display the User Group Detail page. The wildcard character (*) is supported.

   Click a group name to display the User Group Detail page.
3. Click the tab that corresponds with the action to perform:

**Security Policies** - To view or modify policies of the Group, click **Security Policies**.

**Details & Actions** - To view properties of the Group, click **Details & Actions**. Viewable information includes:

- Group Name: Group1 (DOMAIN\Group1)
- Distinguished Name: CN=Group1, OU=Dallas, DC=Organization, DC=com
- Common Name: Group1
- Last Modified in Directory - date and time stamp
- Last Reconciled - date and time stamp
- AG Enabled - Access Group is configured for a user group when selected

**Members** - To view or modify the information of a user in the group, click **Members**. The list of users in the group displays. Click a user to view the user's Security Policies, Details & Actions, Endpoints, User Groups, and Admin. For instructions on how to view or modify User information, refer to [View or Modify User Information](#).

**Admin** - To view, assign, or modify administrator roles assigned to the group, click **Admin**. Select or deselect administrator roles to modify administrator roles assigned to the Group. For more information about privileges available to each administrator role, refer to [Administrator Roles](#).

4. If modified, click **Save**.

**VDI User Policies**

To manage policy for users in a VDI environment, create a Windows domain group, associate domain users with that group, and then import the group into Dell Server. This allows Dell Server to manage the users and their policies.

Policy settings differ, based on whether persistent or non-persistent VDI is deployed in the environment. For an explanation of the differences between persistent and non-persistent VDI, see [Persistent vs. Non-Persistent VDI](#).

**Policy and Configuration Requirements for VDI Users**

The policy requirements below are for VDI users running Advanced Threat Prevention. The list includes only policies that are significant for VDI users. VDI endpoint group policy settings must also meet certain requirements. See [Policy and Configuration Requirements for VDI Endpoint Groups](#).

**Note**: Ensure that you turn off Advanced Threat Prevention Agent Auto Update. In the left pane of the Management Console, select **Management > Services Management > Advanced Threats - Agent Auto Update**, then select **Off**.

**Note**: With Persistent VDI groups, ensure that roaming user profiles are configured.

These policy and configuration settings for VDI users must be configured before VDI client activation:

<table>
<thead>
<tr>
<th>Technology</th>
<th>Category</th>
<th>Policy or Setting</th>
<th>Persistent VDI group setting</th>
<th>Non-Persistent VDI group setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Policy-Based Encryption</td>
<td>On</td>
<td>Off</td>
</tr>
</tbody>
</table>
Navigate the Dell Server

Windows Encryption

Policy-Based Encryption

Encrypt Outlook Personal
Folders

Not Selected

Not Selected

Windows Encryption

Policy-Based Encryption

Encrypt Temporary Files

Not Selected

Not Selected

Windows Encryption

Policy-Based Encryption

Encrypt Temporary Internet
Files

Not Selected

Not Selected

Windows Encryption

Policy-Based Encryption

Encrypt User Profile
Documents

Not Selected

Not Selected

Windows Encryption

Policy-Based Encryption

Secure Post-Encryption
Cleanup

Single-pass Overwrite

Single-pass Overwrite

Windows Encryption

Policy-Based Encryption

Force Logoff/Reboot on
Policy Updates

Selected

Not Selected

Removable Media Encryption Windows Media Encryption

Windows Media Encryption

Removable Media Encryption Windows Media Encryption

EMS Scan External Media

On

On

Not Selected

Not Selected

User Group Details & Actions
The User Group Details & Actions tab lists the properties of a selected user group.
1.

In the left pane, click Populations > User Groups.

2.

Search or select a group name, then the Details & Actions tab.
Remove Group
The Remove Group command permanently removes this user group from the Dell Server.
Details:
Group Name - Name of the user group <user group>(<domain name>\<user group>). This should
match the user group name in the title of the page.
Distinguished Name - CN=Group1, OU=Dallas, DC=Organization, DC=com
CN is the common name
OU is the organizational unit name
DC are domain components
Common Name - non-technical name of the user group
Last Modified - Date/time stamp of the last time this information changed.
Last Reconciled - Date/time stamp of the last time this information was reconciled.
Access Groups Enabled - Access Group is configured for a user group when selected.

User Group Members
This page displays information about each user within the user group.
1.

In the left pane, click Populations > User Groups.

2.

Search or select a Group Name, then click the numeral in the Members column.

56


User - Each user in that user group
Distinguished Name - CN=Group1, OU=Dallas, DC=Organization, DC=com
  CN is the common name
  OU is the organizational unit name
  DC are domain components
Common Name - non-technical name of the user group

Add Users to the Group
1. On the Members tab, click Add Users to Group.
2. Search or select a user, then select the check box to the left of the user name.
3. Click Add Selected Users to Group. OR
   Select Upload Multiple User from File, then click Browse to select a CSV file and click Upload.

Valid CSV requirements:
- The file must be in valid CSV format and contain a maximum of 999 endpoints.
- The first column must contain valid fully qualified host names. All columns except the first column are ignored.
- Only activated endpoints are added to the group.

Remove Users from the Group
1. In User Group Detail, search or select a user, then select the check box to the left of the user name.
2. Click Remove Users from Group.
3. Click OK.

Users can also be removed from the ADMIN DEFINED Groups.

User Group Admin
Assign, modify, or view Administrator roles for a group.
1. In the left pane, click Populations > User Groups.
2. Search or select a Group Name, then the Admin tab.
   Administrator Roles - Assign or modify roles for a group membership and click Save.
   Delegated Roles - Delegate Administrator rights for the Group to a User.

Related topics:
Administrator Roles
Assign or Modify Administrator Roles
Delegate Administrator Roles
Edit Group Priority

The Group priority feature is used to determine policy precedence for effective policies that affect multiple groups. Group priority creates a weight associated with the specific group it is assigned to, and that weight is used to determine which policy setting is applied to an endpoint that is a member of more than one Endpoint Group when policy settings differ between those groups. Policy overrides are used from the group with higher priority when two (or more) separate groups have different priority levels.

Edit Endpoint Group Priority

Endpoint Group Priority can be changed only for Rule-Defined, Admin-Defined, and Active Directory Groups. System-Defined Group priority cannot be modified. In general, the Endpoint Group at the top of the list of Endpoint Groups has highest priority. The Endpoint Group at the bottom of the list has lowest priority.

Precedence Ranking

The System Defined Non-Persistent VDI Endpoint Group has the highest priority level, followed by the Persistent VDI Endpoint Group.

Order of priority:

1. Non-Persistent VDI Endpoint Group
2. Persistent VDI Endpoint Group
3. Highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Group
4. Second and subsequent highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Groups
5. Opt-in Endpoint Group
6. Default Endpoint Group

To change Active Directory/Rule-Defined/Admin-Defined Endpoint Group priority:

1. In the left pane, click Populations > Endpoint Groups.
2. Click Edit Priority.
3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups that reflects its new priority level.
4. Click Save.

Edit User Group Priority
The user group at the top of the list has highest priority. The user group at the bottom of the list has lowest priority.

To edit User Group priority:
1. In the left pane, click **Populations > User Groups**.
2. Click **Edit Priority**.
3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups that reflects its new priority level.
4. Click **Save**.

**Assign or Modify Administrator Roles**

View or modify existing administrator privileges.

1. In the left pane, click **Populations > Administrators**.
2. Search or select the row that displays the user name of the appropriate administrator to display User Detail.
3. View or modify administrator roles in the pane at the right.
4. Click **Save**.

Dell recommends assigning administrator roles at the Group level rather than at the User level.

1. In the left pane, click **Populations > User Groups**.
2. Search or select a group name, then the **Admin** tab.
3. Select or deselect administrator roles assigned to the group.
4. Click **Save**.

If you remove a group that has administrative privileges and later re-add the group, it remains an administrator group.

To view, assign, or modify administrator roles at the User level, see **User Admin**.
View Reconciliation Date

To view the date and time a user group’s or user’s information was last reconciled with Active Directory, click the Details & Actions tab for the group or user, and refer to last reconciled. For instructions, refer to View or Modify User Group Policies and Information and View or Modify User Policies and Information.

View Policy Proxy State

The Management Console tracks the Policy Proxy’s policy updating state.

1. In the left pane, click Populations > Endpoints.
2. Select an endpoint type, for example, Workstation or Mobile Device.
3. If you know the full endpoint hostname, enter it into Search and click Search.

For Windows and Mac, enter the full endpoint hostname if you know it. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the user’s email address.

If you do not know the full hostname or user email address, scroll through the list of available endpoints to locate the endpoint.

4. Click an endpoint in the list to display the endpoint detail.
5. Click the Details & Actions tab of the endpoint to view information.

Users

Users are added through reconciliation. Reconciliation is the automated process the Dell Server uses to compare user data in the Dell Server database with user data in the enterprise directory server and update the Dell Server database when necessary.

In the left pane, click Populations > Users and then click a user name, to view details about the user. Click the arrow next to a User Name to view the Common Name, sAM Account Name, and User Principal Name.

Add a User by Domain

1. In the left pane, click Populations > Users.
2. On the Users page, click Add Users by Domain.
3. In the Add Users by Domain dialog, select a domain from the pull-down list.
4. In Full name, enter the exact text for the user name or use the wildcard character (*).
5. Select Common Name, Universal Principal Name, or sAMAccountName from the list.
A Common Name, Universal Principal Name, and sAMAccountName must be defined in the enterprise directory server for every user. If a user is a member of a domain or group but does not display in the domain or group members list in the Management Console, ensure that all three names are properly defined for the user in the enterprise directory server.

6. Click **Search**. Depending on the size, this may take a few minutes to populate.

   If the query is too large, a dialog prompts you to revise the query.

7. Select users from the directory user list to add to the Domain. The user names are added to the field below the list.

8. Click **X** to remove the user name or click **Add**.

**Remove Users**

In general, a user cannot be removed in the Management Console. Instead, you must remove the user from Active Directory.

**Find Users**

1. In the left pane, click **Populations > Users**.

2. Do one of these:

   • Enter the user name or a filter in **Search** and click **Search**.

   • Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character is supported.

   • Scroll through the user name list.

3. Click a link in the user name column.

   The User Detail page opens, displaying the Security Policies tab.

**Deactivate/Suspend Users**

If the user to deactivate is no longer associated with your organization, be sure the **Current Shield State** policy is set to a value other than **Activate**, and ensure that the policy commit is complete and successful prior to your enterprise directory server. The user does not need to be in your enterprise directory server, but the policy does need to delivered to be their device for it to take effect.

**Best Practice** - Deleting users from the enterprise directory server is not recommended. If a user leaves the organization, the account should be moved to a disabled group. With that said, if a deletion occurs, the user is simply marked “removed”, rather than deleted. The user does not display in the Management Console, but their encryption keys and other information are still available in the Dell Server database.

1. In the left pane, click **Populations > Users**.

2. Click a user name link or enter a filter to search for available users.

   Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character (*) is supported. On the User Detail > Security Policies tab in the Windows Encryption technology group, click the Policy-Based Encryption policy group.

3. Click **Show advanced settings**.
4. Change the *Current Shield State* policy to **Suspend**.
5. Click **Save**.
6. **Commit Policies**.

To reactivate a deactivated Windows user, follow the instructions in [Reinstate Suspended Users](#).

### Reinstate Suspended Users

To reinstate a suspended user, follow these steps:

1. In the left pane, click **Populations > Users**.
2. Click a user name link or enter a filter to search for available users.
   
   To Search, enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character (*) is supported.
3. On the **User Detail > Security Policies** tab in the *Windows Encryption* technology group, click the **Policy-Based Encryption** policy group.
4. Click **Show advanced settings**.
5. Change the *Current Shield State* policy to **Activate**.
6. Click **Save**.
7. **Commit Policies**.
   
   Repeat these steps for each type of device the user was suspended from.
8. To reinstate a suspended Dell Encryption user, perform the preceding steps and then run WSDeactivate on the computer that was suspended for that particular user. WSDeactivate and its instructions are located in the Dell installation media. When using WSDeactivate, existing local encryption keys, credentials, and policy material are no longer accessible to Dell Encryption, and all managed users are forced to reactivate upon their next log on.

### View or Modify User Policies and Information

1. In the left pane, click **Populations > Users**.
2. Click a user name or enter a filter to search for available users. The wildcard character (*) is supported.
   
   Click a user name to display the User Detail page.
3. Click the tab that corresponds with the action to perform:
   
   **Security Policies** - Click to view or modify policies of the user.

   **Details & Actions** - Click to view properties of the user. Viewable information includes:

   User Name: (username@organization.com)

   Distinguished Name: CN=User Name, OU=Dallas, DC=Organization, DC=com

   Common Name: User Name

   User Principal Name: username@organization.com

   sAM Account Name: username
User Type - possible values are AD or local

Last Modified - Date/time stamp

Last Reconciled - Date/time stamp

Endpoints - Click to view or modify information for the User's endpoints. For instructions on how to modify endpoint information, refer to View or Modify Endpoint Information.

User Groups - Click Groups to view information for groups for which the user belongs. Click a user group to view the group's Security Policies, Details & Actions, Members, and Admin.

Admin - Click to view, assign, or modify administrator roles assigned to the user. Select or deselect administrator types to modify administrator roles assigned to the user.

4. If modified, click Save.

User Details & Actions

The user Details & Actions tab lists the properties of the selected user.

1. In the left pane, click Populations > Users.

2. Search or select a user name, then the Details & Actions tab.

Details:

User Name - (username@organization.com)

Distinguished Name - CN=User Name, OU=Dallas, DC=Organization, DC=com

Common Name - User Name

Universal Principal Name - username@organization.com

sAMAccountName - username

Email - User email address

User Type - possible values are AD or local

Last Modified - Date/time stamp

Last Reconciled - Date/time stamp

User Endpoints

This page displays information about a user's endpoints, listed by platform type. Endpoint categories include Shield, Mobile Device, and Cloud.

1. In the left pane, click Populations > Users.

2. Search or select a user name, then the Endpoints tab.

Shield

Platform - The platform type

Device ID - Value that uniquely identifies the target device
Navigate the Dell Server

Last Successful Login - Date/time stamp, per endpoint
Last Unsuccessful Login - Date/time stamp, per endpoint
Last Gatekeeper Sync - Date/time stamp, per endpoint
Effective Policies - Click view for a simple layout view of the effective endpoint policies
Actions - Click Recover to proceed to the Recover Data page
Last Encryption Sweep Start - Date/time stamp, per user
Sweep End - Date/timestamp, per user
Encryption Failure - Click view for a simple list of files that could not be encrypted, per user

States (Date/time stamp, per endpoint):
  - Policy Updating
  - User Encryption Profile Updating
  - EMS Encryption Profile Updating
  - User Data Encryption On
  - Deactivation Pending
  - Suspension Pending
  - Suspended

Mobile Device
  - Platform - The platform type
  - Device ID - Value that uniquely identifies the target device
Effective Policies - Click view for a simple layout view of the effective endpoint policies

Cloud
  - Platform - The platform type
  - Device ID - Value that uniquely identifies the target device

User Groups
If the user belongs to a user group, this page displays information about the group and provides a link to the group.

1. In the left pane, click Populations > Users.
2. Search or select a user name, then the Users Groups tab.

User Group - Group to which the user belongs
  - Distinguished Name - CN=Group1, OU=Dallas, DC=Organization, DC=com
    - CN is the common name
    - OU is the organizational unit name
User Admin

This page allows you to assign, modify, or view administrator roles for the user.

1. In the left pane, click **Populations > Users**.
2. Search or select a user name, then the **Admin** tab.
   
   Administrator Roles - Assign or modify roles for the user and click **Save**.
   
   Inherited Group Roles - A read-only list of roles that the user inherited from a group. To modify the roles, click the **User Groups** tab for that user and select the group name.

   Delegated Roles - Delegate administrator rights to a user.

Related topics:

- Administrator Roles
- Assign or Modify Administrator Roles
- Delegate Administrator Roles

View Reconciliation Date

To view the date and time a user group's or user's information was last reconciled with Active Directory, click the Details & Actions tab for the group or user, and refer to last reconciled. For instructions, refer to View or Modify User Group Policies and Information and View or Modify User Policies and Information.

View Policy Proxy State

The Management Console tracks the Policy Proxy's policy updating state.

1. In the left pane, click **Populations > Endpoints**.
2. Select an endpoint type, for example, **Workstation** or **Mobile Device**.
3. If you know the full endpoint hostname, enter it into **Search** and click **Search**.

For Windows and Mac, enter the full endpoint hostname if you know it. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the user's email address.

If you do not know the full hostname or user email address, scroll through the list of available endpoints to locate the endpoint.

4. Click an endpoint in the list to display the endpoint detail.
5. Click the **Details & Actions** tab of the endpoint to view information.

Issue a User Decryption Policy
1. In the left pane, click **Populations > Users**.

2. Click a user name link or search for a user and then click a link to display the user detail.
   
   Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character (*) is supported.

3. On the **Security Policies** tab, click **Policy-Based Encryption**.

4. Set the value of **Policy-Based Encryption** to **Off**.

5. Click **Save**.

6. **Commit Policies**.

   Once this policy reaches the specified Encryption client, decryption begins.

---

**Endpoint Groups**

---

**Endpoint Groups**

On the **Endpoint Groups** page, you can **add** or **remove** an Endpoint Group, **edit** Endpoint Group priority, or search and select an Endpoint Group to **view** or **modify** Endpoint Group information.

**Types of Endpoint Groups**

- **System** - Endpoint Group maintained by Dell Server. System groups include Default Endpoint Group, Opt-In Endpoint Group, Persistent VDI Endpoint Group, and Non-Persistent VDI Endpoint Group. For more information about VDI Endpoint Groups, see [VDI Endpoint Groups](#).

- **Rule-Defined** - Dynamic Endpoint Group based on a specification, or rule set, defined by the administrator.

- **Admin-Defined** - Static endpoint group for which the administrator can select specific endpoints for inclusion. The group remains unchanged unless the administrator adds or removes an endpoint. For more information, see [Add Endpoints to an Admin-Defined Endpoint Group](#) or [Remove Endpoints from an Admin-Defined Endpoint Group](#).

- **Active Directory Group** - Endpoint group for which the administrator can select a group from Active Directory for inclusion. The Active Directory group scope must be Global, and type must be Security. At least one endpoint in the Active Directory group must be running a Dell Data Security product and be managed by Dell Server. For more information about adding Active Directory endpoint groups to the Dell Server, see KB article [SLN306875](#).

**Add an Endpoint Group**

Before you add the first Endpoint Group see [Endpoint Groups Specification](#), which explains fields and expressions used in Group Specifications.

1. In the left pane, click **Populations > Endpoint Groups**.

2. Click **Add**.

3. In **Select the type of Endpoint Group**, select **RULE-DEFINED Group**, **ADMIN-DEFINED Group**, or **Active Directory Group**.

4. In **Group Name**, enter a name for the new Endpoint Group.

5. In **Description**, enter a description for the new Endpoint Group.

6. (For Rule-Defined Groups only) In **Specification**, enter the rule that describes the Endpoint Group. Specifications can be up to 20,000 characters and are case insensitive.
(For Active Directory Groups only) In Choose AD Group, enter the beginning characters of an Active Directory group name (Example: Accounting), and select the desired group.

7. (For Rule-Defined and Active Directory Groups only) Click Preview to view the endpoints to be included in the group.

8. Click Add Group to save the group definition.

9. After the group is added, modify the group priority if necessary.

Remove an Endpoint Group

1. In the left pane, click Populations > Endpoint Groups.

2. Select the group to remove.

3. Click Delete, then click OK.

Modify an Endpoint Group

1. In the left pane, click Populations > Endpoint Groups.

2. Select the group to modify.

3. Click the Details & Actions tab.

4. Click Modify.

5. Make changes as desired.

6. Click Update Group.

VDI Endpoint Groups

Upon activation, a VDI endpoint is added to the appropriate VDI Endpoint Group on Dell Server, and policies are sent to the endpoint. Persistent VDI Endpoint Groups and Non-Persistent VDI Endpoint Groups are System Endpoint Groups, which are maintained by Dell Server.

Policy settings differ, based on whether persistent or non-persistent VDI is deployed in the environment. For an explanation of the differences between persistent and non-persistent VDI, see Persistent vs. Non-Persistent VDI.

Policy and Configuration Requirements for VDI Endpoint Groups

The policy requirements below are for VDI endpoints running Advanced Threat Prevention. The list includes only policies that are significant for VDI endpoints. VDI User policy settings must also meet certain requirements. See Policy and Configuration Requirements for VDI Users.

Note: Ensure that you turn off Advanced Threat Prevention Agent Auto Update. In the left pane of the Management Console, select Management > Services Management > Advanced Threats - Agent Auto Update, then select Off.

Note: With Persistent VDI Groups, ensure that roaming user profiles are configured.

These policy and configuration settings for VDI Endpoint Groups must be configured before VDI client activation:

<table>
<thead>
<tr>
<th>Technology</th>
<th>Category</th>
<th>Policy or Setting</th>
<th>Persistent VDI Group setting</th>
<th>Non-Persistent VDI Group setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

67
<table>
<thead>
<tr>
<th>Windows Encryption</th>
<th>Self-Encrypting Drive (SED)</th>
<th>Self-Encrypting Drive (SED)</th>
<th>Off</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Encryption</td>
<td>Hardware Crypto Accelerator (HCA)</td>
<td>Hardware Crypto Accelerator (HCA)</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>SDE Encryption Enabled</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Common Encrypted Folders</td>
<td>&lt;retain default settings&gt;</td>
<td>&lt;retain default settings&gt;</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Encrypt Windows Paging File</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Secure Windows Credentials</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Block Unmanaged Access to Domain Credentials</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Secure Windows Hibernation File</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Prevent Unsecured Hibernation</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Policy-Based Encryption</td>
<td>Enable Software Auto Updates</td>
<td>Not Selected</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>BitLocker Encryption</td>
<td>BitLocker Encryption</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Windows Encryption</td>
<td>Server Encryption</td>
<td>Server Encryption</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Threat Prevention</td>
<td>Advanced Threat Protection</td>
<td>Advanced Threat Protection</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>Removable Media Encryption</td>
<td>Mac Media Encryption</td>
<td>Mac Media Encryption</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Port Control</td>
<td>Windows Port Control</td>
<td>Port Control System</td>
<td>Disabled</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

**Persistent vs. Non-Persistent VDI**

Persistent and Non-Persistent VDI endpoints differ in the following ways:

<table>
<thead>
<tr>
<th>Persistent VDI</th>
<th>Non-Persistent VDI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistent endpoints may exist for many days to years.</td>
<td>Non-persistent endpoints usually exist only for a few days or weeks.</td>
</tr>
<tr>
<td>Persistent endpoints retain the configurations that are set for the VM, until the VM clone pool is removed and rebuilt.</td>
<td>Non-persistent endpoints revert to baseline settings after a user logs off.</td>
</tr>
<tr>
<td>A persistent</td>
<td>After reverting to</td>
</tr>
</tbody>
</table>
endpoint is dedicated to a single user.

baseline settings, a non-persistent endpoint is available for another user.

Endpoint Groups Specification

To skip to instructions about how to add an endpoint, see Add Endpoint Groups.

At deployment time, all endpoints belong to a default endpoint group, which is generally sufficient for most deployments. This feature is used to assign policy to a specific group of endpoints. For instance, you may want to create an endpoint group based on the locale that the operating system sends up in inventory. Once that endpoint group is established, you could then apply a specific policy set to just the endpoints in your specified locale.

Conversely, creating an endpoint group based on a platform type would not be useful because policies are already grouped by platform.

Endpoint groups are created using a group specification. This specification allows you to define the endpoint characteristics used to add endpoints to a group. You cannot manually add endpoints to endpoint groups. The system, based on the characteristics in the endpoint group specification, automatically manages endpoints and endpoint group membership.

Endpoints can be members of many endpoint groups simultaneously, as there is no mutual exclusion requirement for endpoints in groups. All endpoints are included in the default endpoint group in addition to any defined endpoint groups that they may be a member of. This is similar to the way users are a member of the domain they are a part of, in addition to any security groups. Like the user group mapping, the endpoint group mapping creates a potential policy arbitration problem for endpoints. To resolve this problem, the default endpoint group has the lowest possible precedence, and cannot be altered. The endpoint groups that you create have medium precedence by default. For more information on group precedence, see Modify Group Precedence.

**Endpoint Group Specification**

The endpoint group specification is a domain specific language that allows you to define groups. The endpoint group specification consists of a set of operators and a set of data fields that these operators can be applied to. A group specification is a Boolean expression that is evaluated per endpoint to determine whether or not a endpoint is a member of a group.

The information obtained to assign endpoints to endpoint groups happens when inventory is received, not at activation time. If you set up endpoint groups, all endpoints will stay only in the default endpoint group until inventory is received.

Group specifications are created using the following fields and expressions. Multiple fields and operators can be used in a single group specification.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATEGORY</td>
<td>Endpoint category: WINDOWS, MAC, SED</td>
</tr>
<tr>
<td>UID</td>
<td>Windows hostname</td>
</tr>
<tr>
<td>DISPLAYNAME</td>
<td>Fully qualified hostname</td>
</tr>
<tr>
<td>OSVERSION</td>
<td>Operating system version as reported in inventory. Dell recommends using other available fields, as discrepancies in operating system versions may reduce the usefulness of this field.</td>
</tr>
<tr>
<td>OS</td>
<td>Operating system name as reported in the endpoint’s inventory</td>
</tr>
</tbody>
</table>
Operators and Expressions

The basic operators are the binary operators that return a Boolean value.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Boolean, Integer, and String equality operator</td>
</tr>
<tr>
<td>&gt;, &gt;=</td>
<td>Greater than, greater than or equal, integer operator</td>
</tr>
<tr>
<td>&lt;, &lt;=</td>
<td>Less than, less than or equal, integer operator</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal, integer string operator</td>
</tr>
<tr>
<td>AND</td>
<td>Logical AND for Boolean expression</td>
</tr>
<tr>
<td>OR</td>
<td>Logical OR for Boolean expression</td>
</tr>
<tr>
<td>NOT</td>
<td>Logical NOT for Boolean expression</td>
</tr>
</tbody>
</table>

The logical operators follow the standard Boolean operator precedence (NOT, AND, OR). String fields have the following string operators that return Boolean values:

BEGINSWITH
ENDSWITH
CONTAINS

These operators can be used on the string fields:

UID BEGINSWITH "A1850502"
ASSETTAG CONTAINS "007"
String fields also have the following string operators that return substrings of the field:
LEFT(string,int)
RIGHT(string,int)
MID(string,int,int)

The substring operators can be used in the string operators that return Boolean values:
LEFT(DISPLAYNAME, 4 ) = "A185"

There is one additional string operator that returns an integer value that is the length of the string:
LEN(string)
This can be used in a Boolean expression:
LEN(DISPLAYNAME)<=10

Rule Specifications in the Management Console allows users to combine rules to filter a unique set of devices. For queries that contain multiple options, isolate sub-rules in parenthesis to ensure they are run separately before they are combined with the larger specification.

This query selects all devices with an operating system named Windows 10 Pro or Windows 10 Ent and DESKTOP in the hostname:
OS CONTAINS "Windows 10 Pro" OR OS CONTAINS "Windows 10 Ent" AND UID CONTAINS "DESKTOP"

This query selects any device containing Windows 10 Pro and only devices with the hostname containing DESKTOP that running an operating system with the name containing Windows 10 Ent:
OS CONTAINS "Windows 10 Pro" OR (OS CONTAINS "Windows 10 Ent" AND UID CONTAINS "DESKTOP")

- Using the FQDN of the client computer to attach it to a device group can be done by keying on any commonality amongst the desired client computers. In the example below, a child domain of ORGANIZATION, AMERS, represents a domain in America. Additionally, a 2nd child domain, EMEA, represents non-American based clients.

DISPLAYNAME ENDSWITH "AMERS.ORGANIZATION.COM"
This group will contain all clients that are in the AMERS domain according to their FQDN.

DISPLAYNAME ENDSWITH "EMEA.ORGANIZATION.COM"
This group will contain all clients that are in the EMEA domain according to their FQDN

- If the hostname of the client computers contain several notations that indicate desired ways in which to create a group, those specific portions can be captured as long as their location is consistent.

Looking at the hostname: A12345jdoe.AMER.ORGANIZATION.COM
A denotes an asset, while the following 5 digits denotes the asset’s assigned value. The user that was assigned the asset has their SAM account appended to the end.

You can capture the assigned number of the asset, and that it is within a certain subsection of assets. This example shows how to look for assets that have a value less than 1000.

\[ \text{MID(DISPLAYNAME}, 2, 5) < 1001 \]

This example targets user’s computer where their last name begins with ‘r’.

\[ \text{MID(DISPLAYNAME}, 8, 1) = \text{“r”} \]

- Data Guardian:
  
  To display Data Guardian internal clients, add the specification "cloudpresent and cloudinternal".
  
  To display Data Guardian external clients, add the specification "cloudpresent and cloudexternal".

For instructions about how to add an endpoint, see Add Endpoint Groups.

**Edit Group Priority**

The Group priority feature is used to determine policy precedence for effective policies that affect multiple groups. Group priority creates a weight associated with the specific group it is assigned to, and that weight is used to determine which policy setting is applied to an endpoint that is a member of more than one Endpoint Group when policy settings differ between those groups. Policy overrides are used from the group with higher priority when two (or more) separate groups have different priority levels.

**Edit Endpoint Group Priority**

Endpoint Group Priority can be changed only for Rule-Defined, Admin-Defined, and Active Directory Groups. System-Defined Group priority cannot be modified. In general, the Endpoint Group at the top of the list of Endpoint Groups has highest priority. The Endpoint Group at the bottom of the list has lowest priority.

**Precedence Ranking**

The System Defined Non-Persistent VDI Endpoint Group has the highest priority level, followed by the Persistent VDI Endpoint Group.

**Order of priority:**

1. Non-Persistent VDI Endpoint Group
2. Persistent VDI Endpoint Group
3. Highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Group
4. Second and subsequent highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Groups
5. Opt-in Endpoint Group
6. Default Endpoint Group

To change Active Directory/Rule-Defined/Admin-Defined Endpoint Group priority:

1. In the left pane, click **Populations > Endpoint Groups**.
2. Click **Edit Priority**.
3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups that reflects its new priority level.
4. Click **Save**.

**Edit User Group Priority**

The user group at the top of the list has highest priority. The user group at the bottom of the list has lowest priority.

To edit User Group priority:

1. In the left pane, click **Populations > User Groups**.
2. Click **Edit Priority**.
3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups that reflects its new priority level.
4. Click **Save**.

**View Endpoints in an Endpoint Group**

This page displays the endpoints included in information for every user of the specified endpoint.

1. In the left pane, click **Populations > Endpoint Groups**.
2. Click a Group Name link or enter a filter to search for available Groups. The wildcard character (*) is supported.
When you click a Group Name, the Endpoint Group Detail page displays.

3. If applicable, View or Modify Endpoint Information.

View or Modify Endpoint Group Policies and Information

1. In the left pane, click Populations > Endpoint Groups.

2. Click a Group Name or enter a filter to search for available Endpoint Groups. The wildcard character (*) is supported.

When you click a Group Name, the Endpoint Group Detail page displays.

3. Click the tab that corresponds with the action to perform:

   Security Policies - To view or modify policies of the Group, click Security Policies. Note: Before modifying VDI Endpoint Group policies, see Policy Requirements for VDI Endpoint Groups.

   Details & Actions - To view properties of the Group, click Details & Actions. Viewable information includes:

   Group Name: Group1 (DOMAIN\Group1)
   Description: The description provided when the Group was added.
   (For Rule-Defined groups) Specification: The endpoint group specification that defines endpoints as members of the group.
   PBA Device Control - The PBA Unlock command for this endpoint group is carried out in the PBA Device Control area. This command unlocks the PBA screen after it has been locked – either by sending a Lock command or by exceeding the maximum number of authentications attempts allowed by policy.

   Members - To view or modify the information of an endpoint in the group, click Members. The list of endpoints in the group displays. Click an endpoint to view the endpoint's Security Policies, Details & Actions, Users, Endpoint Groups, Threat Events, and Advanced Events.

4. If modified, click Save.

Endpoint Group Details & Actions

This page lists the properties of the selected Endpoint Group.

1. In the left pane, click Populations > Endpoint Groups.

2. Search or select a Group Name, then the Details & Actions tab.

   Details:
   Group Name of the endpoint group
   A description of this endpoint group
   The specification that was used to create this endpoint group (applies only to Rule-Defined Groups)
   Active Directory Group (applies only to Active Directory Groups)

   PBA Device Control
The PBA Unlock command for this endpoint group is carried out in the PBA Device Control area. This command unlocks the PBA screen after it has been locked – either by sending a Lock command or by exceeding the maximum number of authentications attempts allowed by policy.

Endpoint Group Members

This page lists the endpoints within an endpoint group. Information displays based on the group specification used to create the endpoint group.

1. In the left pane, click Populations > Endpoint Groups.
2. Search or select a Group Name, then the Members tab.
   
   Category - WINDOWS, MAC, SED, iOS, or Android
   
   Hostname - Endpoint hostname
   
   OS/Version - Endpoint operating system and version

Add Endpoints to an Admin-Defined Endpoint Group

1. In the left pane, click Populations > Endpoint Groups.
2. Select the group to which to add endpoints.
3. Click the Members tab.
4. Select Add Endpoints to Group, then search for specific endpoints or select endpoints in the list, and click Add Selected Endpoints to Group.
   OR
   
   Select Upload Multiple Endpoints from File, then click Browse to select a CSV file and click Upload.

Valid CSV requirements:

- The file must be in valid CSV format and contain a maximum of 999 endpoints.
- The first column must contain valid fully qualified hostnames. All columns except the first column are ignored.
- Only activated endpoints are added to the group.

Remove Endpoints from an Admin-Defined Endpoint Group

1. In the left pane, click Populations > Endpoint Groups.
2. Select the group in which to add endpoints.
3. Click the Members tab.
4. Search for specific endpoints or select endpoints in the list. To select more than one endpoint, press Shift and select the endpoints.
5. Click the red X in the right column for each endpoint, or select the endpoints and click Remove Endpoints from Group.
On the Endpoints page, you can add an endpoint to a group, remove an endpoint, or search and select an endpoint to View or Modify Endpoint Information. You can also quickly view the following summary information about each endpoint:

*Hostname - Endpoint hostname.
*OS/Version - Operating system and version running on the endpoint (Example: Microsoft Windows 10 Enterprise).
*Category - Category of endpoint (Example: Windows or Mac).
*Protected - A green check displays if the endpoint is protected. If the endpoint is not protected, the column is blank.
*Serial Number - Manufacturer assigned serial number.
*Win Computer Name - Computer name Windows uses to identify the computer on the network.
PBE - Policy-Based Encryption version.
Manager - Manager/Agent version.
Data Guardian - Data Guardian version.
Hardware ID - A unique identifier sent to the server from the client.
* Click the column header to sort by column label.
Click a hostname to view additional details about the endpoint. Click an arrow at the left of a hostname to view the Category, Unique ID, and Processor.

Add Endpoint to Group

To add an endpoint to an Endpoint Group:

1. In the left pane, click **Populations > Endpoints**.
2. Select the check box next to a hostname in the list or enter a filter to search for available endpoints. The wildcard character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in **Search**. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

3. At the top left, click **Add Endpoints to Group**.

An endpoint is added to inventory when a user who is in the Dell Server database activates the endpoint.

If the user is not found in the Dell Server database, they are located in Active Directory.

Remove Endpoints

Endpoint removal is permanent. Once an endpoint is removed, the action cannot be undone.

To remove an endpoint:

1. In the left pane, click **Populations > Endpoints**.
2. Select the appropriate endpoint type, for example, **Workstation** or **Mobile Device**.
3. Click the box next to a hostname in the list or enter a filter to search for available endpoints. The wildcard character (*) is supported.
For Windows and Mac, if you know the hostname of the endpoint, enter it in Search. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

4. At the top left, click Remove.
5. Click OK to confirm removal of the endpoint.

As another option, click an endpoint and select the Details & Actions tab. Under Endpoint Detail, click Remove.

Find Endpoints
1. In the left pane, click Populations > Endpoints.
2. Navigate the list of endpoints using the scroll bar or page navigation controls at the bottom of the page or enter a filter into Search to search for available endpoints. The wildcard character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

View or Modify Endpoint Policies and Information
1. In the left pane, click Populations > Endpoints.
2. Select the appropriate endpoint type, for example, Workstation or Mobile Device.
3. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

Click a hostname or endpoint serial number to display the Endpoint Detail page.
4. Click the tab that corresponds with the action to perform:

**Security Policies** - Click Security Policies to view or modify policies of the endpoint.

**Details & Actions** - Click Details & Actions to view properties of the endpoint, including Inventory Information. Viewable information includes hardware information, effective policies, inventory and protection status, threat protection and Advanced Threat Prevention detail, and SED Device Control commands.

**Users** - Click Users to view a list of users who store and access data on the endpoint. These statistics of users may be available on the Endpoint Detail page: login, last Gatekeeper sync, effective policies, and states. You can also recover data from this page.

**Endpoint Groups** - Click Endpoint Groups to view a list of Endpoint Groups to which this endpoint belongs. All endpoint belong to at least one endpoint group, the Default Endpoint Group.

**Threat Events** - Click Threat Events view information about threat events on the endpoint. The following information is displayed for events: severity, category (malware, web filtering, web protection, and firewall), event ID, event description, user name, and received.
Advanced Threat Events - Click Advanced Threat Events view, export, quarantine, or waive unsafe files. Events are grouped by Status (unsafe, quarantined, or abnormal), and the following information is displayed for events: file name, file paths, score, classification, first found time stamp, running, auto run, and detected by.

6. If modified, click Save.

View Effective Policy

When you view Effective Policies, you are viewing the policies and settings that are enforced on an endpoint.

1. In the left pane, click Populations > Endpoints.
2. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

Click a hostname or endpoint serial number to display the Endpoint Detail page.

3. On the Endpoint Detail page, click the Details & Actions tab.
4. Under Manager Detail, click View Effective Policies.

Related topics:
Manage Security Policies

Endpoint Details & Actions

The Details & Actions page lists the details for the selected endpoint as well as commands, such as Remove Endpoint. Available details and commands vary, depending on the endpoint platform.

To access Endpoint Details & Actions, follow these steps:

1. In the left pane, click Populations > Endpoints.
2. Search or select a hostname, then the Details & Actions tab.

Endpoint Detail

Command:
Remove - Endpoint is removed.

Endpoint removal is permanent. Once an endpoint is removed, the action cannot be undone.

Details:
Windows
Category - Windows
OS/Version - Example: Microsoft Windows 10 Enterprise
Processor
Serial Number - Manufacturer assigned serial number
Host ID - Endpoint identifier
Unique ID - Dell assigned unique identifier
Hardware ID - A unique identifier sent to the server from the client.
Protected - Date and time stamp

**Mac**
Category - Mac
OS/OS Version - Example: Mac OS X 10.11.0
Processor
Serial Number - Manufacturer assigned serial number
Host ID - Endpoint identifier
Unique ID - Dell assigned unique identifier
Hardware ID - A unique identifier sent to the server from the client.
Protected - Date and time stamp

**Mobile Device**
Category - Mobile Device
OS/OS Version - Example: Lollipop / 5.0
Model Name - Examples: Android or iPad
Serial Number - Manufacturer assigned serial number
Last Contact Time - Date and time stamp of last contact with the Security Management Server

State:
- **Discovered** – device found
- **Blocked** – block from Exchange access
  
  *Blocked Sub-States (on the Endpoint Detail page)*:
  - **Blocked by Admin** – (EAS only) blocked by administrative override using the Block Device command
  - **Blocked by Policy** – (EAS or iOS) subject to the Allow iOS Devices and Allow Non-iOS Devices policies.
- **Pending** – iOS policy pending
- **Protected** – policies implemented

**Cloud**
Category - Windows, iOS, or Android
OS/OS Version - Examples:
Windows 10
Android / 5.0
iPhone OS / 8.0
Model ID - Examples: iPhone6, or iPad3,4
Model Name (if available)
Phone ESN/IMEI (if available)
Processor (will display if the data is available)
Memory available and total (MBs) (will display if the data is available)
Battery remaining% (will display if the data is available)
Serial Number - Manufacturer assigned serial number
Unique ID - Dell assigned unique identifier
Actions - Hide or Remove Endpoint

**Shield Detail**

**Commands:**

To view the policies of the endpoint, click **View Effective Policies**.

Obtain the endpoint's recovery keys:

1. Click **Device Recovery Keys**.
2. Enter a Recovery Password and click **Download**.

The recovery bundle containing this endpoint's encryption keys is downloaded. You must remember the this recovery password to access the recovery keys.

**Detail:**

**Windows**

Policy Proxy Group (typically CMGREMOTE)
Recovery ID of the specific endpoint
Version (core/edition)
Activation Method (typically Mandatory)
HCA Enabled: True or False
TPM Present: True or False
Edition: Dell or CREDANT

**States:**

Policy Updating: Date and timestamp
Device Encryption Updating: Date and timestamp
Device Data Encryption On: Date and timestamp
Sweep Started: Date and timestamp
Sweep Completed: Date and timestamp
Inventory Received: Date and timestamp
Inventory Processed: Date and timestamp
Manager Inventory Received: Date and timestamp
Manager Inventory Processed: Date and timestamp
Protected:

Protection Status Tab:
- Disk Name
- Capacity (storage)
- Protection Status (Protected, Protecting, Unknown)
- Interface type
- Model number of the endpoint

GPE Tab:
- GPE Available (True or False)
- GPE Driver Version
- GPE Functional (True or False)
- GPE Lifecycle Remaining (number)
- GPE Lifecycle Owner Remaining (number)
- GPE Provisioned Status

TPM Tab:
- TPM Present (True or False)
- TPM Activated (True or False)
- TPM Owned (True or False)
- TPM Functional Status (True or False)
- TPM Spec Version (version number)

HCA Tab:
- HCA Functional Status
- HCA Provision State
- Preboot Present (True or False)
- Preboot Set (True or False)

Actions: Effective policies on the specific endpoint and Recovery Keys for the specific endpoint

Mac
Policy Proxy Group (typically CMGREMOTE)
Recovery ID of the specific endpoint
Version (core/edition)
Activation Method (typically Mandatory)
Edition (Dell or Credant)
States:
Policy Updating: Date and timestamp
Device Encryption Updating: Date and timestamp
Device Data Encryption On: Date and timestamp
Sweep Started: Date and timestamp
Sweep Completed: Date and timestamp
Inventory Received: Date and timestamp
Inventory Processed: Date and timestamp
Protected:
  Protection Status Tab:
    Disk Name
    Capacity (storage)
    Protection Status (Protected, Protecting, Unknown)
    Interface type
    Model number of the endpoint
Actions: Effective policies on the specific endpoint and Recovery Keys for the specific endpoint

Manager Detail (Windows only)

Command:
Click View Effective Policies to go to the effective policy page for this endpoint.

States
The client gathers the following information via a Windows Management Instrumentation (WMI) call to the Operating System. It is updated with each inventory update.

Inventory Received - the date and time that the inventory was received by the Dell Server and placed in the queue.

Inventory Processed - the date and time that the inventory was picked up from the queue and processed. (Note: If the Dell Server is under load, the Processed and Received times may be different, but usually they is the same.)

Agent Version - the version of Manager the endpoint is running.

Protected - the date and time that the device was protected.

Protection Status
Disk - number of the disk
Partitions - number of partitions the disk has
Capacity - capacity of the disk
Encryption Technology - encryption technology in use
Protection Status - Protected or unprotected
Interface - Disk interface (Examples: IDE, SATA)
Model - Manufacturer name and model of the disk

Click the small black arrow on the left to expand the disk details to view information for each partition of the disk.

- Logical Disk - The name of the logical disk.
- ID - The identifying number of the logical disk.
- Encryption % - The percentage of the partition that has been encrypted.
- Capacity - The capacity of the partition.
- Protection Status - Protection status for the partition: Protected, Unprotected, Locked

Providers
Agent - SED, FDE, Authentication Proxy, Preboot Authentication, Windows Authentication, BitLocker, TPM, Threat Protection, Advanced Threat Prevention

Plugin Functional Status (green check mark or red "x") - This indicates whether the Agent has been enabled via policy. To get more detail on whether each plugin is working as expected, look at Plugin State column.

Plugin State:

- BitLocker Plugin:
  - Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory update would capture this so you would probably never see this state in the Management Console.
  - Disabled - Manager is disabled by policy and not enforcing any previously received policy.
  - Active - Manager is running normally and enforcing policies.
  - No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy. This is only relevant the very first time you install the Manager client. Manager does not start a plugin until an initial policy is received from the Dell Server, versus starting the plugin with some default policy placed on the client during install. After an initial policy has been received from the Dell Server, via the activation process, plugins are always started with the last policy the client is aware of.
  - OpSys Not Supported - Manager does not support this operating system. Manager is not actively enforcing policy related to this plugin, due to this plugin-specific exception.

- TPM Plugin:
  - Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory update would capture this so you would probably never see this state in the Management Console.
  - Disabled - Manager is disabled by policy and not enforcing any previously received policy.
  - Active - Manager is running normally and enforcing policies.
  - TPM Services Not Started – In the Enterprise Server Console this is listed as **TPM Base Services Failed**. It means something is preventing the TPM service from starting as expected. The Manager is not actively enforcing policy related to this plugin, due to this plugin-specific exception.
No TPM Device – The TPM device is not present or is not detectable in the indicated computer. The Manager is not actively enforcing policy related to this plugin, due to this plugin-specific exception.

No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy. This is only relevant the very first time you install the Manager client. Manager does not start a plugin until an initial policy is received from the Dell Server, versus starting the plugin with some default policy placed on the client during install. After an initial policy has been received from the Dell Server, via the activation process, plugins are always started with the last policy the client is aware of.

- SED Plugin:
  
  Initialized - Manager is initialized waiting for delayed startup
  
  Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory update would capture this so you would probably never see this state in the Management Console.
  
  Disabled - Manager is disabled by policy and not enforcing any previously received policy.
  
  Active - Manager is running normally and enforcing policies.

No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy. This is only relevant the very first time you install the Manager client. Manager does not start a plugin until an initial policy is received from the Dell Server, versus starting the plugin with some default policy placed on the client during install. After an initial policy has been received from the Dell Server, via the activation process, plugins are always started with the last policy the client is aware of.

  Waiting For Escrow - Manager is waiting for keys to escrow
  
  Waiting For Server Public Key - Manager is waiting for public key to proceed with activation
  
  No Opal Drive Present - Manager did not detect an OPAL drive

Plugin Version - The version of the plugin, which is taken from the plugin's version information

Vendor version - The version of the underlying framework. For example, BitLocker is Microsoft's technology, therefore Vendor Version is Microsoft's version for BitLocker.

**Threat Protection Detail (Windows only)**

- Scan Engine Version - Lists the version of the engine that performed the last scan.
- DAT File Version - Lists the version of the DAT file.
- Last Scan Started - Date/time stamp that the last scan was started.
- Last Scan Completed - Date/time stamp that the last scan was completed.

**Advanced Threat Prevention Detail**

- Device ID - Lists the identifier of the device as it pertains to Advanced Threat Prevention.
- Agent Version - Lists the version of the agent.
- Update Date - Date/time stamp that the agent was updated.
- Provisioned Date - Date/time stamp that the client was provisioned.

**Cloud Device Control**
Cloud device commands apply to the selected endpoint and are carried out from the Cloud Device Control section of the device's endpoint page. Unlike policies, commands are pushed to the device to enable an action.

**Commands:**

- **Suspend** - Suspends the endpoint device. It does not suspend the user account.
- **Unsuspend** - Unsuspends the endpoint device.

**FDE Device Control (Windows only)**

- **Current State of the Endpoint** - Unlocked or Locked

**Commands:**

PBA commands for a specific endpoint are carried out in the PBA Device Control area. Each command has a priority ranking. A command with a higher priority rank cancels commands of lower priorities in the enforcement queue. For a list of command priority rankings, see [Priority of Commands for Self-Encrypting Drives](#).

- **Lock** - Locks the PBA screen and prevents any user from logging into the computer.
- **Unlock** - Unlocks the PBA screen after it has been locked on this endpoint, either by sending a Lock command or by exceeding the maximum number of authentications attempts allowed by policy.
- **Remove Users** - Removes all users from the PBA.
- **Bypass Login** - Bypasses the PBA screen one time to allow a user into the computer without authenticating. The user will still need to login to Windows after PBA has been bypassed.
- **Wipe** - The Wipe command functions as a “restore to factory state” for the FDE drive. The Wipe command can be used to re-purpose a computer or, in an emergency situation, wipe the computer, making the data permanently unrecoverable. When the wipe command is consumed by the client, all history and details about this endpoint are removed from the Dell Server. Ensure that this is the desired behavior before invoking this command.

**The FDE Device Control Table**

The table lists the commands most recently sent to the PBA Device.

To sort the table, click a column header.

**PBA Device Control (Windows only)**

- **Current State of the Endpoint** - Unlocked or Locked

**Commands:**

PBA commands for a specific endpoint are carried out in the PBA Device Control area. Each command has a priority ranking. A command with a higher priority rank cancels commands of lower priorities in the enforcement queue. For a list of command priority rankings, see [Priority of Commands for Self-Encrypting Drives](#).

- **Lock** - Locks the PBA screen and prevents any user from logging into the computer.
- **Unlock** - Unlocks the PBA screen after it has been locked on this endpoint, either by sending a Lock command or by exceeding the maximum number of authentications attempts allowed by policy.
- **Remove Users** - Removes all users from the PBA.
- **Bypass Login** - Bypasses the PBA screen one time to allow a user into the computer without authenticating. The user will still need to login to Windows after PBA has been bypassed.
**Wipe** - The Wipe command functions as a “restore to factory state” for the SED drive. The Wipe command can be used to re-purpose a computer or, in an emergency situation, wipe the computer, making the data permanently unrecoverable. When the wipe command is consumed by the client, all history and details about this endpoint are removed from the Dell Server. Ensure that this is the desired behavior before invoking this command.

**The PBA Device Control**

Lists the commands most recently sent to the PBA device.

To sort, click a column header.

**Protected Status**

Protected status is indicated if any of the following criteria are met:

- Advanced Threat Prevention is installed and enabled.
- Data Guardian is installed and enabled.
- Self-Encrypting Drive Management is installed, enabled, and the PBA is enabled.
- BitLocker Manager is installed, enabled, and encryption has completed.
- Dell Encryption (Mac) is installed and enabled, and policy-based encryption has been enforced.
- Dell Encryption (Windows) is installed, enabled, Policy-Based Encryption has been set for the endpoint, and the most recent policy has been applied for the last logged on user.

To check Protected Status of an endpoint:

1. In the left pane, click **Populations > Endpoints**.
2. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard character (*) is supported.
   - For Windows and Mac, if you know the endpoint hostname, enter it in the Search field. Leave the field blank to display all Windows and Mac endpoints.
   - For Mobile devices, optionally enter the model name or user's email address.
   - Click a hostname or endpoint serial number to display the Endpoint Detail page.
3. A green check mark displays in the Protected column if any of the criteria for Protected status are met.

**Endpoint Users**

This page displays information for every user of the specified endpoint. The user information differs for each technology group or policy category.

1. In the left pane, click **Populations > Endpoints**.
2. Search or select a hostname, then the **Users** tab.

**Shield**

User - Each user on the specific endpoint
Last Successful Login - Date/time stamp, per user
Last Unsuccessful Login - Date/time stamp, per user
Last Gatekeeper Sync - Date/time stamp, per user
Effective Policies - Click view for a simple layout view of the effective user policies
Actions - Click **Recover** to proceed to the Recover Data page
Last Encryption Sweep Start - Date/time stamp, per user
Sweep End - Date/time stamp, per user
Encryption Failure - Click view for a simple list of files that could not be encrypted, per user
States (Date/time stamp, per user):
- Policy Updating
- User Encryption Profile Updating
- EMS Encryption Profile Updating
- User Data Encryption On
- EMS Data Encryption On
- Deactivation Pending
- Suspension Pending
- Suspended

**Cloud**
- User - Each user on the specific endpoint

**Endpoint Threat Events**
This page lists information on threat events for the selected endpoint.

1. In the left pane, click **Populations > Endpoints > Workstation**.
2. Search or select a Hostname, then the **Threat Events** tab.

**Threat Event Data**
- **Severity** - Severity of the threat, where Critical is the most dangerous threat to the endpoint, and Information is just a notification of an event that is unlikely to harm the endpoint. (Critical, Major, Minor, Caution, Information)
- **Category** - Category of the threat. Upon identification, threats are sorted into these categories: Malware, Web Filtering, Web Protection, and Firewall.
- **Event ID** - Unique number assigned to each threat event.
- **Description** - Description of the last preventative action taken to handle the threat.
- **User Name** - The DOMAIN\Username associated with the endpoint where the threat was identified.
- **Received** - Date/time stamp when the last action was taken to handle a threat.

**Navigate the Threat Event Data**
To sort the data, click a column header.
Use the controls at the bottom of the page to:

- Advance to the top of the data.
- Go back one page.
- Go forward one page.
- Advance to the end of the data.
- Increase or reduce the items per page.
- View the range of items currently displayed.
- Refresh the data.

**Endpoint Advanced Threats**

This page allows you to view, export, quarantine, or waive unsafe files that trigger events on the selected endpoint.

An event is not necessarily a threat. An event is generated when a recognized file or program is quarantined, safe listed, or waived. Threats are a category of events that are newly detected as potentially unsafe files or programs and require guided remediation.

1. In the left pane, click **Populations > Endpoints**.
2. Search or select a hostname, then the **Advanced Events** tab.

**List of Events**

The list presents all files that have triggered events found on this device.

**Columns**

- Icon - An icon displays in this column, when available.
- Name - File triggering the event.
- File Paths - The location of the file on the device.
- Cylance Score - A score is assigned to each file that is deemed Abnormal or Unsafe. The score represents the confidence level that the file is malware. The higher the number, the greater the confidence.
- Status - Indicates whether the file has been quarantined or waived.
- Classification - Classification of the threat: High, Medium, or Low. For details, see Advanced Threat Protection Classifications.
- First Found - Date/timestamp that the file was first found.
- Running - Indicates whether the file that triggered the event is running or not.
- Auto Run - Indicates whether the file was set to automatically run upon startup.
- Detected By - Indicates whether the file was detected by Execution Control or by Memory Protection.

**Configure the Threat List**

Add or Remove Columns
Click an arrow next to any column header and select **Columns** to add columns to, or remove columns from, the table.

**Filter on Column Data**

To filter the list based on column data, click the down-arrow on any column to display the context menu, and select **Filter**.

The filter options vary, depending on the type of data in the column. For example, you may want to filter the list so that it shows only high priority threats.

**Group by a Column**

Drag a column header, such as Status, to the area directly above the column headers to group the data by Status. When you drag a column header, it turns green, indicating that the table can be grouped by that data. You can drag additional headers over the table to group the data even further.

For each group, a number displays in parentheses to indicate the total number of threats that share that group's attribute.

**Commands:**

Select the check box next to a file name to perform an action on the file. To select all files, select the check box in the column heading row.

**Export** lets you export selected data to a .CSV file so that you can view the data in Excel or a similar application which has powerful sorting/organizing features.

After selecting the data to export, click **Export** to save the data in a .CSV file.

Click **Quarantine** to add the file to the Quarantine list.

Quarantining a file will prevent the file from being executed on this device.

**Note:** Quarantining a file will move the file from its original location to the Quarantine directory (C:\ProgramData\Cylance\Desktop\q).

Click **Waive** to allow the file to run on this device.

**Note:** Occasionally, a “good” file could be quarantined or reported. This could happen if the features of that file strongly resemble those of malicious files. Waiving or globally safe listing the file can be useful in these instances.

**Exploit Attempts**

This section lists the detection of attempts to exploit running processes, or malware that executes from within memory space.

A number displays the total number of events, followed by the number in each subcategory.

**Check box** - Select all events by selecting the check box in the column heading row, or select individual events. When you select a check box, Quarantine and Waive are activated.

**Added** - Date and time when the exploit attempt was added.

**Process Name** - Name of the process identified as an exploit attempt.

**Process ID** - Unique number associated with the exploit attempt.

**Type** - Type of memory exploit: Exploitation, Process Injection, Escalation.
Action - Action taken to protect the system from the exploit attempt:

- **Ignore** - The agent does not take any action against identified memory violations.
- **Alert** - The agent will record the violation and list the incident on this page.
- **Block** - If an application attempts to call a memory violation process, the agent will block the process call. The application that made the call is allowed to continue to run.
- **Terminate** - If an application attempts to call a memory violation process, the agent will block the process call and will also terminate the application that made the call.

User Name - Name of the user who was logged in when the exploit attempt was identified.

---

**Endpoint Advanced Threat Events**

The Advanced Threat Events tab displays if the Advanced Threat Prevention service is provisioned and Advanced Threat Prevention is enabled on the endpoint.

The tab displays information about events for the endpoint based on information available in the Dell Server.

To access the Enterprise Advanced Threats tab, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Search or select a hostname, then the **Advanced Threat Events** tab.

Use the following filters to select content to display on the Advanced Threat Events tab:

- **Type** - Threat Found, Threat Blocked, Threat Terminated, Memory Violation Blocked, Memory Violation Terminated, Memory Violation (Detected), Threat Removed, Threat Quarantined, Threat Waived, Threat Changed, Protection Status Changed.
- **Severity** - Severity level of the event: Critical, Major, Minor, Caution, or Informational.
- **Timeframe (in days)** - 1, 7, 14, 30, 60, 90
- **Columns** - Allows you to select the following additional columns to display:
  - **Hostname** - The fully qualified name of the computer
  - **Data** - Details about the event
  - **Created** - Date and time that the event was captured
  - **Machine Name** - Name of the computer on which the threat event was detected
  - **Path** - Path to the file in which the threat was detected
  - **Sha256** - The file's 256-character Secure Hash Algorithm can be compared with an expected result to indicate whether the file has been tampered with.
  - **Score** - The threat file's score, indicating the confidence level that the file is malware. The higher the number, the greater the confidence.

---

**Server Encryption Clients**

**Suspend an Encrypted Server**
When you suspend an encrypted server, you suspend the user associated with the encryption client rather than an individual user who logs on to the endpoint.

To suspend a Server Encryption client:

1. In the left pane, click **Populations > Users**.
2. In **Search**, enter **SERVER-USER** and click the magnifying glass.
3. Click the user name of the appropriate user.
4. On the User Detail page, click the **Endpoints** tab.
5. Click the Device ID of the appropriate endpoint.
6. On the Endpoint Detail page, click the **Details & Action** tab.
7. In Server Device Control, click **Suspend**.

Suspension takes effect the next time the endpoint is rebooted.

To reinstate an encrypted server, follow the instructions in the Reinstate a Suspended Server Encryption Client.

**Reinstall an Encrypted Server**

To reinstate an encrypted server, follow these steps:

1. In the left pane, click **Populations > Users**.
2. In **Search**, enter **SERVER-USER** and click the magnifying glass.
3. Click the user name of the appropriate user.
4. On the User Detail page, click the **Endpoints** tab.
5. Click the Device ID of the appropriate endpoint.
6. On the Endpoint Detail page, click the **Details & Action** tab.
7. In Server Device Control, click **Reinstall**.

Reinstatement takes effect the next time the endpoint is rebooted.

**Commands for Self-Encrypting Drives**

**Priority of Commands for Self-Encrypting Drives**

Each command for self-encrypting drives has a priority ranking. A command with a higher priority rank cancels commands of lower priorities in the enforcement queue.

Priority rankings (1 is highest):

1. Wipe
2. Lock
3. Remove Users
4. Unlock
5. Bypass

For example, a Wipe command cancels a Lock command that was previously queued to send to the endpoint.
Allow PBA Login Bypass

You can allow users to bypass the Preboot Authentication (PBA) screen one time to allow a user into the computer without authenticating on an endpoint equipped with a self-encrypting drive.

To send the Bypass Login command, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Select the Workstation Endpoint Type.
3. If you know the full endpoint hostname, enter it in **Search**. Leave the field blank to display all Workstation endpoints.
4. Click 🕵️. An endpoint or list of endpoints displays, based on your search filter.
5. Click the endpoint hostname on which to allow PBA login bypass.
6. Click the **Details & Actions** tab.
7. Under **SED Device Control**, click **Bypass Login**.
8. Click **Yes** to confirm that you want to send the Bypass Login command to the endpoint.

Unlock a Self-Encrypting Drive

You can unlock the PBA screen after it has been locked on this endpoint, either by sending a Lock command or by exceeding the maximum number of authentications attempts allowed by policy.

To send the Unlock command, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Select the **Workstation** endpoint type.
3. If you know the full endpoint hostname, enter it in **Search**. Leave the field blank to display all Workstation endpoints.
4. Click 🕵️. An endpoint or list of endpoints displays, based on your search filter.
5. Click the endpoint hostname with the self-encrypting drive to unlock.
6. Click the **Details & Actions** tab.
7. Under **SED Device Control**, click **Unlock**.
8. Click **Yes** to confirm that you want to send the Unlock command to the endpoint.
Remove Users from Endpoint with Self-Encrypting Drive

To remove users from the PBA, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Select the **Workstation** endpoint type.
3. If you know the full Hostname of the endpoint, enter it in the **Search** field. However, you may leave the field blank to display all Workstation endpoints.
4. Click the search icon.
   An endpoint or list of endpoints displays, based on your search filter.
5. Click the Hostname of the endpoint from which to remove users.
6. Click the **Details & Actions** tab.
7. Under SED Device Control, click **Remove Users**.
8. Click **Yes** to confirm that you want to send the Remove Users command to the endpoint.

Lock a Self-Encrypting Drive

To lock the PBA screen and prevent any user from logging onto the computer, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Select the Workstation Endpoint Type.
3. If you know the full endpoint hostname, enter it in **Search**. Leave the field blank to display all Workstation endpoints.
4. Click **Search**. An endpoint or list of endpoints displays, based on your search filter.
5. Click the endpoint hostname with the self-encrypting drive to lock.
6. Click the **Details & Actions** tab.
7. Under **SED Device Control**, click **Lock**.
8. Click **Yes** to confirm that you want to send the Lock command to the endpoint.

Send Wipe Command to Self-Encrypting Drive

**CAUTION:** The Wipe command clears all data from the disk and cannot be undone.

The Wipe command functions as a “restore to factory state” for the self-encrypting drive. In an emergency situation, wipe the computer, making the data permanently unrecoverable. When the wipe command is consumed, all history and details about this endpoint are removed. Ensure that this is the desired behavior before invoking this command.

To send the Wipe command, follow these steps:

1. In the left pane, click **Populations > Endpoints**.
2. Select the Workstation Endpoint Type.
3. If you know the full endpoint hostname, enter it in **Search**. Leave the field blank to display all Workstation endpoints.
4. Click . An endpoint or list of endpoints displays, based on your search filter.
5. Click the endpoint hostname on which to wipe the self-encrypting drive.
6. Click the Details & Actions tab.
7. Under SED Device Control, click Wipe.
8. Click Yes to confirm that you want to send the Wipe command to the endpoint.

Set the Dell Server Connection Retry Interval

To set the interval that the SED client attempts to contact the Dell Server when it is unavailable to communicate with the SED client, set the following value on the client computer:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\DellMgmtAgent\Parameters
CommErrorSleepSecs (DWORD Value)=300

This value is the number of seconds the SED client waits to attempt to contact the Dell Server if it is unavailable to communicate with the SED client. The default is 300 seconds (5 minutes).

Administrators

Assign or Modify Administrator Roles

View or modify existing administrator privileges.
1. In the left pane, click Populations > Administrators.
2. Search or select the row that displays the user name of the appropriate administrator to display User Detail.
3. View or modify administrator roles in the pane at the right.
4. Click Save.

Dell recommends assigning administrator roles at the Group level rather than at the User level.
1. In the left pane, click Populations > User Groups.
2. Search or select a group name, then the Admin tab.
3. Select or deselect administrator roles assigned to the group.
4. Click Save.

If you remove a group that has administrative privileges and later re-add the group, it remains an administrator group.

To view, assign, or modify administrator roles at the User level, see User Admin.

Related topics:
Administrator Roles
User Admin
Delegate Administrator Roles
**Administrator Roles**

Administrator login is integrated with Active Directory to simplify the process of managing administrators and to allow you to leverage your existing user authentication infrastructure. Administrators are assigned roles that define what level of access each administrator is allowed. For example, some administrators may only be allowed to implement help desk assisted recovery while others have full access to edit security policies. You can assign administrator roles to Active Directory groups so you can easily change the level of administrator access users have with a simple change to AD group membership. Non-domain users can be granted reporting-only access via Compliance Reporter.

There are 11 types of administrators. Distributed administration is key to the secure administration of your environment. It allows you to divide roles appropriately among your administrators and ensures the proper level of privileges are assigned to each administrator. A single administrator can have privileges of more than one administrator type. However, it is recommended to have a maximum of one super administrator (an administrator who has privileges of all administrator types).

The following table shows the tasks each administrator can perform in the Management Console or Compliance Reporter.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Log in</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Log out</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>View current system state</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Search for Users, Groups, and Endpoints</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Add Users and Groups</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Browse Domains</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Add and edit Domains</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Upload licenses</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Recover an endpoint - Authentication Failure</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Remove an endpoint</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Change Dell Server Options</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Suspend a User</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Reinstate suspended user</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Deactivate a</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
</tbody>
</table>
## Navigate the Dell Server

<table>
<thead>
<tr>
<th>User</th>
<th>Modify policies</th>
<th>Commit policies</th>
<th>Issue commands</th>
<th>View audit events</th>
<th>Analyze logs</th>
<th>View Administrator accounts</th>
<th>Create, change, and delete Administrator accounts</th>
<th>Delegate Administrator privileges</th>
<th>Download Endpoint software</th>
<th>Download recovery key bundle</th>
<th>Provision or recover the Advanced Threat Prevention service</th>
<th>Enroll for Advanced Threat Prevention auto updates</th>
<th>Set email notifications of Client Access Licenses, Threat Protection, and Advanced Threat Prevention alerts</th>
<th>Manage Data Guardian external users</th>
</tr>
</thead>
<tbody>
<tr>
<td>View policies</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Modify policies</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Commit policies</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Issue commands</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>View audit events</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Analyze logs</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>View Administrator accounts</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Create, change, and delete Administrator accounts</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Delegate Administrator privileges</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Download Endpoint software</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Download recovery key bundle</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Provision or recover the Advanced Threat Prevention service</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Enroll for Advanced Threat Prevention auto updates</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Set email notifications of Client Access Licenses, Threat Protection, and Advanced Threat Prevention alerts</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Manage Data Guardian external users</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Manage Data Guardian external user key requests</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revoke Data Guardian keys</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Install/uninstall Compliance Reporter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log in to Compliance Reporter</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage report folders and modify/save Compliance Reporter report layouts</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access the Compliance Reporter reports window</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work with Compliance Reporter report views and generate reports</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access the Compliance Reporter report administrator window</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create, manage, schedule, and make Compliance Reporter report layouts available to report users</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specify the data source for Compliance Reporter</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage Compliance Reporter user privileges</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit or delete a</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule and rename a report that is set to run at a specified interval in the Compliance Reporter Scheduler</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter or modify settings in Compliance Reporter Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set up Compliance Reporter plugins</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open a Report, modify an online Report display, and rename a Report view in Compliance Reporter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate, export, store, print, and email a Report result in Compliance Reporter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, edit, and delete a Compliance Reporter Report folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access the Manage Reports Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. The forensic administrator role provides the rights to use the forensic administrator tools via XAPI.
2. The policy administrator role is reserved for future use.

**Delegate Administrator Rights**
Administrator rights for a user group can be delegated to a user. The delegated administrator and users must be members of the user group not only in Active Directory but in the Dell Server database. Administrator rights are available to the delegated administrator only if the delegated administrator is a member of the user group in the Dell Server database. Delegated administrator rights are effective only with regard to Users who are members of the user group in the Dell Server database.

Only the superadmin and account administrator can delegate administrator rights.

To delegate Administrator rights, follow these steps:

1. In the left pane, click **Populations > User Groups**.
2. Search for the appropriate group.
3. Click the **Admin** tab.
4. Under **Delegated Roles**, click **Add**.
5. Search for and select the user to receive administrator rights, then click **Add**.

To remove delegated administrator rights, under **Delegated Roles** in User Group Detail, locate the user to remove as delegated administrator and click the red **X** next to the user name.

**Reporting**

**Manage Reports**

**Manage Reports**

In the left pane, click **Reports > Manage Reports**. For compliance and monitoring purposes, you can:

- **Manage reports**
- **View or modify an existing report**
- **Create a new report**

The Manage Reports page has:

- **New Report** - See **Create a new report**.
- **Report Type** - Select **All** (default) or specific report types to display in the Name column. **Clear selected items** to undo selections. See **Report Type**.

**Note:** Policy-based reports are not an option.

- **Grouping** - Group by **Report Type**, **Author**, **Private**, or **None** (default).
- **Columns** - Select which columns to display on the Manage Reports page, such as Name, Description, Report Type, Author. Also:
  - **Private** - **True** indicates only the owner of the report can access it.
  - **Report Administrator** - can view all public and private reports.
  - **Other Administrators** - can view private reports they created and all public reports.
  - **Created** - Date the report was created.
  - **Modified** - Date the report was modified.
• **Search** - Hover to view columns for performing a search, then enter specific text for those columns. Use * for a wildcard. For additional filtering to provide a detailed search on a specific report, see [Use Search and More to filter](#).

**View or Modify an Existing Report**

On the Manage Reports page, select a report from the Name column to view an instance of that report. The owner can make the report private or public. See [View Report](#).

**Create a New Report**

On the Manage Reports page, click **Create New Report** and select an option. An instance of that report opens to customize the information to display. See [View Report](#).

**View Report**

On the Manage Reports page, select an option in **Create New Report** or click an existing report in the Name column.

- **New report** - An administrator can select **Save As**. Save, Rename, and Delete options are activated, and the report is saved to the Manage Reports page. The owner can make the report private or public. You can create:
  - Single reports
  - Report templates - Determine frequent report content that you will generate. Select Column and Grouping options that are common to all those reports and save it as a template. See [View or modify an existing report](#).

- **Existing report**:  
  - To filter a report, perform a query using **Search** and **More**.
  - Owner of a report - Can view their private reports and all public ones. Only the Owner or a Report administrator can modify or rename the report.
  - Report administrator - Can view all private and public reports. Can modify or rename public and private reports.
  - Public reports - Any administrator can select **Save As** to modify a copy of the report.

Grouping, Columns, and More differ for each report type. Some Column and Grouping options are selected by default.

- **Columns** allows customized options to display. After you select options, you can drag and resequence to avoid scrolling. The resequenced columns return to the default when you close the report.

- **Grouping** allows you to sort the column options you selected.

- Hover over **Search** to view suggested columns for performing a search, then enter specific text. Suggested column options differ for each report type. Use (*) as a wildcard.

For a description of each report's Column and Grouping options, click a link below.
<table>
<thead>
<tr>
<th>Security Management Server v10.2.7 AdminHelp</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Detail</strong></td>
</tr>
<tr>
<td><strong>Shield Detail</strong></td>
</tr>
<tr>
<td><strong>Notifications</strong></td>
</tr>
<tr>
<td><strong>Log Analyzer</strong></td>
</tr>
<tr>
<td><strong>Audit Event</strong></td>
</tr>
<tr>
<td><strong>ATP Event</strong></td>
</tr>
<tr>
<td><strong>EMS Event</strong></td>
</tr>
<tr>
<td><strong>BitLocker Manager</strong></td>
</tr>
<tr>
<td><strong>Windows Encryption Failures</strong></td>
</tr>
<tr>
<td><strong>Windows Shield User Encryption Status</strong></td>
</tr>
</tbody>
</table>

**Query using Search and More... to filter**

*Search* performs a text-only quick search across multiple fields and may return numerous results.

- Hover to view columns that apply to this search, then enter specific text for those columns.
- Use * for a wildcard.

To filter and narrow the search with *More...*:

- Select *More...* and select a check box. Check boxes differ for each report type. Select one or multiple check boxes to narrow the search.
- An additional field displays for that check box option where you can either enter text to search on that column or select from a list of enumerators or a data type for that column.

**Query example for Log Analyzer report**

1. In Columns, select options. From menu options such as, **Priority** and **Category** select enumerators. **Created** allows you to filter by date.
2. Enter text in *Search* to perform a quick search on **Username** and **Message**.
3. For additional filtering, select *More...* and then select **Username**, **Message**, or both. Additional text fields allow you to limit the text search specifically to that column.

**Query example for Data Guardian and Audit Events report**

With Data Guardian, you can set specify policies and the **Protected Office** and **Beacon Monikers** to identify protected Office files in an unexpected location or a non-Data Guardian Device that tries to access a protected Office document. See [Protected Office Document or Basic File Protection audit_events](#) or [Map visualization](#).

**Query example for BitLocker Manager report**

1. In Columns, select options.
2. Enter text in *Search* to perform a quick search on **Registered User**.
3. For additional filtering, select More... and then select one or more options. Additional text fields allow you to limit the text search to that column:
   - Registered User - Enter text to search specifically on that column.
   - BitLocker Enabled or TPM Enabled - Boolean search specifically on those columns.
   - Disk Status and Logical Disk Status - Enumerator searches specifically on those columns.

Export File

Export to Excel or a .csv file.

Add Schedule

To add an email schedule for a report:

1. In the left pane of the Management Console, click Reporting > Manage Reports.
2. In Columns, click a report name then click Schedule.
3. In Schedules, click Add Schedule.
4. In Add Schedule, set the following parameters:
   - Email - add a single or multiple addresses separated by commas
   - Schedule - select one of the following:
     - Every Day
     - Days of Week - select a specific weekday or multiple weekdays
     - Day of Month - select a day of the month
   - Time - select a time of day
   - Locale - select a language
5. Click Save.

Compliance Reporter

Compliance Reporter has its own help system. When Compliance Reporter launches, click the Help link on the top menu.

To launch Compliance Reporter:

1. In the left pane of the Management Console, click Compliance Reporter.
2. When Compliance Reporter launches, log in with superadmin credentials or reporting credentials.
Data Guardian Audit Events

Data Guardian audit event logs maintain an audit trail of file activity for Windows, Mac, mobile devices, and the web portal. By alternating between a map visualization and multiple filter options, you can access audit data in various ways, from a global overview to specific geolocations or audit data on a specific file or a specific user. This audit data offers the potential to visually identify data security breaches or preliminary security risks.

To view audit events, select Reporting > Audit Events. The Audit Events page contains the map visualization and columns for filtering. For tips on getting started, see Get Started with Data Guardian Audit Events.

Map visualization

In Populations > Enterprise > Global Settings, if you enable the Data Guardian Geo Location Audit Data policy and have the operating system's geolocation API, audit events that are sent to the Dell Server include the geolocation data (latitude and longitude) of each device. A map visualization of audit events can identify device locations that might indicate significant location changes or unexpected/questionable locations for devices within an organization. The geolocation is checked periodically, not each time an event is recorded. See Examples of Map Visualization and Column Filters.

If the policy for geolocation is disabled, no geolocation data is contained in the audit events.

The map displays the following:

- Marker cluster - A numeric value represents audit events within a similar area. Hover over the marker cluster to view an outline of the determined area. Click a marker cluster to zoom to the audit event markers within that cluster. Continue to click marker clusters until blue markers.

- Blue marker - Represents the location of a single audit event.
  - Click a marker to list the device, file, user, and timestamp for that marker's audit event.
  - The audit event can be a combination of the device and user that caused the audit event, for example: One device or user accessed one file. Multiple devices or users accessed one file, and the time stamp indicates the user who last accessed the file. One user accessed numerous files.

- Mapping points of interest and points visible - Scroll to the bottom right of the columns to display the total number of items in the column. The map displays only files that have geolocation data (latitude and longitude). If a column lists 1000 files, but some lack geolocation data, the map displays only the points with geolocation data.
  - For performance, the map limits the display to the first 2000 audit events that have latitude/longitude points in the table. It also varies depending on the filters you set.
  - Drill into a marker cluster to list the total points of interest and visible points.

Note: Files that lack geolocation data and display only in the columns still provide some information for auditing.

- Show only visible check box - If you click a marker cluster, the map only displays the area for that cluster, but the columns list all audit events in the original query. Select the check box on the lower right for the columns to only list audit events for those visible map points. As you continue to drill down, the columns only list the events for the visible map points. Clear the check box to return to the global view.

Audit Event Options and Filters

Use these options to determine the type and amount of audit event data to display.
• **Moniker** - By default, information displays for all monikers. Select one or more check boxes to display specific monikers. Click **Clear selected items** to display all.
  - Cloud Encryption - applies to:
    - Cloud Encryption (Mac, mobile and web portal; Windows Data Guardian v2.3 and earlier)
    - **Cloud Access Security Broker** (CASB) (web portal 2.9 and higher)
    - Basic File Protection (web portal 2.9 and higher with CASB, when a .xen file event is created)
  - Protected Office (Windows, Mac, mobile, and web portal) - also applies to **Cloud Access Security Broker**
  - **System** - Populates the user logged into or logged out of the device that has Data Guardian installed.
  - **Content Based Protection** - previously **Data Classification** (Windows)
  - **Protected Email** (Windows) - Relates to files other than protected Office documents.
  - **Share** (Windows) - Lists events when a user shares one or more files or attaches an encrypted file to an email.
  - **Beacon** - (protected Office documents) Indicates a device without Data Guardian installed that tried to access a protected file. These audit events may have limited data. For example, the location where the file was accessed but without the name of the user of the device.
  - **Time stamp** - Select the amount of past time for audit events to display - 1, 7, 14, 30, 60, or 90 days.
  - **More** - If you set filters and create a query, you can select the filter options in More to modify the query. As you select an option, it displays as a menu. Some actions apply to Windows, Mac, and mobile devices. Some are specific to one or more.
    - **Action** - The default is **All**. Select one or more check boxes to display specific actions associated with the payload file. See **Action** and the tables below for details and to determine the operating system.
    - **Cloud Action** - The default is **All**. Select one or more check boxes to display the reason for an Action. See **Cloud_Encryption_audit events** and the tables below for details and to determine the operating system.
    - **Data Guardian Action** - The default is **All**. Select one or more check boxes to display the reason for an Action. See **Protected_Office_Document_or_Basic_File_Protection_audit_events** and the tables below for details and to determine the operating system.
    - **Net Action** - (Windows and Data Guardian v2.7 and earlier)
  - **Grouping** - Allows you to select one option. The default is **None**. For example:
    - **Moniker** - Groups by moniker if you have more than one selected.
    - **Device or User** - Allows you to determine the activity of specific devices or users.
    - **File Name, File Path or File Key ID** - With device and user columns added, allows you to see which users or devices accessed a file.


- **Columns** - Filter the amount of data by selecting one or multiple columns to display. If you clear all column check boxes, audit events are listed for all endpoints and all users. Some filters apply to all monikers and some to specific monikers. For a description of column filters, see [Options in the Columns menu](#).

- **Search** - Hover to view columns for performing a search (device, user, file name, and file key ID), then enter specific text for those columns. Use a wildcard (*) to search on .docx, .pptx, .xlsx, .docm, .pptm, .xlsm, or .pdf.

- **Export File** - Export to Excel or a .csv file.

### Options in the Columns Menu

Options can apply to all monikers or to a specific moniker. Policies must be enabled for audit data to display.

Search icons in the columns - If you click next to an item in the device, user, file name, or key ID columns, it copies the cell content to Search and executes a search on that content. You can then select Action or IP address to do additional filtering.

### Column options for all audit events

<table>
<thead>
<tr>
<th>Audit Event - Column options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Moniker</strong> - Select one or more.</td>
<td>Category of the audit event:</td>
</tr>
<tr>
<td>- Cloud Encryption (mobile and web portal; Windows Data Guardian v2.3 and earlier; Mac; web portal for CASB; Basic File Protection)</td>
<td></td>
</tr>
<tr>
<td>- Protected Office (Windows, Mac, mobile, web portal, CASB)</td>
<td></td>
</tr>
<tr>
<td>- System (protected Office documents and Windows)</td>
<td></td>
</tr>
<tr>
<td>- Content Based Protection - previously Data Classification (Windows)</td>
<td></td>
</tr>
<tr>
<td>- Protected Email (Windows)</td>
<td></td>
</tr>
<tr>
<td>- Share (Windows)</td>
<td></td>
</tr>
<tr>
<td>- Beacon (protected Office documents)</td>
<td></td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>The hostname of the device where the event occurred.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>User associated with the event. Typically, this is the email address of the activated user. See also <a href="#">Logged In User</a>.</td>
</tr>
<tr>
<td><strong>Logged In User</strong></td>
<td>For manual activations or external users, the login name and email address used to activate may differ. If you do not recognize the user name, open the log files to view the logged-in user name.</td>
</tr>
<tr>
<td>- In the log file for Protected Office, information displays as sl_protected_file.</td>
<td></td>
</tr>
<tr>
<td>- In the log file for Cloud Encryption, information displays as sl_xen_file. Applies to Mac or mobile. Also applies to Windows Data Guardian v2.3 and earlier.</td>
<td></td>
</tr>
<tr>
<td><strong>Timestamp</strong></td>
<td>Date and time when the event occurred.</td>
</tr>
<tr>
<td><strong>Created</strong></td>
<td>Date and time when the entry was created. View this if a delay occurs.</td>
</tr>
<tr>
<td><strong>Column options related to payload data:</strong></td>
<td>Data for an audit event's moniker or parameters.</td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td>To search for a specific file, use the file key ID.</td>
</tr>
<tr>
<td><strong>File Path</strong></td>
<td>Note: When both .xen and protected Office files exist in Mac or mobile or Windows (v2.3 and earlier), parameters may differ for each audit event but are the same within the event. For example, the data may differ for sl_xen_file and sl_protected_file, but the data for each Cloud Encryption .xen file event is the same.</td>
</tr>
<tr>
<td><strong>File Key ID</strong></td>
<td>Note: For web portal and CASB, no File Path exists.</td>
</tr>
<tr>
<td><strong>File Size</strong></td>
<td>Indicates whether the client is internal or external. For Windows and Mac, the only option is internal.</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>The action associated with the payload file. See <a href="#">Protected Office Document or Basic File Protection audit events</a>. For Mac or mobile, see also <a href="#">Cloud Encryption audit events</a>.</td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>For internal Dell use only.</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>For internal Dell use only. (Windows and Mac)</td>
</tr>
</tbody>
</table>
**Column options for Protected Office only**

<table>
<thead>
<tr>
<th>Audit Event - Column options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Guardian Action</td>
<td>If a service acts on a protected Office file, for example, modifying or deleting a file, the Data Guardian Action column lists the reason. See <a href="#">Protected_Office_Document_or_Basic_File_Protection_audit_events</a>.</td>
</tr>
<tr>
<td>Column options related to Embargo:</td>
<td>From - The time that an external user can start viewing a protected file. To - The time that an external user can no longer view a protected file.</td>
</tr>
<tr>
<td>From</td>
<td></td>
</tr>
<tr>
<td>To</td>
<td></td>
</tr>
<tr>
<td>See also <a href="#">Column_options_for_all_audit_events</a>.</td>
<td></td>
</tr>
</tbody>
</table>

**Protected Office Document or Basic File Protection audit events (Windows, Mac, mobile, web portal, CASB)**

This table lists audit events that apply to Office documents or other files entered in Basic File Protection:

- For Windows and Mac, audit events apply to Opt-in or Force Protected modes.
- Mobile has Opt-in mode only.
- Protected Office document audit events do not contain the Cloud Name or Cloud Action events since protected Office documents can move to a cloud storage provider outside of the bounds of Data Guardian. Those display for XEN audit events under [Cloud_Encryption](#).
- Basic File Protection events for Windows (excluding any .xen file extensions)

<table>
<thead>
<tr>
<th>Actions for audit events</th>
<th>Data Guardian Action and Description</th>
<th>Windows</th>
<th>Mac</th>
<th>Mobile device</th>
<th>Web portal</th>
<th>CASB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>New Opt-in mode - logs an event when a user selects Save As Protected and an Office document is protected. Force-Protected mode - logs events when Data Guardian performs a sweep and creates protected Office documents.</td>
<td>● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accessed</td>
<td>Open - A user opened a protected Office document.</td>
<td>● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modified</td>
<td>Swept - For Windows, when Force Protected is enabled, provides data about files that were swept and converted from unprotected to protected Office.</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modified</td>
<td>Updated - Summary of the number of times a file was changed since the last audit data transmission.</td>
<td>● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modified (Data Guardian v2.7 and earlier)</td>
<td>Watermarked - User printed a file or exported a file with a watermark.</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accessed (Windows only with Data Guardian)</td>
<td>Block Copy - Indicates a file where a user tried to copy from a protected Office.</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

106
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessed (Windows only with Data Guardian v2.7 and earlier)</td>
<td>Blocked Print</td>
<td>Indicates a file where a user tried to print a protected Office document and was blocked.</td>
</tr>
<tr>
<td>Accessed</td>
<td>Detected tampering</td>
<td>Tampering was detected in the .xen file portion of a protected Office document. This audit event alerts you to the tampering, but the .xen file cannot be repaired. For the web portal, tampering is detected on protected Office documents but not .xen files.</td>
</tr>
<tr>
<td>Modified</td>
<td>Repaired tampering</td>
<td>Tampering was detected in the wrapper of the protected Office document, which contains the cover page that opens in the cloud or on a device that does not have Data Guardian installed. Data Guardian repaired the wrapper or cover page.</td>
</tr>
<tr>
<td>Attempt Access</td>
<td>Request Access</td>
<td>An external user requested a key for a file to which they do not have access or the access time has expired. Audit data includes user account, time stamp, filename, key ID, and geolocation if enabled by policy.</td>
</tr>
<tr>
<td>Modified</td>
<td>Unprotected: (Opt-in mode)</td>
<td>A Mac user unprotected a protected Office file or a Basic File Protected one-time decrypt. Windows - Opt-in mode only, for example, a protected Office document is open and the user selects Save As and unprotected it.</td>
</tr>
<tr>
<td>Deleted (Mac only)</td>
<td>Deleted</td>
<td>The user deleted a .xen file from the cloud sync folder.</td>
</tr>
<tr>
<td>Accessed (Mobile only)</td>
<td>Geo Blocked</td>
<td>A user outside the geofence tried to access a protected document, and the attempt was blocked.</td>
</tr>
<tr>
<td>Open (Windows only)</td>
<td>Used with Email Action</td>
<td></td>
</tr>
<tr>
<td>Sent (Windows only)</td>
<td>Used with Email Action</td>
<td></td>
</tr>
<tr>
<td>Reply (Windows only)</td>
<td>Used with Email Action</td>
<td></td>
</tr>
<tr>
<td>Forward (Windows only)</td>
<td>Used with Email Action</td>
<td></td>
</tr>
</tbody>
</table>

**Column options for System (protected Office documents and Windows)**

The following actions relate to the computer, so they have no corresponding Data Guardian action.

**Note:** The grey options apply to Windows and Data Guardian v2.7 and earlier.
### Audit Event - Column options

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>If a user logged in and did a fast user switch, for example, logged in and then rebooted.</td>
</tr>
<tr>
<td>Logout</td>
<td>User logged out of a session.</td>
</tr>
<tr>
<td>Blocked PrintScreen (Windows only and Data Guardian v2.7 and earlier)</td>
<td>Indicates a file where a user tried to capture a screen while a protected Office document was open and is blocked.</td>
</tr>
<tr>
<td>Blocked Process (Windows only and Data Guardian v2.7 and earlier)</td>
<td>When policy blocks a specified process executable, indicates a file where a user tried to run that process executable.</td>
</tr>
<tr>
<td>Process Name (Windows only and Data Guardian v2.7 and earlier)</td>
<td>The name of the process that was blocked, for example, Snipping Tool.</td>
</tr>
<tr>
<td>Process Disposition (Windows only and Data Guardian v2.7 and earlier)</td>
<td>Indicates whether the process has exited or has been terminated.</td>
</tr>
</tbody>
</table>

### Column options for Beacon only (protected Office documents)

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Column options related to geolocation: IP Address</td>
<td>IP Address - When a Beacon event comes in and the Beacon server can determine the location of the event, it lists the IP address.</td>
</tr>
<tr>
<td>Routable</td>
<td>Routable - True or False</td>
</tr>
<tr>
<td>Geo Type</td>
<td>If True, geolocation data exists for that IP address and identifies the device's latitude and longitude based on each operating system’s APIs.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Note: If the Routable column lists True, but no geolocation data displays, an error occurred.</td>
</tr>
<tr>
<td>Longitude</td>
<td>If False, the IP address is non-routable.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Latitude and longitude - The data visualization is based on these coordinates rather than a street address. Usually, the map visualization displays the location of the device. If a user accesses the computer remotely and neither GPS or WiFi is available, the map visualization may display the location based on the remote computer's VPN IP address. The column lists the coordinates as plus (+) or minus (-), correlating to North, South, East, or West.</td>
</tr>
<tr>
<td>Routable</td>
<td>Geo Type - Typically, this is Point.</td>
</tr>
<tr>
<td>Geo Type</td>
<td>Geolocation for audit events is supported on Windows 8.1 and higher</td>
</tr>
</tbody>
</table>

### Column options for Cloud Encryption only (mobile and web portal; Windows Data Guardian v2.3 and earlier; Mac)

Greyed out options indicate earlier versions of Windows and Mac Data Guardian. See also [Column options for all audit events](#).

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Cloud storage provider. (Used for earlier versions.)</td>
</tr>
<tr>
<td>Cloud Name</td>
<td>Cloud storage provider name. See also File_Name.</td>
</tr>
<tr>
<td>Cloud Action</td>
<td>If a service acts on a .xen file, the Cloud Action column lists the reason. See Cloud_Encryption_audit events.</td>
</tr>
<tr>
<td>Folder Path</td>
<td>Application - App indicates this is part of the Cloud Encryption application.</td>
</tr>
<tr>
<td>Folder Protection</td>
<td>Column options related to folder management (Windows only with Data Guardian v2.3 and earlier):</td>
</tr>
</tbody>
</table>

If the Folder Management Enabled policy in Data Guardian > Cloud Encryption is enabled for an endpoint, a user can select the Data Guardian icon in the endpoint's notification area, select Manage Folders, and manually protect or unprotect a sync client folder. Typically, this policy is enabled for a manager on a temporary basis.

This audit event allows you to monitor overrides to protected folders and investigate if files that need...
Cloud Encryption audit events (mobile and web portal; Windows Data Guardian v2.3 and earlier; Mac)

This table lists audit events that occur for files or folders stored in the cloud sync client folders. Events may differ slightly for Mac and mobile devices. Greyed out options indicate earlier versions of Windows and Mac Data Guardian.

<table>
<thead>
<tr>
<th>Actions for audit events</th>
<th>Cloud Action and Description</th>
<th>Windows 2.7 and earlier</th>
<th>Mac</th>
<th>Mobile device</th>
<th>Web portal</th>
<th>CASB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Encrypt</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>A new .xen file has been uploaded and encrypted.</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Modified</td>
<td>Encrypt</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>An existing .xen file has been modified in the cloud and encrypted.</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Unprotected</td>
<td>Decrypt</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Data Guardian decrypted a .xen file.</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Deleted</td>
<td>Deleted</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>A user deleted a .xen file from the cloud sync folder or cloud storage provider.</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Accessed</td>
<td>Decrypt</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>A user accessed a .xen file, and Data Guardian decrypted it.</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>N/A</td>
<td>Upload (Windows 2.7 and earlier; Mac)</td>
<td>Lists the folder path and whether the folder was protected.</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Column options for Cloud Access Security Broker (CASB) (web portal v2.9 and higher)

If an enterprise uses Data Guardian with Netskope, a Cloud Access Security Broker (CASB), to monitor cloud storage providers, you must select these monikers to run a report:

- Protected Office
- Cloud Encryption

The Device column lists CASB.

For actions, see the CASB column in Protected_Office_Document_or_Basic_File_Protection_audit_events and Cloud_Encryption_audit_events.

See also Column_options_for_all_audit_events.

Column options for Content Based Protection only (Windows)

Content Based Protection applies to Windows' Opt-in mode.
Policies: Protected Office Documents, Content Based Protection, Content Based Protection Rules. To include emails that must comply with a Content Based Protection rule, also enable Email Encryption via Outlook.

For a report, select from these column options.

<table>
<thead>
<tr>
<th>Audit Event - Column options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Rule</td>
<td>The content rule category, such as Public, Internal Use, or Restricted.</td>
</tr>
<tr>
<td>Content Rule File</td>
<td>The name of the file that was audited or encrypted based on a content rule.</td>
</tr>
<tr>
<td>Content Rule Path</td>
<td>The location of the file.</td>
</tr>
<tr>
<td>Content Rule Action</td>
<td>Based on the content rule selected, these actions can display:</td>
</tr>
<tr>
<td></td>
<td>• Audit - If a rule in the Categories list has a priority of two and higher, audit events are created.</td>
</tr>
<tr>
<td></td>
<td>• Encrypt - If the Encrypt check box is selected for a rule in the Categories list, the file was encrypted based on the rules set.</td>
</tr>
<tr>
<td></td>
<td>Public rule has no actions.</td>
</tr>
<tr>
<td>Content Rule Triggers</td>
<td>The rules that cause the actions to occur.</td>
</tr>
</tbody>
</table>

Column options for Protected Email only (Windows)

<table>
<thead>
<tr>
<th>Audit Event - Column options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Keyid</td>
<td>The Key ID used to protect the email.</td>
</tr>
<tr>
<td>Email Subject</td>
<td>Subject line from the email.</td>
</tr>
<tr>
<td>Email From</td>
<td>The email address of the person who sent the email.</td>
</tr>
<tr>
<td>Email To</td>
<td>Email addresses of recipients.</td>
</tr>
<tr>
<td>Email Cc</td>
<td>Email addresses of those copied.</td>
</tr>
<tr>
<td>Email Bcc</td>
<td>Email addresses of those blind-copied.</td>
</tr>
<tr>
<td>Email Attachment</td>
<td>Names of attachments added to the email.</td>
</tr>
<tr>
<td>Email Action</td>
<td>What the user did with the action. In Protected_Office_Document_or_Basic_File_Protection_audit_events, see Opened, Sent, Reply, and Forwarded.</td>
</tr>
</tbody>
</table>

Column options for Share only (Windows)

In Column options for all audit events, see User, Logged in User, Client Type, Action. You can also select File, Email, Group, and Status.

Actions for Share are listed here.

<table>
<thead>
<tr>
<th>Actions for Share audit events</th>
<th>Description</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>A protected file or email was shared with a user or a group. This applies to pre-share.</td>
<td>●</td>
</tr>
<tr>
<td>Remove</td>
<td>Data Guardian Access to a protected file or email has been revoked from a user or a group.</td>
<td>●</td>
</tr>
<tr>
<td>Request</td>
<td>A user had to request access to a protected file or email because they did not have access.</td>
<td>●</td>
</tr>
</tbody>
</table>

Examples of Map Visualization and Column Filters
You can alternate between drilling in at the map level and drilling in at the filter and search level. For example:

- Endpoint or endpoint group - If geolocation is enabled, the map displays the location of the events for each endpoint's .xen and protected Office files. If the map indicates protected files in an unexpected location, you can use the audit data to identify who modified the file. If several users modified the file, you can filter the time stamp column to determine the last person who modified it.

- User - You can audit a users' file activities. For example, in Columns, if you select Action, the protected Office files for that column can list Created or Modified. If you also select Data Guardian Action, the column lists the reason for a user modifying files, such as Updated or Swept. For information on Action and Data Guardian Action, see Options in the Columns menu, Cloud Encryption audit events, and Protected Office Document or Basic File Protection audit events.

Example of drilling in at the map level

1. In the global view, drill in to a marker cluster and select a blue marker.
2. Select the Show only visible check box for the columns to list only the files for that audit event.
3. Click next to a device, user, file name, or key ID. For example, click next to a user name, then click next to a file name to zoom to the map location of the specified user when a specified file was accessed.
4. Clear Search and press Enter to return to the global map view.

Return to Data Guardian policies.

Get Started with Data Guardian Audit Events

Before you begin, navigate to Populations > Global > Settings and select the Data Guardian Audit Data Enabled policy for these policy groups:

- Audit Control Policies (for Windows or Mac)
- Web Portal Audit Policies
- Mobile Audit Control Policies

In the Management Console > Reporting > Audit Events, use these examples to get started.

For detailed information about column options, see Data Guardian and Audit Events.

Audit Protected Office Documents

To audit protected Office documents only:

1. In Moniker, select Protected Office.
3. In Columns, select Device, User, Timestamp, File Name, and File KeyID.
4. Optionally, in Grouping, select one item like Device or User to sort.
5. Select Export File > Excel or CSV to view the data for the Action and Data Guardian Action columns. For more information, see Protected_Office_Document_audit_events. Optionally, you can export the audit events to a SIEM server.
6. To identify issues, return to the Management Console, click Data Guardian Action, and select:
• **Block Copy** (for Windows) - indicates a Windows user tried to copy from a protected Office document and was blocked.

• **Geo Blocked** (for Mobile) - indicates a mobile user outside a geofence tried to access a protected document and the attempt was blocked.

If these options display in the Data Guardian Action column, click next to that user or device. In **Data Guardian Action**, click **Clear selected items** and view all the actions by that user or device to determine a potential issue. For more information, see [Protected_Office_Document_audit_events](#).

7. To identify issues, select **Data Guardian Action** and select the following:

   • Detected tampering
   
   • Repaired tampering

   If these options display, determine any potential issues.

8. For Windows, in **Moniker**, select **System**. In **Action**, select **Login** and **Logout** to identify a user who logged into the device that has Data Guardian installed.

9. Analyze the data in the Management Console or select **Export File > Excel** or **CSV** where you can sort the data. Optionally, you can export the audit events to a SIEM server.

### Audit events related to external users

In addition to the steps above:

1. In **Columns**, select:

   • **Client Type** - to indicate internal or external users.
   
   • **From** and **To** - to audit embargo and external users.
   
   • **Request Access** - an external user requested access to encryption keys from an internal user.

2. Analyze the data in the Management Console or select **Export File > Excel** or **CSV** where you can sort the data. Optionally, you can export the audit events to a SIEM server.

### Map visualization

You can use this to identify protected Office files in an unexpected location or a non-Data Guardian Device that tries to access a protected Office document.

For map data to display, you must enable policy. See **Global > Settings** and select the **Data Guardian Geo Location Audit Data** policy from one or more of these:

• **Audit Control Policies**

• **Web Portal Audit Policies**

• **Mobile Audit Control Policies**

For Beacon events, see the advanced settings for **Data Guardian** and select the **Enable Callback Beacon** policy from one or more of these policy groups:

• **Protected Office**

• **Mobile Client**

• **Web Portal**
1. In Moniker, select **Protected Office** and **Beacon**.

2. In the global map view, drill in to a marker cluster in an unexpected location and select a blue marker.

3. Select the **Show only visible** check box for the columns to list only the files for that audit event.

4. Click next to a Device, User, File Name, or File KeyID.

   For example, click next to a user name, then click next to a file name to zoom to the map location of the specified user when a specified file was accessed.

5. Analyze the data in the Management Console or click **Export File > Excel** or **CSV** where you can sort the data. Optionally, you can export the audit events to a SIEM server.

6. Clear **Search** and press **Enter** to return to the global map view.

**Audit Cloud Encryption (Mac or mobile)**

To audit protected .xen files only:

1. In **Moniker**, select **Cloud Encryption**.

2. In **More**, select **Action** and **Cloud Action**.


**Default Monikers and Columns**

If you leave the defaults, all monikers and columns display. Select one item from Grouping to sort monikers or column options. Select options to minimize the data that displays.

**EU General Data Protection Regulation (GDPR)**

For privacy laws in Europe, you can disable audit events. See **Enterprise > Global Settings > Settings > Web Portal Audit Policies**.

**View Audit Events (Geolocation)**

Click **Audit Events** in the left pane to view geographic map points of file events on computers and devices running Data Guardian.

For a list of audit event types, see **Data Guardian and Audit Events**.

For information about exporting audit events to a SIEM server, see **Export Events to SIEM Server**.

Map points are color coded to indicate the number of audit events in a location:

<table>
<thead>
<tr>
<th>Map point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Map point 1" /></td>
<td>Map point represents a single event</td>
</tr>
<tr>
<td><img src="image" alt="Map point 7" /></td>
<td>Fewer than 10 events</td>
</tr>
<tr>
<td><img src="image" alt="Map point 10" /></td>
<td>More than 10 events</td>
</tr>
</tbody>
</table>
More than 100 events

Use the + and - icons in the upper left corner of the map to zoom in or out. Drag the map to view different areas of the map.

To view individual events for map points representing multiple events, use the + icon in the upper left corner to zoom in on the map point. Click an individual map point within the group of points to view the event.

Event Data

Event data displays below the map about the events represented on the map. Narrow the amount of data displayed by using the + icon in the upper left corner of the map to zoom in. Expand the amount of data displayed by using the - icon in the upper left corner of the map to zoom out.

Filter the event data with the following fields, which are immediately below the map:

- **Event Type** - Data Guardian Cloud Encryption, Protected Office, or Beacon
- **Timestamp** - Event date and time
- **Device** - Device type and identifier (hostname, serial number, IMEI/MEID, CDN)
- **User** - User name in UPN format
- **File Key ID** - GUID that identifies the key used to protect the file
- **FileName** - File name with extension
- **Action** - File action that triggered the event
- **Data Guardian Action** - Action taken by Data Guardian, based on policy and the file action that triggered the event

Select columns to display from the **Columns** list.

Export Events to a SIEM/Syslog Server
Integrating with a SIEM/syslog server allows administrators to run customized analytics on threat and audit data within their environments. The Dell Server supports the export of Advanced Threat Prevention and Data Guardian events.

To export audit events to a syslog server or to a local file:

1. In the left pane, click **Management > Services Management**.
2. Select the **Events Management** tab.
3. Select the appropriate option(s):
   - **Export to Local File** allows export of audit events to a file. Enter the location in which to store the file. This option also provides a backup of the audit events database.
   - **Export to Syslog** allows specification of the syslog server to which to export the file. If TCP protocol is not selected, select it.
4. Click **Save Preferences**.

### Export Audit Events with TLS/SSL over TCP

To use TLS/SSL, the syslog server must be configured to listen for TLS/SSL messages. The root certificate used for the syslog server configuration must be added to the Dell Server Java keystore.

The following example shows necessary configurations for a Splunk server with default certificates. Configurations are specific to individual environments. Property values vary when using non-default certificates.

1. Configure the Splunk server to use the Splunk server certificate and root certificate to listen on TCP for TLS/SSL messages:

   ```
   $SPLUNK_HOME\etc\system\local\inputs.conf
   [tcp-ssl:<port number>]
   disabled = 0
   [SSL]
   serverCert = $SPLUNK_HOME\etc\auth\server.pem
   sslPassword = <password>
   requireClientCert = false
   
   $SPLUNK_HOME\etc\system\local\server.conf
   [sslConfig]
   sslRootCAPath = $SPLUNK_HOME\etc\auth\cacert.pem
   sslPassword = <password>
   
   2. Restart the Splunk server.

   After the restart, **splunkd.log** will have entries similar to the following:

   ```
   07-10-2017 16:27:02.646 -0500 INFO  TcpInputConfig - IPv4 port 5540 is reserved for raw input (SSL)
   07-10-2017 16:27:02.646 -0500 INFO  TcpInputConfig - IPv4 port 5540 will negotiate new-s2s protocol
   ```
Navigate the Dell Server

3. Configure the Dell Server to communicate with the Splunk server and export audit events.

Use the keytool command to add the Splunk server's root certificate (cacert.pem) to the Dell Server operating system Java keystore. The certificate is added to the operating system Java keystore and not to the Dell Server application Java keystore.

```
keytool -keystore <keystore_location> -alias <alias-name> -importcert -file <certificate_file>
```

Add the Splunk server's root certificate (cacert.pem) to the Java keystore, which in Windows is usually located at: `C:\Program Files\Dell\Java Runtime\jre1.8\lib\security\cacerts`

4. Modify the Dell Server database to change the SSL value from `false` to `true`:

In the database, navigate to the information table, SIEM-specific support configuration.

Change the "SSL":"false" value to "SSL":"true" – for example:

```
{"eventsExport":{"exportToLocalFile":{"enabled":"false","fileLocation":"./logs/siem/audit-export.log"},"exportToSyslog":{"enabled":"true","protocol":"TCP","SSL":"true","host":"yourDellServer.yourdomain.com","port":"5540"}}}
```

Advanced Threat Prevention Syslog Event Types

Following are event types that are supported with the Syslog/SIEM Advanced Threats option.

**Application Control**

This option is visible when the Application Control feature is enabled. Application Control events represent actions occurring when the device is in Application Control mode. Selecting this option sends a message to the Syslog server whenever an attempt is made to modify or copy an executable file, or when an attempt is made to execute a file from an external device or network location.

Example Message for Deny PE File Change:

```
CylancePROTECT: Event Type: AppControl, Event Name: pechange, Device Name: WIN-7entSh64, IP Address: (192.168.119.128), Action: PFileChange, Action Type: Deny, File Path: C:\Users\admin\AppData\Local\Temp\MyInstaller.exe, SHA256: 64d4dc02d96673eca9050fe7281044fd838e3cfe80d727e93d835a7e9845edaa
```
Example Message for Deny Execution from External Drive:

```plaintext
CylancePROTECT: Event Type: AppControl, Event Name: executionFromexternalDrives, Device Name: WIN-7entSh64, IP Address: (192.168.119.128), Action: PFileChange, Action Type: Allow, File Path: \shared\psexec.exe, SHA256: F8DBABDF0A3068130C277CE49C60E35C029FF29D9E3C74C362521F3FB02670D5
```

Devices

Select this option to send device events to the Syslog server.

- When a new device is registered, two messages for this event are received: Registration and SystemSecurity.

  Example Message for Device Registered Event:

  ```plaintext
  Event Type: Device, Event Name: Registration, Device Name: WIN-5SNATVQHBUU
  Event Type: Device, Event Name: SystemSecurity, Device Name: WIN-5SNATVQHBUU, Agent Version: 1.1.1270.58, IP Address: (10.3.0.154), MAC Address: (005056881877), Logged On Users: (WIN-5SNATVQHBUU\Administrator), OS: Microsoft Windows Server 2008 R2 Standard Service Pack 1 x64 6.1.7601
  ```

- When a device is removed.

  Example Message for Device Removed Event:

  ```plaintext
  Event Type: Device, Event Name: Device Removed, Device Names: (\staging\cylance)
  ```

- When a device's policy or logging level has changed.

  Example Message for Device Updated Event:

  ```plaintext
  Event Type: Device, Event Name: Device Updated, Device Message: Renamed: 'WIN-5SNATVQHBUU' to 'WIN-2008R2-IRV1'; Policy Changed: 'Default' to 'IRVPolicy1';
  ```

Memory Protection

Selecting this option logs any Memory Exploit Attempts that might be considered an attack from any of the Tenant's devices to the Syslog server.

There are four types of Memory Exploit actions:

- **None**: Allowed because no policy has been defined for this violation.
- **Allowed**: Allowed by policy.
- **Blocked**: Blocked from running by policy.
- **Terminated**: Process has been terminated.

Example Message of Memory Protection Event:

Cyl CylancePROTECT: Event Type: ExploitAttempt, Event Name: blocked, Device Name: WIN-7entSh64, IP Address: (192.168.119.128), Action: Blocked, Process ID: 3804, Process Name: C:\AttackTest64.exe, User Name: admin, Violation Type: LSASS Read

**Script Control**

Selecting this option logs any newly found scripts that have been blocked or have triggered an alert to the Syslog server.

Syslog Script Control events contain the following properties:

- **Alert**: The script is allowed to run. A script control event is sent to the Dell Server.
- **Block**: The script is not allowed to run. A script control event is sent to the Dell Server.

Example Message of Script Control

CylancePROTECT - - - Event Type: ScriptControl, Event Name: Blocked, Device Name: Fake_Device, File Path: d:\windows\system32\windowspowershell\v2.1\newlyMade.vbs, Interpreter: active, Interpreter Version: 6.1.7600.16385 (win7_rtm.090713-1255)

**Threats**

Select this option to log any newly found threats or changes observed for any existing threat, to the Syslog server. Changes include a threat being Removed, Quarantined, Waived, or Executed.

There are five types of Threat Events:

- **threat_found**: A new threat has been found in an Unsafe status.
- **threat_removed**: An existing threat has been Removed.
- **threat_quarantined**: A new threat has been found in the Quarantine status.
- **threat_waived**: A new threat has been found in the Waived status.
- **threat_changed**: The behavior of an existing threat has changed (examples: Score, Quarantine Status, Running Status).

Example Message of Threat Event:

Event Type: Threat, Event Name: threat_found, Device Name: User1, IP Address: (10.10.10.10), File Name: virusshare_00fbc4cc4b42774b50a9f71074b79bd9, Path: c:\ruby\host_automation\test\data\test_files, SHA256: 1EBF3B86A17E023AAB380CB24038535651D0786E1FCC6D42E137FB2AD7D510B, Status: Unsafe, Cylance Score: 100, Found Date: 6/1/2015 10:57:42 PM, File Type: Executable, Is Running: False, Auto Run: False, Detected By: FileWatcher

**Threat Classifications**
Hundreds of threats are classified each day as either Malware or Potentially Unwanted Programs (PUPs). If this option is selected, you subscribe to be notified when these events occur.

Example Message of Threat Classification:

```
Event Type: ThreatClassification, Event Name: ResearchSaved, Threat Class: Malware, Threat Subclass: Worm, SHA256:
1218493137321C1D1F897B8C258EF17CD08EB9C99984B4D08B51EAC8F9794F65
```

**Security Information and Event Management (SIEM)**

Specifies the type of Syslog server or SIEM that events are to be sent to.

**Protocol**

This must match what is configured on your Syslog server. The choices are UDP or TCP. UDP is generally not recommended as it does not guarantee message delivery. Dell recommends TCP (default).

**TLS/SSL**

Only available if the Protocol specified is TCP. TLS/SSL ensures the Syslog message is encrypted in transit from Advanced Threat Prevention to the Syslog server. Dell encourages customers to select this option. Ensure that the Syslog server is configured to listen for TLS/SSL messages. To use TLS/SSL, it is necessary to configure the Syslog server and import certificates. For more information, see [Export Audit Events with TLS/SSL over TCP](#).

**IP/Domain**

Specifies the IP address or fully-qualified domain name of the Syslog server that the customer has setup. Consult with your internal network experts to ensure firewall and domain settings are properly configured.

**Port**

Specifies the port number on the devices that the Syslog server listens for messages. It must be a number between 1 and 65535. Typical values are: 512 for UDP, 1235 or 1468 for TCP, and 6514 for Secured TCP (example: TCP with TLS/SSL enabled).

**Severity**

Specifies the severity of the messages that should display in the Syslog server. This is subjective, and it may be set to whatever level preferred. The value of severity does not change the messages that are forwarded to Syslog.

**Facility**

Specifies what type of application is logging the message. The default is Internal (or Syslog). This is used to categorize the messages when they are received by the Syslog server.

**Testing the Connection**

Click **Test Connection** to test the IP/Domain, Port and Protocol settings. If valid values are entered, after a couple of moments, a success confirmation displays.

**Advanced Threat Prevention Syslog IP Addresses**

Syslog server IP addresses to allow, by region:

- **US (includes my.cylance.com and my-vs2.cylance.com):**
  - 52.2.154.63
52.20.244.157
52.71.59.248
52.72.144.44
54.88.241.49

AU (my-au.cylance.com):
52.63.15.218
52.65.4.232

EU (my-vs0-euc1.cylance.com and my-vs1-euc1.cylance.com):
52.28.219.170
52.29.102.181
52.29.213.11

Note: This IP Address should remain static.
For the latest IP addresses for Syslog messages, contact Dell ProSupport.

Management

Commit Policies

Uncommitted policies display in a badge icon in the top left of the Management Console. Click the badge icon to navigate to Management > Commit.

To commit polices that have been modified and saved:

1. In the left pane, click Management > Commit.
2. In Comment, enter a description of the change.
   Best practice: add a comment about the changes that are committed.
3. Click Commit Policies.

A policy publication/commit occurs when an administrator clicks Commit Policies. The following information displays:

Pending Policy Changes - The number of policy changes ready to commit.
Date Committed - Date and time the policies were committed.
Changed by - User name of the administrator who performed the policy commit.
Comment - Any comments that were added when the polices were committed.
Version - The number of policy saves since the last policy commit plus the previous Version.

Log Analyzer

Log Analyzer gives you the power to search logs by message priority level, date and time periods, and occurrences of usernames and hosts.
To view or export logs:

1. In the left pane, click **Management > Log Analyzer**.
2. Select a Category.
   The Categories are Admin Actions, Shield for Server Events, Policy, Advanced Threat Events, System Logs, Whitelist, and Full Access List.
3. To narrow the results, select from these optional filters:
   - **Priority** - Choose DEBUG, INFO, WARN, ERROR, or FATAL. FATAL returns fewest entries; DEBUG returns the greatest number of entries.
   - **And more severe** - Select this option to include all areas of greater severity than the priority level you selected.
   - **Date Range** - Enter a Start Date and End Date to limit results to entries that occur between these dates. To insert dates into these fields, click the calendar icons to the right of the fields.
   - **Time Range** - If you entered a Date Range, further narrow the entries by entering a Start Time and End Time. To insert times into these fields, click the calendar icons to the right of the fields.
   - **Username and Host** - Enter a either a username or host or both.
4. Click **Search**.
5. To sort the results in ascending order by column, click the heading of the column to sort.
6. To export the results to an Excel or CSV file, pull down the **Export File** list and select **Excel** or **CSV**.
   Exported files can hold up to 100,000 records.

**Recovery**

**Recover Data - Encryption External Media Authentication Failure**

For the steps to perform a recovery on removable media when a user is no longer associated with your organization, see Encryption External Media Recovery for User Removed from Database.

Encryption External Media encrypts data on removable media, as defined by policy. There may be several conditions where access to encrypted data needs to be regained. In general, these scenarios fall into two categories:

- The Encryption External Media password is lost or forgotten
- The Encryption External Media software or encryption key material has been lost or corrupted on the device

If more than one Dell Server is part of a federation, to perform Encryption External Media Recovery across Dell Servers in the federation, see Enable Federated Key Recovery.

**Manual Authentication when Encryption External Media Password is Lost or Forgotten**

If a user has lost or forgotten a password, manual authentication is necessary.

1. The user is prompted for their password. Since the password is not available, the user clicks **I forgot**.
2. The user is given another opportunity to try again. If the user clicks **Yes - I forgot**, manual authentication begins (or the manual authentication begins upon the set number of retries allowed).
3. The user is instructed to contact their administrator and inform them that they need to manually recover Encryption External Media for Windows.

4. As a Dell administrator, log in to the Management Console.

5. In the left pane, click **Populations > Users**.

6. Enter a filter to search for the user. The wild card character is *. You can enter Common Name, Universal Principal Name, or sAMAccountName.

7. Click 📦. A user or list of users displays, based on your search filter.

8. Locate the appropriate user and click the **Endpoints** tab.

9. Locate the appropriate **Shielded** Endpoint.

10. Under **Actions**, click the **Recover** link.

**Tip:** Numbers are red and letters are blue.

11. Ask the user for the **Shield ID** and verify that it is correct or enter it into **Shield ID**. Shield IDs do not contain the letters B, O, Q, and S.

12. Ask the user for the 8, 16, or 32-character **Endpoint Code** (not case sensitive) and enter it into the appropriate field. Endpoint Codes contain only the letters A-F.

13. Ask the user for the **Key ID** and enter it into the appropriate field (if your organization allows non-domain user activation, the Key ID is required).

14. Click **Generate Access Code**. The Restore User Access page displays the directory user alias associated with the Encryption client, along with an access code.

15. Confirm to your satisfaction that the request is coming from the directory user alias shown.

   This is especially important if recovering media that may have been given to another user. Dell recommends that you set a help desk policy for how to handle requests from users other than those who originally copied the data.

16. Do **one** of the following:

   - To allow the user to access the endpoint, click **Activate**.
   - To not allow the user to access the endpoint, click **Cancel**.

17. If the requester is the device authorized user, ask the user to enter the Access Code (not case sensitive) on the endpoint and click **OK**. The Access Code policies of the user affect this process (for example, how many attempts the user has to enter the code correctly).

18. When the user successfully enters the Access Code, the Encryption client changes the **Current Shield State** policy to **Activate**, and the successfully entered Access Code is no longer valid. Instruct the user to click **OK** to close the dialog.

19. In the left pane, click **Management > Commit**.

20. Click **Commit Policies**.

Once manual authentication is successful, the user is directed to reset their password. Depending on how policies are set, one of the following three options are displayed. The user enters a new password and confirms it, then clicks **OK** or **Cancel**.

Depending on policies set, the user may be prompted to type this password when using this removable media in other computers.
If the policy is set to **block** all access to removable media until authenticated/encrypted and the user clicks Cancel, they cannot access any files on this removable storage.

If a user re-uses a password that has been used too recently, a dialog displays asking them to use a different password.

If a password does not meet the criteria set by policy, a dialog displays, outlining the password criteria.

If the policy gives **read-access** to removable storage until authenticated/encrypted and the user clicks Cancel, they can read/delete existing files on this removable media, but cannot edit/add files to this removable storage.

If a user re-uses a password that has been used too recently, a dialog displays asking them to use a different password.

If a password does not meet the criteria set by policy, a dialog displays, outlining the password criteria.

If the policy gives **full access** to removable media until authenticated/encrypted and the user clicks Cancel, they have full access to unencrypted files on this removable media, but cannot access encrypted files.

If a user re-uses a password that has been used too recently, a dialog displays asking them to use a different password.

If a password does not meet the criteria set by policy, a dialog displays, outlining the password criteria.

The user may now use the removable media as usual.

If manual authentication is **not** successful, the device is disabled according to policy, as follows:

- The policy could be set to wait (cooldown) between unsuccessful manual authentication attempts.

  or

- The policy may be set to delete the encryption key material and prevent any access to encrypted files on this removable media. In this case, the user need to contact an administrator again for instructions to re-enable access.

### Restore Lost Encryption Key Material

If encryption keys have been deleted on the removable media (because of failed manual authentication, accidentally deleting a necessary file, a change in policy), the encrypted data is inaccessible until an authorized user reinitializes the encryption key material.

A dialog displays, notifying the user that key material is missing. Click **Yes** to use the self-healing feature of Encryption External Media or click **No**.

If the policy **blocks** all access to removable media until encrypted and the user clicks **No**, they cannot access this removable media.

If the policy gives **read-access** to removable media until encrypted and the user clicks **No**, they have read-access to unencrypted data on this media, but no access to encrypted data.

If the policy gives **full access** to removable media, whether or not encrypted and the user clicks **No**, they have full access to unencrypted data on this media. They cannot access encrypted data.

Occasionally, based on policies set, encryption keys cannot be reinitialized on the computer that the removable media is inserted in. If policy permits, the user can insert the media into any Dell-encrypted
computer where the original user is logged in, to reinitialize the encryption keys. If policy does not permit this, it must be inserted into the originally encrypting computer, with the originally specified user name.

On rare occasions, when encryption key material is lost, the Encryption client cannot automatically locate the necessary information. Use the following process to recover encrypted data.

1. Attach the device to a Windows computer that is not running the Encryption client.
2. Copy all folders from the device onto the Windows computer.
3. Use WSScan to determine the DCID of the encrypted data.
4. Follow the process for recovering access to encrypted data on Windows computers. Use the DCID obtained from WSScan for the RecoveryID.

**Encryption External Media Recovery for User "Removed" from Database**

If a user is removed from Active Directory (such as an employee termination), when the Security Management Server gets the update from AD, the user is marked as "removed" in the database, so that they do not continue to get policy updates and endpoint access. However, if an Administrator needs to recover access to data on removable storage that was encrypted by the removed user, the Administrator does not know the user's password, and therefore cannot access the external media.

Note that the Administrator will need to repeat the following process for each piece of removable storage encrypted by the removed user, since the recovery code is per endpoint and does not apply to every piece of media owned by that user.

The following are SQL queries to accomplish "unmarking" the removed flag for the user in the database.

1. Follow the steps below. The user in this example is "games".

   1. `select * from entity where displayname like '%gam%'`

<table>
<thead>
<tr>
<th>KID</th>
<th>CID</th>
<th>EntityType</th>
<th>ESubType</th>
<th>Removed</th>
<th>Hidden</th>
<th>UID</th>
<th>DisplayName</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>123</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>#NTLDCNX:010...</td>
<td><a href="mailto:games@guest.test.local">games@guest.test.local</a></td>
</tr>
</tbody>
</table>

   2. `update entity set removed = '0' where EID = 'G'`

   (1 row(s) affected)

   3. Then to verify:

   `select * from entity where EID = 'G'`

<table>
<thead>
<tr>
<th>KID</th>
<th>CID</th>
<th>EntityType</th>
<th>ESubType</th>
<th>Removed</th>
<th>Hidden</th>
<th>UID</th>
<th>DisplayName</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>123</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>#NTLDCNX:010...</td>
<td><a href="mailto:games@guest.test.local">games@guest.test.local</a></td>
</tr>
</tbody>
</table>

The next triage resets the "removed" flag.

   2. Perform a recovery through Security Management Server (meaning, lock yourself out of the removable storage by entering an incorrect password until the recovery screen displays).

   Generate an Access Code through the Security Management Server.

   3. Reset the Encryption External Media password.

   4. **IMPORTANT** - Reverse the process from step 1 to re-mark the flag as "removed" in the database.

**Enable Federated Key Recovery**
If more than one Dell Server is part of a federation, to perform Encryption External Media Recovery across Dell Servers in the federation, enable federated key recovery:

1. Navigate to `<Security Server install dir>`\conf\ and open the federatedservers.properties file.
2. Update the `server.code` property with a new a code, password or passphrase to be shared across Dell Servers in the federation. Enclose the code, password, or passphrase within a new CLR() tag, to replace the ENC() tag.
   
   Example: `server.code=CLR(mypassword)`
3. List all Dell Servers to be federated in the server uris property, delimited by a comma.
   
4. Save and copy the federatedservers.properties file to all Dell Servers that are part of the federation.
5. Restart all Security Servers in the federation.
   
   The restart converts the CLR() tag to the encrypted tag, ENC(), in the federatedservers.properties file.

**Recover Data - BitLocker Manager**

See the [Recovery Guide](#) for the most up-to-date recovery instructions.

**Recover Endpoint**

To download encryption keys of a managed or removed endpoint:

**NOTE:** Select **Include Removed Endpoints** to display endpoints that were previously removed.

1. In the left pane, click **Management > Recover Endpoint**.
2. Enter the hostname and click **Search**.
3. Click **Recover** next to the endpoint.
4. Enter a password then click **Download**.
5. Copy the recovery file to the endpoint and run the file.

**Windows Recovery**

For Windows Recovery, follow the instructions in the [Recovery Guide](#). The latest Recovery Guide is available at these locations:

- [Encryption](#)
- [Endpoint Security Suite Enterprise](#)

**SED Recovery**

For information about SED authentication failure or SED endpoint recovery, see [SED Recovery](#).

**Encryption External Media Recovery**

For information about recovering after Encryption External Media authentication failure, see [Encryption External Media Authentication Failure](#).

**Mac Recovery**

125
License Management

Upload Client Access Licenses

You received CALs separately from the installation files, either at the initial purchase or later if you added additional CALs.

1. In the left pane, click **Management > License Management**.
2. Under Upload Licenses, click **Choose File** to browse to and select the saved CAL.

View or Add License Notifications

Through Notification Management, you can set up notifications of license usage or expiration.

In the left pane, click **Management > Notification Management**.

Related topics:

- **CAL Information**
- **Notification Management**

Client Access License (CAL) Information

Upon log in to the Management Console, if there is a problem with your CAL, an error message displays (typically, the error states that the Dell Server has exceeded the maximum number of authorized client licenses). The next step is to review your CALs to ensure that your enterprise has the appropriate number of CALs to client ratio (1-to-1 ratio).

If authorized CALs exceed 5% of that specific CAL total, new client activations for that specific product is blocked until the license key is brought into compliance. No other client or Dell Server functions is impacted when a license key is in the over 105% state. Two separate warning messages are displayed, the first warning message is when the CAL reaches 99% of the authorized licenses, the second when the CAL count reaches or exceeds the 105% total.

For example:

- Authorized CAL for Dell Encryption (Windows): 5000 user licenses
- First warning message from Dell Server and an email message is sent to the administrator: CAL count reaches 5000
- Second warning message from Dell Server and an email message is sent to the administrator: CAL count reaches 5250

If a client has previously been activated and inventory records exist, then it is not blocked from any re-activation. However, if the CAL authorized count is exceeded during this process, new activations are blocked for the specific CAL that is in the over 105% state.
1. **License structure:**
   b. Encryption External Media (EME)
   c. Dell Data Guardian (CE)
   d. Threat Protection (TP) - includes Malware Protection and/or Client Firewall and/or Web Protection features
   e. Advanced Threat Prevention (ATP) - includes optional Client Firewall and/or Web Protection features

2. **Dell Digital Delivery of entitlements**

   **Upload Client Access Licenses**

   You received CALs separately from the installation files, either at the initial purchase or later if you added additional CALs.

   1. In the left pane of the Management Console, click **Management > License Management**.
2. Under Upload Licenses, click Choose File to browse to the location of the saved CAL.

Related topics:
- CAL Information
- License Management
- Services Management

Services Management

From the left pane of the Management Console, select Management > Services Management. The following options are available:

**Provision or Recover the Advanced Threat Prevention service** - After the service is provisioned, clients are automatically provisioned with Advanced Threat Prevention. For more information, see Provision or Recover Advanced Threat Prevention Service.

**Enroll to receive Advanced Threat Prevention agent auto updates** - After enrollment, clients can automatically download and apply updates from the Advanced Threat Prevention server. For more information, see Enroll for Agent Auto Update.

**Export audit events** - Audit events can be exported to a syslog server or to a local file. For more information, see Export Events to SIEM Server.

**Provision or Recover Advanced Threat Prevention Service**

The Advanced Threat Prevention service is provisioned and recovered through the Services Management Advanced Threats tab. Only system administrator can provision and recover the service.

After provisioning is complete, the contact information of the administrator who provisioned the service is displayed.

The guided setup prompts the system administrator to back up the Advanced Threat Prevention certificate at this time.

**Provision service**

To provision the Advanced Threat Prevention service:

1. In the left pane of the Management Console, click Management > Services Management.
2. Select the Advanced Threats tab.
3. Click Setup Advanced Threat Prevention Service.
4. Follow the guided setup and complete the necessary fields.

Regional provisioning to support geographical data centers is available for NA (North America), EU (EMEA), and AU (APAC).

Download and back up the Advanced Threat Prevention certificate in a safe location, separate from the server running the Dell Server. The backed up certificate is required if a service recovery is necessary.

Clients are automatically provisioned with Advanced Threat Prevention.

After provisioning is complete, the Setup link no longer displays.

**Recover service**

You will need your backed up certificate to recover the Advanced Threat Prevention service.
1. In the left pane of the Management Console, click **Management > Services Management**.

2. Click **Recover Advanced Threat Prevention Service**.

3. Follow the guided service recovery dialogs and upload the Advanced Threat Prevention certificate when prompted.

**Enroll for Advanced Threat Prevention Agent Auto Updates**

You can enroll to receive Advanced Threat Prevention agent auto updates. Enrolling to receive agent auto updates allows clients to automatically download and apply updates from the Advanced Threat Prevention server. Updates are released monthly.

**Receive agent auto updates**

To enroll to receive agent auto updates:

1. In the left pane of the Management Console, click **Management > Services Management**.

2. On the **Advanced Threats** tab, under **Agent Auto Update**, click **On** then click **Save Preferences**.

**Stop receiving agent auto updates**

To stop receiving agent auto updates:

1. In the left pane of the Management Console, click **Management > Services Management**.

2. On the **Advanced Threats** tab, under **Agent Auto Update**, click **Off** then click the **Save Preferences**.

**Events Management - Export Audit Events to a SIEM Server**

To export audit events to a syslog server or to a local file:

1. In the left pane, click **Management > Services Management**.

2. Select the **Events Management** tab.

3. Select the appropriate option(s):

   **Export to Local File** allows you to export audit events to a file. Enter the location in which to store the file. This option also provides a backup of the audit events database.

   **Export to Syslog** lets you specify the syslog server to which to export the file. If TCP protocol is not selected, select it.

4. Click the **Save Preferences** button.

**Product Notifications**

You can enroll to receive notifications of product updates, recommended configuration changes, and relevant knowledge base articles.

**Receive product notifications**

To enroll to receive product notifications:

1. In the left pane, click **Management > Services Management**.

2. Select the **Product Notifications** tab.
3. Click On then click **Save Preferences**.

**Note:** The product notification switch does not display when servers are configured in disconnected mode.

**Stop receiving product notifications**

To stop receiving product notifications:

1. In the left pane of the Management Console, click **Management > Services Management**.
2. Select the **Product Notifications** tab.
3. Click **Off** then click **Save Preferences**.

**Enable Data Guardian Access Groups**

You can allow access to selected user groups to collaborate on encrypted data by updating Access Groups preferences. Users outside that group cannot access or view the data unless the owner of the file grants access. See Configure_Access_Groups.

**Note:** Access Groups were initially named Circle of Trust. The Management Console is in the process of updating the user interface.

To enable Access Groups:

1. In the left pane, navigate to **Management > Services Management**.
2. Select the **Data Guardian** tab.
3. For Access Groups, click **On**.
   
   **Important:** Currently, if you enable Access Groups, you cannot disable it.
4. Click **Save Preferences**. A check box displays.
5. Optionally, if you are implementing a transitional period for an initial implementation, click the **Auto access for swept files** check box. When the transitional period is complete, clear the check box.
6. Click **Save Preferences**.
7. Continue with Configure_Access_Groups.

**Notification Management**

The Notification Management page lets you manage email notifications.

To add an email notification:

1. In the left pane, click **Management > Notification Management**.
2. Click **Add** and enter the following information:
   
   **Email:** Enter or select your email address.
   
   **Notification Type:** Select the type of alert to add.
   
   **Priority Level:** Select the priority levels of notifications.
   
   **Email Frequency:** Select how often alerts of this type. The default frequency is 24 hours.
3. Click **Add** when complete.

To edit an alert:

- Select the alert to change, click **Edit**, make the changes, and press **Enter**.

To delete an alert:

- Select the alert to delete, and click **Delete**.

Related topics:

- **License Management**
- **Enable SMTP Server for Email Notifications**

### Enable SMTP Server for Email Notifications

If using Data Guardian, these settings are automated by using the Server Configuration Tool.

Use this procedure to enable the SMTP server for email notifications for purposes outside of Data Guardian.

When configuration changes are complete, restart the Security Server service. The Security Server service must be restarted for the settings to be updated.

### Product Notifications

You can enroll to receive notifications of product updates, recommended configuration changes, and relevant knowledge base articles.

#### Receive product notifications

To enroll to receive product notifications:

1. In the left pane, click **Management > Services Management**.
2. Select the **Product Notifications** tab.
3. Click **On** then click **Save Preferences**.

**Note:** The product notification switch does not display when servers are configured in disconnected mode.

#### Stop receiving product notifications

To stop receiving product notifications:

1. In the left pane of the Management Console, click **Management > Services Management**.
2. Select the **Product Notifications** tab.
3. Click **Off** then click **Save Preferences**.

### Data Guardian Management

#### Registration Access

To allow or block Data Guardian access for users who are not in the organization's domain:

1. In the left pane, click **Management > Data Guardian Management**.
2. Select the **Registration Access** tab.
3. Click **Add**.
4. Select Registration Access Type:
   - **Blacklist** - Blocks registration and file access for a user or a domain.
   - **Full Access List** - Grants registration and file access for a user or domain. If the user or domain is also on the blacklist, no access is granted.
5. Enter either a domain to set access for the entire domain, or email address to set access only for a single user.
6. Click **Add**.

External users can also be added to the blacklist from the Audit Events page, if the user is associated with an audit event:
1. In the left pane, click **Reporting > Audit Events**.
2. In the user column, click to the right of the user name to add to the blacklist.

**Key Request**

Data Guardian external users can request a key from an internal user to access a protected Office document. Key requests are shown on the Key Request Management page until the internal user approves or denies the request. After 48 hours, key requests are removed from the list. At that time, external users can request access again.

If the internal user is not available or has left the enterprise, an administrator can use this page to approve or deny requests.

Columns include:
- User - external user making the request
- File Name
- Request Date
- Request Expiration
- File Owner - internal user
- Approve/Deny

To approve or deny a request:
1. In the left pane, click **Management > Data Guardian Management**.
2. Select the **Key Request** tab.
3. Search for specific requests or select requests in the list.
   To select multiple requests to approve or deny, press **Ctrl** and then select the requests.
   To select multiple sequential requests, select the first request and then press **Shift** and select the last request in the sequential list.
4. Click **Approve** or **Deny**.

To approve or deny a single request, click approve or deny icon at the right end of the request.
Key Revocation

The administrator can revoke access to files, at both the user level and the file level.

To revoke access:
1. In the left pane, click Management > Data Guardian Management.
2. Select the Key Revocation tab.
3. Select the user or file from which to revoke files.
4. Click Revoke Keys.

Key Management

The administrator can manage key ownership.

The keyid is available here:
- Reporting > Audit Events > Columns > File KeyID. See Options in the Columns menu.
- On the client side, a user can right-click a protected file to see the KeyID.

To find/change the owner for a key:
1. In the left pane, navigate to Management > Data Guardian Management.
2. Select the Key Management tab.
3. Enter the keyid and click Find Owner. The owner displays in the Current Owner field.
4. In the New Owner field, enter the email address of the new owner and click Change Owner.

To change ownership for all keys:
1. In the left pane, navigate to Management > Data Guardian Management.
2. Select the Key Management tab.
3. Select Change Ownership for ALL keys.
4. Enter the email address of the current owner.
5. Enter the email address of the new owner.
6. Click Change Owner.

If changing ownership for all keys, a table, Key Changes in Progress, displays at the bottom during the transfer. When complete, this content is removed. The Log Analyzer displays a log of the entries in the Transfer of keys column that have changed ownership.

Web Portal

To access the Web Portal URL:
1. In the left pane, click Management > Data Guardian Management.
2. Select the Web Portal tab.
Portal URL - The URL used to access the enterprise's Data Guardian web portal. After the portal URL is entered and saved, it is displayed on the Management Console's Downloads page. Additionally, it is displayed on the cover page of a protected file if the user does not have access to the key. This portal URL also displays on the Activation page after a new user registers.

Change Superadmin Password

1. In the masthead at the top of the screen, click the gear icon and select Change superadmin password.
2. Enter the current password.
3. Enter the new password.
   The new password must be at least 6 characters, contain at least one capital letter and one of these characters: ~@#$%^*()|?!{}\[].
4. Confirm the new password.
5. Click Update.

After three failed login attempts, the superadmin account is locked for five minutes. To change these settings, see Set or Change Account Lockout Settings.

Change Account Lockout Settings

After three failed login attempts, the superadmin account is locked for five minutes. To change these settings:

1. Open <Security Server installation folder>\conf\application.properties.
2. Edit the following property to change the maximum allowed number of failed login attempts.
   login.cooldown.max.failed.attempts=3
3. Edit the following property to change the length of lockout time after the maximum allowed number of failed login attempts is reached.
   login.cooldown.minutes=5
4. Save the file, and restart the Security Server.

Downloads

Endpoint Software

To download the latest version of Dell Encryption:

1. In the left pane, click Management > Downloads.
2. Select the Endpoint Software tab.
3. Click Navigate to Download.
   The Download tab is only available if the user has been assigned a security and a system administrator role.
To download the latest version of Dell Data Guardian:

1. In the left pane, click Management > Downloads.
2. Select the Endpoint Software tab.
3. Choose from the following:
   - Navigate to Download (for Windows or Mac)
   - Download on the App Store (for iOS)
   - Get it on Google Play (for Android)

The Download tab is only available if the user has been assigned a security and a system administrator role.

To download the latest version of Endpoint Security Suite Enterprise (ESSE):

1. In the left pane, click Management > Downloads.
2. Select the Endpoint Software tab.
3. Click Dell Support to contact Dell for access to Dell Endpoint Security Suite Enterprise.
Manage Policies

Manage Security Policies

You can apply security policies at the Enterprise, Domain, User Group, User, Endpoint Group, and Endpoint levels. Default policy settings allow your enterprise to get started with Dell security, but you should customize the security and configuration settings. If you've migrated from an earlier version of Dell Server, your policy settings have been migrated for you.

Security policies are grouped by technology. Click a technology group to view its policies and policy descriptions.

<table>
<thead>
<tr>
<th>Windows Encryption</th>
<th>Threat Prevention</th>
<th>Mac Encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Disk Encryption (FDE)</td>
<td>Advanced Threat Prevention</td>
<td>Dell Volume Encryption</td>
</tr>
<tr>
<td>Self-Encrypting Drive (SED)</td>
<td>Threat Protection</td>
<td>Mac Global Settings</td>
</tr>
<tr>
<td>Policy-Based Encryption</td>
<td>Web Protection</td>
<td></td>
</tr>
<tr>
<td>BitLocker Encryption</td>
<td>Client Firewall</td>
<td></td>
</tr>
<tr>
<td>Server Encryption</td>
<td>Protection Settings</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Removable Media Encryption</th>
<th>Port Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Boot Authentication</td>
<td>Windows Media Encryption</td>
<td>Windows Port Control</td>
</tr>
<tr>
<td>Windows Authentication</td>
<td>Mac Media Encryption</td>
<td>Windows Device Control</td>
</tr>
<tr>
<td></td>
<td>Media Encryption Settings</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Guardian</th>
<th>Global Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Encryption</td>
<td>Settings</td>
</tr>
<tr>
<td>Protected Office Documents</td>
<td></td>
</tr>
<tr>
<td>Content Based Protection</td>
<td></td>
</tr>
<tr>
<td>Mobile Client</td>
<td></td>
</tr>
<tr>
<td>Web Portal</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td></td>
</tr>
</tbody>
</table>

The following override information displays at the top of the Security Policies page:

- **Override count** - the number of policy settings that are changed from their default settings.
- **Uncommitted overrides** - the number of changes from default settings that are not yet committed.

**NOTE:** The Security Policies page for a population displays overrides to localizable policies in the browser language only.
Icons and their meanings:

- The master switch for policies in the subgroup is On, which means the policy group is enabled. Policies in the group are sent to clients when policies are committed.
- Policies in the subgroup are not enabled.
- At least one default setting in the policy group has been overridden.
- Group of policy settings that has no master switch.
- The policy change is not yet committed.
- The policy value can be localized, so that policies on the endpoint computer display in a selected language. For more information, see Localize Policies Displayed on the Endpoint Computer and Localizable_policies.
- The default setting of a localizable policy is overridden.
- A localizable policy change is not yet committed.

To remove a policy override, hover over the red flag next to the policy name. The red flag becomes a red X. Click the red X to revert to the default value.

Group precedence

You can Modify Group Precedence. Group precedence creates a weight associated with the specific group it is assigned to, and that weight is used in policy arbitration for all policy overrides.

Related topics:
- View or Modify Enterprise-Level Policies
- View or Modify Domain Policies and Information
- View or Modify User Group Policies and Information
- View or Modify User Policies and Information
- View or Modify Endpoint Group Policies and Information
- View or Modify Endpoint Policies and Information

Localize Policies Displayed on the Endpoint Computer

Localizable policies are indicated by:

To localize policies that are displayed on the endpoint computer, follow these steps:

1. In the left pane, expand Populations and select a population.
2. Click the **Security Policies** tab.
3. Select the technology group, such as *Windows Encryption*, or policy group, such as *Policy-Based Encryption*, to modify.
4. Select a language for localizable policies from the list at the top right of the screen.

   ![Show default settings | Save | Cancel]

   **Policies localized in**

<table>
<thead>
<tr>
<th>English</th>
</tr>
</thead>
<tbody>
<tr>
<td>French</td>
</tr>
<tr>
<td>German</td>
</tr>
<tr>
<td>Italian</td>
</tr>
<tr>
<td>Spanish</td>
</tr>
<tr>
<td>Japanese</td>
</tr>
<tr>
<td>Korean</td>
</tr>
<tr>
<td>Portuguese</td>
</tr>
<tr>
<td>Brazilian Portuguese</td>
</tr>
</tbody>
</table>

   5. Enter text that is in the language you selected for localizable policies. Navigate the populations and technology groups as necessary to localize all desired policies for that language.

   6. Click **Save**.

   7. To update policies in a different language, select the language from the list, enter localized text for all desired policies, and click **Save**.

      **Save policy changes before selecting another language in the list. A different language cannot be selected until policy changes are saved.**

   8. When finished, select the desired language. Any changes made to localizable policies are made in the language that displays.

   **NOTE:** The Security Policies page for a population displays overrides to localizable policies in the browser language only.

### Localizable Policies

Localizable policies are indicated with by

**Available languages:**

<table>
<thead>
<tr>
<th>English</th>
<th>Korean</th>
</tr>
</thead>
<tbody>
<tr>
<td>French</td>
<td>Brazilian Portuguese</td>
</tr>
<tr>
<td>German</td>
<td>Portuguese</td>
</tr>
<tr>
<td>Italian</td>
<td>Spanish</td>
</tr>
<tr>
<td>Japanese</td>
<td></td>
</tr>
</tbody>
</table>

For instructions about localizing policies, see [Localize policies](#).
The following policies can be displayed in a selected language on the endpoint computer:

**Enterprise Level**

<table>
<thead>
<tr>
<th>Technology Group</th>
<th>Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Encryption &gt; Full Disk Encryption</td>
<td>Support Information Text</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Full Disk Encryption Title Text</td>
</tr>
<tr>
<td></td>
<td>Legal Notice Text</td>
</tr>
<tr>
<td></td>
<td>Self Help Questions</td>
</tr>
<tr>
<td>Windows Encryption &gt; Self-Encrypting Drive (SED)</td>
<td>Support Information Text</td>
</tr>
<tr>
<td></td>
<td>PBA Title Text</td>
</tr>
<tr>
<td></td>
<td>Legal Notice Text</td>
</tr>
<tr>
<td></td>
<td>Self Help Questions (Pre-8.0 clients)</td>
</tr>
<tr>
<td>Windows Encryption &gt; Policy-Based Encryption</td>
<td>Common Encrypted Folders</td>
</tr>
<tr>
<td></td>
<td>User Encrypted Folders</td>
</tr>
<tr>
<td></td>
<td>OS Update Encryption Rules</td>
</tr>
<tr>
<td></td>
<td>Application Data Encryption List</td>
</tr>
<tr>
<td></td>
<td>Managed Services</td>
</tr>
<tr>
<td>Windows Encryption &gt; BitLocker Encryption</td>
<td>Default Folder Location to Save Recovery Password</td>
</tr>
<tr>
<td>Authentication &gt; Windows Authentication</td>
<td>Recovery Questions for Windows Authentication (check box selections)</td>
</tr>
<tr>
<td>Removable Media Encryption &gt; Windows Media Encryption</td>
<td>EMS Device Whitelist</td>
</tr>
<tr>
<td></td>
<td>EMS Access Code Required Message</td>
</tr>
<tr>
<td></td>
<td>EMS Access Code Failed Message</td>
</tr>
<tr>
<td>Data Guardian &gt; Cloud Encryption</td>
<td>Help File Name</td>
</tr>
<tr>
<td>Section</td>
<td>Help File Contents</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Excluded Folders</td>
<td></td>
</tr>
<tr>
<td>Excluded Files</td>
<td></td>
</tr>
<tr>
<td>Data Guardian &gt; Protected Office Documents</td>
<td>Office Protected Clipboard Unauthorized Text</td>
</tr>
<tr>
<td></td>
<td>Office Protected Document Tamper Prompt</td>
</tr>
<tr>
<td></td>
<td>Offline Key Generation Escrow Reminder Text</td>
</tr>
<tr>
<td></td>
<td>Office Protected Files Cover Page Notice</td>
</tr>
<tr>
<td>Data Guardian &gt; Mobile Client &gt; Cover Page</td>
<td>Office Protected Files Cover Page Acceptance Text</td>
</tr>
<tr>
<td></td>
<td>Office Protected Document Tamper Prompt</td>
</tr>
<tr>
<td>Data Guardian &gt; Web Portal</td>
<td>Office Protected Files Cover Page EULA</td>
</tr>
<tr>
<td>Users Level</td>
<td></td>
</tr>
<tr>
<td>Technology Group</td>
<td>Policy</td>
</tr>
<tr>
<td>Windows Encryption &gt; Policy-Based Encryption</td>
<td>User Encrypted Folders</td>
</tr>
<tr>
<td></td>
<td>Application Data Encryption List</td>
</tr>
<tr>
<td></td>
<td>Managed Services</td>
</tr>
<tr>
<td>Removable Media Encryption &gt; Windows Media Encryption</td>
<td>EMS Device Whitelist</td>
</tr>
<tr>
<td></td>
<td>EMS Access Code Required Message</td>
</tr>
<tr>
<td></td>
<td>EMS Access Code Failed Message</td>
</tr>
<tr>
<td>Endpoints Level</td>
<td></td>
</tr>
<tr>
<td>Technology Group</td>
<td>Policy</td>
</tr>
<tr>
<td>Windows Encryption &gt; Self-Encrypting Drive (SED)</td>
<td>Support Information Text</td>
</tr>
<tr>
<td></td>
<td>PBA Title Text</td>
</tr>
</tbody>
</table>
A word about types of encryption: SDE is designed to encrypt the operating system and program files. To accomplish this purpose, SDE must be able to open its encryption key while the operating system is booting without intervention of a password by the user. Its intent is to prevent alteration or offline attacks on the operating system by an attacker. SDE is not intended for user data. Common and User key encryption are intended for sensitive user data because they require a user password to unlock encryption keys.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Disk Encryption (FDE)</td>
<td>This technology manages drives using software-based Full Disk Encryption. Authentication by users through a Pre-Boot Authentication environment (before the operating system has booted) is required to unlock the drive.</td>
<td></td>
</tr>
</tbody>
</table>
### Full Disk Encryption (FDE)

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
<td>Toggle to ON to enable all full disk encryption policies. If this policy is toggled to OFF, no full disk encryption takes place, regardless of other policy values. On means that all Full Disk Encryption policies are enabled. Changing the value of this policy triggers a new sweep to encrypt/decrypt files.</td>
</tr>
</tbody>
</table>

#### Encryption Algorithm

- **AES 256**, **AES 128**, **FIPS AES 256**, **FIPS AES 128**

  Encryption algorithm used for Full Disk Encryption.

#### Encryption Mode

- **CBC**, **XTS**

  Encryption mode used for Full Disk Encryption.

#### Enable FDE Plugin

- **Selected**

  The plugin must remain selected. To deactivate the PBA and disable full disk encryption, toggle the Full Disk Encryption policy to OFF.

### Self-Encrypting Drive (SED)

This technology manages self-encrypting drives (SEDs). Authentication by users through a Pre-Boot Authentication environment (before the operating system has booted) is required to unlock the drive.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
<td>Enable this policy to provision the PBA. If disabled after the PBA is provisioned, the PBA is de-provisioned and the PBA database is deleted. Re-enabling this policy re-provisions the PBA and re-creates the PBA database.</td>
</tr>
</tbody>
</table>

### Policy-Based Encryption

This technology uses Dell's proprietary data centric encryption to allow user data and computer encryption. This allows greater protection over individual data than traditional full disk encryption, by limiting access on a computer to only what a user is authorized to view.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
<td>Toggle to ON to enable all policy-based encryption policies. If this policy is toggled to OFF, no policy-based encryption takes place, regardless of other policy values. On means that all Policy-Based Encryption policies are enabled. Changing the value of this policy triggers a new sweep to encrypt/decrypt files.</td>
</tr>
</tbody>
</table>

### Application Data Encryption Key

- **Common**, **User**, **User Roaming**

  Common, User, User Roaming
Choose a key to indicate who can access files encrypted by Application Data Encryption List, and where.

**More...**

Common for these files to be accessible to all managed users on the computer where they were created (the same level of access as Common Encrypted Folders), and encrypted with the Common encryption algorithm.

User for these files to be accessible only to the user who created them, only on the computer where they were created (the same level of access as User Encrypted Folders), and encrypted with the user encryption algorithm.

User Roaming for these files to be accessible only to the user who created them, on any encrypted Windows computer, and encrypted with the User encryption algorithm.

Changes to this policy do not affect files already encrypted because of this policy.

If this policy is not selected, SDE encryption is disabled, regardless of other policy values. Selected means that all data not encrypted by other Intelligent Encryption policies are encrypted per the SDE Encryption Rules policy. Changing the value of this policy requires a reboot.

Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. See Encryption Rules for information. SDE Encryption Rules may be changed as appropriate for your environment. However, these defaults have been tested extensively. Removing these exclusions may result in Windows issues, particularly after applying patch updates. Contact ProSupport for guidance if you are unsure about changing the values.
### Common Encrypted Folders

<table>
<thead>
<tr>
<th>Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>~@%ENV:SYSTEMDRIVE%\;vol</code></td>
<td>Base drive volume root (default)</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation</code></td>
<td>PGP Corporation folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE00</code></td>
<td>PGPWE Drive 00 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE01</code></td>
<td>PGPWE Drive 01 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE02</code></td>
<td>PGPWE Drive 02 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE03</code></td>
<td>PGPWE Drive 03 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\Symantec</code></td>
<td>Symantec folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files (x86)\Symantec</code></td>
<td>Symantec (x86) folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\Common Files\Symantec</code></td>
<td>Symantec Common Files folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\Symantec\Symantec Shared</code></td>
<td>Symantec Shared folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files (x86)\Common Files\Symantec Shared</code></td>
<td>Symantec Shared (x86) folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation\PGPWDE00</code></td>
<td>PGPWE Drive 00 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE01</code></td>
<td>PGPWE Drive 01 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE02</code></td>
<td>PGPWE Drive 02 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\PGPWDE03</code></td>
<td>PGPWE Drive 03 folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\Symantec\Symantec Shared</code></td>
<td>Symantec Shared folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files (x86)\Symantec\Symantec Shared</code></td>
<td>Symantec Shared (x86) folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation\PGPWDE00\SafeBoot.fs</code></td>
<td>SafeBoot.fs file</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation\PGPWDE01\SafeBoot.rsv</code></td>
<td>SafeBoot.rsv file</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation\PGPWDE02\SafeBoot.csv</code></td>
<td>SafeBoot.csv file</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\PGP Corporation\PGPWDE03\SafeBoot.csv</code></td>
<td>SafeBoot.csv file</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee</code></td>
<td>McAfee folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Common Files\McAfee</code></td>
<td>McAfee Common Files folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files (x86)\Common Files\McAfee</code></td>
<td>McAfee (x86) Common Files folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee</code></td>
<td>Mcafee folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee\Trend Micro\</code></td>
<td>Trend Micro folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee\Trend Micro\</code></td>
<td>Trend Micro folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee\Kace</code></td>
<td>Kace folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee\Kace\</code></td>
<td>Kace folder</td>
</tr>
<tr>
<td><code>~%ENV:SYSTEMDRIVE%\Program Files\McAfee\Mcafee\Kace\</code></td>
<td>Kace folder</td>
</tr>
</tbody>
</table>

**String**

- Maximum of 100 entries of 500 characters each (up to a maximum of 2048 characters)
- A list of folders on computer drives to be encrypted or excluded from encryption, which can then be accessed by all managed users who have access to the computer.
- See [Encryption Rules](#) for information. The text in this policy is translatable.

**Important:** Overriding directory protection can result in an unbootable computer and/or require reformatting drives.

**More...**

- The available drive letters are:
  - #: Refers to all drives
  - f#: Refers to all fixed (non-removable) drives
  - r#: Refers to all removable drives
If the same folder is specified in both this policy and the User Encrypted Folders policy, this policy prevails.

See advanced settings

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| BitLocker Encryption       | Not Managed     | Managed
|                            |                 | Not Managed
|                            |                 | Toggle to Managed to enable BitLocker Manager policy settings. Toggling to Not Managed disables all BitLocker Manager policies, regardless of other policy values. |
| TPM Manager Enabled        | Not Selected    | Selected
|                            |                 | Not Selected
|                            |                 | Selected enables TPM management with BitLocker management. Not Selected disables all TPM management policies, including policies in the Operating System Volume Settings category. |
| Disable Sleep Mode         | Not Selected    | Selected
|                            |                 | Not Selected
|                            |                 | Selected disables sleep mode on the local computer. Changing this policy requires a reboot for the new value to take effect. |
| Encrypt System Drive       | Do Not Manage   | Do Not Manage
|                            |                 | Turn On Encryption
|                            |                 | Turn Off Encryption
<p>|                            |                 | Do Not Manage ignores the System Drive (typically the drive that the operating system is installed on). Turn On Encryption allows BitLocker to encrypt the System Drive only. Turn Off Encryption disables BitLocker from encrypting the system drive or decrypts any BitLocker-encrypted system drives. |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt Fixed Drives</td>
<td>Do Not Manage</td>
<td>This policy does not encrypt the system drive. To also encrypt the system drive, make sure that Encrypt System Drive Only is also selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Do Not Manage ignores Fixed Drives. Turn On Encryption allows BitLocker to encrypt Fixed Drives. Turn Off Encryption causes Manager to decrypt any BitLocker encrypted fixed drives.</td>
</tr>
<tr>
<td>Encrypt Removable Drives</td>
<td>Do Not Manage</td>
<td>Do Not Manage ignores Removable Drives. Turn On Encryption allows BitLocker to encrypt Removable Drives. Turn Off Encryption causes Manager to decrypt any BitLocker encrypted removable drives.</td>
</tr>
<tr>
<td>Require Additional Authentication at System Startup</td>
<td>Not Selected</td>
<td>This policy allows for the configuration of BitLocker to require additional authentication each time the computer starts up [with or without a Trusted Platform module (TPM)].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>More... This policy is the parent policy to: Allow BitLocker Encryption Without a Compatible TPM Configure TPM Startup Configure TPM Startup PIN Configure TPM Startup Key Configure TPM Startup Key and PIN</td>
</tr>
<tr>
<td>Allow BitLocker Encryption Without a Compatible TPM</td>
<td>Selected</td>
<td>Selected allows a computer without a compatible TPM to use BitLocker encryption. In this mode, a USB drive is required for startup. When the key is inserted, access to the drive is authenticated and the drive is accessible. If the USB key is lost or unavailable, the computer will require BitLocker recovery for access. To use this policy, Require Additional Authentication at System Startup must be set to Selected.</td>
</tr>
<tr>
<td>Policy</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configure TPM Startup</td>
<td>Allow</td>
<td>On computers with a compatible TPM, three types of authentication are supported. Only one of the following can be required or allowed: Configure TPM Startup PIN Configure TPM Startup Key Configure TPM Startup Key and PIN To use this policy, Require Additional Authentication at System Startup must be set to Selected.</td>
</tr>
<tr>
<td>Configure TPM Startup PIN</td>
<td>Allow</td>
<td>To use this policy, Require Additional Authentication at System Startup must be set to Selected. This type of authentication involves the entry of a 4-digit to 20-digit personal identification number (PIN).</td>
</tr>
<tr>
<td>Configure TPM Startup Key</td>
<td>Do Not Allow</td>
<td>To use this policy, Require Additional Authentication at System Startup must be set to Selected. This type of authentication involves insertion of a USB drive containing the startup key.</td>
</tr>
<tr>
<td>Configure TPM Startup Key and PIN</td>
<td>Do Not Allow</td>
<td>To use this policy, Require Additional Authentication at System Startup must be set to Selected. This type of authentication involves a 4-digit to 20-digit personal identification number (PIN) and a USB drive containing the startup key.</td>
</tr>
</tbody>
</table>
### Encryption Method and Cipher Strength (Removable Volumes)

Encryption and cipher strength used by BitLocker Drive Encryption for Removable Volumes.

- AES-128
- AES-256
- XTS-AES-128 (for use with Windows 10 Anniversary Edition and later)
- XTS-AES-256 (for use with Windows 10 Anniversary Edition and later)

Algorithm and cipher strength used by BitLocker Drive Encryption for Removable Volumes. To encrypt removable drives to use with older versions of Windows as well as with Windows 10 Anniversary Edition and later, use AES-128 or AES-256.

### Encryption Method and Cipher Strength (Fixed Volumes)

Encryption and cipher strength used by BitLocker Drive Encryption for Fixed Volumes.

- AES-128
- AES-256
- XTS-AES-128 (for use with Windows 10 Anniversary Edition and later)
- XTS-AES-256 (for use with Windows 10 Anniversary Edition and later)

Algorithm and cipher strength used by BitLocker Drive Encryption for Fixed Volumes.

---

### Policy

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Encryption</strong></td>
<td>Off</td>
<td>This technology manages Dell's data centric encryption using certificate-based authentication instead of the typical user-based authentication. This technology allows for protection of devices such as Windows Servers that do not commonly have users logged in.</td>
</tr>
<tr>
<td><strong>Allow Software Server Encryption</strong></td>
<td>Selected</td>
<td>If this policy is Selected, client servers are activated at the Enterprise level. This policy may be set to Not Selected to block activations during initial Dell Server setup and maintenance interruptions.</td>
</tr>
<tr>
<td><strong>Server Maintenance Schedule</strong></td>
<td>Not Selected</td>
<td>This policy must be selected to use all other Server Maintenance policies. If this policy is Not Selected, no Server Maintenance policies are enforced, regardless of</td>
</tr>
</tbody>
</table>

---

See [advanced settings](#).
| Server Maintenance Schedule Repeats | Weekly | Selected allows a maintenance schedule to control application of policy that requires a reboot. | Daily, Weekly, Monthly, Quarterly, Annually. The schedule configuration defines when the task should run. Daily: Runs the task every day at the specified Server Maintenance Schedule Start Time. Weekly: Runs the task weekly on the days specified in Server Maintenance Day of the Week. Monthly: Runs the task monthly on the specified Server Maintenance Day of the Month. Quarterly: Runs the task quarterly on the specified Server Maintenance Day of the Month. Annually: Runs the task annually on the specified Server Maintenance Day of the Month. |
| Port Control System | Disabled | Enable or Disable all Port Control System policies. If this policy is set to Disable, no Port Control System policies are applied, regardless of other Port Control System policies. All PCS policies require a reboot before the policy takes effect. | If this policy is Not Selected, SDE encryption is disabled, regardless of other policy values. Selected means that all data not encrypted by other Intelligent Encryption policies are encrypted per the SDE Encryption Rules policy. Changing the value of this policy requires a reboot. |
| SDE Encryption Enabled | Selected | This policy must be selected to use all Common Encryption policies. Not Selected means that no Common Encryption takes place, regardless of other policy values. Changing the value of this policy may result in Windows issues, particularly after applying patch updates. Contact ProSupport for guidance if you are unsure about changing the values. | Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. See Encryption Rules for information. SDE Encryption Rules may be changed as appropriate for your environment. However, these defaults have been tested extensively. Removing these exclusions may result in Windows issues, particularly after applying patch updates. Contact ProSupport for guidance if you are unsure about changing the values. |
| SDE Encryption Rules | String | Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. See Encryption Rules for information. SDE Encryption Rules may be changed as appropriate for your environment. However, these defaults have been tested extensively. Removing these exclusions may result in Windows issues, particularly after applying patch updates. Contact ProSupport for guidance if you are unsure about changing the values. | Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. See Encryption Rules for information. SDE Encryption Rules may be changed as appropriate for your environment. However, these defaults have been tested extensively. Removing these exclusions may result in Windows issues, particularly after applying patch updates. Contact ProSupport for guidance if you are unsure about changing the values. |
| Encryption Enabled | Selected | | |
triggers a new sweep to encrypt/decrypt files.

See advanced settings

Variables

Some Windows policies support the following variables. A pathname can consist entirely of one or more of these variables, or can include one or more of these variables at any point.

To get directory locations that these CSIDL values resolve to, go to http://msdn.microsoft.com/en-us/library/bb762494.aspx. All names listed on the MSDN page are CSIDL_<name>.

- Includes any of the following Windows CSIDL constants:

  DESKTOP
  INTERNET
  PROGRAMS
  CONTROLS
  PRINTERS
  PERSONAL
  FAVORITES
  STARTUP
  RECENT
  SENDTO
  STARTMENU
  STARTMENU
  MYDOCUMENTS
  MYMUSIC
  MYVIDEO
  DESKTOPDIRECTORY
  DRIVES
  NETWORK
  NETHOOD
  FONTS
  TEMPLATES
  COMMON_STARTMENU
  COMMON_PROGRAMS
  COMMON_STARTUP
  COMMON_DESKTOPDIRECTORY
APPDATA
PRINTHOOD
LOCAL_APPDATA
ALTSTARTUP
COMMON_ALTSTARTUP
COMMON_FAVORITES
INTERNET_CACHE
COOKIES
HISTORY
COMMON_APPDATA
WINDOWS
SYSTEM
PROGRAM_FILES
PROGRAMFILES
MYPICTURES
PROFILE
SYSTEMX86
PROGRAM_FILESEX86
PROGRAMFILESX86
PROGRAM_FILES_COMMON
PROGRAM_FILES_COMMONX86
COMMON_TEMPLATES
COMMON_DOCUMENTS
COMMON_ADMINTOOLS
ADMINTOOLS
CONNECTIONS
COMMON_MUSIC
COMMON_PICTURES
COMMON_VIDEO
RESOURCES
PROFILES

- Includes a numeric or text value stored in the registry for the current user. If you specify a path but not an item, the client uses the default value
Includes a numeric or text value stored in the registry for the local computer. If you specify a path but not an item, the client uses the default value

Includes the value of a Windows local environment variable

Includes the % character

Windows Policies that Require Reboot

- SDE Encryption Enabled
- Encrypt Windows Paging File
- Secure Windows Credentials
- All PCS policies

Windows Policies that Require Logoff

- SDE Encryption Enabled
- User state change to Suspended
- EMS Encrypt External Media
- EMS Scan External Media
- EMS Encryption Algorithm
- EMS Exclude CD/DVD Encryption
- EMS Data Encryption Key

Advanced Windows Encryption

A word about types of encryption: SDE is designed to encrypt the operating system and program files. To accomplish this purpose, SDE must be able to open its encryption key while the operating system is booting without intervention of a password by the user. Its intent is to prevent alteration or offline attacks on the operating system by an attacker. SDE is not intended for user data. Common and User key encryption are intended for sensitive user data because they require a user password to unlock encryption keys.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self-Encrypting Drive (SED)</td>
<td>Selected</td>
<td>This technology manages self-encrypting drives (SEDs). Authentication by users through a Pre-Boot Authentication environment (before the operating system has booted) is required to unlock the drive.</td>
</tr>
<tr>
<td>Enable SED Plugin</td>
<td>Selected</td>
<td>The plugin must remain selected. To deactivate the PBA and disable SED Management, toggle the Self-encrypting Drive policy to OFF.</td>
</tr>
<tr>
<td>See basic settings</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Policy-Based Encryption
This technology uses Dell’s proprietary data centric encryption to allow user data and computer encryption. This allows greater protection over individual data than traditional full disk encryption, by limiting access on a computer to only what a user is authorized to view.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt with SDE when SED is detected</td>
<td>Not Selected</td>
<td>When Selected, this policy applies SDE encryption to self-encrypting drives. Use this policy when SDE encryption is preferred instead of native SED encryption.</td>
</tr>
</tbody>
</table>
| User Encrypted Folders | String | String - maximum of 100 entries of 500 characters each (up to a maximum of 2048 characters)
A list of folders on the computer hard drive to be encrypted with the user data encryption key or excluded from encryption.
If the same folder is specified in this policy for multiple users of the same Windows computer, each file in that folder is encrypted for the **first owner** of the file after the policy takes effect, and can be decrypted only by that owner.
The text in this policy is translatable. |
| Application Data Encryption List | Exe List | String - maximum of 100 entries of 500 characters each
Do not add explorer.exe or iexplorer.exe to the ADE list, as unexpected or unintended results may occur.
Explorer.exe is the process used to create a new notepad file on the desktop using the right-click menu.
Setting encryption by file extension, instead of the ADE list, provides more comprehensive coverage.
Changes to this policy do not affect files already encrypted because of this policy.
List process names of applications (without paths) whose new files you want encrypted, separated by carriage returns. Do not use wildcards.
The text in this policy is translatable. |

You can also specify these process names (separated by commas) via the registry value
HKLM\Software\Dell\CMGShield\ApplicationDataEncryptionList.
The Encryption client encrypts all new files (not already being encrypted by Common Encrypted Folders and User Encrypted Folders) on the current computer hard drives created by these application processes whenever they are owned by a currently-logged-on managed user. This may include files excluded from encryption by Common Encrypted Folders and/or User Encrypted Folders.
The following folders and their subfolders are always excluded from encryption by this policy:
C:\Windows\system32
C:\Windows\Software Distribution
C:\Windows\Security
C:\System Volume Information\Program Files\Dell\(\d\\.\sys\mac\ddp\wip\rt\nmd\inv)
Dell strongly recommends not listing applications or installers that write system-critical files. Doing so could result in encryption of important system files, which could make a Windows computer unbootable.
Common process names:
outlook.exe
The following hard-coded system and installer process names are ignored if specified in this policy (you can also add to this list via the registry value HKLM\Software\Dell\CMGShield\EUWPrivilegedList):
- hotfix.exe, a Windows update process
- update.exe, a Windows update process
- setup.exe, a third-party installer process
- msiexec.exe, a third-party installer process
- wuaudit.exe, a Windows update process
- wmicprvse.exe, a Windows system process
- migrate.exe, a Windows update process
- unregmp2.exe, a Windows update process
- ikernel.exe, a third-party installer process
- wssetup.exe, the Windows Encryption client installer
- svchost.exe, a Windows system process

<table>
<thead>
<tr>
<th>User Encryption Algorithm</th>
<th>AES256</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption algorithm used to encrypt data at the individual user level. You can specify different values for different users of the same computer. Encryption algorithms in order of speed, fastest first, are Rijndael 128, AES 128, Rijndael 256, AES 256, 3DES.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SDE Encryption Algorithm</th>
<th>AES256</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption algorithm used to encrypt data at the endpoint (all users) level. System paging files are encrypted using AES 128. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Common Encryption Algorithm</th>
<th>AES256</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption algorithm used to encrypt data at the endpoint (all users) level. System paging files are encrypted using AES 128. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt Outlook Personal Folders</th>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypts Outlook Personal Folders (%csidl:local_appdata %\Microsoft\Outlook) with the User data encryption key.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt Temporary Files</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the paths listed in the environment variables TEMP and TMP are encrypted. TEMP and TMP for the operating system are encrypted with the Common encryption key. To reduce encryption sweep time, the contents of the TEMP and TMP folders are cleared for initial encryption, as well as updates to this policy. However, if your organization uses a third-party application that requires the file structure within the \temp directory to be preserved, you should prevent this deletion. To disable temporary file deletion, create DeleteTempFiles (REG_DWORD) and set its value to 0 in the registry at HKLM\SOFTWARE\Credant\CMGShield.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt Temporary Internet Files</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the path listed in the environment variable CSIDL_INTERNET_CACHE is encrypted with the User data encryption key. To reduce encryption sweep time, the contents of CSIDL_INTERNET_CACHE are cleared for initial encryption, as well as updates to this policy. This policy is applicable when using Microsoft Internet Explorer only. For other web browsers, an administrator must create an encryption policy that is specific to the storage location of the temporary internet files used by each browser.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt User Profile Documents</th>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the following are encrypted: • The users profile (C:\Users\jsmith) with the User data encryption key • U\Users\Public with the Common encryption key</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt Windows Paging File</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the Windows paging file is encrypted. A change to this policy requires a reboot.</td>
<td></td>
</tr>
<tr>
<td>Policy</td>
<td>Type</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Managed Services</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Secure Post-Encryption Cleanup     | No Overwrite | No Overwrite, Single-pass Overwrite, Three-pass Overwrite, Seven-pass Overwrite Once encryption is complete, this policy determines what happens to the unencrypted residue of the original files:  
• No Overwrite deletes it. This value yields the fastest encryption processing.  
• Single-pass Overwrite overwrites it with random data.  
• Three-pass Overwrite overwrites it with a standard pattern of 1s and 0s, then with its complement, and then with random data.  
• Seven-pass Overwrite overwrites it with a standard pattern of 1s and 0s, then with its complement, and then with random data five times. This value makes it most difficult to recover the original files from memory, and yields the most secure encryption processing. |
| Secure Windows Credentials         | Not Selected | When this policy is selected, the Windows Credentials are secured by encrypting the entire registry with the exception of registry information required for computer boot. The information required for computer boot includes HKLM/SYSTEM and all sub-keys. More... A reboot is required when a change to this policy is delivered. To control this reboot, configure the following policies: Force Reboot on Update, Length of Each Reboot Delay, and Number of Reboot Delays Allowed. |
| Block Unmanaged Access to Domain Credentials | Not Selected | This policy prevents unmanaged users and applications from accessing the Windows domain credentials when a user is logged in. |
| Secure Windows Hibernation File    | Not Selected | When this policy is selected, the hibernation file is encrypted only when the computer enters hibernation. The Encryption client disengages protection when the computer comes out of hibernation, providing protection without impacting users or applications while the computer is in use. |
| Prevent Unsecured Hibernation      | Not Selected | When this policy is selected, the Encryption client does not allow computer hibernation if the client is unable to encrypt the hibernation data. |
| Scan Workstation on Logon          | Not selected | When this policy is selected, all current and previously encrypted folders on the encrypted computer's local hard drives are scanned each time a managed user logs on, ensuring that all Common Encrypted Folders and User Encrypted Folders policy values are properly implemented. Abides by the Workstation Scan Priority policy. |
| Workstation Scan Priority          | Highest, High, Normal, Low, Lowest | Specifies the relative Windows priority of encrypted folder scanning. High and Highest prioritize scanning speed over computer responsiveness, Low and Lowest prioritize computer responsiveness over scanning speed and favor other resource-intensive activities, and Normal balances the two. The client checks for a changed Workstation Scan Priority before processing the next file. |
The scan priority levels are used in two ways:

1. These values correspond with the values used by the Microsoft SDK to set thread execution priority.
2. The client uses these values to introduce a delay in the encryption sweep after every single file is processed.

The values translate to the following millisecond delay ranges, where the encryption thread will sit idle and then return full control to the operating system:

<table>
<thead>
<tr>
<th>Highest</th>
<th>Lowest</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ms</td>
<td>100 ms</td>
</tr>
</tbody>
</table>

Common, User, User Roaming
Choose a key to indicate who can access files encrypted by the following policies, and where:

- User Encrypted Folders
- Encrypt Outlook Personal folders
- Encrypt Temporary Files (\Users\<Username>\AppData\Local\Temp only)
- Encrypt Temporary Internet Files
- Encrypt User Profile Documents (except \All Users\Shared Documents)

Select:
- Common for User Encrypted Folders to be accessible by all managed users on the computer where they were created (the same level of access as Common Encrypted Folders), and encrypted with the Common encryption algorithm.
- More...

The Common encryption algorithm controls the encryption algorithm for all User Encrypted Folders and overrides any encryption algorithm selected, including the default User encryption algorithm. For example, if the Common encryption algorithm is set to AES 256, all Common and User Encrypted Files/Folders is encrypted with the AES 256 algorithm.

All other encryption parameters can be selected to override default settings. For example, if the Encrypt Temporary Files policy is set to Not Selected, you can override this setting for any managed user by setting this value to Selected.

Designated User Encrypted Folders use the Common Key, resulting in all managed users having the key to access any encrypted files stored in these folders as permitted by security settings on the operating system.

- User for these files to be accessible only to the user who created them, only on the computer where they were created (the same level of access as User Encrypted Folders), and encrypted with the User Encryption Algorithm.
- User Roaming for these files to be accessible only to the user who created them, on any encrypted Windows computer, and encrypted with the User encryption algorithm.

When incorporating an encryption policy to encrypt entire disk partitions, Dell recommends using the default SDE policy, rather than Common or User. This ensures that any operating system files that are encrypted are accessible during times when the managed user is not logged in.

**Policy Proxy Connections**

String

List fully qualified Policy Proxy hostnames, or IP addresses, separated by carriage returns. Ports cannot be specified in this policy.

More...

Once a valid entry is found, the remainder of the Policy Proxies listed are ignored.

Entries are processed in the following order:

1. GKConnections Override (this registry entry overrides all other entries)
2. GKConnections (this registry entry is set automatically by the client, based on the this policy)
3. GK

To override this policy and specify ports via the registry key, set HKLM\Software\Microsoft\WindowsNT\CurrentVersion\
### Manage Policies

<table>
<thead>
<tr>
<th>Policy Description</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Policy Proxy Polling Interval | 360 | 1-1440 minutes  
The interval that the Encryption client attempts to poll Policy Proxy for policy updates, and send inventory information to Policy Proxy. The Encryption client also attempts to poll Policy Proxy each time a user logs on. |
| Allow Activations | Selected | This policy is available at the Enterprise, Domain, User Group, and User levels. This policy is used only by the Encryption client. Other applications do not have an activation policy setting. When this policy is selected, Encryption client activations are allowed. When this policy is not selected, activations are blocked. Blocking activations is useful for staggering activations, preventing activations during the initial Dell Server setup, or preventing activations during a maintenance interruption. |
| Current Shield State | Activate | Activate is the normal state for an encrypted user. A user must be in this state to activate a computer. Select Suspend to require recovery before the user can access the computer. When a user is suspended, encrypted data cannot be accessed. The user can be recovered by changing this policy to Activate, and committing the policy. |
| Enable Software Auto Updates | Not Selected | Selected enables the client update agent to automatically check for updates to Encryption client software. If this policy is not selected, Encryption client auto updates do not take place, regardless of other policy values. If this policy is selected, the On Premise Update Staging Location policy must have a network location in its value. |
| On Premise Update Staging Location | String | This policy defines the network location (UNC) where the Dell Server stages Encryption client update packages. If a network location is not specified in this policy, the Enable Software Auto Updates policy should not be published. |
| Update Check Period | 10080 | 1-43200 minutes (1 minute to 30 days)  
The period in minutes between checks for software auto updates. |
| Number of Policy Update Delays Allowed | 3 | 0-5000  
If Force Logoff/Reboot on Policy Updates is Selected, a non-zero value allows the user to delay the required logoff or reboot the specified number of times. Set to zero to disable delays. |
| Force Logoff / Reboot on Policy Updates | Selected | Selected requires either a logoff or a reboot in order for key policy updates to take effect. Otherwise, these policy updates take effect whenever the next logoff or reboot occurs. |
| Policy Viewer Enabled | Not Selected | When Selected, the user can view their encryption policies from the Encryption icon in the notification area. |
| Display Local Encryption Processing Control | Not Selected | When Selected, the user sees a menu option in the notification area icon that allows them to pause/resume encryption/decryption (depending on what the client is currently doing). |
### Important

**Allowing a user to pause encryption could allow the user to prevent the Encryption client from fully encrypting or decrypting data per policy.**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Suppress File Contention Notification</strong></td>
<td>Selected</td>
<td>This policy controls whether users see notification pop-ups if an application attempts to access a file while the client is processing it. More... If the client is processing a large file that an application needs, and this policy is Selected, it may appear that the application is unresponsive or slow to open (with no message indicating what the issue is). Care should be taken when using this policy.</td>
</tr>
<tr>
<td><strong>Number of Encryption Processing Delays Allowed</strong></td>
<td>0</td>
<td>0-5000 A non-zero value allows the user to delay any encryption processing required by the encryption policies you set, the specified number of times. Set to zero to disable delays.</td>
</tr>
</tbody>
</table>
| **Length of Each Encryption Processing Delay** | 5         | 5-40320 minutes If Number of Encryption Processing Delays Allowed has a non-zero value, use this policy to specify how often the user is prompted to continue with encryption processing or delay again. More... This prompt displays for five minutes each time. If the user does not respond to the prompt, encryption processing begins. The final delay prompt includes a countdown and progress bar, and it displays until the user responds, or the final delay expires and encryption processing begins. Calculate the maximum possible delay as follows (a maximum delay would involve the user responding to each delay prompt immediately prior to the 5-minute mark):

\[(\text{Number of Encryption Processing Delays Allowed} \times \text{Length of Each Encryption Processing Delay}) + (5 \text{ minutes} \times [\text{Number of Encryption Processing Delays Allowed} - 1])\] |
| **Length of Each Policy Update Delay**       | 15        | 5-40320 minutes If Number of Policy Update Delays Allowed has a non-zero value, use this policy to specify how often the user is prompted to logoff/reboot or delay again. More... This prompt displays for five minutes each time. If the user does not respond to the prompt, the next delay begins. The final delay prompt includes a countdown and progress bar, and it displays until the user responds, or the final delay expires and the required logoff/reboot occurs. You can change the behavior of the user prompt to begin or delay encryption, to prevent encryption processing following no user response to the prompt. To do this, set the registry key \text{SnoozeBeforeSweep} \{(\text{DWORD})\}, stored in HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\CMGShield, to a non-zero value. Any non-zero value will change the default behavior to snooze. With no user interaction, encryption processing is delayed up to the number of configurable allowed delays. When the final delay expires, encryption processing begins. Calculate the maximum possible delay as follows (a maximum delay would involve the user never responding to a delay prompt, each of which displays for 5 minutes):

\[(\text{Number of Policy Update Delays Allowed} \times \text{Length of Each Policy Update Delay}) + (5 \text{ minutes} \times [\text{Number of Policy Update Delays Allowed} - 1])\] |
<p>| <strong>Force Reboot on Update</strong>                   | Selected  | When selected, the computer immediately reboots to allow processing of encryption or updates related to device-based policy, such as System Data Encryption (SDE). |
| <strong>Length of Each Reboot Delay</strong>              | 15        | 5-40320 minutes The number of minutes to delay when the user chooses to delay reboot for device-based policy. |
| <strong>Number of Reboot Delays</strong>                 | 3         | 0-50000 |</p>
<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delays Allowed</td>
<td>The number of times the user is allowed to delay reboot for device-based policy.</td>
<td></td>
</tr>
<tr>
<td>Allow Encryption Processing Only When Screen is Locked</td>
<td>False</td>
<td>True, False, User-Optional When True, there is no encryption or decryption of data while the user is actively working. The client will only process data when the workstation screen is locked. When False, encryption processing occurs any time, even while the user is working. User-Optional adds an option to the notification area icon allowing the user to turn this feature on or off. Enabling this option will significantly extend the amount of time it takes to complete encryption or decryption.</td>
</tr>
<tr>
<td>Hide Overlay Icons</td>
<td>Selected</td>
<td>When Selected, Encryption overlay icons is not present on encrypted files in File Explorer for all managed users on the computer.</td>
</tr>
<tr>
<td>Encrypt temporary files</td>
<td>Off</td>
<td>When Off SDE Common</td>
</tr>
<tr>
<td>See basic settings</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**BitLocker Encryption**

This technology manages Microsoft BitLocker policies for full disk and removable media encryption.

- **Disable BitLocker on Self-Encrypting Drives**
  - Default Setting: Selected
  - Description: If Selected, BitLocker Manager does not start encryption on a volume that is already protected by a provisioned SED. For example, if this policy is Selected and both C: and D: are on one physical self-encrypting drive, and the PBA has been provisioned, then C: and D: does not encrypt for BitLocker even if System and Fixed drive encryption are turned on in the BitLocker Manager policies.

See basic settings

**BitLocker Encryption - Fixed Data Volume Settings**

- **Configure the Use of Smart Cards on Fixed Data Drives**
  - Default Setting: Allow
  - Description: This policy specifies whether smart cards can be used to authenticate access to BitLocker fixed data drives. These settings are enforced when turning on BitLocker, not when unlocking a drive. BitLocker will allow unlocking a drive with any of the protectors available on the drive.

- **Deny Write Access to Fixed Data Drives Not Protected by BitLocker**
  - Default Setting: Disabled
  - Description: If the drive is protected by BitLocker, it is mounted with read and write access. If you disable or do not configure this policy setting, all fixed data drives on the computer is mounted with read and write access. When Disabled, this policy element will force the option to be blocked from being used, and will not proceed unless it is met. When Enabled, this policy element will force the option to be used, and will not proceed unless it is met.

- **Allow Access to BitLocker Protected**
  - Default Setting: Selected
  - Description: Selected Not Selected
### Fixed Data Drives from Earlier Versions of Windows

When Selected, fixed data drives with the FAT file system can be unlocked and viewed on computers running Windows Server 2008. This policy does not apply to drives that are formatted with the NTFS file system. Set this policy to Selected and the Do Not Install BitLocker to Go Reader on FAT formatted Fixed Drives policy to Not Selected to allow BitLocker to Go Reader to be installed on the fixed drive.

### Do Not Install BitLocker to Go Reader on FAT Formatted Fixed Drives

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Selected</td>
<td>If this policy is Not Selected, BitLocker to Go Reader is installed on the fixed drive to enable users to unlock the drive on computers running Windows Server 2008. Set this policy to Not Selected and the Allow Access to BitLocker Protected Fixed Data Drives from Earlier Versions of Windows policy to Not Selected to allow BitLocker to Go Reader to be installed on the fixed drive.</td>
</tr>
</tbody>
</table>

### Configure Use of Passwords for Fixed Data Drives

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow</td>
<td>When set to Require, a connection to a domain controller is necessary to validate the complexity of the password. When set to Allow, a connection to a domain controller is attempted to validate complexity, but if no domain controller is found, the password will still be accepted. When set to Do Not Allow, no password complexity validation is done. To use this policy, Configure Use of Passwords for Fixed Data Drives must be set to Allow or Require.</td>
</tr>
</tbody>
</table>

### Configure Password Complexity for Fixed Data Drives

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Allow</td>
<td>When set to Require, a connection to a domain controller is necessary to validate the complexity of the password. When set to Allow, a connection to a domain controller is attempted to validate complexity, but if no domain controller is found, the password will still be accepted. When set to Do Not Allow, no password complexity validation is done. To use this policy, Configure Use of Passwords for Fixed Data Drives must be set to Allow or Require.</td>
</tr>
</tbody>
</table>

### Minimum Password Length for Fixed Data Drives

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Passwords must be at least 8 characters. To configure a greater minimum length for the password enter the desired number of characters. To use this policy, Configure Use of Passwords for Fixed Data Drives must be set to Allow or Require.</td>
</tr>
</tbody>
</table>

### Encryption Type for Fixed Data Drives

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Encryption</td>
<td>Select the type of encryption to use for Fixed Data Drives.</td>
</tr>
</tbody>
</table>

### Choose How BitLocker-protected Fixed Drives Can be Recovered

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Selected</td>
<td>BitLocker drives can always be recovered with BitLocker Manager, even if this value is Not Selected. This policy allows for the control of how BitLocker protected fixed data drives are recovered in the absence of the required credentials. This policy is the parent policy to: Allow Data Recovery Agent for Protected Fixed Data Drives Config User Storage of BitLocker 48-digit Recovery Password Config User Storage of BitLocker 256-bit Recovery Key Omit Recovery Options from the BitLocker Setup Wizard Save BitLocker Recovery Info to AD DS for Fixed Data Drives BitLocker Recovery Info to Store in AD DS</td>
</tr>
</tbody>
</table>

---

161
<table>
<thead>
<tr>
<th>Policy Description</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow Data Recovery Agent for Protected Fixed Data Drives</strong></td>
<td><strong>Selected</strong></td>
<td>When Selected, a data recovery agent is allowed for use with BitLocker protected fixed data drives. Before the agent can be used, it must be added from the Public Key Policies in either the Group Policy Management Console or the Local Group Policy Editor. When setting this policy to Selected, the Choose How BitLocker-protected Fixed Drives Can be Recovered policy must also be set to Selected.</td>
</tr>
<tr>
<td><strong>Configure User Storage of BitLocker 48-digit Recovery Password</strong></td>
<td><strong>Allow</strong></td>
<td>This policy determines if a user is allowed, required, or not allowed to generate a 48-digit password. When setting this policy to Allow or Require, the Choose How BitLocker-protected Fixed Drives Can be Recovered policy must also be set to Selected.</td>
</tr>
<tr>
<td><strong>Configure User Storage of BitLocker 256-bit Recovery Key</strong></td>
<td><strong>Allow</strong></td>
<td>This policy determines if a user is allowed, required, or not allowed to generate a 256-bit recovery key. When setting this policy to Allow or Require, the Choose How BitLocker-protected Fixed Drives Can be Recovered policy must also be set to Selected.</td>
</tr>
<tr>
<td><strong>Omit Recovery Options from the BitLocker Setup Wizard</strong></td>
<td><strong>Not Selected</strong></td>
<td>When Selected, users are prevented from specifying recovery options when BitLocker is enabled. Recovery options for the drive are determined by policy settings. When setting this policy to Not Selected, the Choose How BitLocker-protected Fixed Drives Can be Recovered policy must also be set to Selected.</td>
</tr>
<tr>
<td><strong>Save BitLocker Recovery Information to AD DS for Fixed Data Drives</strong></td>
<td><strong>Selected</strong></td>
<td>Selected allows BitLocker recovery information to be stored in AD DS for fixed data drives. BitLocker recovery information is always saved to the Dell Server. Enabling this policy additionally saves the information to AD. More... The appropriate schema extensions and access control settings on the domain must be first configured before AD DS backup can succeed. When setting this policy to Selected, the Choose How BitLocker-protected Fixed Drives Can be Recovered policy must also be set to Selected. Set this policy to Selected to use the policy BitLocker Recovery Information to Store in AD DS.</td>
</tr>
<tr>
<td><strong>BitLocker Recovery Information to Store in AD DS</strong></td>
<td>Recovery Passwords and Key Packages</td>
<td>This policy provides the option of storing recovery passwords and key packages, or storing the recovery password only in AD DS. The appropriate schema extensions and access control settings on the domain must be first configured before applying this policy. The Choose How BitLocker-protected Fixed Drives Can be Recovered policy must be set to Selected to use this policy. To use this policy, Save BitLocker Recovery Information to AD DS for Fixed Data Drives must be set to Selected.</td>
</tr>
<tr>
<td><strong>Do Not Enable BitLocker Until Recovery Information is</strong></td>
<td><strong>Not Selected</strong></td>
<td>Although BitLocker recovery information is automatically stored in the Dell Server, this policy additionally requires BitLocker drive encryption recovery policy.</td>
</tr>
<tr>
<td>Stored in AD DS for Fixed Data Drives</td>
<td>information to be stored in AD DS. The appropriate schema extensions and access control settings on the domain must be configured before using this policy. More... This policy is used to prevent users from enabling BitLocker unless the computer is connected to the domain and the backup of the BitLocker recovery information to AD DS has succeeded. The Choose How BitLocker-protected Fixed Drives Can Be Recovered policy must be set to Selected to use this policy.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Configure Use of Hardware-Based Encryption for Fixed Data Drives</td>
<td>Selected</td>
<td>Selected enables the configuration of hardware-based encryption on fixed data drives.</td>
</tr>
<tr>
<td></td>
<td>Not Selected</td>
<td>PARENT to the next 4 policies.</td>
</tr>
<tr>
<td>Use Hardware-Based Encryption for Fixed Data Drives</td>
<td>Selected</td>
<td>Selected enables hardware-based encryption for fixed data drives. To use this policy, Configure Use of Hardware-Based Encryption for Fixed Data Drives must be set to Selected.</td>
</tr>
<tr>
<td>Use BitLocker Software-Based Encryption on Fixed Data Drives When Hardware Encryption Is Not Available</td>
<td>Selected</td>
<td>Selected enables BitLocker software-based encryption on fixed data drives if hardware-based encryption is not available. To use this policy, Configure Use of Hardware-Based Encryption for Fixed Data Drives must be set to Selected.</td>
</tr>
<tr>
<td>Restrict Crypto Algorithms and Cipher Suites Allowed for Hardware-Based Encryption on Fixed Data Drives</td>
<td>Not Selected</td>
<td>Selected allows only specific crypto algorithm and cipher suites for BitLocker hardware encryption on fixed data drives. To use this policy, Configure Use of Hardware-Based Encryption for Fixed Data Drives must be set to Selected.</td>
</tr>
<tr>
<td>Configure Specific Crypto Algorithms and Cipher Suites Settings on Fixed Data Drives</td>
<td>String</td>
<td>String - 2.16.840.1.101.3.4.1.2; 2.16.840.1.101.3.4.1.42 Set specific Crypto Algorithms and Cipher Suites on fixed data drives. To use this policy, Configure Use of Hardware-Based Encryption for Fixed Data Drives must be set to Selected.</td>
</tr>
</tbody>
</table>

See basic settings

**Bitlocker Encryption - Global Settings**

<table>
<thead>
<tr>
<th>Default Folder Location to Save Recovery Password</th>
<th>Qualified path Important: This policy is not used by BitLocker Manager, because it does not prompt the user when saving recovery passwords. Microsoft defines this policy as: This setting provides the default path that is displayed when the BitLocker drive encryption setup wizard prompts the user to enter the location of a folder to save the recovery password. The text in this policy is translatable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption Method and Cipher Strength</td>
<td>AES 128 with Diffuser AES 256 with Diffuser AES 128 AES 256 This policy specifies the encryption method and cipher strength used for BitLocker drive encryption. Changing this policy has no effect if the drive is already encrypted or encryption is in progress.</td>
</tr>
<tr>
<td>Enable Organizational Unique Identifiers</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Manage Policies</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Set Organizational Unique Identifiers</strong></td>
<td>The allowed identification field is used in combination with the Deny Write Access to Removable Drives Not Protected by BitLocker policy to help control the use of removable drives in the organization. This policy must be set to Selected to use the policies Set Organizational Unique Identifiers and Set Allowed Organizational Unique Identifiers.</td>
</tr>
<tr>
<td><strong>Set Allowed Organizational Unique Identifiers</strong></td>
<td>The allowed identification field is used in combination with the Deny Write Access to Removable Drives Not Protected by BitLocker policy to help control the use of removable drives in the organization. It is a comma separated list of identification fields from your organization or other external organizations. To use this policy, Enable Organizational Unique Identifiers must be set to Selected.</td>
</tr>
<tr>
<td><strong>Prevent Memory Overwrite on Restart</strong></td>
<td>Selected prevents memory from being overwritten on restart. Preventing memory overwrite may improve restart performance, but will increase the risk of exposing BitLocker secrets. When Not Selected, BitLocker secrets are removed from memory when the computer restarts.</td>
</tr>
<tr>
<td><strong>Enable Smart Card Certificate Identifier</strong></td>
<td>This policy allows or denies an object identifier to be specified for enhanced key usage with a certificate. This policy must be set to Selected to use the policy Smart Card Certificate Identifier.</td>
</tr>
<tr>
<td><strong>Smart Card Certificate Identifier</strong></td>
<td>1.3.6.1.4.1.311.67.1.1 This policy provides for an object identifier to be specified for enhanced key usage with a certificate. BitLocker can identify which certificates may be used to authenticate a user certificate to a BitLocker drive by matching the object identifier in the certificate with the object identifier that is defined by this policy. Use caution if changing the default value. To use this policy, Enable Smart Card Certificate Identifier must be set to Selected.</td>
</tr>
<tr>
<td><strong>See basic settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>BitLocker Encryption - Operating System Volume Settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Allow Enhanced PINs for Startup</strong></td>
<td>Selected allows enhanced startup PINs to be used with BitLocker. Enhanced startup PINs permit the use of characters including uppercase and lowercase letters, symbols, numbers, and spaces. This policy setting is applied when you turn on BitLocker.</td>
</tr>
<tr>
<td><strong>Number of Characters Required in PIN</strong></td>
<td>4-20 digits This policy configures the minimum length for a TPM startup PIN. The startup PIN must have a minimum length of 4 digits and can have a</td>
</tr>
<tr>
<td><strong>Number of Characters Required in PIN</strong></td>
<td>4-20 digits This policy configures the minimum length for a TPM startup PIN. The startup PIN must have a minimum length of 4 digits and can have a</td>
</tr>
<tr>
<td>Policy Description</td>
<td>Default Setting</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Allow Network Unlock at Startup on Operating System Drives</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Allow SecureBoot on Operating System Drives</td>
<td>Selected</td>
</tr>
<tr>
<td>Disallow Standard Users from Changing the PIN on Operating System Drives</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Enable Use of Preboot Keyboard Input on Slates</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Reset Platform Validation Data After Recovery</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Choose How BitLocker-protected Operating System Drives Can be Recovered</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Allow Data Recovery Agent for Protected Operating System Drives</td>
<td>Selected</td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 48-digit Recovery Password</td>
<td>Allow</td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 256-bit Recovery Key</td>
<td>Allow</td>
</tr>
</tbody>
</table>
### Omit Recovery Options from the BitLocker Setup Wizard

**Selected**

When selected, users are prevented from specifying recovery options when BitLocker is enabled. Recovery options for the drive are determined by policy settings.

To use this policy, Choose How BitLocker-protected Operating System Drives Can be Recovered must be set to Selected.

**Not Selected**

### Save BitLocker Recovery Information to AD DS for Operating System Drives

**Selected**

Selected allows BitLocker recovery information to be stored in AD DS for operating system drives. The appropriate schema extensions and access control settings on the domain must be first configured before AD DS backup can succeed.

To use this policy, Choose How BitLocker-protected Operating System Drives Can be Recovered must be set to Selected.

### BitLocker Recovery Information to Store in AD DS (Windows Server 2008 Only)

**Recovery Passwords and Key Packages**

This policy provides the option of storing recovery passwords and key packages, or storing the recovery password only in AD DS. The appropriate schema extensions and access control settings on the domain must be first configured before applying this policy.

This policy is applicable only to computers running Windows Server 2008.

To use this policy, Choose How BitLocker-protected Operating System Drives Can be Recovered must be set to Selected.

**Recovery Passwords Only**

### Do Not Enable BitLocker Until Recovery Information is Stored in AD DS for Operating System Drives

**Not Selected**

Although BitLocker recovery information is automatically stored in the Dell Server, this policy additionally requires BitLocker drive encryption recovery information to be stored in AD DS. The appropriate schema extensions and access control settings on the domain must be configured before using this policy.

This policy is used to prevent users from enabling BitLocker unless the computer is connected to the domain and the backup of the BitLocker recovery information to AD DS has succeeded.

To use this policy, Choose How BitLocker-protected Operating System Drives Can be Recovered must be set to Selected.

### Configure Use of Hardware-Based Encryption for Operating System Drives

**Selected**

Selected enables the configuration of hardware-based encryption on operating system drives.

**Not Selected**

PARENT to the next 4 policies.

### Use Hardware-Based Encryption for Operating System Drives

**Selected**

Selected enables hardware-based encryption on operating system drives.

To use this policy, Configure Use of Hardware-Based Encryption for Operating System Drives must be set to Selected.

### Use BitLocker Software-Based Encryption on Operating System Drives When Hardware Encryption is Not Available

**Selected**

Selected enables BitLocker software-based encryption on operating system drives if hardware-based encryption is not available.

To use this policy, Configure Use of Hardware-Based Encryption for Operating System Drives must be set to Selected.

### Restrict Crypto Algorithms and Cipher Suites Allowed for Hardware-Based Encryption on

**Not Selected**

Selected allows only specific crypto algorithm and cipher suites for BitLocker hardware encryption on operating system drives.

To use this policy, Configure Use of Hardware-Based Encryption for Operating System Drives must be set to Selected.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Specific Crypto Algorithms and Cipher Suites Settings on Operating System Drives</td>
<td>2.16.840.1.101.3.4.1.2;2.16.840.1.101.3.4.1.42</td>
<td>Specific Crypto Algorithms and Cipher Suites allowed on operating system drives. To use this policy, Configure Use of Hardware-Based Encryption for Operating System Drives must be set to Selected.</td>
</tr>
<tr>
<td>Encryption Type for Operating System Drives</td>
<td>Full Encryption</td>
<td>Full Encryption Used Space Only Encryption Select the type of encryption to use for operating system drives.</td>
</tr>
<tr>
<td>Configure Use of Passwords for Operating System Drives</td>
<td>Not Configured</td>
<td>Configure password requirements for Operating System Drives. When Disabled, this policy element will force the option to be blocked from being used, and will not proceed until it is met. When Enabled, this policy element will force the option to be used, and will not proceed unless it is met. When Not Configured, this policy element will consume the default action to do nothing.</td>
</tr>
<tr>
<td>Configure Password Complexity for Operating System Drives</td>
<td>Allow</td>
<td>Require Do Not Allow When set to Require, a connection to a domain controller is necessary to validate the complexity of the password. When set to Allow, a connection to a domain controller is attempted to validate complexity, but if no domain controller is found, the password will still be accepted. When set to Do Not Allow, no password complexity validation is done. To use this policy, Configure Use of Passwords for Operating System Drives must be set to Enabled.</td>
</tr>
<tr>
<td>Minimum Password Length for Operating System Drives</td>
<td>8</td>
<td>8-256 The default value is a password length of 8 characters. 8-256 characters are allowed. To use this policy, Configure Use of Passwords for Operating System Drives must be set to Enabled.</td>
</tr>
<tr>
<td>Require ASCII-Only Passwords for Operating System Drives</td>
<td>Not Selected</td>
<td>Require ASCII-only passwords for operating system drives to create stronger passwords. To use this policy, Configure Use of Passwords for Operating System Drives must be set to Enabled.</td>
</tr>
<tr>
<td>Use Enhanced Boot Configuration Data Profile</td>
<td>Disabled</td>
<td>Set this policy to Enable to allow the verification and exclusion of BCD settings. When Disabled, this policy element will force the option to be blocked from being used, and will not proceed until it is met. When Enabled, this policy element will force the option to be used, and will not proceed unless it is met. When Not Configured, this policy element will consume the default action to do nothing.</td>
</tr>
<tr>
<td>Verify Additional BCD Settings</td>
<td>String</td>
<td>Specify the additional Boot Configuration settings. To use this policy, Use Enhanced Boot Configuration Data Profile must be set to Enabled.</td>
</tr>
<tr>
<td>Exclude Additional</td>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>Feature</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>BCD Settings</strong></td>
<td></td>
<td>Exclude specific Boot Configuration settings. To use this policy, Use Enhanced Boot Configuration Data Profile must be set to Enabled.</td>
</tr>
<tr>
<td><strong>Configure TPM Platform Validation Profile</strong></td>
<td>Not Selected</td>
<td><strong>Selected</strong>&lt;br&gt;Not Selected&lt;br&gt;Set to Selected to enable boot up TPM drive unlocking for Windows 7 and Windows Server 2008 R2. Selected allows the configuration of how the TPM security hardware secures the BitLocker encryption key. This policy does not apply if the computer does not have a compatible TPM or if BitLocker has already been turned on with TPM protection. This policy must be set to Selected to use the policy Configure Specific TPM Platform Settings. See <a href="http://technet.microsoft.com/en-us/library/jj679890.aspx#BKMK_depopt3">http://technet.microsoft.com/en-us/library/jj679890.aspx#BKMK_depopt3</a> for more information.</td>
</tr>
<tr>
<td><strong>Configure Specific TPM Platform Settings</strong></td>
<td></td>
<td><strong>PCRO, on</strong>&lt;br&gt;<strong>PCR1, off</strong>&lt;br&gt;<strong>PCR2, on</strong>&lt;br&gt;<strong>PCR3, off</strong>&lt;br&gt;<strong>PCR4, on</strong>&lt;br&gt;<strong>PCR5, on</strong>&lt;br&gt;<strong>PCR6, off</strong>&lt;br&gt;<strong>PCR7, off</strong>&lt;br&gt;<strong>PCR8, on</strong>&lt;br&gt;<strong>PCR9, on</strong>&lt;br&gt;<strong>PCR10, on</strong>&lt;br&gt;<strong>PCR11, on</strong>&lt;br&gt;<strong>PCR12, off</strong>&lt;br&gt;<strong>PCR13, off</strong>&lt;br&gt;<strong>PCR14, off</strong>&lt;br&gt;<strong>PCR15, off</strong>&lt;br&gt;<strong>PCR16, off</strong>&lt;br&gt;<strong>PCR17, off</strong>&lt;br&gt;<strong>PCR18, off</strong>&lt;br&gt;<strong>PCR19, off</strong>&lt;br&gt;<strong>PCR20, off</strong>&lt;br&gt;<strong>PCR21, off</strong>&lt;br&gt;<strong>PCR22, off</strong>&lt;br&gt;<strong>PCR23, off</strong>&lt;br&gt;This policy allows you to configure how the computer’s TPM security hardware secures the BitLocker encryption key. This policy setting does not apply if the computer does not have a compatible TPM or if BitLocker has already been turned on with TPM protection. This setting determines what values the TPM measures when it validates early boot components before unlocking a drive on a computer running Windows 7 or Windows Server 2008 R2. More... If you enable this policy before turning on BitLocker, you can configure the boot components that the TPM will validate before unlocking access to the BitLocker-encrypted operating system drive. If any of these components change while BitLocker protection is in effect, the TPM does not release the encryption key to unlock the drive and the computer will instead display the BitLocker recovery console and require that either the recovery password or recovery key be provided to unlock the drive. If you disable or do not configure this policy, the TPM uses the default platform validation profile or the platform validation profile specified by the setup script. A platform validation profile consists of a set of Platform Configuration Register (PCR) indices ranging from 0 to 23. The default platform validation profile secures the encryption key against changes to the Core Root of Trust of Measurement (CRTM), BIOS, and Platform Extensions (PCR 0), the Option ROM Code (PCR 2), the Master Boot Record (MBR) Code (PCR 4), the NTFS Boot Sector (PCR 8), the NTFS Boot Block (PCR 9), the Boot Manager (PCR 10), and the BitLocker Access Control (PCR 11). The descriptions of PCR settings for computers that use an Extensible Firmware Interface (EFI) are different than the PCR settings described for computers that use a standard BIOS. The BitLocker Drive Encryption Deployment Guide on Microsoft TechNet contains a complete list of PCR settings for both EFI and standard BIOS. Caution: Changing from the default platform validation profile affects the security and manageability of your computer. BitLocker’s sensitivity to platform modifications (malicious or authorized) is increased or decreased depending upon inclusion or exclusion (respectively) of the PCRs. To use this policy, Configure TPM Platform Validation Profile must be set to True.</td>
</tr>
<tr>
<td><strong>Configure BIOS TPM Platform Validation Profile</strong></td>
<td>Not Selected</td>
<td><strong>Selected</strong>&lt;br&gt;Not Selected&lt;br&gt;Set to Selected to enable boot up BIOS TPM drive unlocking. Selected allows the configuration of how the BIOS TPM security hardware secures the BitLocker encryption key. This policy does not apply if the computer does not have a compatible TPM or if BitLocker has already been turned on with TPM protection. This policy must be set to Selected to use the policy Configure Specific BIOS TPM Platform Settings. See <a href="http://technet.microsoft.com/en-us/library/jj679890.aspx#BKMK_tpmbios">http://technet.microsoft.com/en-us/library/jj679890.aspx#BKMK_tpmbios</a> for more information.</td>
</tr>
</tbody>
</table>
| Configure Specific BIOS TPM Platform Settings | PCR0, on  
PCR1, off  
PCR2, on  
PCR3, off  
PCR4, on  
PCR5, off  
PCR6, off  
PCR7, off  
PCR8, on  
PCR9, on  
PCR10, on  
PCR11, on  
PCR12, off  
PCR13, off  
PCR14, off  
PCR15, off  
PCR16, off  
PCR17, off  
PCR18, off  
PCR19, off  
PCR20, off  
PCR21, off  
PCR22, off  
PCR23, off  |
|------------------------------------------------|
| This policy setting allows you to configure how the computer’s TPM security hardware secures the BitLocker encryption key. This setting determines what values the TPM measures when it validates early boot components before unlocking an operating system drive on a computer with BIOS configuration or with UEFI firmware that has the Compatibility Support Module (CSM) enabled.  
If you enable this policy before turning on BitLocker, you can configure the boot components that the TPM will validate before unlocking access to the BitLocker-encrypted operating system drive. If any of these components change while BitLocker protection is in effect, the TPM does not release the encryption key to unlock the drive and the computer will instead display the BitLocker recovery console and require that either the recovery password or recovery key be provided to unlock the drive.  
To use this policy, Configure BIOS TPM Platform Validation Profile must be set to Selected. |

<table>
<thead>
<tr>
<th>Configure UEFI TPM Platform Validation Profile</th>
<th>Not Selected</th>
</tr>
</thead>
</table>
| This policy setting allows you to configure how the computer’s TPM security hardware secures the BitLocker encryption key. This setting determines what values the TPM measures when it validates early boot components before unlocking an operating system drive on a computer with native UEFI firmware configurations.  
If you enable this policy before turning on BitLocker, you can configure the boot components that the TPM will validate before unlocking access to the BitLocker-encrypted operating system drive. If any of these components change while BitLocker protection is in effect, the TPM does not release the encryption key to unlock the drive and the computer will instead display the BitLocker recovery console and require that either the recovery password or recovery key be provided to unlock the drive.  
To use this policy, Configure UEFI TPM Platform Validation Profile must be set to Selected. |

See [basic settings](http://technet.microsoft.com/en-us/library/jj679890.aspx#BKMK_tpmvaluefi) for more information.
### Bitlocker Encryption - Removable Storage Settings

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow User to Apply BitLocker Protection on Removable Drives</td>
<td>Selected</td>
<td>When Selected, users are permitted to run the BitLocker setup wizard on a removable data drive.</td>
</tr>
<tr>
<td>Allow User to Suspend and Decrypt BitLocker Protection on Removable Data Drives</td>
<td>Selected</td>
<td>When Selected, users are authorized to suspend and decrypt BitLocker protection on removable data drives.</td>
</tr>
<tr>
<td>Configure Use of Smart Cards on Removable Data Drives</td>
<td>Allow</td>
<td>This policy specifies whether smart cards can be used to authenticate access to BitLocker removable data drives. These settings are enforced when turning on BitLocker, not when unlocking a drive. BitLocker will allow unlocking a drive with any of the protectors available on the drive.</td>
</tr>
<tr>
<td>Deny Write Access to Removable Drives Not Protected by BitLocker</td>
<td>Disabled</td>
<td>If this policy is enabled, all removable drives that are not BitLocker protected are mounted as read only. If this policy is disabled, all removable drives on the computer are mounted with read and write access.</td>
</tr>
<tr>
<td>Allow Access to BitLocker Protected Removable Data Drives from Earlier Versions of Windows</td>
<td>Selected</td>
<td>When Selected, removable data drives with the FAT file system can be unlocked on computers running Windows Server 2008. This policy does not apply to drives that are formatted with the NTFS file system.</td>
</tr>
<tr>
<td>Do Not Install BitLocker to Go Reader on FAT formatted Removable Drives</td>
<td>Not Selected</td>
<td>If this policy is Not Selected, removable data drives formatted with the FAT file system that are BitLocker protected cannot be unlocked on computers running Windows Server 2008. Bitlockertogo.exe is not installed.</td>
</tr>
<tr>
<td>Configure Use of Passwords for Removable Data Drives</td>
<td>Allow</td>
<td>This policy specifies whether a password is required to unlock BitLocker removable data drives. These settings allow the use of a password, require the use of a password, or disallow the use of a password. This policy must be set to Allow or Require to use the Configure Password Complexity for Removable Data Drives and Minimum Password Length for Removable Data Drives polices.</td>
</tr>
<tr>
<td>Configure Password Complexity for Removable Data Drives</td>
<td>Allow</td>
<td>This policy specifies whether a password is required to unlock BitLocker removable data drives. These settings allow the use of a password, require the use of a password, or disallow the use of a password. This policy must be set to Allow or Require to use the Configure Password Complexity for Removable Data Drives and Minimum Password Length for Removable Data Drives polices.</td>
</tr>
<tr>
<td>Minimum Password Length for Removable Data Drives</td>
<td>8</td>
<td>Passwords must be at least 8 characters in length, with a maximum of 20 characters. To use this policy, Configure Use of Passwords for Removable Data Drives must be set to Allow or Require.</td>
</tr>
<tr>
<td>Security Management Server v10.2.7 AdminHelp</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Encryption Type for Removable Data Drives</strong></td>
<td>Full Encryption</td>
<td></td>
</tr>
<tr>
<td>Allow User to Choose</td>
<td>Full Encryption</td>
<td></td>
</tr>
<tr>
<td>Used Space Only Encryption</td>
<td>Select the type of encryption to use for Removable Data Drives.</td>
<td></td>
</tr>
<tr>
<td>Choose How BitLocker-protected Removable Drives Can be Recovered</td>
<td>Not Selected</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>Not Selected</td>
<td></td>
</tr>
<tr>
<td>BitLocker drives can always be recovered with BitLocker Manager, even if this value is Not Selected. This policy allows for the control of how BitLocker protected removable data drives are recovered in the absence of the required credentials.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>More...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>This policy is the parent policy to:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Data Recovery Agent for Protected Removable Data Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 48-digit Recovery Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 256-bit Recovery Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Recovery Options from the BitLocker Setup Wizard for Removable Media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save BitLocker Recovery Information to AD DS for Removable Data Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BitLocker Recovery Info to Store in AD DS for Removable Data Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do Not Enable BitLocker Until Recovery Info is Stored in AD DS for Removable Data Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Data Recovery Agent for Protected Removable Data Drives</td>
<td>Selected</td>
<td></td>
</tr>
<tr>
<td>Not Selected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When Selected, a data recovery agent is allowed for use with BitLocker protected removable data drives. Before the agent can be used, it must be added from the Public Key Policies in either the Group Policy Management Console or the Local Group Policy Editor.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 48-digit Recovery Password</td>
<td>Allow</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Require</td>
<td>Do Not Allow</td>
<td></td>
</tr>
<tr>
<td>This policy configures if a user is allowed, required, or not allowed to generate a 48-digit password.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure User Storage of BitLocker 256-bit Recovery Key</td>
<td>Allow</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Require</td>
<td>Do Not Allow</td>
<td></td>
</tr>
<tr>
<td>This policy configures if a user is allowed, required, or not allowed to generate a 256-bit recovery key.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Recovery Options from the BitLocker Setup Wizard for Removable Media</td>
<td>Not Selected</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>Not Selected</td>
<td></td>
</tr>
<tr>
<td>When Selected, users are prevented from specifying recovery options when BitLocker is enabled. Recovery options for the drive are determined by policy settings.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save BitLocker Recovery Information to AD DS for Removable Data Drives</td>
<td>Selected</td>
<td></td>
</tr>
<tr>
<td>Not Selected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selected allows BitLocker recovery information to be stored in AD DS for removable data drives. The appropriate schema extensions and access control settings on the domain must be first configured before AD DS backup can succeed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set this policy to Selected to use the policy BitLocker Recovery Information...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Policy</td>
<td>Default Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BitLocker Recovery Information to Store in AD DS for Removable Data Drives</td>
<td>Recovery Passwords and Key Packages</td>
<td>This policy provides the option of storing recovery passwords and key packages, or storing the recovery password only in AD DS. The appropriate schema extensions and access control settings on the domain must be first configured before applying this policy. To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected. To use this policy, Save BitLocker Recovery Information to AD DS for Removable Data Drives must be set to Selected.</td>
</tr>
</tbody>
</table>
| Do Not Enable BitLocker Until Recovery Information is Stored in AD DS for Removable Data Drives | Not Selected | Selected  
Not Selected  
PARENT to the next 4 policies.  
Selected enables the configuration of hardware-based encryption on removable data drives.  
Although BitLocker recovery information is automatically stored in the Dell Server, this policy additionally requires BitLocker drive encryption recovery information to be stored in AD DS. The appropriate schema extensions and access control settings on the domain must be configured before using this policy.  
This policy is used to prevent users from enabling BitLocker unless the computer is connected to the domain and the backup of the BitLocker recovery information to AD DS has succeeded.  
To use this policy, Choose How BitLocker-protected Removable Drives Can be Recovered must be to Selected. |
| Configure Use of Hardware-Based Encryption for Removable Data Drives | Selected | Not Selected  
PARENT to the next 4 policies.  
Selected enables the configuration of hardware-based encryption on removable data drives. |
| Use Hardware-Based Encryption for Removable Data Drives | Selected | Not Selected  
Selected enables hardware-based encryption on removable data drives.  
To use this policy, Configure Use of Hardware-Based Encryption for Removable Data Drives must be set to Selected. |
| Use BitLocker Software-Based Encryption on Removable Data Drives When Hardware Encryption is Not Available | Selected | Not Selected  
Selected enables BitLocker software-based encryption on removable data drives if hardware-based encryption is not available.  
To use this policy, Configure Use of Hardware-Based Encryption for Removable Data Drives must be set to Selected. |
| Restrict Crypto Algorithms and Cipher Suites Allowed for Hardware-Based Encryption on Removable Data Drives | Not Selected | Selected  
Not Selected  
Selected allows only specific crypto algorithm and cipher suites for BitLocker hardware encryption.  
To use this policy, Configure Use of Hardware-Based Encryption for Removable Data Drives must be set to Selected. |
| Configure Specific Crypto Algorithms and Cipher Suites Settings on Removable Data Drives | 2.16.840.1.101.3.4.1.2;2.16.840.1.101.3.4.1.42 | String - 2.16.840.1.101.3.4.1.2; 2.16.840.1.101.3.4.1.42  
Specific Crypto Algorithms and Cipher Suites allowed.  
To use this policy, Configure Use of Hardware-Based Encryption for Removable Data Drives must be set to Selected. |

See basic settings
## Server Encryption
This technology manages Dell's data centric encryption using certificate-based authentication instead of the typical user-based authentication instead of the typical user-based authentication. This technology allows for protection of devices such as Windows Servers that do not commonly have users logged in.

| Server Encryption | Off | On
|-------------------|-----|---
| This policy enables or disables System Data Encryption (SDE) and Common encryption on the client server.
| Changing the value of this policy triggers a new sweep to encrypt/decrypt files. |
| Allow Software Server Encryption | Selected | Not Selected
| If this policy is Selected, client servers are activated at the Enterprise level. This policy may be set to Not Selected to block activations during initial Dell Server setup and maintenance interruptions. |
| Max Network Failed Attempts | 3 | 1-10
| Number of successive failed attempts for a client server to connect to the Dell Server before encryption keys are locked. |
| Retry Interval to connect to Dell Server | 5 | 1-60 minutes
| Time interval for the client server to attempt to connect to the Dell Server. |
| Retry if Authentication Fails Upon Network Failure | Selected | Not Selected
| If Selected, the client server continues to attempt to contact the Dell Server if the first attempt fails due to a network failure. |
| Retry Interval Upon Network Failure | 10 | 10-60 minutes
| The length of time between attempts to contact the Dell Server if the first attempt fails due to a network failure. The Retry if Authentication Fails Upon Network Failure policy must be set to Selected for this policy to be enforced. |
| Server Maintenance Schedule | Not Selected | This policy must be selected to use all other Server Maintenance policies. If this policy is Not Selected, no Server Maintenance policies are enforced, regardless of other policy values. Selected allows a maintenance schedule to control application of policy that requires a reboot. |
| Server Maintenance Schedule Repeats | Weekly | Daily, Weekly, Monthly, Quarterly, Annually
The schedule configuration defines when the task should run.
Daily: Runs the task every day at the specified Server Maintenance Schedule Start Time.
Weekly: Runs the task weekly on the days specified in Server Maintenance Day of the Week.
Monthly: Runs the task monthly on the specified Server Maintenance Day of the Month.
Quarterly: Runs the task quarterly on the specified Server Maintenance Day of the Month.
Annually: Runs the task annually on the specified Server Maintenance Day of the Month. |
| Server Maintenance Schedule Start Time | 21:00 | Format is HH:mm. Example: 23:59
The time the task should run. |
| Server Maintenance Day of the Week | Saturday | Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
The day of the week the task should run. |
| Server Maintenance Day of the Month | 1 | 1-31
The day of the month the task should run.
Example: 17. |
| Infinite Suppress | Not Selected | When Selected, an automatic reboot is suppressed indefinitely. |
| Port Control System | Disabled | Enable or Disable all Port Control System policies. If this policy is set to Disable, no Port Control System policies are applied, regardless of other |
### Manage Policies

*Port Control System policies. All PCS policies require a reboot before the policy takes effect.*

<table>
<thead>
<tr>
<th>Port: Express Card Slot</th>
<th>Enabled</th>
<th>Enable, Disable, or Bypass ports exposed through the Express Card Slot.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port: USB</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to external USB ports. <strong>Note:</strong> USB port-level blocking and HID class-level blocking is only honored if we can identify the computer chassis as a laptop/notebook form-factor. We rely on the computer's BIOS for the identification of the chassis.</td>
</tr>
<tr>
<td>Port: eSATA</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to external SATA ports.</td>
</tr>
<tr>
<td>Port: PCMCIA</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to PCMCIA ports.</td>
</tr>
<tr>
<td>Port: Firewire (1394)</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to external Firewire (1394) ports.</td>
</tr>
<tr>
<td>Port: SD</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to SD card ports.</td>
</tr>
<tr>
<td>Port: Memory Transfer Device (MTD)</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass access to Memory Transfer Device (MTD) ports.</td>
</tr>
<tr>
<td>Class: Storage</td>
<td>Enabled</td>
<td>PARENT to the next 3 policies. Set this policy to Enabled to use the next 3 Subclass Storage policies. Setting this policy to Disabled disables all 3 Subclass Storage policies - no matter what their value.</td>
</tr>
<tr>
<td>Subclass Storage: External Drive Control</td>
<td>Full Access</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. This policy interacts with the EMS Access to unShielded Media policy. If you intend to have Full Access to media, also set this policy to Full Access to ensure that the media is not set to read only and the port is not blocked. Full Access: External drive port does not have read/write data restrictions applied Read Only: Allows read capability /write data is disabled Blocked: Port is blocked from read/write capability This policy is endpoint-based and cannot be overridden by user policy.</td>
</tr>
<tr>
<td>Subclass Storage: Optical Drive Control</td>
<td>UDF Only</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. Full Access: Optical Drive port does not have read/write data restrictions applied UDF Only: Blocks all data writes that are not in the UDF format (CD/DVD burning, ISO burning). Read data is enabled. Read Only: Allows read capability. Write data is disabled Blocked: Port is blocked from read/write capability This policy is endpoint-based and cannot be overridden by user policy. Universal Disk Format (UDF) is an implementation of the specification known as ISO/IEC 13346 and ECMA-167 and is an open vendor-neutral file system for computer data storage for a broad range of media. To encrypt data written to CD/DVD media: Set EMS Encrypt External Media = Selected, EMS Exclude CD/DVD Encryption = Not Selected, and Storage Class: Optical Drive Control = UDF Only.</td>
</tr>
<tr>
<td>Subclass Storage: Floppy Drive Control</td>
<td>Read Only</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. Full Access: Floppy Drive port does not have read/write data restrictions applied Read Only: Allows read capability. Write data is disabled Blocked: Port is blocked from read/write capability This policy is endpoint-based and cannot be overridden by user policy.</td>
</tr>
<tr>
<td>Class: Windows Portable Device (WPD)</td>
<td>Enabled</td>
<td>PARENT to the next policy. Set this policy to Enabled to use the Subclass Windows Portable Device (WPD): Storage policy. Setting this policy to Disabled disables the Subclass Windows Portable Device (WPD): Storage policy - no matter what its value. Control access to all Windows Portable Devices.</td>
</tr>
<tr>
<td>Subclass Windows Portable Device</td>
<td>Full Access</td>
<td>CHILD of Class: Windows Portable Device (WPD). Class: Windows Portable Device (WPD) must be set to Enabled to use this policy.</td>
</tr>
<tr>
<td><strong>(WPD): Storage</strong></td>
<td>Full Access: Port does not have read/write data restrictions applied. Read Only: Allows read capability. Write data is disabled. Blocked: Port is blocked from read/write capability.</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Class: Human Interface Device (HID)</strong></td>
<td>Enabled</td>
<td>Control access to all Human Interface Devices (keyboards, mice). <strong>Note:</strong> USB port-level blocking and HID class-level blocking is <em>only</em> honored if we can identify the computer chassis as a laptop/notebook form-factor. We rely on the computer's BIOS for the identification of the chassis.</td>
</tr>
<tr>
<td><strong>Class: Other</strong></td>
<td>Enabled</td>
<td>Control access to all devices not covered by other Classes.</td>
</tr>
<tr>
<td><strong>EMS Encrypt External Media</strong></td>
<td>Not Selected</td>
<td>This policy must be selected to use all other removable media policies. Not Selected means that no encryption of removable media takes place, regardless of other removable media policy values.</td>
</tr>
<tr>
<td><strong>EMS Exclude CD/DVD Encryption</strong></td>
<td>Not Selected</td>
<td>Not Selected encrypts CD/DVD devices.</td>
</tr>
<tr>
<td><strong>EMS Access to unShielded Media</strong></td>
<td>Read Only</td>
<td><strong>Block, Read Only, Full Access</strong>&lt;br&gt;Note that this policy interacts with the Storage &gt; Subclass Storage: External Drive Control policy. If you intend to set this policy to Full Access, ensure that Subclass Storage: External Drive Control is not set to Read Only or Blocked.&lt;br&gt;<strong>More...</strong>&lt;br&gt;When this policy is set to Block Access, you have no access to removable media unless it is encrypted. Choosing either Read-Only or Full Access allows you to decide what removable media to encrypt. If you choose not to encrypt removable media and this policy is set to Full Access, you have full read/write access to removable media. If you choose not to encrypt removable media and this policy is set to Read-Only, you can read or delete existing files on the unencrypted media, but files cannot be edited on, or added to, the media.</td>
</tr>
<tr>
<td><strong>EMS Encryption Algorithm</strong></td>
<td>AES256</td>
<td>AES 256, AES 128, 3DES&lt;br&gt;Encryption algorithm used to encrypt removable media. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.</td>
</tr>
<tr>
<td><strong>EMS Automatic Authentication</strong></td>
<td>Disabled</td>
<td><strong>Disabled, Local, Roaming</strong>&lt;br&gt;Local automatic authentication allows the encrypted media to be automatically authenticated when inserted in the originally encrypting computer when the owner of that media is logged in. When local automatic authentication is disabled, users must always manually authenticate to access encrypted media. Not selecting roaming automatic authentication helps to prevent users from forgetting their password when they take the media home or share it with a colleague. Not selecting roaming automatic authentication also promotes a sense of awareness from a security perspective for users that the data being written to that media is protected.</td>
</tr>
<tr>
<td><strong>EMS Scan External Media</strong></td>
<td>Not Selected</td>
<td>Selected allows removable media to be scanned every time it is inserted. When this policy is Not Selected and the EMS Encrypt External Media policy is Selected, only new and changed files are encrypted. See <a href="#">EMS Encryption Rules</a> if changing this policy to Selected. Do not enable this policy without applying EMS Encryption Rules also.&lt;br&gt;<strong>More...</strong>&lt;br&gt;A scan occurs at every insertion so that any files added to the removable media without authenticating can be caught. Files can be added to the media if authentication is declined, but encrypted data cannot be accessed. The files added are not encrypted in this case, so the next time the media is authenticated (to work with encrypted data), any files that may have been added are scanned and encrypted.</td>
</tr>
<tr>
<td><strong>EMS Access Encrypted Data on unShielded Device</strong></td>
<td>Selected</td>
<td>Selected allows the user to access encrypted data on removable media whether the endpoint is encrypted or not.&lt;br&gt;<strong>More...</strong>&lt;br&gt;When this policy is Not Selected, the user can work with encrypted data...</td>
</tr>
</tbody>
</table>
when logged on to any encrypted device, regardless of the Dell Server the user activated against. The user cannot work with encrypted data using any unencrypted device.

### EMS Device Whitelist

String - Maximum of 150 devices with a maximum of 500 characters per PNPDeviceID. Maximum of 2048 total characters allowed. "Space" and "Enter" characters count in the total characters used. This policy allows the specification of removable media devices to exclude from encryption (using the device's Plug and Play device identifier (PNPDeviceID)), thereby allowing users full access to the specified removable media devices.

**More...**

This policy is available on an Enterprise, Domain, Group, and User level. Note that local settings override inherited settings. If a user is in more than one group, all EMS Device Whitelist entries, across all Groups, apply. This policy is particularly useful when using removable media devices which provide hardware encryption. However, this policy should be used with caution. This policy does not check whether external media devices on this list provide hardware encryption. Whitelisting removable storage devices that do not have hardware encryption do not have enforced security and are not protected.

For example, the Kingston® DataTraveler® Vault Privacy model enforces that encryption is enabled to use the device. However, the Kingston DataTraveler Vault model has an unsecured partition and a secured partition. Because it is the same physical removable media device with only one PNPDeviceID, the two partitions cannot be distinguished, meaning that whitelisting this particular device would allow unencrypted data to leave the endpoint.

Additionally, if a removable media device is encrypted and is subsequently added to the EMS Device Whitelist policy, it remains encrypted and requires a reformat of the device to remove encryption.

The following is an example of a PNPDeviceID, which contains the manufacturer identifier, product identifier, revision, and hardware serial number:

```
USBSTOR\DISK\VEN_KINGSTON &PROD_DTVault_Privacy
REV_1.0\07005B831A0004B4&0
```

To whitelist a removable media device, provide a string value that matches portions of the device's PNPDeviceID. Multiple device PNPDeviceIDs are allowed.

For example, to whitelist all Kingston DataTraveler Vault Privacy models, input the string:

`PROD_DTVault_Privacy`

To whitelist both models of Kingston DataTraveler, the Vault and Vault Privacy models, input the string:

`PROD_DTVault_Privacy; PROD_DT_Vault`

Space characters are considered part of the substring to match to a PNPDeviceID. Using the previous PNPDeviceID as an example, a space before and after the semicolon would cause neither of the substrings to be matched, because the space character is not part of the PNPDeviceID.

**Instructions...**

To find the PNPDeviceID for removable media:

1. Insert the removable media device into an encrypted computer.
2. Open the EMSService.log in C:\Programdata\Dell\Dell Data Protection\Encryption\EMS.
3. Find PNPDeviceID=

   For example:

   14.03.18 18:50:06.834 [I] [Volume "F:\"] PnPDeviceID =
To find the PNPDeviceID for removable media on Windows 7 or later:

1. Insert the removable media device.
2. Open the Control Panel and go to Administrative Tools > Computer Management.
3. Select the Hardware tab, select the drive, and click Properties.

The PNPDeviceID is displayed in Value.

Available Delimiters:
Tabs
Commas
Semi colons
Hex character 0x1E (Record separator character)

| EMS Alpha Characters Required in Password | Selected | Selected requires one or more letters in the password. |
| EMS Mixed Case Required in Password | Selected | Selected requires at least one uppercase and one lowercase letter in the password. |
| EMS Number of Characters Required in Password | 8 | 1-40 characters |
| EMS Numeric Characters Required in Password | Selected | Selected requires one or more numeric characters in the password. |
| EMS Password Attempts Allowed | 3 | 1-10 |
| EMS Special Characters Required in Password | Not Selected | Selected requires one or more special characters in the password. |
| EMS Access and Device Code Length | 16 | 8, 16, 32 |
| EMS Access Code Attempts Allowed | 3 | 1-10 |
| EMS Access Code Failure Action | Apply Cooldown | Apply Cooldown, Wipe Encryption Keys |
|                                       |                                      | Action to take following unsuccessful EMS Access Code Attempts Allowed: |
|                                       |                                      | • Apply Cooldown to allow another round of attempts following the specified cooldown period (EMS Cooldown Time Delay and EMS Cooldown Time Increment policies) |
### EMS Access Code Required Message

<table>
<thead>
<tr>
<th>Required Message</th>
<th>String</th>
</tr>
</thead>
</table>
| Authentication Failed. Please contact your system administrator. | **String - 5-512 characters - Authentication Failed: Please contact your system administrator.**

**More...**

Message policies must have non-blank values. "Space" and "Enter" characters used to add lines between rows count as characters used. Messages over the 512 character limit are truncated on the client.

Optionally customize the second sentence of the message to include specific instructions about how to contact a help desk or security administrator for authentication failures.

### EMS Cooldown Time Delay

<table>
<thead>
<tr>
<th>Time Delay</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-5000 seconds</td>
<td>Number of seconds the user must wait before attempting to enter the access code after failing the specified number of times.</td>
</tr>
</tbody>
</table>

### EMS Cooldown Time Increment

<table>
<thead>
<tr>
<th>Time Increment</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-5000 seconds</td>
<td>Incremental time to add to the cooldown time each time the user fails to enter the correct access code in the specified number of attempts.</td>
</tr>
</tbody>
</table>

### EMS Access Code Failed Message

<table>
<thead>
<tr>
<th>Failed Message</th>
<th>String</th>
</tr>
</thead>
</table>
| You are not authorized to use this media. Please contact your system administrator. | **String - 5-512 characters - You are not authorized to use this media. Please contact your system administrator.**

**More...**

Message policies must have non-blank values. "Space" and "Enter" characters used to add lines between rows count as characters used. Messages over the 512 character limit are truncated on the client.

Optionally customize the message to include specific instructions about how to contact the help desk or security administrator.

### EMS Encryption Rules

<table>
<thead>
<tr>
<th>Rules</th>
<th>String</th>
</tr>
</thead>
</table>
| Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. A total of 2048 characters are allowed. "Space" and "Enter" characters used to add lines between rows count as characters used. Any rules exceeding the 2048 limit are ignored. See Encryption Rules for information. | **String**

**More...**

Storage devices which incorporate multi-interface connections, such as Firewire, USB, eSATA, etc. may require the use of both Encryption External Media and encryption rules to encrypt the endpoint. This is necessary due to differences in how the Windows operating system handles storage devices based on interface type.

To ensure encrypting an iPod via Encryption External Media does not make the device unusable, use the following rules:

- R#:\Calendars
- R#:\Contacts
- R#:\Pod_Control
- R#:\Notes
- R#:\Photos

You can also force encryption of specific file types in the directories above. Adding the following rules will ensure that ppt, pptx, doc, docx, xls, and xlsx files are encrypted in the directories excluded from encryption via the previous rules:

- ^R#:\Calendars .ppt.doc .xls.pptx .docx.xlsx
- ^R#:\Contacts
Replacing these five rules with the following rule will force encryption of ppt, pptx, doc, docx, xls, and xlsx files in any directory on the iPod, including Calendars, Contacts, iPod_Control, Notes, and Photos:

^R#: \ppt.doc.xls
^R#: \pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for all removable devices - not just an iPod. Use care when defining rules to exclude an iPod from encryption.

These rules have been tested against the following iPods:
- iPod Video 30gb fifth generation
- iPod Nano 2gb second generation
- iPod Mini 4gb second generation

Dell does not recommend the use of the iPod Shuffle, as unexpected results may occur.

As iPods change, this information could also change, so caution is advised when allowing the use of iPods on Encryption External Media-enabled computers.

Because folder names on iPods are dependent on the model of the iPod, Dell recommends creating an exclusion encryption policy which covers all folder names, across all iPod models.

EMS Block Access to UnShieldable Media

Block access to any removable media that is less than 55 MB and thus has insufficient storage capacity to host Encryption External Media (such as a 1.44MB floppy disk).

More...

All access is blocked if EMS Encrypt External Media and this policy are both Selected. If EMS Encrypt External Media is Selected, but this policy is Not Selected, data can be read from the unencryptable media, but write access to the media is blocked.

If EMS Encrypt External Media is Off, then this policy has no effect and access to unencryptable media is not impacted.

SDE Encryption Enabled

If this policy is Not Selected, SDE encryption is disabled, regardless of other policy values. Selected means that all data not encrypted by other Intelligent Encryption policies are encrypted per the SDE Encryption Rules policy. Changing the value of this policy requires a reboot.

SDE Encryption Algorithm

AES256

AES 256, AES 128, 3DES

Encryption algorithm used to for System Data Encryption. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.

SDE Encryption Rules

Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. See Encryption Rules for information. SDE Encryption Rules may be changed as appropriate for your environment. However, these defaults have been tested extensively. Removing these exclusions may result in Windows issues, particularly after reboot.

F:\%
-\%env:systemdrive%\system volume information
-\%env:systemroot%\dli.exe.sys.ocx.man.cat.manifest.policy
<table>
<thead>
<tr>
<th>Encryption Enabled</th>
<th>Selected</th>
<th>This policy must be selected to use all Common encryption policies. Not Selected means that no Common encryption takes place, regardless of other policy values. Changing the value of this policy triggers a new sweep to encrypt/decrypt files.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Encrypted Folders</td>
<td><strong>String</strong></td>
<td></td>
</tr>
<tr>
<td>%ENV:SYSTEMDRIVE%\accdb.doc.docx.mdb.pdf.pps.ppsm.ppt.pptx.pptm.pptn.rtf.tif.tifv.tifv.sd.sld.sld.sld.sld.vsd.vsd.xlam.xlsm.xls.xlsb.xlsm.xlsx</td>
<td>A list of folders on computer drives to be encrypted or excluded from encryption, which can then be accessed by all managed users who have access to the computer. See Encryption Rules for information. <strong>Important:</strong> Overriding directory protection can result in an unbootable computer and/or require reformatting drives. More... The available drive letters are: #: Refers to all drives f#: Refers to all fixed (non-removable) drives #: Refers to all removable drives</td>
<td></td>
</tr>
<tr>
<td>Common Encryption Algorithm</td>
<td>AES256</td>
<td>AES 256 or AES 128 Encryption algorithm used to encrypt data at the endpoint (all users) level. System paging files are encrypted using AES 128. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.</td>
</tr>
<tr>
<td>Application Data Encryption List</td>
<td><strong>Exe List</strong></td>
<td></td>
</tr>
</tbody>
</table>
| winword.exe excel.exe powerpnt.exe maccess.exe winproj.exe outlook.exe acrobat.exe visio.exe mspub.exe winzip.exe winrar.exe onenote.exe onenotem.exe | Dell does not add explorer.exe or iexplorer.exe to the ADE list, as unexpected or unintended results may occur. Explorer.exe is the process used to create a new notepad file on the desktop using the right-click menu. Setting encryption by file extension, instead of the ADE list, provides more comprehensive coverage. Changes to this policy do not affect files already encrypted because of this policy. List process names of applications (without paths) whose new files you want encrypted, separated by carriage returns. Do not use wildcards. More... You can also specify these process names (separated by commas) via the registry value HKLM\SOFTWARE\Credant\CMGShield\ApplicationDataEncryptionList. The Encryption client encrypts all new files (not already being encrypted by Common Encrypted Folders and User Encrypted Folders) on the current computer hard drives created by these application processes whenever they are owned by a currently-logged-on managed user. This may include files excluded from encryption by Common Encrypted Folders and/or User Encrypted Folders. The following folders and their subfolders are always excluded from encryption by this policy: C:\Windows\system32 C:\Windows\Software Distribution C:\Windows\Security C:\System Volume Information\Program Files\Credant\(.dll.exe.sys.mac.ddp.wip.ryt.nmd.inv)
Dell strongly recommends not listing applications or installers that write system-critical files. Doing so could result in encryption of important system files, which could make a Windows computer unbootable.

Common process names:
- outlook.exe
- winword.exe
- powerpnt.exe
- msaccess.exe
- wordpad.exe
- mspaint.exe
- excel.exe

The following hard-coded system and installer process names are ignored if specified in this policy (you can also add to this list in the registry value HKLM\SOFTWARE\Credant\CMGShield\EUWPrivilegedList):
- hotfix.exe, a Windows update process
- update.exe, a Windows update process
- setup.exe, a third-party installer process
- msiexec.exe, a third-party installer process
- wuaautl.exe, a Windows update process
- wmiprvse.exe, a Windows system process
- migrate.exe, a Windows update process
- unregmp2.exe, a Windows update process
- ikernel.exe, a third-party installer process
- wssetup.exe, the Windows Encryption client installer
- svchost.exe, a Windows system process

<table>
<thead>
<tr>
<th>Encrypt Temporary Files</th>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the paths listed in the environment variables TEMP and TMP are encrypted. TEMP and TMP for the operating system are encrypted with the Common encryption key. To reduce encryption sweep time, the contents of the TEMP and TMP folders are cleared for initial encryption, as well as updates to this policy. However, if your organization uses a third-party application that requires the file structure within the <code>temp</code> directory to be preserved, you should prevent this deletion. To disable temporary file deletion, create <code>DeleteTempFiles</code> (REG_DWORD) and set its value to 0 in the registry at HKLM\SOFTWARE\Credant\CMGShield.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encrypt User Profile Documents</th>
<th>Not Selected</th>
</tr>
</thead>
</table>
| When this policy is selected, the following are encrypted:
  - The users profile (`C:\Users\jsmith`) with the User data encryption key
  - `\Users\Public` with the Common encryption key |

<table>
<thead>
<tr>
<th>Encrypt Windows Paging File</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When this policy is selected, the Windows paging file is encrypted. A change to this policy requires a reboot.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Managed Services</th>
<th>null</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed services are not started if an unmanaged user logs on.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Secure Post-Encryption Cleanup</th>
<th>Single Pass Overwrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Overwrite, Single-pass Overwrite, Three-pass Overwrite, Seven-pass Overwrite</td>
<td></td>
</tr>
<tr>
<td>Policy Name</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>Manage Policies</td>
<td></td>
</tr>
<tr>
<td>Secure Windows Credentials</td>
<td>Selected</td>
</tr>
<tr>
<td>Block Unmanaged Access to Domain Credentials</td>
<td>Selected</td>
</tr>
<tr>
<td>Secure Windows Hibernation File</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Prevent Unsecured Hibernation</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Workstation Scan Priority</td>
<td>Lowest</td>
</tr>
</tbody>
</table>
| Policy Proxy Connections | String | String - maximum of 1500 characters List fully qualified Policy Proxy hostnames, or IP addresses, separated by carriage returns. Ports cannot be specified in this policy. More... Once a valid entry is found, the remainder of the Policy Proxies listed are ignored. Entries are processed in the following order: 1. GKConnections Override (this registry entry overrides all other entries) 2. GKConnections (this registry entry is set automatically by the client, based on the this policy) 3. GK To override this policy and specify ports via the registry key, set HKLM\Software\Microsoft\WindowsNT\CurrentVersion\ Winlogon\CMGShield\GKConnectionsOverride. The client communicates with Policy Proxies using the GKPORT (the default
is 8000). If necessary, change that port via the registry key HKLM\SOFTWARE\Microsoft\WindowsNT\Current Version\Winlogon\CMGShield\GKPort. Inherited values for this policy accumulate. For the client to connect to a Policy Proxy specified in this policy, it must be in the same group as the Policy Proxy specified during client installation. Because the client supports up to 255 users per computer, this policy is available only at the Enterprise level.

<table>
<thead>
<tr>
<th>Policy Proxy Polling Interval</th>
<th>720</th>
<th>1-1440 minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The interval that the client attempts to poll Policy Proxy for policy updates, and send inventory information to Policy Proxy. The client also attempts to poll Policy Proxy each time a user logs on.</td>
</tr>
</tbody>
</table>

See [basic settings](#).

**Variables**

Some Windows policies support the following variables. A pathname can consist entirely of one or more of these variables, or can include one or more of these variables at any point.

To get directory locations that these CSIDL values resolve to, go to [http://msdn.microsoft.com/en-us/library/bb762494.aspx](http://msdn.microsoft.com/en-us/library/bb762494.aspx). All names listed on the MSDN page are CSIDL_<name>.

- Includes any of the following Windows CSIDL constants:
  - DESKTOP
  - INTERNET
  - PROGRAMS
  - CONTROLS
  - PRINTERS
  - PERSONAL
  - FAVORITES
  - STARTUP
  - RECENT
  - SENDTO
  - STARTMENU
  - STARTMENU
  - MYDOCUMENTS
  - MYMUSIC
  - MYVIDEO
  - DESKTOPDIRECTORY
  - DRIVES
  - NETWORK
  - NETHOOD
FONTS
TEMPLATES
COMMON_STARTMENU
COMMON_PROGRAMS
COMMON_STARTUP
COMMON_DESKTOPDIRECTORY
APPDATA
PRINTHOOD
LOCAL_APPDATA
ALTSTARTUP
COMMON_ALTSTARTUP
COMMON_FAVORITES
INTERNET_CACHE
COOKIES
HISTORY
COMMON_APPDATA
WINDOWS
SYSTEM
PROGRAMFILES
PROGRAMFILES
MYPICTURES
PROFILE
SYSTEMX86
PROGRAM_FILESX86
PROGRAMFILESX86
PROGRAM_FILES_COMMON
PROGRAM_FILES_COMMONX86
COMMON_TEMPLATES
COMMON_DOCUMENTS
COMMON_ADMINTOOLS
ADMINTOOLS
CONNECTIONS
COMMON_MUSIC
COMMON_PICTURES
COMMON_VIDEO
RESOURCES
PROFILES

- Includes a numeric or text value stored in the registry for the current user. If you specify a path but not an item, the client uses the default value

- Includes a numeric or text value stored in the registry for the local computer. If you specify a path but not an item, the client uses the default value

- Includes the value of a Windows local environment variable

- Includes the % character

Windows Policies that Require Reboot

- SDE Encryption Enabled
- Encrypt Windows Paging File
- Secure Windows Credentials
- All PCS policies

Windows Policies that Require Logoff

- SDE Encryption Enabled
- User state change to Suspended
- EMS Encrypt External Media
- EMS Scan External Media
- EMS Encryption Algorithm
- EMS Exclude CD/DVD Encryption
- EMS Data Encryption Key

Encryption Rules

**Important:** Before you begin, you must understand directory protection, as well as when and how to override directories and file types. If you do not completely understand the information included in this section, as well as the encryption settings that currently exist on your environment, do not attempt to override protected directories.

Do not encrypt files with the extension tmp. Encrypting .tmp files may result in an unbootable computer and/or require reformatting drives.

Protected Directories
The Encryption client has several directories that are, by default, protected from encryption. The level of protection varies from folder to folder. If a folder is protected, then the only way to encrypt data within that directory is to use the override modifier described in Modifiers – What they are and what they do.

There are four levels (categories) of protection that directories and files can have: 0, 1, 2, and 3. Category 3 is the most protected level.

Modifiers - What they are and what they do

The ^ character is the “Override” command. It causes the listed policy to override protected directories. It may be followed by a “2” or a “3”, indicating the level of the override.

The @ character is the “At” command. It will cause the listed policy to be applied at the specified folder location only (subdirectories of that folder are not subject to that policy).

The - is the “Not” command. It will cause the listed policy to be an exclusion policy instead of an inclusion policy.

Using the Override Modifier

The Override Modifier can be used to allow for inclusion or exclusion in cases where there is a higher level of protection. The following are the different override levels supported:

- ^ Category 1 Override
- ^2 Category 2 Override
- ^3 Category 3 Override

Encrypting/Not Encrypting Extensions

To include or exclude file name extensions using encryption rules, use the following within your rules:

- After specifying your directory location, use a semi-colon (;) before listing your extensions.
- After specifying your directory location, you do not need to list a trailing backslash (\).
- The period is used as a delineator. It is not meant to be used as “dot-extension.” However, you can precede the first extension with a period.
- The Override command (^) can be used with extensions.
- The At command (@) can be used with extensions.
- The Not command (-) can be used with extensions.
- You can make any combination of the modifiers with an extension inclusion or exclusion.

Examples of Extension Inclusions/Exclusion

C:\;doc.xls.ppt.docx.xlsx.xlsx.pptx
What this does: On the C: drive, this encrypts all doc, docx, xls, xlsx, ppt, and pptx files that do not exist within any protected directory.

^C:\;txt
What this does: On the C: drive, this encrypts all txt files that are not in a directory that has protection of Category 1 or better.

-C:\;bat.exe.dll
What this does: On the C: drive, this causes all files with the extension bat, exe, and dll to not be encrypted.
Encrypting/Not Encrypting Directories

To include or exclude directories using encryption rules, use the following within your rules:

- After specifying your directory location, you **do not need** to list a trailing backslash (`\`).
- If you list a directory for inclusion, every file contained within that directory is encrypted.
- The **Override** command (`^`) can be used with folders only when specifying an exclusion policy.
- The **At** command (@) can be used with folders.
- The **Not** command (-) can be used with folders.
- You can make any combination of the supported modifiers for folders. If the **Override** command (`^`) is used, the statement can only be an exclusion statement.

Examples of folder inclusion/exclusion

**C:\CustomApplication\DataStore**

*What this does:* On the C: drive, this causes every file within the directory of `\CustomApplication\DataStore` to be encrypted.

```
-C:\Documents and Settings\All Users
```

*What this does:* On the C: drive, this applies a Category 0 level of protection to the directory of `\Documents and Settings\All Users`.

```
^2C:\CustomApplication\dll
```

*What this does:* On the C: drive, this applies a Category 2 level of protection to the directory of `\CustomApplication\dll`.

Sub-directories and Precedence of Directives

Encryption rules may be listed in any order. If more than one rule applies to a given folder or file, then the following general rules determine which one prevails:

1. The rule with the more specific path prevails.
2. If the rules have equal paths, specified extensions prevail.
3. If the rules both specify extensions, exclusion overrides inclusion.

Example of sub-directories

**C:\**

```
-C:\MyApplicationFolder
```

*What this does:* (1st statement is an inclusion, 2nd statement is an exclusion) On the C: drive, encrypt all files in folders at the root level and below, **except** for files residing in the **protected directories** and any files residing in “MyApplicationFolder”.

Example 1 of competing directives:

**C:\**

```
-C:\MyApplicationFolder
^C:\;doc.xls;ppt.docx;xlsx.pptx
```

*What this does:* (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an inclusion) On the C: drive, encrypt all files in folders at the root level and below, **except** for files residing in the **protected directories** and files residing in “MyApplicationFolder”. However, override and encrypt
files with the extension doc, docx, xls, xlsx, ppt, and pptx in the protected directories and in the folder “MyApplicationFolder”.

Example 2 of competing directives:

C:\
-C:\MyApplicationFolder
^C:\\;doc.xls.ppt.docx.xlsx.pptx
-^C:\MyApplicationFolder;doc.xls.ppt.docx.xlsx.pptx

What this does: (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an inclusion, 4th statement is an exclusion) On the drive of C:, encrypt all files in folders at the root level and below, except for files residing in the protected directories and files residing in “MyApplicationFolder”. However, override and encrypt files with the extension doc, docx, xls, xlsx, ppt, and pptx in the protected directories, but not in the folder “MyApplicationFolder”.

Example 3 of competing directives:

C:\
-C:\MyApplicationFolder
^C:\;doc.xls.ppt.docx.xlsx.pptx
-^C:\MyApplicationFolder;doc.xls.ppt.docx.xlsx.pptx
-^C:\MyApplicationFolder\Templates

What this does: (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an inclusion, 4th statement is an exclusion, 5th statement is an exclusion) On the C: drive, encrypt all files in folders at the root level and below, except for files residing in the protected directories and files residing in “MyApplicationFolder”. However, override and encrypt files with the extension doc, docx, xls, xlsx, ppt, and pptx in the protected directories, but not in the folder “MyApplicationFolder”. Additionally, the folder “MyApplicationFolder\Templates” gains a category 2 protection causing no data to be encrypted there, since the inclusion statements are less than or equal to category 2.

Environment Variables, KNOWNFOLDERID constants, and CSIDL

Using encryption rules, you can make use of environment variables, KNOWNFOLDERID constants (Windows 7 and later), and CSIDL values (pre-Windows 7 computers) in addition to specifying your policy folder locations as absolute paths. To use variables in your encryption rules, follow these formatting rules:

- Before and after the use of the variable, use a percent sign (%).
- For environment variables, you must use “ENV:” preceding the variable name, all contained within the percent signs.
- For KNOWNFOLDERID constants, you must use “FOLDERID_” preceding the variable name. Percent signs are not used.
- For CSIDL variables, you must use “CSIDL:” preceding the variable name, all contained within the percent signs.
- Ensure that your variable contains a trailing backslash if you plan on appending another directory after the use of the variable.
- Variables can be used in both folder and extension inclusion or exclusion rules.

The following environment variables are supported:
All locally defined environment variables

The following KNOWNFOLDERID values are supported:

RoamingAppData
Cookies
Desktop
Favorites
InternetCache
LocalAppData
Music
Pictures
Documents
Programs
Recent
SendTo
StartMenu
Startup
Templates

The following CSIDL variables are supported:

APPDATA
COOKIES
DESKTOPDIRECTORY
FAVORITES
INTERNET\_CACHE
LOCAL\_APPDATA
MYMUSIC
MYPICTURES
PERSONAL
PROGRAMS
RECENT
SENDTO
STARTMENU
STARTUP
TEMPLATES

Some examples of variables used in folder and extension policy:
%ENV:SYSTEMDRIVE%\CustomApplication

**What this does:** This lists the folder \CustomApplication\ for encryption on the default drive where Windows is installed.

- %ENV:USERPROFILE%\Desktop

**What this does:** This lists the user who is logged in to have their desktop obtain a category 0 protection.

**Application Data Encryption (ADE)**

ADE encrypts any file written by a protected application, using a category 2 override. This means that any directory that has a category 2 protection or better, or any location that has specific extensions protected with category 2 or better, will cause ADE to not encrypt those files.

For example, ADE does not encrypt any files written into /Windows/System32 folder, because this directory has a default protection of category 2.

**Example Policies for Common/User Key Encryption**

The following set of encryption rules encrypts most of the drive, including standard Microsoft Office-type documents in the Documents and Settings folders. This policy set should only be used for Common encryption (not User encryption, removable media, or SDE). This is considered a strong policy set, and will typically require some adjustments for local conditions and requirements.

%ENV:SYSTEMDRIVE%\  
%^%ENV:USERPROFILE%\<insert standard office extensions here >  
FOLDERID_Documents or %CSIDL:PERSONAL% (pre-Windows 7)  
%ENV:USERPROFILE%\Desktop\  
%^%ENV:USERPROFILE%\;mp3.mp4.mpeg.avi.wmv.wav  
-%^%ENV:USERPROFILE%\Desktop\;<system file extensions to exclude>  
-%ENV:SYSTEMDRIVE%\;<system file extensions to exclude>  
-%ENV:SYSTEMDRIVE%\config.msi

**What this does:**

Encrypts all of C:\, except for protected directories  
Encrypts standard Microsoft Office documents across the drive, except for protected directories, although it will encrypt them in the USERPROFILE directory.  
Encrypts all of My Documents  
Encrypts all of the Desktop, except for any selected excluded extensions  
Excludes common system files from encryption  
Excludes all encryption from C:\config.msi directory, due to MSI upgrade migration issues  
All paths are dynamic based on environment variables  
%^%ENV:USERPROFILE% (inclusion or exclusion) variable should never be used with SDE Encryption.

**System Data Encryption (SDE)**

SDE is an intelligent file-based encryption method where the encryption key is auto-authenticated during the volume mount process. A unique SDE key is generated for each volume that is targeted for
encryption by SDE. This allows the SDE key to be used to encrypt data that would not otherwise be possible with the Common or User keys due to time-based availability of the keys.

Due to the difference in how the SDE key can be used, there are several caveats to be aware of when considering use of this feature.

- The built-in exclusions covered in protected directories do not apply to SDE. By design, SDE excludes portions of the operating system that are necessary for booting and updating.
- If a file is targeted for encryption by any key other than SDE in addition to SDE, then SDE does not encrypt the file.
- All encryption rules apply when writing SDE policies.

Encryption Rules for SDE Encryption

The following is the default SDE policy. Any changes to this policy should be considered carefully.

The protection of the SystemRoot directory is specified so that only the root itself is protected, meaning that the sub-directories of the SystemRoot do not inherit this protection. This would be the equivalent of using the following policy:

-@C:\

Encryption Rules for Encryption External Media

Removable Media Encryption policies operate off their own set of encryption rules, independent of Common encryption, User encryption, or SDE uses. User/Common encryption policies are only applied to fixed disks. If an endpoint is determined to be removable media, then Removable Media Encryption policies are applied.

What Happens When Policies Tie

- When an exclusion and inclusion statement both apply to a given directory or file, the exclusion policy prevails.
- If you apply a Common encryption policy and User encryption policy specifically to the same file or location, the file or location is Common key encrypted.
- If you apply a Common encryption policy and an SDE encryption policy specifically to the same file or location, the file or location is Common key encrypted.
- If you apply a User encryption policy and an SDE encryption policy specifically to the same file or location, the file or location is User key encrypted.

See Sub-directories and Precedence of Directives for more information.

Encryption Rules for Generic Drive Statements

Instead of having to specify each drive in an inclusion or exclusion rule by its drive letter assignment, you may use a generic rule to target either All Fixed Drives or all Removable Drives.

Fixed Drive Usage: Replace the drive letter with F#.

Example: F#:\ instead of C:\ or D:\

The Fixed Drive rule can only be used within a Common Encrypted Folder policy, User Encrypted Folder policy, and/or SDE policy.

Removable Drive Usage: Replace the drive letter with R#.

Example: R#:\ instead of F:\ or H:\
The Removable Drive rule can only be used within an Encryption External Media Encryption Rules policy.

Remove System Data Encryption (SDE)

To completely decrypt SDE encrypted files, apply the following policies:

- SDE Encryption Enabled = Not Selected
- Encrypt Windows Paging File = Not Selected
- Secure Windows Credentials = Not Selected

Authentication

Authentication policies allow you to configure user experience and Windows authentication.

Policy descriptions also display in tooltips in the Management Console.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Boot Authentication</td>
<td>Password</td>
<td>This technology provides a secure, tamper-proof environment by preventing data from being read from the hard disk or operating system until the user enters the correct PBA login credentials. Pre-Boot Authentication serves as an extension of the BIOS or boot firmware to provide a trusted authentication layer, separate from the operating system.</td>
</tr>
<tr>
<td>Support Information Text</td>
<td>String</td>
<td>Please contact your system administrator.</td>
</tr>
<tr>
<td>PBA Title Text</td>
<td>0-17 characters</td>
<td>The text to display on the top of the PBA screen. Not entering text in this field results in no title being displayed. Text does not wrap, so entering more than 17 characters results in the text being truncated. The text in this policy is translatable.</td>
</tr>
<tr>
<td>Sync Users at PBA Activation</td>
<td>Not Selected</td>
<td>Select this option to sync all users of this computer with the PBA database during PBA activation.</td>
</tr>
</tbody>
</table>

Windows Authentication

This technology sets definitions around user login, specifically what is required to login (password, smart card, fingerprint), password recovery options, and password requirements (number of attempts allowed, password length).

Logon Authentication Policy for | Windows Password and None | The possible VALUES are:
Administrators

<table>
<thead>
<tr>
<th>Logon Authentication Policy for Users</th>
<th>Windows Password and None</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible VALUES are:</td>
<td></td>
</tr>
<tr>
<td>Windows Password</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Fingerprints</td>
<td></td>
</tr>
<tr>
<td>Contactless Card</td>
<td></td>
</tr>
</tbody>
</table>

See advanced settings

Microsoft Passport

This technology allows the use of Microsoft Passport, specifically authentication attempts and PIN usage.

Microsoft Passport

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>On</td>
<td>Toggle to On to enable Microsoft Passport. If this policy is toggled to Off, no Microsoft Passport policies are enabled. Microsoft Passport is supported only on computers running Windows 10.</td>
</tr>
<tr>
<td>Maximum Windows Passport Authentication Attempts</td>
<td>3</td>
<td>1-10 attempts</td>
</tr>
<tr>
<td>Number of chances the user has to authenticate with correct credentials.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logon Authentication Method</td>
<td>PIN</td>
<td>Currently, logon authentication method is supported only with PIN.</td>
</tr>
<tr>
<td>PIN Length</td>
<td>8</td>
<td>4-127 numeric characters</td>
</tr>
<tr>
<td>Minimum number of characters required in the PIN.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Advanced Authentication

Authentication policies allow you to configure user experience and Windows authentication.

Policy descriptions also display in tooltips in the Management Console.

Policy                          | Default Setting | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Boot Authentication</td>
<td>Password</td>
<td>This technology provides a secure, tamper-proof environment by preventing data from being read from the hard disk or operating system until the user enters the correct PBA login credentials. Pre-Boot Authentication serves as an extension of the BIOS or boot firmware to provide a trusted authentication layer, separate from the operating system.</td>
</tr>
<tr>
<td>Authentication Method</td>
<td>Password</td>
<td>Password Smart Card</td>
</tr>
<tr>
<td>Select the type of authentication to use when logging in to the PBA.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Support Information Text</td>
<td><strong>String</strong>&lt;br&gt;Please contact your system administrator.&lt;br&gt;Text to display on the PBA support information screen. Customize the message to include specific instructions about how to contact the help desk or Security administrator. Not entering text in this field results in no support contact information being available for the user. Text wrapping occurs at the word level, not the character level. If a single word is more than approximately 50 characters in length, it does not wrap and no scroll bar is present, therefore the text is truncated. The text in this policy is translatable.</td>
<td></td>
</tr>
<tr>
<td>PBA Title Text</td>
<td><strong>0-17 characters</strong>&lt;br&gt;The text to display on the top of the PBA screen. Not entering text in this field results in no title being displayed. Text does not wrap, so entering more than 17 characters results in the text being truncated. The text in this policy is translatable.</td>
<td></td>
</tr>
<tr>
<td>Sync Users at PBA Activation</td>
<td><strong>Not Selected</strong>&lt;br&gt;Select this option to sync all users of this computer with the PBA database during PBA activation.</td>
<td></td>
</tr>
<tr>
<td>Legal Notice Text</td>
<td><strong>String 0-512 characters</strong>&lt;br&gt;Text to display before being allowed to log on to the computer. For example: By clicking OK, you agree to abide by the acceptable computer use policy. Not entering text in this field results in no text, OK, or Cancel buttons being displayed. Text wrapping occurs at the word level, not the character level. If a single word is more than approximately 50 characters in length, it does not wrap and no scroll bar is present, therefore the text is truncated. The text in this policy is translatable.</td>
<td></td>
</tr>
<tr>
<td>Self Help Questions (Pre-8.0 clients)</td>
<td><strong>At least 3 selectable questions</strong>&lt;br&gt;Specify the questions to present to Windows users during recovery questions setup. Separate each question by a carriage return. These questions are used if the Windows password is forgotten. At least 3 questions must be specified. What is the name of your first pet? Who was your first employer? What was the first concert you attended? What was the make of the first car you owned? What was the last name of your third grade teacher? In what city or town did your mother and father meet? In what city or town was your first job?</td>
<td></td>
</tr>
<tr>
<td>Policy Name</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Initial Access Code</td>
<td>String 1-100 characters</td>
<td>This policy is used to log on to a computer when network access to Dell Server and Active Directory (AD) are both unavailable. The Initial Access Code policy should only be used if absolutely necessary, it is not the recommended method to log in. Using the Initial Access Code policy does not provide the same level of security as the usual authentication method of logging in using user name, domain, and password. The Initial Access Code can only be used one time, immediately after activation. The first domain login that occurs after the Initial Access Code is entered is cached and the Initial Access Code entry field does not displayed again.</td>
</tr>
<tr>
<td>Encryption Administrator Password</td>
<td>String</td>
<td>Computer-generated password used by the Dell Server and client for recovery and other internal processes. No user or administrator interaction is required. All values are automatically maintained in the Dell Server and can never be deleted. Entering a value for this policy does not affect the Override Count.</td>
</tr>
<tr>
<td>Non-Cached User Login Attempts Allowed</td>
<td>50</td>
<td>Any number This policy does not come into play when connected to the network (there is a connection to AD), because authentication with AD is attempted. This policy only comes into play when the computer is not connected to the network and an unknown user attempts to log in (meaning, a user that has not logged in to the computer before -- no credentials have been cached).</td>
</tr>
<tr>
<td>Cached User Login Attempts Allowed</td>
<td>10</td>
<td>1-20 times Number of times that a cached user can attempt to log in.</td>
</tr>
<tr>
<td>Self Help Question/Answer Attempts Allowed</td>
<td>3</td>
<td>1-10 times Number of times the user can attempt to enter the correct answer.</td>
</tr>
<tr>
<td>Enable One Step Logon</td>
<td>Selected</td>
<td>This policy simplifies the logon process when multi-factor authentication is enabled at both preboot and Windows logon. If selected (or not configured), authentication is required at preboot only, and users are automatically logged on to Windows. If not selected, authentication may be required multiple times.</td>
</tr>
<tr>
<td>Number of Shutdown/Restart Delays Allowed</td>
<td>5</td>
<td>1-25 times Number of times that a user is allowed to snooze/delay a shutdown/restart before being forced to shutdown/restart. TPM requires a reboot. SED requires a shutdown.</td>
</tr>
<tr>
<td>Length of Each Shutdown/Restart Delay</td>
<td>300 seconds</td>
<td>300-300000 seconds Number of seconds between each time the user is asked to shutdown/reboot. TPM requires a reboot. SED requires a shutdown.</td>
</tr>
<tr>
<td>Policy Name</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Length of Forced Shutdown/Restart Notice</td>
<td>60</td>
<td>60-1800 seconds. When user has reached the maximum number of authorized shutdown/restart snoozes/delays, this policy sets the number of seconds allowed before forcing a shutdown/restart. TPM requires a reboot. SED requires a shutdown.</td>
</tr>
<tr>
<td>Allow PBA to Remember User Name</td>
<td>Selected</td>
<td>Enables or disables the ability for users to select Remember Me on the PBA login screen.</td>
</tr>
<tr>
<td>Crypto Erase Password</td>
<td>String 0-100 characters</td>
<td>A word or code of up to 100 characters used as a fail-safe security mechanism. Entering this word or code in the user name or password field during PBA authentication initiates a crypto erase, which removes the keys from secure storage. Once this process is invoked, the drive is unrecoverable. Leave this field blank if you do not want a crypto erase password available in case of emergency.</td>
</tr>
<tr>
<td>Enable Client Check for PBA Commands</td>
<td>Not Selected</td>
<td>Allows the client to automatically check for PBA Device Control commands that are pushed from the Dell Server. When enabled, the PBA environment checks for new commands from the Dell Server every five minutes.</td>
</tr>
</tbody>
</table>

See [basic settings](#)

### Windows Authentication

This technology sets definitions around user login, specifically what is required to login (password, smart card, fingerprint), password recovery options, and password requirements (number of attempts allowed, password length).

<table>
<thead>
<tr>
<th>Policy Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon Authentication Policy for Administrators</td>
<td>Windows Password and None</td>
<td>The possible VALUES are: Windows Password None Fingerprints Contactless Card</td>
</tr>
<tr>
<td>Logon Authentication Policy for Users</td>
<td>Windows Password and None</td>
<td>The possible VALUES are: Windows Password None Fingerprints Contactless Card</td>
</tr>
<tr>
<td>In-session Authentication Policy for Administrators</td>
<td>Windows Password and None</td>
<td>The possible VALUES are: Windows Password None Fingerprints Contactless Card One-Time Password</td>
</tr>
</tbody>
</table>
### In-session Authentication Policy for Users

<table>
<thead>
<tr>
<th>Windows Password and None</th>
</tr>
</thead>
<tbody>
<tr>
<td>The possible VALUES are:</td>
</tr>
<tr>
<td>Windows Password</td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>Fingerprints</td>
</tr>
<tr>
<td>Contactless Card</td>
</tr>
<tr>
<td>One-Time Password</td>
</tr>
</tbody>
</table>

### Recovery Questions for Windows Authentication

<table>
<thead>
<tr>
<th>At least 3 selectable questions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the questions to present to Windows users during recovery questions setup. Separate each question by a carriage return. These questions are used if the Windows password is forgotten. At least 3 questions must be specified.</td>
</tr>
<tr>
<td>What is your mother’s maiden name?</td>
</tr>
<tr>
<td>What was the name of the first school you attended?</td>
</tr>
<tr>
<td>What is the name of your first pet?</td>
</tr>
<tr>
<td>What is your father’s middle name?</td>
</tr>
<tr>
<td>What is your mother’s middle name?</td>
</tr>
<tr>
<td>Who was your first employer?</td>
</tr>
<tr>
<td>Who was your first teacher?</td>
</tr>
<tr>
<td>What city were you born in?</td>
</tr>
<tr>
<td>What city was your mother born in?</td>
</tr>
<tr>
<td>What city was your father born in?</td>
</tr>
<tr>
<td>What was the first concert you attended?</td>
</tr>
<tr>
<td>Who is your favorite TV show character?</td>
</tr>
<tr>
<td>What was the name of your first stuffed animal?</td>
</tr>
<tr>
<td>What was the make of the first car you owned?</td>
</tr>
<tr>
<td>Where did you spend your honeymoon?</td>
</tr>
<tr>
<td>Where did you meet your spouse?</td>
</tr>
<tr>
<td>What is your oldest cousin’s name?</td>
</tr>
<tr>
<td>What is your oldest niece’s name?</td>
</tr>
<tr>
<td>What is your oldest nephew’s name?</td>
</tr>
<tr>
<td>What is your youngest child’s nickname?</td>
</tr>
<tr>
<td>What is your oldest child’s nickname?</td>
</tr>
<tr>
<td>What was the last name of your third grade teacher?</td>
</tr>
<tr>
<td>In what city or town did your mother and father meet?</td>
</tr>
<tr>
<td>In what city or town was your first job?</td>
</tr>
</tbody>
</table>

### Allow Recovery Questions

<table>
<thead>
<tr>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected</td>
</tr>
<tr>
<td>Not Selected</td>
</tr>
</tbody>
</table>

Set to Selected to allow users to use recovery questions/answers to log on to Windows.
Log Events Level | Audit | Errors
Audit Details
Level of detail in Windows Event logs. Determines whether events such as fingerprint registration and authentication attempts are logged in the Windows Event log. Each higher level includes all previous levels. Events are logged on the computer where they occur. Normally, the auditing level provides sufficient detail, covering all logon, authentication, fingerprint management, and user management events. The details levels can fill the log file very quickly. Status events provide information about the state of several important systems on the computer. They are logged on configurable intervals and generally used when events are remotely collected.

False Accept Rate of Fingerprint | Medium High - 1 in 100,000 | The False Accept Rate is the probability of receiving a false acceptance decision when comparing fingerprints scanned from different fingers. You can select one of the following FAR values:
* Medium (1 in 10,000)
* Medium High (1 in 100,000)
* High (1 in 1,000,000)
For example: if you select Medium High, on average, one false acceptance will occur when a fingerprint is compared against one hundred thousand fingerprints scanned from different fingers.
The higher the setting, the lower the chance of receiving a false acceptance. However, at the High setting, the system may reject legitimate fingerprints.
NOTE: The FAR is set on a per verification basis. When matching a fingerprint against fingerprints of multiple users (identification), the internally used FAR is automatically adjusted to maintain the same effective FAR as was selected for a single match.

- Minimum Number of Fingerprints to Enroll: 2
- Maximum Number of Fingerprints to Enroll: 10
- Minimum Length of PIN: 4
- Allow Users to Enroll Credentials: Selected
- Allow Users to Modify Credentials: Selected
### Reminder to Enroll Credentials (Admin)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Reminder</td>
<td>Values for reminders: Disable Reminder At Next Logon In One Day In One Week Every Two Hours</td>
</tr>
<tr>
<td>At Next Logon</td>
<td>The date (time is always 12 am) when authentication policy is going into full effect. Meaning, the client stops asking the local administrator to enroll credentials and forces them to enroll before they can logon. The default is “now”.</td>
</tr>
<tr>
<td>In One Day</td>
<td></td>
</tr>
<tr>
<td>In One Week</td>
<td></td>
</tr>
<tr>
<td>Every Two Hours</td>
<td></td>
</tr>
</tbody>
</table>

### Reminder to Enroll Credentials Expiration Date (Admin)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>The date (time is always 12 am) when authentication policy is going into full effect. Meaning, the client stops asking the local administrator to enroll credentials and forces them to enroll before they can logon. The default is “now”.</td>
</tr>
</tbody>
</table>

### Reminder to Enroll Credentials (User)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Reminder</td>
<td>Values for reminders: Disable Reminder At Next Logon In One Day In One Week Every Two Hours</td>
</tr>
<tr>
<td>At Next Logon</td>
<td></td>
</tr>
<tr>
<td>In One Day</td>
<td></td>
</tr>
<tr>
<td>In One Week</td>
<td></td>
</tr>
<tr>
<td>Every Two Hours</td>
<td></td>
</tr>
</tbody>
</table>

### Reminder to Enroll Credentials Expiration Date (User)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>The date (time is always 12 am) when authentication policy is going into full effect. Meaning, the client stops asking the user to enroll credentials and forces them to enroll before they can logon. The default is “now”.</td>
</tr>
</tbody>
</table>

### Action Upon Smart Card Removal

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Workstation</td>
<td>No Action Lock Workstation Force Logoff Disconnect if on a Remote Desktop session The action that occurs when a smart card is removed from the computer.</td>
</tr>
</tbody>
</table>

### Threat Prevention

#### Threat Prevention

Threat Prevention policies are available at the Enterprise, Endpoint Group, and Endpoint levels.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Threat Prevention</td>
<td>Off</td>
<td><strong>On</strong> Toggle ON to enable Advanced Threat Prevention. If this policy is toggled to OFF, Advanced Threat Prevention is disabled, regardless of other policies. This technology is powered by Cylance and protects your operating system by detecting and preventing malware pre-execution. Advanced Threat Prevention uses artificial intelligence and predictive mathematical models to quickly and accurately identify what is safe and what is a threat.</td>
</tr>
</tbody>
</table>
### File Actions

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsafe Executable Auto Quarantine with Executable Control Enabled</td>
<td>Selected</td>
<td>If selected, Unsafe executable files are automatically quarantined or blocked to prevent their execution. Note: If you Auto Quarantine, it is highly recommended that before deployment, you test Auto Quarantine only on devices using a test policy to observe the behavior and ensure that no business-critical applications are blocked at execution.</td>
</tr>
<tr>
<td>Abnormal Executable Auto Quarantine with Executable Control Enabled</td>
<td>Selected</td>
<td>If selected, Abnormal executable files are automatically quarantined or blocked to prevent their execution. Note: If you Auto Quarantine, it is highly recommended that before deployment, you test Auto Quarantine only on devices using a test policy to observe the behavior and ensure that no business-critical applications are blocked at execution.</td>
</tr>
</tbody>
</table>

### Memory Actions

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Protection Enabled</td>
<td>Not Selected</td>
<td>This policy must be selected to use all other Memory policies. If this policy is Not Selected, no Memory Action policies are enforced, regardless of other policy values. NOTE: Before enabling Memory Protection, enable Compatibility Mode, to ensure applications function properly on the client computer. For instructions on how to enable Compatibility Mode, see Enable_Compatibility_Mode_for_Memory_Protection.htm. Compatibility Mode does not apply to Mac clients.</td>
</tr>
</tbody>
</table>

See advanced settings

### Policy

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat Protection</td>
<td>Off</td>
<td>This technology protects computers by identifying and taking action against threats of malware and malicious activity involving files, folders, the registry, and processes. On Toggle to ON to enable Threat Protection. If toggled to OFF, no Threat Protection policies are applied. Threat Protection includes Malware Protection, Web Protection, and Client Firewall.</td>
</tr>
</tbody>
</table>

### Exploit Protection

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploit Protection</td>
<td>Selected</td>
<td>This policy is the &quot;master policy&quot; for all other Exploit Protection policies. If this policy is Not Selected, no Exploit Protection policies are enforced, regardless of other policy values. A Selected value means that Exploit Protection is enabled. Exploit Protection monitors for application vulnerabilities and keeps buffer overflow exploits from executing arbitrary code on the computer. This policy must be set to Selected to enable Exploit Protection. If this policy is Not Selected, no Exploit Prevention policies are applied.</td>
</tr>
</tbody>
</table>

### Action on Malicious Activity for Files and Folders

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action on Malicious Activity for Files and Folders</td>
<td>Block and Report</td>
<td>Block Only Report Only</td>
</tr>
<tr>
<td>Policy</td>
<td>Default Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Web Protection</strong></td>
<td></td>
<td>This technology protects computers by leveraging a web-based content ranking system to determine if a site that a user is browsing is considered safe or not. This technology also grants the administrator the ability to define what happens when an unsafe site is navigated to (allow, block, warn).</td>
</tr>
</tbody>
</table>
| Web Protection                             | Off             | **On**
|                                            |                 | Toggle to ON to enable Web Protection. If toggled to OFF, no Web Protection policies are applied.                                                                                                           |
| Enforcement - Action to Apply to Sites Not Verified |                 | **Block**
|                                            |                 | Specifies the default action to apply to sites that have not been verified.
|                                            |                 | Block: Prevents users from accessing the site and displays a message that the site is blocked.
|                                            |                 | Allow: Permits users to access the site.
|                                            |                 | Warn: Displays a warning to notify users of potential dangers associated with the site. Users must dismiss the warning before continuing.                                                                |
| Enforcement - Enable File Scanning for File Downloads |                 | **Selected**
|                                            |                 | Specifies the default action to apply to file downloads that have not been verified.
|                                            |                 | Selected: Enables file scanning and allows file downloads.
|                                            |                 | Not Selected: Disables file scanning and prohibits file downloads.                                                                                                                                       |
A Selected value scans all files (including .zip files) before downloading. This option prevents users from accessing a downloaded file until Threat Protection marks the file as clean. Downloaded files are sent to Threat Protection for scanning. Threat Protection performs a Reputation Service lookup on the file. If a downloaded file is detected as a threat, Threat Protection takes action on the file and alerts the user.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Client Firewall | Off | On
Toggle to ON to enable Client Firewall. If toggled to OFF, no Client Firewall Settings or Rules are applied. Client firewall is a stateful firewall. |

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Protection Settings | Not Selected | Selected
If Selected, popup notifications of Advanced Threat Prevention events are disabled on the computer. |

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Suppress Popup Notifications | Not Selected | Selected
Not Selected
If Selected, popup notifications of Advanced Threat Prevention events are disabled on the computer. |

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Minimum Popup Notification Level | High | High
Medium
Low
Severity level of events that result in popup notifications that display on the computer. High allows only notifications of critical events to display. Low displays all on-screen notifications for all events. Listed below are examples of events: High
1) Protection status has changed. (Protected means that the Advanced Threat Prevention service is running and protecting the computer and needs no user or administrator interaction.) 2) A threat is detected and policy is not set to automatically address the threat. |
Medium
1) Execution Control blocked a process from starting because it was detected as a threat.
2) A threat is detected that has an associated mitigation (for example, the threat was manually quarantined), so the process has been terminated.
3) A process was blocked or terminated due to a memory violation.
4) A memory violation was detected and no automatic mitigation policy is in effect for that violation type.

Low
1) A file that was identified as a threat has been added to the Global Safe List or deleted from the file system.
2) A threat has been detected and automatically quarantined.
3) A file has been identified as a threat, but waived on the computer.
4) The status of a current threat has changed (for example, Threat > Quarantined, Quarantined > Waived, or Waived > Quarantined).

Log Files Location
<String - File path>
<SYSTEM_DRIVE>:\ProgramData\DDP\Suite\Logs>

Selects the location for the log files. The default location is <SYSTEM_DRIVE>:\ProgramData\DDP\Suite\Logs>.

Enable Activity Logging
Selected
Not Selected
This policy is the "master policy" for all other Threat Protection logging policies. If this policy is Not Selected, no Threat Protection logging takes place, regardless of other policy values. A Selected value enables Threat Protection logging.

Debug Logging for Web Protection
Selected
Not Selected
A Selected value enables verbose logging of Web Protection activity.

Debug Logging for Client Firewall
Not Selected
Selected
A Selected value enables verbose logging of Firewall activity.

Advanced Threat Prevention

Threat Prevention policies are available at the Enterprise, Endpoint Group, and Endpoint levels.
Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Threat Prevention</td>
<td>Selected</td>
<td>This technology is powered by Cylance and protects your operating system by detecting and preventing malware pre-execution. Advanced Threat Prevention uses artificial intelligence and predictive mathematical models to quickly and accurately identify what is safe and what is a threat.</td>
</tr>
</tbody>
</table>
### Advanced Threat Prevention

<table>
<thead>
<tr>
<th>Policy</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Threat Prevention</td>
<td>Off</td>
</tr>
</tbody>
</table>

Toggle ON to enable Advanced Threat Prevention. If this policy is toggled to OFF, Advanced Threat Prevention is disabled, and policies are set to defaults for activated devices. This results in Execution Control blocking threats, but Auto Quarantine, Memory Protection, and Script Control will be disabled.

### File Actions

<table>
<thead>
<tr>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsafe Executable Auto Quarantine With Executable Control Enabled</td>
</tr>
<tr>
<td>Unsafe Executable Auto Upload Enabled</td>
</tr>
<tr>
<td>Abnormal Executable Auto Quarantine With Executable Control Enabled</td>
</tr>
<tr>
<td>Allow Execution of Files in Exclude Folders</td>
</tr>
<tr>
<td>Auto Delete</td>
</tr>
<tr>
<td>Days until Deleted</td>
</tr>
</tbody>
</table>

- **Unsafe Executable Auto Quarantine With Executable Control Enabled**: If selected, Unsafe executable files are automatically quarantined or blocked to prevent their execution. Note: If you Auto Quarantine, it is highly recommended that before deployment, you test Auto Quarantine only on devices using a test policy to observe the behavior and ensure that no business-critical applications are blocked at execution.
- **Unsafe Executable Auto Upload Enabled**: If selected, any detected Unsafe file is automatically uploaded for a deeper analysis and additional details about the file.
- **Abnormal Executable Auto Quarantine With Executable Control Enabled**: If selected, Abnormal executable files are automatically quarantined or blocked to prevent their execution. Note: If you Auto Quarantine, it is highly recommended that before deployment, you test Auto Quarantine only on devices using a test policy to observe the behavior and ensure that no business-critical applications are blocked at execution.
- **Allow Execution of Files in Exclude Folders**: If selected, executable files are allowed to run, even if they are in folders excluded in the Exclude Specific Folders policy.
- **Auto Delete**: If selected, after the time period specified in the Days until Deleted policy, files that are quarantined on an endpoint are automatically deleted.
- **Days until Deleted**: 14-365 days

### Memory Actions

<table>
<thead>
<tr>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Protection Enabled</td>
</tr>
<tr>
<td>Enable Exclude executable files</td>
</tr>
</tbody>
</table>

This policy must be selected to use all other Memory policies. If this policy is Not Selected, no Memory Action policies are enforced, regardless of other policy values. **NOTE:** Before enabling Memory Protection, enable Compatibility Mode, to ensure applications function properly on the client computer. For instructions on how to enable Compatibility Mode, see `Enable Compatibility Mode for Memory Protection`. Compatibility Mode does not apply to Mac clients.
Exclude executable files

String

Exclude specific process files from Memory Protection. This allows the specified files to run or be installed on any device on which this policy is enforced.

All exclusions added must be specified using the relative path of that executable file (exclude the drive letter from the path).

Correct (Windows): \Application\SubFolder\application.exe
Correct (Mac): /Users/application.app/executable
Incorrect: \Application\SubFolder\application.exe
Incorrect: C:\Application\SubFolder\application.exe
<table>
<thead>
<tr>
<th>Manage Policies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform\VSCore_ENS_10.1\Release\mfehidin.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\Release\mfehidin.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\Release\mfmms.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\Release\mfevtps.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\Release\mmsinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\Release\vtpinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\aacinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\cacheinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\fwinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mfecanary.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mfefire.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mfehidin.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mfmms.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mfevtps.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\mmsinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Endpoint Security Platform\VSCore_ENS_10.1\x64\vtpinfo.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\FWInstCheck.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\FwWindowsFirewallHandler.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\mffw.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\RepairCache\McAfee_Firewall_x64.msi</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\RepairCache\McAfee_Firewall_x86.msi</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Firewall\RepairCache\setupFW.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\McCHost.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\mffwch.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\mfwch.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\mfwcui.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\RepairCache\McAfee_Web_Control_x86.msi</td>
</tr>
<tr>
<td>Program Files\McAfee\Endpoint Security\Web Control\RepairCache\setupWC.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\marepomirror.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\McScanCheck.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\McScript_InUse.exe</td>
</tr>
<tr>
<td>Program Files\McAfee\mctray_back.exe</td>
</tr>
<tr>
<td>Directory Path</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>\Program Files\McAfee\Mue.exe</td>
</tr>
<tr>
<td>\Program Files\McAfee\policyupgrade.exe</td>
</tr>
<tr>
<td>\Program Files\McAfee\UpdaterUI.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\MaComServer.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\MFEConsole.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\MFEProvisionModeUtility.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\RepairCache\CCUninst.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\aacinfo.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\cacheinfo.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\fwinfo.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\mfecanary.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\mfefire.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\mfehidin.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\mfeProvisionModeUtility.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\repairCache\CCUninst.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\VSComServer.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\VSCoreENSPolicyUpgrade.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\windir\vssetup.exe</td>
</tr>
<tr>
<td>\Program Files (x86)\McAfee\Endpoint Security\Platform\VSCore_ENS_10.1\Release\mfeProvisionModeUtility.exe</td>
</tr>
</tbody>
</table>
Ignore
Alert
Block
Terminate

Specify the action to take when a stack pivot threat is detected.
Ignore - No action is taken against identified memory violations.
Alert - Record the violation and report the incident to the Dell Server.
Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.
Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.
Stack Pivot - The stack for a thread has been replaced with a different stack. Generally the system will only allocate a single stack for a thread. An attacker would use a different stack to control execution in a way that is not blocked by Data Execution Prevention (DEP).
The Stack Pivot exploitation affects Windows and macOS operating systems.
<table>
<thead>
<tr>
<th>Exploitation: Stack Protect</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Stack Protect</strong></td>
<td>Stack Protect - The memory protection of a thread's stack has been modified to enable execution permission. Stack memory should not be executable, so usually this means that an attacker is preparing to run malicious code stored in stack memory as part of an exploit, an attempt which would otherwise be blocked by Data Execution Prevention (DEP).</td>
</tr>
<tr>
<td></td>
<td>The Stack Protect exploitation affects Windows and macOS operating systems.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exploitation: Overwrite Code</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Overwrite Code</strong></td>
<td>Overwrite Code - Code residing in a process's memory has been modified using a technique that may indicate an attempt to bypass Data Execution Prevention (DEP).</td>
</tr>
<tr>
<td></td>
<td>The Overwrite Code exploitation affects Windows operating systems. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exploitation: Scanner Memory Search</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Scanner Memory Search</strong></td>
<td>Scanner Memory Search, or RAM Scraping - A process is trying to read valid magnetic stripe track data from another process. Typically related to point-of-sale systems (POS).</td>
</tr>
<tr>
<td></td>
<td>The Scanner Memory Search exploitation affects Windows operating systems. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>
| Exploitation: Malicious Payload | Alert | Ignore  
Alert  
Block  
Terminate  
Specify the action to take when a malicious payload is detected.  
Ignore - No action is taken against identified memory violations.  
Alert - Record the violation and report the incident to the Dell Server.  
Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.  
Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.  
Malicious Payload - A generic shellcode and payload detection associated with exploitation has been detected.  
The Malicious Payload exploitation affects Windows operating systems. This policy does not apply to Mac clients. |
|---|---|---|
| Process Injection: Remote Allocation of Memory | Alert | Ignore  
Alert  
Block  
Terminate  
Specify the action to take when a remote memory allocation threat is detected.  
Ignore - No action is taken against identified memory violations.  
Alert - Record the violation and report the incident to the Dell Server.  
Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.  
Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call. Most allocations will only occur within the same process. This generally indicates an attempt to inject code or data into another process, which may be a first step in reinforcing a malicious presence on a system.  
The Remote Allocation of Memory process injection affects Windows and macOS operating systems. |
| Process Injection: Remote Mapping of Memory | Alert | Ignore  
Alert  
Block  
Terminate  
Specify the action to take when a remote attempt to map memory threat is detected.  
Ignore - No action is taken against identified memory violations.  
Alert - Record the violation and report the incident to the Dell Server.  
Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.  
Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call. Remote Mapping of Memory - A process has introduced code and/or data into another process. This may indicate an attempt to begin executing code in another process and thereby reinforce a malicious presence.  
The Remote Mapping of Memory process injection affects Windows and macOS operating systems. |
<table>
<thead>
<tr>
<th>Process Injection: Remote Write to Memory</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Specify the action to take when a remote attempt to write to memory threat is detected.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Remote Write to Memory</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Remote Write to Memory process injection</strong></td>
<td>Remote Write to Memory - A process has modified memory in another process. This is usually an attempt to store code or data in previously allocated memory but it is possible that an attacker is trying to overwrite existing memory to divert execution for a malicious purpose.</td>
</tr>
<tr>
<td><strong>Remote Write to Memory process injection elements</strong></td>
<td>The Remote Write to Memory process injection affects Windows and macOS operating systems.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Process Injection: Remote Write PE to Memory</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Specify the action to take when a remote attempt to write a portable executable to memory threat is detected.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Remote Write PE to Memory</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Remote Write PE to Memory process injection</strong></td>
<td>Remote Write PE to Memory - A process has modified memory in another process to contain an executable image. Generally this indicates that an attacker is attempting to execute code without first writing that code to disk.</td>
</tr>
<tr>
<td><strong>Remote Write PE to Memory process injection elements</strong></td>
<td>The Remote Write PE to Memory process injection affects Windows operating systems. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Process Injection: Remote Overwrite Code</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore</strong></td>
<td>Specify the action to take when a remote overwrite code threat is detected.</td>
</tr>
<tr>
<td><strong>Alert</strong></td>
<td>Ignore - No action is taken against identified memory violations.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
</tr>
<tr>
<td><strong>Terminate</strong></td>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
</tr>
<tr>
<td><strong>Remote Overwrite Code</strong></td>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
</tr>
<tr>
<td><strong>Remote Overwrite Code process injection</strong></td>
<td>Remote Overwrite Code - A process has modified executable memory in another process. Under normal conditions executable memory is not modified, especially by another process. This usually indicates an attempt to divert execution in another process.</td>
</tr>
<tr>
<td><strong>Remote Overwrite Code process injection elements</strong></td>
<td>The Remote Overwrite Code process injection affects Windows operating systems. This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Process Injection: Remote Unmap of Memory</td>
<td>Alert</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Ignore</td>
<td>Alert</td>
</tr>
<tr>
<td>Block</td>
<td>Alert</td>
</tr>
<tr>
<td>Terminate</td>
<td>Alert</td>
</tr>
<tr>
<td>Specify the action to take when a remote memory unmapping threat is detected. Ignore - No action is taken against identified memory violations. Alert - Record the violation and report the incident to the Dell Server. Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run. Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call. Remote Unmap of Memory - A process has removed a Windows executable from the memory of another process. This may indicate an intent to replace the executable image with a modified copy for the purpose of diverting execution. The Remote Unmap of Memory process injection affects Windows operating systems. This policy does not apply to Mac clients.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Process Injection: Remote Thread Creation</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore</td>
<td>Alert</td>
</tr>
<tr>
<td>Block</td>
<td>Alert</td>
</tr>
<tr>
<td>Terminate</td>
<td>Alert</td>
</tr>
<tr>
<td>Specify the action to take when a remote thread creation threat is detected. Ignore - No action is taken against identified memory violations. Alert - Record the violation and report the incident to the Dell Server. Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run. Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call. Remote Thread Creation - A process has created a new thread in another process. A process's threads are usually only created by that same process. This is generally used by an attacker to activate a malicious presence that has been injected into another process. The Remote Thread Creation process injection affects Windows and macOS operating systems.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Process Injection: Remote APC Scheduled</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore</td>
<td>Alert</td>
</tr>
<tr>
<td>Block</td>
<td>Alert</td>
</tr>
<tr>
<td>Terminate</td>
<td>Alert</td>
</tr>
<tr>
<td>Specify the action to take when a remote APC scheduled threat is detected. Ignore - No action is taken against identified memory violations. Alert - Record the violation and report the incident to the Dell Server. Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run. Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call. Remote APC Scheduled - A process has diverted the execution of another process's thread. This is generally used by an attacker to activate a malicious presence that has been injected into another process. The Remote APC Scheduled process injection affects Windows operating systems. This policy does not apply to Mac clients.</td>
<td></td>
</tr>
<tr>
<td>Process Injection: Remote DYLD Injection (Mac OS X only)</td>
<td>Alert</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Specify the action to take when a remote DYLD injection threat is detected.</td>
<td></td>
</tr>
<tr>
<td>Ignore - No action is taken against identified memory violations.</td>
<td></td>
</tr>
<tr>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
<td></td>
</tr>
<tr>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
<td></td>
</tr>
<tr>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
<td></td>
</tr>
<tr>
<td>DYLD Injection - An environment variable has been set to cause a shared library to be injected into a launched process. Attacks can modify the plist of applications like Safari or replace applications with bash scripts, that cause their modules to be loaded automatically when an application starts. The DYLD Injection process injection affects macOS operating systems. This policy does not apply to Windows clients.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Escalation: LSASS Read</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the action to take when an LSASS read threat is detected.</td>
<td></td>
</tr>
<tr>
<td>Ignore - No action is taken against identified memory violations.</td>
<td></td>
</tr>
<tr>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
<td></td>
</tr>
<tr>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
<td></td>
</tr>
<tr>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
<td></td>
</tr>
<tr>
<td>LSASS Read - Memory belonging to the Windows Local Security Authority process has been accessed in a manner that indicates an attempt to obtain users' passwords. The LSASS Read escalation affects Windows operating systems. This policy does not apply to Mac clients.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Escalation: Zero Allocate</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the action to take when a zero byte allocation threat is detected.</td>
<td></td>
</tr>
<tr>
<td>Ignore - No action is taken against identified memory violations.</td>
<td></td>
</tr>
<tr>
<td>Alert - Record the violation and report the incident to the Dell Server.</td>
<td></td>
</tr>
<tr>
<td>Block - Block the process call if an application attempts to call a memory violation process. The application that made the call is allowed to continue to run.</td>
<td></td>
</tr>
<tr>
<td>Terminate - Block the process call if an application attempts to call a memory violation process and terminate the application that made the call.</td>
<td></td>
</tr>
<tr>
<td>Zero Allocate - A null page has been allocated. The memory region is typically reserved, but in certain circumstances it can be allocated. Attacks can use this to setup privilege escalation by taking advantage of some known null dereference exploit, typically in the kernel. The Zero Allocate escalation affects Windows and macOS operating systems.</td>
<td></td>
</tr>
</tbody>
</table>

| Execution Control | |
|------------------||
| Prevent Service Shutdown from Device | Not Selected |
| Selected |
| Not Selected |
| If selected, the Advanced Threat Prevention service is protected from being shut down either manually or by another process. |
### Manage Policies

<table>
<thead>
<tr>
<th>Kill Unsafe Running Processes and Sub-Processes</th>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>If selected, processes and sub-processes are quarantined and terminated regardless of their state when a threat is detected (exe or dll). Although a process or sub-process is terminated, the command prompt window remains open. If a file has been determined to be Safe and allowed to run and then a threat model update occurs that results in the file being identified as unsafe, the process is automatically terminated. Dell recommends that you review threat model updates before Selecting this policy. For more information, see Threat Model Updates.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Background Threat Detection</th>
<th>Run Once</th>
</tr>
</thead>
<tbody>
<tr>
<td>If set to Run Recurring or Run Once, a full-disk scan is run to detect and analyze any dormant threats on the disk. An update to the Threat Model triggers a full-disk scan.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Watch for New Files</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>If selected, any new or modified files are detected and analyzed for dormant threats. Dell recommends enabling this policy. However, if Auto Quarantine is enabled for all Unsafe or Abnormal files, all malicious files are blocked at execution. Therefore, it is not necessary to enable this policy with Auto Quarantine mode unless you prefer to quarantine a file as it is added to a disk but before execution.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set Maximum Archive File Size to Scan</th>
<th>150 MB</th>
</tr>
</thead>
<tbody>
<tr>
<td>The default setting is 150 MB. Specify the maximum size of archive (compressed) files, including .jar files to be scanned. Because scanning compressed files can negatively affect computer performance, Dell recommends Quick-Scan - Scan Archives and Full-Scan - Scan Archives to run during off-work hours.</td>
<td></td>
</tr>
</tbody>
</table>

### Protection Settings

<table>
<thead>
<tr>
<th>Enable Exclude Specific Folders (includes subfolders)</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow specific folders to be excluded from Auto Quarantine and Auto Upload. This policy must be Selected to use the Exclude Specific Folders policy.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exclude Specific Folders (includes subfolders)</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folders specified in this policy are excluded from actions performed based on Background Threat Detection and Watch for New Files, when these policies are enabled. This exclusion extends to subfolders of folders that are specified in this policy. All exclusions must be specified using the Absolute path of that executable file. Windows requires an absolute path (requires a drive letter) Mac requires an absolute path (macOS does not use a drive letter) Correct (Windows): C:\Program Files\Dell Correct (Mac): /Mac\ HD/Users/Application\ Support/Dell Incorrect: C:\Program Files\Dell\Executable.exe Incorrect: \Program Files\Dell\ Spaces only must be escaped on Mac-based exclusions.</td>
<td></td>
</tr>
</tbody>
</table>

### Application Control
# Application Control

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Control</td>
<td>Not Selected</td>
<td>If selected, specified devices are locked down, restricting any changes. Only applications that exist on a device before the lock-down are allowed to execute on that device. Any new applications, as well as changes to the executables of existing applications, are denied. The Advanced Threat Prevention agent updater is also disabled. Additionally, certain File Action, Memory Action, and Execution Control policies are automatically set. These policies may be changed after they are automatically set, without disabling Application Control. See Policies Set by Application Control for a list of policies that are automatically set when the Application Control policy is Selected. To exclude specific folders from lockdown, specify the folders in the Application Control Allowed Folders policy. <strong>IMPORTANT:</strong> Specify the following folder in the Application Control Allowed Folders policy when running Data Guardian Protected Office mode with this policy Selected: C:\Users&lt;Username&gt;\AppData\Local\assembly\tmp This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Application Control Allowed Folders</td>
<td>String</td>
<td>Specify folders to be excluded from Application Control lockdown. <strong>IMPORTANT:</strong> Specify the following folder in this policy when running Data Guardian Protected Office mode with the policy Selected: C:\Users&lt;Username&gt;\AppData\Local\assembly\tmp This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Enable Change Window</td>
<td>Not Selected</td>
<td>If selected, Application Control is temporarily disabled to allow, edit, and run new applications or perform updates. This includes updating the Advanced Threat Prevention agent. After performing the necessary changes, deselect Enable Change Window. <strong>Note:</strong> Enable Change Window retains changes made to Application Control. Deselecting Application Control and resetting back to Selected resets Application Control to default values. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>

## Script Control

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Control</td>
<td>Not Selected</td>
<td>If selected, Script Control protects devices by blocking malicious scripts from running. <strong>Note:</strong> Script Control is currently only available for PowerShell and Active Scripts. This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Script Control Mode</td>
<td>Alert</td>
<td>Alert monitors scripts running in the environment. Recommended for initial deployment. Block allows scripts to run only from specific folders. This should be used only after testing in Alert mode. This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Active Script</td>
<td>Alert</td>
<td>Alert monitors Active Scripts running in the environment. Recommended for initial deployment. Block allows Active Scripts to run only from specific folders. This should be used only after testing in Alert mode. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>
Manage Policies

<table>
<thead>
<tr>
<th>Component</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macros</td>
<td>Alert</td>
<td>Alert monitors Office macros running in the environment. Recommended for initial deployment. Block allows Office macros to run only from specific folders. This should be used only after testing in Alert mode. Note: Starting with Office 2013, macros are disabled by default. Most of the time, users should not be required to enable macros to view the content of an Office document. Dell recommends enabling macros only for documents from trusted users. Otherwise, macros should always be disabled. This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>PowerShell</td>
<td>Alert</td>
<td>Alert (default) - Monitors PowerShell scripts running in the environment. Recommended for initial deployment. Block - Allow PowerShell scripts to run only from specific folders. This should be used only after testing in Alert mode. This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>PowerShell Console</td>
<td>Allow</td>
<td>Allow (default) - Allows the PowerShell v3 console to be launched. Block - Blocks the PowerShell v3 console from being launched. Provides additional security by protecting against the use of PowerShell one-liners. Note: If this policy is set to Block and you use a script that launches the PowerShell console, the script will fail. It is recommended that users change their scripts to invoke the PowerShell scripts, not the PowerShell console. This policy applies only to PowerShell v3 and does not apply to Mac clients.</td>
</tr>
<tr>
<td>Enable Approve Scripts in Folders (and Subfolders)</td>
<td>Not Selected</td>
<td>Allows scripts stored in specific folders to be automatically approved to run. This policy must be selected to use the Script Control Approve Scripts in Folders (and Subfolders policy). This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Approve Scripts in Folders (and Subfolders)</td>
<td>String</td>
<td>Folders specified in this policy are excluded from actions performed based on the Script Control policy. This exclusion extends to subfolders of folders that are specified with this policy. A folder must be specified using its relative path. A path may not include the drive letter. Example: \Cases\ScriptsAllowed A specified path may represent any of the following: - local drive path - mapped network drive path - universal naming convention (UNC) path This policy does not apply to Mac clients.</td>
</tr>
<tr>
<td>Quarantine</td>
<td>String</td>
<td>The value of this policy includes a collection of hashes for portable executable that need to be automatically quarantined within the Endpoint Group or on the specific Endpoint. This policy will force quarantine files based on a SHA256 hash of the specific portable executable.</td>
</tr>
<tr>
<td>Waive</td>
<td>String</td>
<td>The value of this policy includes a collection of hashes for portable executable that need to be allowed to run within the Endpoint Group or on the specific Endpoint. This policy will force allow files based on a SHA256 hash of the specific portable executable.</td>
</tr>
<tr>
<td>Global Allow</td>
<td>String</td>
<td>This policy defines a change to the local math model to prevent problematic portable executable to properly run on the machine. This is used in situations where normal exclusions may not properly apply to the files that are needing to be waived. The value of this policy will consist of an XML blob that can be</td>
</tr>
</tbody>
</table>
provided by support if it is required. The value of this policy must include the entire contents of the policy.xml file. Copy and paste the contents of policy.xml into the policy editor as shown in this example.

<table>
<thead>
<tr>
<th>Global Quarantine List</th>
<th>String</th>
<th><strong>String</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The value of this policy includes a collection of hashes for portable executable that need to be automatically quarantined within the enterprise. This policy will force quarantine files based on a SHA256 hash of the specific portable executable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Global Safe List</th>
<th>String</th>
<th><strong>String</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The value of this policy includes a collection of hashes for portable executable that need to be allowed to run within the enterprise. This policy will force allow files based on a SHA256 hash of the specific portable executable.</td>
</tr>
</tbody>
</table>

**Agent Settings**

<table>
<thead>
<tr>
<th>Suppress Popup Notifications</th>
<th>Not Selected</th>
<th><strong>Selected</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If Selected, popup notifications for Advanced Threat Prevention events do not display on the client computer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Minimum Popup Notification Level</th>
<th>High</th>
<th><strong>High</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Medium</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Severity level of events that result in popup notifications that display on the client computer. A setting of High allows only notifications of critical events to display. A setting of Low displays all on-screen notifications for all events. Listed below are examples of events that fall into the severity levels:</td>
</tr>
<tr>
<td>High</td>
<td>1)</td>
<td>Protection status has changed. (Protected means that the Advanced Threat Prevention service is running and protecting the computer and needs no user or administrator interaction.)</td>
</tr>
<tr>
<td>Medium</td>
<td>2)</td>
<td>A threat is detected and policy is not set to automatically address the threat.</td>
</tr>
<tr>
<td>Low</td>
<td>3)</td>
<td>A threat is detected that has an associated mitigation (for example, the threat was manually quarantined), so the process has been terminated.</td>
</tr>
<tr>
<td></td>
<td>4)</td>
<td>A process was blocked or terminated due to a memory violation.</td>
</tr>
<tr>
<td></td>
<td>5)</td>
<td>A memory violation was detected and no automatic mitigation policy is in effect for that violation type.</td>
</tr>
<tr>
<td></td>
<td>6)</td>
<td>A file that was identified as a threat has been added to the Global Safe List or deleted from the file system.</td>
</tr>
<tr>
<td></td>
<td>7)</td>
<td>A threat has been detected and automatically quarantined.</td>
</tr>
<tr>
<td></td>
<td>8)</td>
<td>A file has been identified as a threat but waived on the computer.</td>
</tr>
<tr>
<td></td>
<td>9)</td>
<td>The status of a current threat has changed (for example, Threat to Quarantined, Quarantined to Waived, or Waived to Quarantined).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable BIOS Assurance</th>
<th>Selected</th>
<th><strong>Selected</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If selected, BIOS integrity checks are performed on endpoints computers to validate that the BIOS has not been modified from the Dell factory version. A custom factory image cannot be used with this feature, as the BIOS has been modified. This feature is available only on Dell platforms. Platforms available with this feature include the newest release of select XPS, Latitude, Optiplex, Precision Workstations, and Venues. Speak to your Sales Associates for details or contact Dell ProSupport. This policy does not apply to Mac clients.</td>
</tr>
</tbody>
</table>
## Manage Policies

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Enable Auto-upload of Log Files** | Not Selected    | **Selected**  
If selected, log files are automatically uploaded at 12:00 am or when their size reaches 100 MB. If this policy is Not Selected, logs can still be manually uploaded.  
**Not Selected**  
If this policy is Not Selected, logs can still be manually uploaded. |
| **Enable Standard UI**         | Not Selected    | **Selected**  
If selected, the User Interface that will show individual details for threat events that have occurred on the local client is enabled.  
**Not Selected**  
If this policy is Not Selected, the User Interface that will show individual details for threat events that have occurred on the local client is disabled. |

See [basic settings](#)

### Threat Protection
This technology protects computers by identifying and taking action against threats of malware and malicious activity involving files, folders, the registry, and processes.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Threat Protection**          | Off             | On  
Toggle to ON to enable Threat Protection. If toggled to OFF, no Threat Protection policies are applied.  
Threat Protection includes Malware Protection, Web Protection, and Client Firewall. |
| **Action on Malicious Activity for Files and Folders** | Block and Report | Block Only  
Prevents users from modifying or deleting Threat Protection system files and folders and sets the action to take upon attempt.  
Block Only: Blocks activity but does not report to the Dell Server.  
Report Only: Reports activity to the Dell Server but does not block activity.  
Block and Report (default): Blocks and reports activity to the Dell Server. |
| **Action on Malicious Activity for Registry** | Block and Report | Block Only  
Prevents users from modifying or deleting Threat Protection registry keys and values and sets the action to take upon attempt.  
Block Only: Blocks activity but does not report to the Dell Server.  
Report Only: Reports activity to the Dell Server but does not block activity.  
Block and Report (default): Blocks and reports activity to the Dell Server. |
| **Action on Malicious Activity for Processes** | Block and Report | Block Only  
Prevents users from stopping Threat Protection processes and sets the action to take upon attempt.  
Block Only: Blocks activity but does not report to the Dell Server.  
Report Only: Reports activity to the Dell Server but does not block activity.  
Block and Report (default): Blocks and reports activity to the Dell Server. |
| **Exclude Processes**          | String          | Excludes specific process files from Threat Protection scans.  
Enter the exact resource name of a process to exclude. |

### Client Update

---

218
<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Selected</td>
<td>This policy is the &quot;master policy&quot; for all other Client Scheduling policies. If this policy is Not Selected, no Client Scheduling takes place, regardless of other policy values. A Selected value enables the Client Scheduling options.</td>
</tr>
<tr>
<td>Schedule Repeats</td>
<td>Daily</td>
<td>The schedule configuration defines when the task should run. Schedule types are Daily, Weekly, and Monthly. Daily: Runs the task every day at the specified Schedule Start Time. Weekly: Runs the task weekly on the days specified in Day of the Week. Monthly: Runs the task monthly on the specified Day of the Month.</td>
</tr>
<tr>
<td>Schedule Start Time</td>
<td>String</td>
<td>The time the task should run.</td>
</tr>
<tr>
<td>Day of the Week</td>
<td>Wednesday</td>
<td>The day of the week the task should run.</td>
</tr>
<tr>
<td>Day of the Month</td>
<td>1</td>
<td>The day of the month the task should run. Example: 17.</td>
</tr>
<tr>
<td>Debug Logging for Malware and Exploit Protection</td>
<td>Not Selected</td>
<td>A Selected value enables debug logging of Malware and Exploit Protection activity.</td>
</tr>
<tr>
<td>Exploit Protection</td>
<td>Off</td>
<td>Toggle to ON to enable Exploit Protection. If toggled to OFF, no Exploit Protection policies are applied. Exploit Protection protects the critical operating system resources from changes made by malware or other unauthorized processes.</td>
</tr>
<tr>
<td>On-Access Protection</td>
<td>Off</td>
<td>Toggle to ON to enable On-Access Protection. If toggled to OFF, no On-Access Protection policies are applied. On-Access Protection protects the critical operating system resources from changes made by malware or other unauthorized processes at the time a resource is accessed.</td>
</tr>
<tr>
<td>Max Seconds for Scan</td>
<td>45</td>
<td>Specifies the maximum number of seconds for each file scan. Limits each file scan to the specified number of seconds. If a scan exceeds the time limit, the scan stops and logs a message.</td>
</tr>
<tr>
<td>Scan Boot Sectors</td>
<td>Selected</td>
<td>Examines the disk boot sector. Consider disabling this policy if a disk contains a unique or abnormal boot sector that cannot be scanned.</td>
</tr>
</tbody>
</table>
### Manage Policies

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Processes on Enable</strong></td>
<td>Not Selected</td>
<td>Rescans all processes that are currently in memory each time:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- On-Access Scan is disabled and re-enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The computer starts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the on-access scanner is enabled, it always scans all processes when</td>
</tr>
<tr>
<td></td>
<td></td>
<td>they are executed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Because some programs or executables start automatically when the computer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>starts, enabling this option can slow the computer and increase computer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>startup time.</td>
</tr>
<tr>
<td><strong>Scan Trusted Installers</strong></td>
<td>Not Selected</td>
<td>Scans MSI files or Windows Trusted Installer service files. Disable this</td>
</tr>
<tr>
<td></td>
<td></td>
<td>option to improve the performance of large Microsoft application installers.</td>
</tr>
<tr>
<td><strong>Scan When Copying Between Local Folders</strong></td>
<td>Not Selected</td>
<td>Scans files whenever the user copies from one local folder to another. If</td>
</tr>
<tr>
<td></td>
<td></td>
<td>disabled, only items in the destination folder are scanned. If enabled, items</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in both source and destination folders are scanned.</td>
</tr>
<tr>
<td><strong>Reputation Service Sensitivity</strong></td>
<td>Medium</td>
<td>When enabled, samples are submitted to the lab to determine if they are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>malware. Sensitivity level configures the sensitivity level to use when</td>
</tr>
<tr>
<td></td>
<td></td>
<td>determining if a detected sample is malware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The higher the sensitivity level, the higher the number of malware detections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(the closer to Very High the better). However, allowing more detections might</td>
</tr>
<tr>
<td></td>
<td></td>
<td>result in more false positive results.</td>
</tr>
<tr>
<td><strong>Risk levels:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Very Low</strong></td>
<td></td>
<td>Very low - The detections and risk of false positives are the same as with</td>
</tr>
<tr>
<td></td>
<td></td>
<td>regular content files. A detection is made available to Threat Protection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>when the lab publishes it instead of waiting for the next file update. Use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>this setting for desktops and servers with restricted user rights and a strong</td>
</tr>
<tr>
<td></td>
<td></td>
<td>security footprint. This setting results in an average of 10–15 queries per</td>
</tr>
<tr>
<td></td>
<td></td>
<td>day, per computer.</td>
</tr>
<tr>
<td><strong>Low</strong></td>
<td></td>
<td>Low - This setting is the minimum recommendation for laptops or desktops and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>servers with a strong security footprint. This setting results in an average</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of 10–15 queries per day, per computer.</td>
</tr>
<tr>
<td><strong>Medium</strong></td>
<td></td>
<td>Medium - Use this level when the regular risk of exposure to malware is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>greater than the risk of a false positive. The proprietary, heuristic checks</td>
</tr>
<tr>
<td></td>
<td></td>
<td>result in detections that are likely to be malware. However, some detections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>might result in a false positive. With this setting, the lab checks that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>popular applications and operating system files do not result in a false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>positive. This setting is the minimum recommendation for laptops or desktops</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and servers. This setting results in an average of 20–25 queries per day,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>per computer.</td>
</tr>
<tr>
<td><strong>High</strong></td>
<td></td>
<td>High - Use this setting for deployment to systems or areas which are regularly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>infected. This setting results in an average of 20–25 queries per day, per</td>
</tr>
<tr>
<td></td>
<td></td>
<td>computer.</td>
</tr>
<tr>
<td><strong>Very High</strong></td>
<td></td>
<td>Very high - Dell recommends using this level only for scanning volumes and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>directories that do not support executing programs or operating systems.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Detections found with this level are presumed malicious, but have not been</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fully tested to determine if they are false positives. Use this setting for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on-demand scans on non-operating system volumes. This setting results in an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>average of 20–25 queries per day, per computer.</td>
</tr>
<tr>
<td>Policy</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>On-Demand Protection - Full Scan</td>
<td>Selected</td>
<td>This policy is the &quot;master policy&quot; for all other On-Demand Protection: Full Scan policies. If this policy is Not Selected, no On-Demand Protection: Full Scan policies are enforced, regardless of other policy values. A Selected value means that On-Demand Protection: Full Scan is enabled. This policy must be set to Selected to enable On-Demand Protection: Full Scan settings. If this policy is Not Selected, no On-Demand Protection: Full Scan policies are applied. By default, every time Full Scan runs, it scans the following locations for threats: - the computer memory for installed rootkits, hidden processes, and other behavior that suggests malware is attempting to hide itself. This scan occurs before all other scans. - the memory of all running processes. - all drives and their subfolders on the computer. By default, the scanner scans all file types, regardless of extension.</td>
</tr>
<tr>
<td>Full Scan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boot Sectors</td>
<td>Selected</td>
<td>Examines the disk boot sector. Consider disabling this policy if a disk contains a unique or abnormal boot sector that cannot be scanned.</td>
</tr>
<tr>
<td>Unwanted Programs</td>
<td>Selected</td>
<td>Enables the scanner to detect potentially unwanted programs. The scanner uses configured information to detect potentially unwanted programs.</td>
</tr>
<tr>
<td>Decode MIME Files</td>
<td>Not Selected</td>
<td>Detects, decodes, and scans Multipurpose Internet Mail Extensions (MIME) encoded files.</td>
</tr>
<tr>
<td>Scan Archives</td>
<td>Selected</td>
<td>Examines the contents of archive (compressed) files, including .jar files. Because scanning compressed files can negatively affect computer performance, Dell recommends using this option in scans during off-work hours.</td>
</tr>
<tr>
<td>Files Migrated to Storage</td>
<td>Not Selected</td>
<td>Scans files that remote storage manages. When the scanner encounters a file with migrated content, it restores the file to the local computer before scanning.</td>
</tr>
<tr>
<td>Program Threats</td>
<td>Selected</td>
<td>Detects executable files that have code that resembles malware.</td>
</tr>
<tr>
<td>Macro Threats</td>
<td>Selected</td>
<td>Detects unknown macro viruses.</td>
</tr>
<tr>
<td>Scan Subfolders</td>
<td>Selected</td>
<td>Examines all subfolders of the specified folder.</td>
</tr>
<tr>
<td>Reputation Service Sensitivity</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------</td>
<td></td>
</tr>
</tbody>
</table>
| When enabled, samples are submitted to the lab to determine if they are malware. Sensitivity level configures the sensitivity level to use when determining if a detected sample is malware. The higher the sensitivity level, the higher the number of malware detections. However, allowing more detections might result in more false positive results. | Disable
Very Low
Low
Medium
High
Very High |

Risk levels:

Very low - The detections and risk of false positives are the same as with regular content files. A detection is made available to Threat Protection when the lab publishes it instead of waiting for the next content file update. Use this setting for desktops and servers with restricted user rights and a strong security footprint. This setting results in an average of 10–15 queries per day, per computer.

Low - This setting is the minimum recommendation for laptops or desktops and servers with a strong security footprint. This setting results in an average of 10–15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is greater than the risk of a false positive. The proprietary, heuristic checks result in detections that are likely to be malware. However, some detections might result in a false positive. With this setting, the lab checks that popular applications and operating system files do not result in a false positive. This setting is the minimum recommendation for laptops or desktops and servers. This setting results in an average of 20–25 queries per day, per computer.

High - Use this setting for deployment to systems or areas which are regularly infected. This setting results in an average of 20–25 queries per day, per computer.

Very high - Dell recommends using this level only for scanning volumes and directories that do not support executing programs or operating systems. Detections found with this level are presumed malicious, but have not been fully tested to determine if they are false positives. Use this setting for on-demand scans on non-operating system volumes. This setting results in an average of 20–25 queries per day, per computer.

<table>
<thead>
<tr>
<th>Exclusions</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify files, folders, and drives to exclude from scanning. Comma separated list of parameters: &lt;ExclusionType&gt;,&lt;ExclusionData&gt;,&lt;ExcludeSubfolders (only applies to FileOrFolder type)&gt; Possible values: &lt;FileOrFolder</td>
<td>FileType</td>
</tr>
</tbody>
</table>

Examples: FileOrFolder,C:\\Users,false FileType,xml,false FileType,mp?,false ModifiedAge,120,true AccessedAge,150,false CreatedAge,300,true
<table>
<thead>
<tr>
<th>Threat First Response</th>
<th>Clean file</th>
<th>Delete file</th>
<th>Continue scanning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean file</td>
<td>Clean file</td>
<td>Delete file</td>
<td>Continue scanning</td>
</tr>
<tr>
<td>Delete files</td>
<td>Clean file</td>
<td>Delete file</td>
<td>Continue scanning</td>
</tr>
<tr>
<td>Delete files</td>
<td>Clean file</td>
<td>Delete file</td>
<td>Continue scanning</td>
</tr>
<tr>
<td>Continue scanning</td>
<td>Clean file</td>
<td>Delete file</td>
<td>Continue scanning</td>
</tr>
</tbody>
</table>

**Threat First Response**
- **Clean file** - Removes the threat from the detected file, if possible.
- **Delete file** - Deletes files with potential threats.
- **Continue scanning** - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.

**Threat First Response Fails**
- **Clean file** - Removes the threat from the detected file, if possible.
- **Delete file** - Deletes files with potential threats.
- **Continue scanning** - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.

**Exploit First Response**
- **Clean file** - Removes the threat from the detected file, if possible.
- **Delete file** - Deletes files with potential threats.
- **Continue scanning** - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.

**Exploit First Response Fails**
- **Clean file** - Removes the threat from the detected file, if possible.
- **Delete file** - Deletes files with potential threats.
- **Continue scanning** - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.

**Use Scan Cache**
- **Selected** - A Selected value enables the scanner to use the existing clean scan results. A Selected value reduces duplicate scanning and improves performance.
- **Not Selected** - Not Selected postpones the scan until the computer is no longer using battery power.

**System Utilization**
- **Below Normal** - Enables the operating system to specify the amount of CPU time that the scanner receives during the scan. Each task runs independently, unaware of the limits for other tasks. Low Priority - Provides improved performance for other running applications. Select this option for computers with end user activity. Below Normal - Sets the computer utilization for the scan to the default. Normal - Enables the scan to complete faster. Select this option for computers that have large volumes and low user activity.

**Scan on Battery Power**
- **Selected** - A Selected value allows the scan when the computer is using battery power. Not Selected postpones the scan until the computer is no longer using battery power.
## Manage Policies

| Schedule Repeats | Daily | Daily  
|------------------|-------|-------
|                  |       | Weekly
|                  |       | Monthly
| The schedule configuration defines when the task should run. Schedule types are Daily, Weekly, and Monthly. Daily: Runs the task every day at the specified Full-Scan Schedule Start Time. Weekly: Runs the task weekly on the days specified in Full-Scan Schedule Day of the Week. Monthly: Runs the task monthly on the specified Full-Scan Schedule Day of the Month. |

<table>
<thead>
<tr>
<th>Schedule Start Time</th>
<th>String</th>
<th>String - format is [HH:mm tt]. Example: 11:59 PM The time the task should run.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Day of the Week</th>
<th>Wednesday</th>
<th>Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday The day of the week the task should run.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Day of the Month</th>
<th>1</th>
<th>1-31 The day of the month the task should run. Example: 17.</th>
</tr>
</thead>
</table>

### Quick Scan

<table>
<thead>
<tr>
<th>On-Demand Protection - Quick Scan</th>
<th>Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>This policy is the &quot;master policy&quot; for all other On-Demand Protection: Quick Scan policies. If this policy is Not Selected, no On-Demand Protection: Quick Scan policies are enforced, regardless of other policy values. A Selected value means that On-Demand Protection: Quick Scan is enabled. This policy must be set to Selected to enable On-Demand Protection: Quick Scan settings. If this policy is Not Selected, no On-Demand Protection: Quick Scan policies are applied. By default, every time Quick Scan runs, it scans the following locations for threats: - the memory of all running processes - the files that the Windows Registry references - the contents of the Windows folder - the contents of the Temp folder By default, the scanner scans all file types, regardless of extension.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Boot Sectors</th>
<th>Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examines the disk boot sector. Consider disabling this policy if a disk contains a unique or abnormal boot sector that cannot be scanned.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unwanted Programs</th>
<th>Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enables the scanner to detect potentially unwanted programs. The scanner uses configured information to detect potentially unwanted programs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Decode MIME Files</th>
<th>Not Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detects, decodes, and scans Multipurpose Internet Mail Extensions (MIME) encoded files.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scan Archives</th>
<th>Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examines the contents of archive (compressed) files, including .jar files. Because scanning compressed files can negatively affect computer performance, Dell recommends using this option in scans during off-work hours.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Files Migrated to Storage</td>
<td>Not Selected</td>
<td>Selected: Scans files that remote storage manages. When the scanner encounters a file with migrated content, it restores the file to the local computer before scanning.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not Selected:</td>
</tr>
<tr>
<td>Program Threats</td>
<td>Selected</td>
<td>Selected: Detects executable files that have code that resembles malware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not Selected: Detects executable files that have code that resembles malware.</td>
</tr>
<tr>
<td>Macro Threats</td>
<td>Selected</td>
<td>Selected: Detects unknown macro viruses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not Selected: Detects unknown macro viruses.</td>
</tr>
<tr>
<td>Scan Subfolders</td>
<td>Selected</td>
<td>Selected: Examines all subfolders of the specified folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not Selected:</td>
</tr>
<tr>
<td>Reputation Service Sensitivity</td>
<td>Medium</td>
<td>Disable:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Very Low: When enabled, samples are submitted to the lab to determine if they are malware. Sensitivity level configures the sensitivity level to use when determining if a detected sample is malware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low: The higher the sensitivity level, the higher the number of malware detections. However, allowing more detections might result in more false positive results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium: Use this level when the regular risk of exposure to malware is greater than the risk of a false positive. The proprietary, heuristic checks result in detections that are likely to be malware. However, some detections might result in a false positive. With this setting, the lab checks that popular applications and operating system files do not result in a false positive. This setting is the minimum recommendation for laptops or desktops and servers. This setting results in an average of 10–15 queries per day, per computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High: Use this setting for deployment to systems or areas which are regularly infected. This setting results in an average of 20–25 queries per day, per computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Very High: Dell recommends using this level only for scanning volumes and directories that do not support executing programs or operating systems. Detections found with this level are presumed malicious, but have not been fully tested to determine if they are false positives. Use this setting for on-demand scans on non-operating system volumes. This setting results in an average of 20–25 queries per day, per computer.</td>
</tr>
</tbody>
</table>
### Exclusions

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td></td>
<td>Specify files, folders, and drives to exclude from scanning.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Comma separated list of parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;ExclusionType&gt;,&lt;ExclusionData&gt;,&lt;ExcludeSubfolders (only applies to FileOrFolder type)&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Possible values: `&lt;FileOrFolder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FileOrFolder,C:\Users,false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FileType,xml,false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FileType,mp?,false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ModifiedAge,120,true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AccessedAge,150,false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CreatedAge,300,true</td>
</tr>
</tbody>
</table>

### Threat First Response

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean file</td>
<td>Specifies the first action for the scanner to take when a threat is detected. Clean files - Removes the threat from the detected file, if possible. Delete files - Deletes files with potential threats. Continue scanning - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.</td>
</tr>
<tr>
<td>Delete file</td>
<td></td>
</tr>
<tr>
<td>Continue scanning</td>
<td></td>
</tr>
</tbody>
</table>

### Threat First Response Fails

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean file</td>
<td>Specifies the first action for the scanner to take when a threat is detected if the first action fails. Clean files - Removes the threat from the detected file, if possible. Delete files - Deletes files with potential threats. Continue scanning - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.</td>
</tr>
<tr>
<td>Delete file</td>
<td></td>
</tr>
<tr>
<td>Continue scanning</td>
<td></td>
</tr>
</tbody>
</table>

### Exploit First Response

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean file</td>
<td>Specifies the first action for the scanner to take when a potential exploit is detected. Clean files - Removes the threat from the detected file, if possible. Delete files - Deletes files with potential threats. Continue scanning - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.</td>
</tr>
<tr>
<td>Delete file</td>
<td></td>
</tr>
<tr>
<td>Continue scanning</td>
<td></td>
</tr>
</tbody>
</table>

### Exploit First Response Fails

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean file</td>
<td>Specifies the action for the scanner to take when an exploit is detected if the first action fails. Clean files - Removes the threat from the detected file, if possible. Delete files - Deletes files with potential threats. Continue scanning - Continues scanning files when a threat is detected. The scanner does not move items to the quarantine.</td>
</tr>
<tr>
<td>Delete file</td>
<td></td>
</tr>
<tr>
<td>Continue scanning</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Use Scan Cache</td>
<td>Selected</td>
</tr>
<tr>
<td>System Utilization</td>
<td>Below Normal</td>
</tr>
<tr>
<td>Scan on Battery Power</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Schedule Repeats</td>
<td>Daily</td>
</tr>
<tr>
<td>Schedule Start Time</td>
<td>String</td>
</tr>
<tr>
<td>Day of the Week</td>
<td>Wednesday</td>
</tr>
<tr>
<td>Day of the Month</td>
<td>1</td>
</tr>
<tr>
<td>Access Protection</td>
<td>Selected</td>
</tr>
<tr>
<td>Script Scan Protection</td>
<td>Selected</td>
</tr>
</tbody>
</table>
| Source Sites for Update         | Hyperlink   | To modify the source sites your clients access for Malware Protection signature updates, click the Source Sites for Updates link. To modify the priority level or availability of an external source site, click either NAIHttp or NAIFtp, edit the necessary fields, and click OK. To designate an internal signature update server, see Designate a Threat Protection Signature Update Server. Designating a signature update server
within your network allows client computers to obtain signature updates without accessing the Internet.

See [basic settings](#)

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Protection</strong></td>
<td>Off</td>
<td>On Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Toggle to ON to enable Web Protection. If toggled to OFF, no Web Protection policies are applied.</td>
</tr>
<tr>
<td><strong>Enforcement - Action to Apply to Sites Not Verified</strong></td>
<td>Allow</td>
<td>Block Allow Warn</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specifies the default action to apply to sites that have not been verified. Block: Prevents users from accessing the site and displays a message that the site is blocked. Allow: Permits users to access the site. Warn: Displays a warning to notify users of potential dangers associated with the site. Users must dismiss the warning before continuing.</td>
</tr>
<tr>
<td><strong>Enforcement - Enable File Scanning for File Downloads</strong></td>
<td>Selected</td>
<td>Selected Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A Selected value scans all files (including .zip files) before downloading. This option prevents users from accessing a downloaded file until Threat Protection marks the file as clean. Downloaded files are sent to Threat Protection for scanning. Threat Protection performs a Reputation Service lookup on the file. If a downloaded file is detected as a threat, Threat Protection takes action on the file and alerts the user. NOTE: This policy does not apply when Web Protection is installed as an optional feature with Advanced Threat Prevention.</td>
</tr>
<tr>
<td><strong>Enforcement - Enable HTML iframes Support</strong></td>
<td>Selected</td>
<td>Selected Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A Selected value blocks access to malicious (Red) and warn (Yellow) sites that display in an HTML iframe.</td>
</tr>
<tr>
<td><strong>Enforcement - Block Sites by Default if Reputation Service Server is not Reachable</strong></td>
<td>Not Selected</td>
<td>Selected Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A Selected value blocks access to websites if Web Control cannot reach the Reputation Service server.</td>
</tr>
<tr>
<td><strong>Enforcement - Block Phishing Pages for All Sites</strong></td>
<td>Selected</td>
<td>Selected Not Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A Selected value blocks all phishing pages, overriding content rating actions.</td>
</tr>
</tbody>
</table>
| Enforcement - Specify Reputation Service Risk Level to Block | Very High | Disable
Very Low
Low
Medium
High
Very High |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the Reputation Service risk level to block when the Threat Protection on-demand scan feature is not installed and enabled. Web Protection uses the risk level to calculate the score when retrieving the checksum reputation from the Reputation Service.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Exclusions for Web Protection</td>
<td>String</td>
<td>String - IP or IP Range Configures Web Protection not to rate or act on the specified private IP address range. The format is the IP address or IP address range.</td>
</tr>
</tbody>
</table>
| Enable Secure Search | Not Selected | Selected
Not Selected |
| A Selected value enables Secure Search, automatically blocking malicious sites in search results based on safety rating. |
| Set Default Search Engine | Google | Google
Yahoo
Bing
Ask |
| Specifies the default search engine to use for supported browsers: Google, Yahoo, Bing, Ask. |
| Block Links to Risky Sites in Search Results | Not Selected | Selected
Not Selected |
| A Selected value prevents users from clicking links to risky sites in search results. |
| Rating Action for Red Sites | Block | Block
Allow
Warn |
| Specifies the action to apply to sites that are rated Red. Block: Prevents users from accessing the site and displays a message that the site is blocked. Block is the default for Red sites. Allow: Permits users to access the site. Warn: Displays a warning to notify users of potential dangers associated with the site. Users must dismiss the warning before canceling or proceeding to the site. Green-rated sites and downloads are automatically allowed. |
| Rating Action for Yellow Sites | Warn | Block
Allow
Warn |
<p>| Specifies the action to apply to sites that are rated Yellow. Block: Prevents users from accessing the site and displays a message that the site is blocked. Allow: Permits users to access the site. Warn: Displays a warning to notify users of potential dangers associated with the site. Users must dismiss the warning before canceling or proceeding to the site. Warn is the default for Yellow sites. Green-rated sites and downloads are automatically allowed. |</p>
<table>
<thead>
<tr>
<th>Rating Action for Unrated Sites</th>
<th>Allow</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Allow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Warn</td>
</tr>
<tr>
<td>Specifies the action to apply to sites that are Unrated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block: Prevents users from accessing the site and displays a message that the site is blocked.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow: Permits users to access the site. Allow is the default for Unrated sites.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warn: Displays a warning to notify users of potential dangers associated with the site. Users must dismiss the warning before canceling or proceeding to the site.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green-rated sites and downloads are automatically allowed.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rating Action for Red Downloads</th>
<th>Block</th>
<th>Warn</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Allow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Warn</td>
</tr>
<tr>
<td>Specifies the action to apply to file downloads that are rated Red.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block: Prevents users from downloading the file and displays a message that the download is blocked. Block is the default for Red downloads.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow: Permits users to proceed with the download.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warn: Displays a warning to notify users of potential dangers associated with the download file. Users must dismiss the warning before ending or proceeding with the download.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rating Action for Yellow Downloads</th>
<th>Warn</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td>Allow</td>
</tr>
<tr>
<td></td>
<td>Warn</td>
</tr>
<tr>
<td>Specifies the action to apply to file downloads that are rated Yellow.</td>
<td></td>
</tr>
<tr>
<td>Block: Prevents users from downloading the file and displays a message that the download is blocked.</td>
<td></td>
</tr>
<tr>
<td>Allow: Permits users to proceed with the download.</td>
<td></td>
</tr>
<tr>
<td>Warn: Displays a warning to notify users of potential dangers associated with the download file. Users must dismiss the warning before ending or proceeding with the download. Warn is the default for Yellow sites.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rating Action for Unrated Downloads</th>
<th>Allow</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td>Allow</td>
</tr>
<tr>
<td></td>
<td>Warn</td>
</tr>
<tr>
<td>Specifies the action to apply to file downloads that are Unrated.</td>
<td></td>
</tr>
<tr>
<td>Block: Prevents users from downloading the file and displays a message that the download is blocked.</td>
<td></td>
</tr>
<tr>
<td>Allow: Permits users to proceed with the download. Allow is the default for Unrated downloads.</td>
<td></td>
</tr>
<tr>
<td>Warn: Displays a warning to notify users of potential dangers associated with the download file. Users must dismiss the warning before ending or proceeding with the download.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web Event Logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Web Control iFrame Events</td>
</tr>
<tr>
<td>Selected</td>
</tr>
<tr>
<td>When this policy is selected, blocked Red (malicious) and Yellow (warn) sites that display in an HTML iFrame are logged.</td>
</tr>
</tbody>
</table>

| Log Web Categories Green Rated Sites | Not Selected |
| Selected | Not Selected |
| When this policy is selected, content categories are logged for all green-rated sites. Selecting this policy may affect Server performance. | |

<p>| Enable Web Category Blocking | Not Selected |
| Selected | Not Selected |
| When this policy is selected, web sites can be blocked based on category. Web Categories that can be blocked | |
| When this policy is selected, the following categories can be blocked. Select the check box next to a category to block that category. Categories indicated | |</p>
<table>
<thead>
<tr>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Art/Culture/Heritage</td>
</tr>
<tr>
<td>Alcohol</td>
</tr>
<tr>
<td>Anonymizers</td>
</tr>
<tr>
<td>Anonymizing Utilities</td>
</tr>
<tr>
<td>Business</td>
</tr>
<tr>
<td>Chat</td>
</tr>
<tr>
<td>Public Information</td>
</tr>
<tr>
<td>Potential Criminal Activities</td>
</tr>
<tr>
<td>Drugs</td>
</tr>
<tr>
<td>Education/Reference</td>
</tr>
<tr>
<td>Entertainment</td>
</tr>
<tr>
<td>Extreme</td>
</tr>
<tr>
<td>Finance/Banking</td>
</tr>
<tr>
<td>Gambling</td>
</tr>
<tr>
<td>Games</td>
</tr>
<tr>
<td>Government/Military</td>
</tr>
<tr>
<td>Potential Hacking/Computer Crime*</td>
</tr>
<tr>
<td>Health</td>
</tr>
<tr>
<td>Humor/Comics</td>
</tr>
<tr>
<td>Discrimination</td>
</tr>
<tr>
<td>Instant Messaging</td>
</tr>
<tr>
<td>Stock Trading</td>
</tr>
<tr>
<td>Internet Radio/TV</td>
</tr>
<tr>
<td>Job Search</td>
</tr>
<tr>
<td>Information Security</td>
</tr>
<tr>
<td>Dating/Social Networking</td>
</tr>
<tr>
<td>Mobile Phone</td>
</tr>
<tr>
<td>Media Downloads</td>
</tr>
<tr>
<td>Malicious Sites*</td>
</tr>
<tr>
<td>Usenet News</td>
</tr>
<tr>
<td>Nudity</td>
</tr>
<tr>
<td>Non-Profit/Advocacy/NGO</td>
</tr>
<tr>
<td>General News</td>
</tr>
<tr>
<td>Online Shopping</td>
</tr>
<tr>
<td>Provocative Attire</td>
</tr>
<tr>
<td>P2P/File Sharing</td>
</tr>
<tr>
<td>Politics/Opinion</td>
</tr>
<tr>
<td>Personal Pages</td>
</tr>
<tr>
<td>Portal Sites</td>
</tr>
<tr>
<td>Remote Access</td>
</tr>
<tr>
<td>Religion/Ideology</td>
</tr>
<tr>
<td>Resource Sharing</td>
</tr>
<tr>
<td>Search Engines</td>
</tr>
<tr>
<td>Sports</td>
</tr>
<tr>
<td>Streaming Media</td>
</tr>
<tr>
<td>Shareware/Freeware</td>
</tr>
<tr>
<td>Pornography*</td>
</tr>
<tr>
<td>Spyware/Adware/Keyloggers*</td>
</tr>
<tr>
<td>Tobacco</td>
</tr>
<tr>
<td>Travel</td>
</tr>
<tr>
<td>Violence</td>
</tr>
<tr>
<td>Web Ads</td>
</tr>
<tr>
<td>Weapons</td>
</tr>
<tr>
<td>Web Mail</td>
</tr>
<tr>
<td>Web Phone</td>
</tr>
<tr>
<td>Auctions/Classifieds</td>
</tr>
<tr>
<td>Forum/Bulletin Boards</td>
</tr>
<tr>
<td>Profanity</td>
</tr>
<tr>
<td>School Cheating Information</td>
</tr>
<tr>
<td>Sexual Materials</td>
</tr>
</tbody>
</table>
### Manage Policies

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Client Firewall</strong></td>
<td>Off</td>
<td>This technology protects computers by allowing administrators to determine which network traffic is permitted to pass between end user computers and the network.</td>
</tr>
</tbody>
</table>

**See basic settings**

**Client Firewall**

This technology protects computers by allowing administrators to determine which network traffic is permitted to pass between end user computers and the network.

- **On**
  - Toggle to ON to enable Client Firewall. If toggled to OFF, no Client Firewall Settings or Rules are applied.
  - Client firewall is a stateful firewall.
Client Firewall Settings and Rules

In the Client Firewall policy, Settings and Rules, click View/Edit.

In the Settings window, you can set Client Firewall Options and Client Firewall Rules.

Return to Client Firewall Policies

### Client Firewall Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>UI Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protection Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow traffic for unsupported protocols</td>
<td>Check box</td>
<td>Allows all traffic that uses unsupported protocols. When disabled, all traffic using unsupported protocols is blocked.</td>
</tr>
<tr>
<td>Allow only outgoing traffic until firewall services have started</td>
<td>Check box</td>
<td>Allows outgoing traffic but no incoming traffic until the Firewall service starts. If this option disabled, Firewall allows all traffic before services are started.</td>
</tr>
<tr>
<td>Allow bridged traffic</td>
<td>Check box</td>
<td>Allows traffic with a local MAC address. The MAC address is an address in the list of VMs that Firewall supports, not the local system's MAC address. Use this option to allow traffic through a bridged environment with virtual machines.</td>
</tr>
<tr>
<td>Enable IP spoof protection</td>
<td>Check box</td>
<td>Blocks network traffic from non-local host IP addresses or from local processes that attempt to spoof their IP address.</td>
</tr>
<tr>
<td>Enable firewall intrusion alerts</td>
<td>Check box</td>
<td>Displays alerts automatically when Firewall detects a potential attack.</td>
</tr>
<tr>
<td><strong>Tuning Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Adaptive mode</td>
<td>Check box</td>
<td>Creates rules automatically to allow traffic. <strong>NOTE:</strong> Enable this option temporarily while tuning a deployment.</td>
</tr>
<tr>
<td>Log all blocked traffic to client activity log</td>
<td>Check box</td>
<td>Enabled by default Logs all blocked traffic to the Firewall event log (FirewallEventMonitor.log) on the Endpoint Security Client.</td>
</tr>
<tr>
<td>Log all allowed traffic to client activity log</td>
<td>Check box</td>
<td>Disabled by default Logs all allowed traffic to the Firewall event log (FirewallEventMonitor.log) on the Endpoint Security Client. <strong>NOTE:</strong> Enabling this option might negatively impact performance.</td>
</tr>
</tbody>
</table>
### Network Reputation

<table>
<thead>
<tr>
<th>Setting</th>
<th>UI Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming network - reputation threshold</td>
<td>Drop-down menu</td>
<td><strong>High Risk</strong>: Specifies the rating threshold for blocking incoming or outgoing traffic from a network connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Unverified</strong>: This site appears to be a legitimate source or destination of content/traffic, but also displays properties suggesting that further inspection is necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Do not block</strong>: This site is a legitimate source or destination of content/traffic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Medium Risk</strong>: This source/destination shows behavior that is considered suspicious. Any content/traffic from the site requires special scrutiny.</td>
</tr>
<tr>
<td>Outgoing network - reputation threshold</td>
<td>Drop-down menu</td>
<td><strong>High Risk</strong>: Specifies the rating threshold for blocking incoming or outgoing traffic from a network connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Unverified</strong>: This site appears to be a legitimate source or destination of content/traffic, but also displays properties suggesting that further inspection is necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Do not block</strong>: This site is a legitimate source or destination of content/traffic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Medium Risk</strong>: This source/destination shows behavior that is considered suspicious. Any content/traffic from the site requires special scrutiny.</td>
</tr>
</tbody>
</table>

### Stateful Firewall

<table>
<thead>
<tr>
<th>Setting</th>
<th>UI Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of seconds (1-240) before TCP connections time out</td>
<td>Up/down number selector</td>
<td>Specifies the time, in seconds, that an unestablished TCP connection remains active if no more packets matching the connection are sent or received. The default number is 60; the valid range is 1–240.</td>
</tr>
</tbody>
</table>
Number of seconds (1-300) before UDP and ICMP echo virtual connections time out

- **Up/down number selector**

  Specifies the time, in seconds, that a UDP or ICMP Echo virtual connection remains active if no more packets matching the connection are sent or received. This option resets to its configured value every time a packet that matches the virtual connection is sent or received. The default number is 60; the valid range is 1–300.

<table>
<thead>
<tr>
<th>Setting</th>
<th>UI Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNS Blocking</td>
<td>Button/text input field</td>
<td>Defines domain names to block. When applied, this setting adds a rule near the top of the firewall rules that blocks connections to the IP addresses resolving to the domain names. Add - To add a domain name to block, click Add, then enter a domain name. You can use the * and ? wildcards. For example, *domain.com. Separate multiple domains with a comma (,) or a carriage return. Duplicate entries are automatically removed. Delete - To remove a domain name from the blocked list, select the domain name and click Delete.</td>
</tr>
<tr>
<td>Domain name</td>
<td>Text input field</td>
<td>Specifies the descriptive name of the item.</td>
</tr>
</tbody>
</table>

**Return to top**

**Client Firewall Rules**

Client Firewall applies the rule at the top of the firewall rules list.

1. Client Firewall applies the rule at the top of the firewall rules list. If the traffic meets this rule's conditions, Client Firewall allows or blocks the traffic. It doesn't try to apply any other rules in the list.

2. If the traffic doesn't meet the first rule's conditions, Client Firewall continues to the next rule in the list until it finds a rule that the traffic matches.

3. If no rule matches, the firewall automatically blocks the traffic.

To modify Core Networking or Default Rules, expand either Core Networking Rules or Default Rules, select the rule to modify, and edit the desired settings, and click OK. The settings are described in the table below.

Alternatively, click one of the following buttons to perform the desired action:

- **Add Rule** - Adds a firewall rule.
- **Duplicate** - Creates a copy of the selected item.
- **Delete** - Removes a selected firewall item.
### Manage Policies

<table>
<thead>
<tr>
<th>Status</th>
<th>Check box</th>
<th>Select <strong>Enable rule</strong> to make the rule active.</th>
</tr>
</thead>
</table>

**Actions**  
Radio button/Check box

- **Allow**
- **Block**
- **Treat match as intrusion**
- **Log matching traffic**

**Details:**
- **Allow** - Allows traffic through the firewall if the item is matched.
- **Block** - Stops traffic from passing through the firewall if the item is matched.
- **Treat match as intrusion** - Treats traffic that matches the rule as an attack and generates an event that is sent to the Reputation Service. The **Block** action for the rule must be selected for an event to be generated.
- **Log matching traffic** - Preserves a record of matching traffic in the Firewall activity log on the Endpoint Security Client.

**Direction**  
Drop-down menu

- **In**
- **Out**
- **Either**

**Details:**
- **In** - Monitors incoming traffic.
- **Out** - Monitors outgoing traffic.
- **Either** - Monitors both incoming and outgoing traffic.

**Notes**  
Text input field  
**Provides more information about the rule.**

### Setting | UI Control | Description

### Networks

**Network protocol**  
Radio button/Check box  
**Any protocol**
**IP protocol**
**Non-IP protocol**
- **Any protocol** - Allows both IP and non-IP protocols.
- **IP protocol** - Indicates select either IP protocol IPv4 protocol or IPv6 protocol. If neither check box is selected, any IP protocol applies. Both IPv4 and IPv6 are selectable.
- **Non-IP protocol** - Includes non-IP protocols only.

**Connection types**  
Check box

- **Wired**
- **Wireless**
- **Virtual**

**Details:**
- **Indicates if one or all connection types apply.**
- **A Virtual connection type is an adapter presented by a VPN or a virtual machine application, such as VMware, rather than a physical adapter.**

**Specify Networks**  
Button/Drop-down menu/text input field

**Details:**
- **To add a network, click **Add**, then specify the following:**
  - **Name** - Specifies the network address name (required).
  - **Type** - Select either Local Network or Remote Network.
  - **Click **Add**, then specify the following:**
  - **Network type** - Specifies the origin or destination of traffic. Select from the network types Single IP, Subnet, Local subnet, Range, or Fully qualified.
### Domain name

*IP address - Specifies the IP address to add to the network. Wildcards are valid.*

### Transport

<table>
<thead>
<tr>
<th><strong>Transport protocol</strong></th>
<th>Drop-down menu</th>
</tr>
</thead>
</table>

**Select the transport protocol from the menu.**

### Executables

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th><strong>String</strong></th>
</tr>
</thead>
</table>

*The name that you use for the executable to add or edit.*

<table>
<thead>
<tr>
<th><strong>File path</strong></th>
<th><strong>String</strong></th>
</tr>
</thead>
</table>

*The file path to the executable.*

<table>
<thead>
<tr>
<th><strong>File description</strong></th>
<th><strong>String</strong></th>
</tr>
</thead>
</table>

*Description of the executable.*
Manage Policies

<table>
<thead>
<tr>
<th>Fingerprint</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>The MD5 hash of the process.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable digital signature check</th>
<th>Check box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enables or disables the digital signature check that guarantees code has not been altered or corrupted since it was signed with a cryptographic hash. If enabled, specify: Allow any signature — Allows files signed by any process signer. Signed by — Allows only files signed by the specified process signer.</td>
<td></td>
</tr>
</tbody>
</table>

Return to top

Return to Client Firewall Policies

Policies Set by Application Control

The following policies are set when Advanced Threat Prevention > Application Control is selected.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Setting When Application Control policy is Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsafe Executable Auto Quarantine With Executable Control Enabled</td>
<td>Selected</td>
</tr>
<tr>
<td>Abnormal Executable Auto Quarantine With Executable Control Enabled</td>
<td>Selected</td>
</tr>
<tr>
<td>Memory Protection Enabled</td>
<td>Selected</td>
</tr>
<tr>
<td>Exploitation: Stack Pivot</td>
<td>Terminate</td>
</tr>
<tr>
<td>Exploitation: Stack Protect</td>
<td>Terminate</td>
</tr>
<tr>
<td>Exploitation: Overwrite Code</td>
<td>Terminate</td>
</tr>
<tr>
<td>Exploitation: Scanner Memory Search</td>
<td>Terminate</td>
</tr>
<tr>
<td>Exploitation: Malicious Payload</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Allocation of Memory</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Mapping of Memory</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Write to Memory</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Write PE to Memory</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Overwrite Code</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Unmap of Memory</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote Thread Creation</td>
<td>Terminate</td>
</tr>
<tr>
<td>Process Injection: Remote APC Scheduled</td>
<td>Terminate</td>
</tr>
</tbody>
</table>
Process Injection: Remote DYLD Injection (Mac OS X only) | Terminate
---|---
Escalation: LSASS Read | Terminate
Escalation: Zero Allocate | Terminate
Watch for New Files | Selected

### Advanced Threat Events tab fields and filters

The Advanced Threat Events tab displays information about events for the entire enterprise based on information available in the Dell Server.

The tab displays if the Advanced Threat Prevention service is provisioned and licenses are available.

To access the Enterprise Advanced Threats tab, follow these steps:

1. In the left pane, click **Populations > Enterprise**.
2. Select the **Advanced Threat Events** tab.

Use the following filters to select content to display on the Advanced Threat Events tab:

- **Type** - Threat Found, Threat Blocked, Threat Terminated, Memory Violation Blocked, Memory Violation Terminated, Memory Violation (Detected), Threat Removed, Threat Quarantined, Threat Waived, Threat Changed, Protection Status Changed.
- **Severity** - Severity level of the event: Critical, Major, Minor, Caution, or Informational.
- **Timeframe (in days)** - 1, 7, 14, 30, 60, 90
- **Columns** - Allows you to select the following additional columns to display:
  - **Hostname** - The fully qualified name of the computer
  - **Data** - Details about the event
  - **Created** - Date and time that the event was captured
  - **Machine Name** - Name of the computer on which the threat event was detected
  - **Path** - Path to the file in which the threat was detected
  - **Sha256** - The file's 256-character Secure Hash Algorithm can be compared with an expected result to indicate whether the file has been tampered with.
  - **Score** - The threat file's score, indicating the confidence level that the file is malware. The higher the number, the greater the confidence.

### Manage Enterprise Advanced Threats - Protection

The Protection tab provides information about files and scripts that are potentially harmful.

### Threats

The table lists all events found across the organization. An event may also be a threat but is not necessarily so.

View additional information about a specific threat either by clicking on the threat name link to view details displayed on a new page or by clicking anywhere in the row of the threat to view details at the bottom of the page.
To view additional threat information in the table, click the drop-down arrow on a column header to select and add columns. Columns display metadata about the file, such as Classifications, Cylance Score (confidence level), AV Industry conviction (links to VirusTotal.com for comparison with other vendors), Date first found, Data last found, SHA256, MD5, File information (author, description, version), and Signature details.

Filter Events Table Data
Click the Threat Filters list at the upper right side of the table to view data about events by Priority, Status: Last 24 Hours, and Status: Total.

The number of events occurring in each subcategory are shown in parentheses.

Priority: Unsafe - Select a priority to view only events that match the selected priority. High, Medium, or Low.

Status: Last 24 Hours - Select a status to view only events that have had changes to this status in the last 24 hours.

Status: Total - Select a status to only events with that status.

The predictive threat model used to protect devices receives periodic updates to improve detection rates. To understand differences in how a new threat model affects information about files in your organization, see Threat Model Updates.

Commands
Select a threat to act on it. On this page, you can do the following to the selected threat data:

Export - Export threat data to a CSV file.

Select the rows to export, and then click Export.

Open the file with Microsoft Excel or similar application, which allows you to sort and organize the data.

Global Quarantine - Add a file to the global quarantine list. The threat is permanently quarantined from all devices.

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the organization. Adding a file to Quarantine removes it from lists of Unsafe files.

1. Select a threat.
2. Click Global Quarantine.
3. Enter a reason that this file should be global quarantined and click Yes.

Safe - Add a file to the safe list. The file is permanently treated as safe across all devices.

1. Select the file to list as safe.
2. Click Safe.
3. Select the category that fits the file.
4. Enter a reason why the file should be listed as safe, and click Yes.

Note: Occasionally, a "good" file may be reported as unsafe (this could happen if the features of that file strongly resemble those of malicious files). Waiving or safelisting the file can be useful in these instances.

Edit Global List - Add or remove files from the global quarantine list.

1. Click Edit Global List.
2. Select the items to change.
3. Select **Safe** to add the selected items to the safelist, or select **Remove from list** to remove the selected files from the Global Quarantine list.

**Manually Add File to the Global Quarantine list**

1. Click **Edit Global List**.
2. Click **Add File**.
3. Enter the file’s SHA256 hash number (required).
4. Enter the file’s MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be quarantined.
7. Click **Submit**.

**View Threat Details** - Click a threat name to display details of the threat details on a new page. Click anywhere in the threat’s row to display the same threat details on the left side of this page, under the table.

**File Details**

**Details: [file name]**

At the bottom of the page, this section displays details about the file that triggered an event. To display this information, select the row that displays the file name in the Advanced Events table.

Click the file name next to Details: to display the same information about the event on a new page.

**Overview**

The overview contains summary information about the file.

**Threat Indicators**

Threat Indicators are observations about a file that has been analyzed.

These indicators help administrators understand the reason for a file’s classification and provide insight into its attributes and behavior. Threat Indicators are grouped into categories.

**Devices**

In the Devices pane, the administrator can view a list of devices that have unsafe or abnormal files and quarantine or waive them.

The device list can be filtered by file state: Unsafe, Quarantined, Waived, or Abnormal.

Waiving a file will allow that file to run on the device.

**Detailed Threat Data**

If the file has been uploaded for analysis, the Detailed Threat Data pane may display a comprehensive summary of the static and dynamic characteristics of the file including additional file metadata, file structure details, and dynamic behaviors such as files dropped, registry keys created or modified, and URLs with which it attempted to communicate.

**Note:** If no results display in the Detailed Threat Data pane, the file has not yet been uploaded for analysis. Debug logging may provide information about why the file was not uploaded.

**Script Control Table**

The table lists details about Active and PowerShell scripts that have been blocked or have triggered an alert and the affected devices.
Columns display the file name, interpreter (PowerShell or ActiveScript), last found, drive type (such as internal hard drive), SHA256, Number of devices on which the script is found, and Number of occurrences that were blocked or triggered alerts.

To filter column data, click the filter icon on a column header and select values to include or exclude.

**Manage Enterprise Advanced Threats - Agents**

After an Advanced Threat Prevention client is installed on an endpoint computer, it is recognized by the Dell Server as an agent.

**Agents Table Data, Explained**

- **Name** - The name of the agent on the endpoint computer.
- **State** - State of the agent, online or offline. A computer is in the offline state after three failed attempts in a 15-minute period to contact the Cylance server.
- **Offline Date** - If applicable, the date on which the agent went offline.
- **Files Analyzed** - Number of files analyzed on the endpoint computer.
- **Unsafe** - Number of files deemed Unsafe on the device. An unsafe file has characteristics that greatly resemble malware.
- **Quarantined** - Number of files Quarantined on the device.
- **Waived** - Number of Waived files on the device.
- **Abnormal** - Number of Quarantined files on the device.
- **Exploit Attempts** - Number of exploit attempts on the device.

**Commands**

To export details about an agent or remove an agent from the list:

- **Export** - Creates and downloads a CSV file that contains device information (Name, State, Policy, etc.).
- **Remove** - Removes selected agents from the Agent Table. This does not uninstall the agent from the device.

**Manage Enterprise Advanced Threats - Certificate**

The Certificate tab allows you to upload a certificate for the purpose of safelisting it.

Certificates must be in .cer or .crt format.

To upload a certificate, follow these steps:

1. Navigate to **Populations > Enterprise > Advanced Threats tab > Certificate tab**.
2. Click **Browse**.
3. Select a certificate and click **Open**.
4. Click **Upload Certificate**.
5. Click **OK** once the upload is successful.

For instructions about how to safelist a certificate, see **Manage Enterprise Advanced Threats - Global List**.
Manage Enterprise Advanced Threats - Cylance Score and Threat Model Updates

A Cylance score is assigned to each file that is deemed Abnormal or Unsafe. The score represents the confidence level that the file is malware. The higher the number, the greater the confidence.

Threat Model Updates

The predictive threat model used to protect devices receives periodic updates to improve detection rates.

Two columns on the Protection page in the Management Console show how a new threat model affects your organization. Display and compare the Production Status and New Status columns to see which files on devices might be impacted by a model change.

To view the Production Status and New Status columns:
1. In the left pane, click Populations > Enterprise.
2. Select the Advanced Threats tab.
3. Click the Protection tab.
4. Click the down-arrow on a column header in the table.
5. Hover over Columns.
6. Select the Production Status and New Status columns.

**Production Status** - Current model status (Safe, Abnormal or Unsafe) for the file.

**New Status** - Model status for the file in the new model.

For example, a file that was considered Safe in the current model might change to Unsafe in the new model. If your organization needs that file, you can add it to the Safe list. A file that has never been seen or scored by the current model might be considered Unsafe by the new model. If your organization needs that file, you can add it to the Safe list.

Only files found on device in your organization and that have a change in its Cylance Score are displayed. Some files might have a score change but still remain within its current Status. For example, if the score for a file goes from 10 to 20, the file status may remain Abnormal and the file appears in the updated model list (if this file exists on devices in your organization).

The information for the model comparison comes from the database, not your devices. So no re-analysis is done for the model comparison. However, when a new model is available and the proper Agent is installed, a re-analysis is done on your organization and any model changes are applied.

Compare Current Model with New Model

You can now review differences between the current model and the new model.

The two scenarios you should be aware of are:

Production Status = Safe, New Status = Abnormal or Unsafe

- Your Organization considers the file as Safe
- Your Organization has Abnormal and/or Unsafe set to Auto-Quarantine

Production Status = Null (not seen or scored), New Status = Abnormal or Unsafe

- Your Organization considers the file as Safe
- Your Organization has Abnormal and/or Unsafe set to Auto-Quarantine

In the above scenarios, the recommendation is to Safelist the files to allow in your organization.
Identify Classifications

To identify classifications that could impact your organization, Dell recommends the following approach:

1. Apply a filter to the New Status column to display all Unsafe, Abnormal, and Quarantined files.
2. Apply a filter to the Production Status column to display all Safe files.
3. Apply a filter to the Classification column to only show Trusted - Local threats. Trusted - Local files have been analyzed by Cylance and found to be safe. Safelist these items after review. If you have a lot of files in the filtered list, you may need to prioritize using more attributes. For example, add a filter to the Detected By column to review threats found by Execution Control. These were convicted when a user attempted to execute an application and need more urgent attention than dormant files convicted by Background Threat Detection or File Watcher.

Manage Enterprise Advanced Threats - Global List

The Global Quarantine, Safe, and Unassigned tables provide a view of files in list as well as options to perform actions on these files.

Global Quarantine

Global Quarantine lists files that are permanently quarantined from all devices.

Add a file to the global quarantine list

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1. Select Global Quarantine (n).
2. Select a threat.
3. Click Add File.
4. Enter a reason that this file should be global quarantined and click Yes.

Manually Add File to the Global Quarantine list

1. Select Global Quarantine (n).
2. Click Add File.
3. Enter the file’s SHA256 hash number. (required)
4. Enter the file’s MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be quarantined.
7. Click Submit.

Remove a file from the global quarantine list

Remove the selected file from the Global Quarantine list to allow it to run on any device in the organization.

1. Select Global Quarantine (n).
2. Select a file.
3. Click Remove from List.

Safelist a file from the global quarantine list
Safelist the selected file from the Global Quarantine list to allow it to run on any device in the organization.

1. Select **Global Quarantine (n)**.
2. Select a file.
3. Click **Safe**.

**Safe**

Safelisted files and certificates are permanently treated as safe across all devices. Any certificate that is safelisted is a known safe certificate for the Advanced Threat Prevention tenant.

**Add a file to the safe list**

Safelisting a file allows that file to run on any device across the entire organization.

**Note:** Occasionally, a “good” file may be reported as unsafe (this could happen if the features of that file strongly resemble those of malicious files). Waiving or safelisting the file can be useful in these instances.

1. Select **Safe (n)**.
2. Click **Add File**.
3. Enter the file's SHA256 hash number. (required)
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be safelisted.
7. Click **Submit**.

**Remove a file from the safe list**

1. Select **Safe (n)**.
2. Select **Files (n)**.
3. Select the file to remove from the safe list.
4. Click **Remove from List**.

**Add a certificate to the safe list**

Safelisting a certificate allows access to that certificate, as needed, across the entire organization.

1. Select **Safe (n)**.
2. Select **Certificates (n)**.
3. Select the certificate to list as safe.
4. Click **Add Certificate**.
5. Select the category that fits the certificate.
6. Enter a reason why the certificate should be listed as safe, and click **Submit**.

**Note:** You must upload a certificate for it to be available to safelist. For more information, see [Manage Enterprise Advanced Threats - Certificate](#).

**Remove a certificate from the safe list**
1. Select **Safe** (n).
2. Select **Certificates** (n).
3. Select the certificate to remove from the safe list.
4. Click **Remove from List**.

Unassigned

Unassigned files can be added to the global quarantine or safe list.

**Add an unassigned file to the global quarantine list**

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1. Select **Unassigned** (n).
2. Select a file.
3. Click **Global Quarantine**.
4. Enter a reason that this file should be global quarantined and click **Yes**.

**Manually Add File to the Global Quarantine list**

1. Select **Unassigned** (n).
2. Click **Add File**.
3. Enter the file's SHA256 hash number. (required)
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be quarantined.
7. Click **Submit**.

**Add an unassigned file to the safe list**

Safelisting a file allows that file to run on any device across the entire organization.

1. Select **Unassigned** (n).
2. Select a file.
3. Click **Safe**.
4. Select the category that fits the file.
5. Enter a reason why the file should be listed as safe, and click **Yes**.

**Note:** Occasionally, a “good” file may be reported as unsafe (this could happen if the features of that file strongly resemble those of malicious files). Waiving or safelisting the file can be useful in these instances.

**Manually Add File to the Safe list**

1. Select **Unassigned** (n).
2. Click **Add File**.
3. Enter the file's SHA256 hash number. (required)
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be safelisted.
7. Click Submit.

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1. Select Global Quarantine (n).
2. Select a threat.
3. Click Add File
4. Enter a reason that this file should be global quarantined and click Yes.

**Manually Add File to the Global Quarantine list**
1. Select Global Quarantine (n).
2. Click Add File.
3. Enter the file's SHA256 hash number. (required)
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.
6. Enter the reason the file should be quarantined.
7. Click Submit.

---

**Manage Enterprise Advanced Threats - Options**

The Options tab allows you to integrate with Security Information Event Management (SIEM) software using the Syslog feature as well as export Advanced Threat data. SIEM software allows administrators to run customized analytics on threat data within their environments. Software options include Splunk, available to Splunkbase users at [https://splunkbase.splunk.com/app/3233](https://splunkbase.splunk.com/app/3233).

Syslog events are persisted at the same time Agent events are persisted to the Cylance server. For more information about supported event types, see [Syslog Event Types](#).

To integrate with SIEM, select Syslog/SIEM on the Options tab, and complete the form that displays. For a list of syslog server IP addresses to allow, see [Syslog IP Addresses](#).

With SIEM integration, to export data about threats, select Threat Data Report on the Options tab. For instructions and a description of exportable data, see [Threat Data Report](#).

**Threat Data Report**

Select Threat Data Report on the Options tab to enable threat data export to .csv files.

The following types of data are available for export:

**Threats** - Lists all threats discovered in your organization. This information includes file name and File Status (unsafe, abnormal, waived, and quarantined).

**Devices** - Lists all devices in your organization that have an Agent installed. This information includes device name, operating system version, agent version, and policy applied.
Events - Lists all events related to the Threat Events graph on the dashboard for the last 30 days. This information includes file hash, device name, file path, and the date the event occurred.

Indicators - Lists each threat and the associated threat characteristics.

Cleared - Lists all files that have been cleared in your organization. This information includes files that were waived, added to the safe list, or deleted from the quarantine folder on a device.

**Export Data**

To access the exported data:

1. Select **Generate token**.
2. Copy the URL of the desired data and paste it into a web browser address field.
3. In the URL, replace [Token] with the generated token displayed in **Token**.

To disable access to the exported data, select **Delete** or **regenerate** to invalidate the current token. After regenerating a token, provide it to persons who should have continued access to the exported data.

**Advanced Threat Prevention Classifications**

The Advanced Threat Prevention Classifications pane shows a heat map of threats. The color indicates the priority classification of the threat. The size of the box indicates the relative number of endpoints that have a particular threat. This classification helps administrators determine which threats and devices to address first. Click a threat to view threat and device details.

Threat classifications include the following:

- **Malware**
  - Trojan
  - Downloader

- **Potentially Unwanted Programs (PUP)**
  - Adware
  - Hacking Tool
  - Portable Application

**Enable Compatibility Mode for Memory Protection**

Compatibility Mode allows applications to run on the client computer while Memory Protection or Memory Protection and Script Control policies are enabled. Compatibility Mode is enabled through a registry setting or a command on the client computer. Compatibility Mode does not apply to Mac clients.

To enable Compatibility Mode with a registry setting:

1. In the Remote Management Console, disable the Memory Protection Enabled policy. If the Script Control policy is enabled, disable it.
2. Save the policy changes, and [Commit Policies](#).
3. Using the Registry Editor on the client computer, go to HKEY_LOCAL_MACHINE\SOFTWARE\Cylance\Desktop.
4. Right-click Desktop, click Permissions, then take ownership and grant yourself Full Control.

5. Right-click Desktop, then select New > Binary Value.

6. For the name, type CompatibilityMode.

7. Open the registry setting and change the value to 01.

8. Click OK, then close Registry Editor.

9. In the Management Console, enable the Memory Protection Enabled policy. If the Script Control policy was enabled, enable it.

10. Save the policy changes, and Commit_Policies.

To add the registry setting with a command:

1. In the Management Console, disable the Memory Protection Enabled policy. If the Script Control policy is enabled, disable it.

2. Save the policy changes, and Commit_Policies.

3. Select one command line option to run on the client computer:

   (For one computer) Psecexec:
   
   psecexec -s reg add HKEY_LOCAL_MACHINE\SOFTWARE\Cylance\Desktop /v CompatibilityMode /t REG_BINARY /d 01

   (For multiple computers) Invoke-Command cmdlet:
   
   $servers = "testComp1","testComp2","textComp3"
   $credential = Get-Credential -Credential {UserName}\administrator
   Invoke-Command -ComputerName $servers -Credential $credential -ScriptBlock {New-Item -Path HKCU:\Software\Cylance\Desktop -Name CompatibilityMode -Type REG_BINARY -Value 01}

4. In the Management Console, enable the Memory Protection Enabled policy. If the Script Control policy was enabled, enable it.

5. Save the policy changes, and Commit_Policies.

Disconnected Mode Policy Examples

Examples for Global Allow, Quarantine List, and Safe List policies are shown below.

Global Allow policy example

<?xml version="1.0" encoding="utf-8"?>
<disconnected_policy>
<policy_name>Default</policy_name>
<policy_company>Acme</policy_company>
<policy_company_id>uxSYabW9P2nMbGLzuqJhvT9Y</policy_company_id>
<policy_utctimestamp>Date(-62135596800000+0000)</policy_utctimestamp>

<filetype_actions>
  <suspicious_files file_type="executable" actions="7" />
  <threat_files file_type="executable" actions="7" />
</filetype_actions>

<memoryviolation_actions>
  <memory_violation violation_type="stackpivot" action="Alert" />
  <memory_violation violation_type="stackprotect" action="Block" />
  <memory_violation violation_type="stackpivot" action="Terminate" />
  <memory_violation violation_type="overwritecode" action="None" />
  <memory_violation violation_type="outofprocessallocation" action="Scuba" />
  <memory_violation violation_type="outofprocessmap" action="Alert" />
  <memory_violation violation_type="outofprocesswrite" action="Block" />
  <memory_violation violation_type="outofprocesswritepe" action="Terminate" />
  <memory_violation violation_type="outofprocessoverwritecode" action="None" />
  <memory_violation violation_type="outofprocessunmapmemory" action="Alert" />
  <memory_violation violation_type="outofprocesscreatethread" action="Alert" />
  <memory_violation violation_type="outofprocessapc" action="Alert" />
  <memory_violation violation_type="lsassread" action="Alert" />
</memoryviolation_actions>

<memory_exclusion_list>
  <path>temp\files\exe1.exe</path>
  <path>stuff\folder\exe2.exe</path>
</memory_exclusion_list>

<appcontrol>
  <changewindow_enabled>0</changewindow_enabled>
  <lockdown lockdown_type="executionfromexternaldrives" action="deny" />
</appcontrol>
<lockdown lockdown_type="pechange" action="deny" />
</appcontrol>

<policy>
  <option name="auto_blocking" value="0" />
  <option name="auto_uploading" value="1" />
  <option name="threat_report_limit" value="500" />
  <option name="low_confidence_threshold" value="-600" />
  <option name="full_disc_scan" value="0" />
  <option name="watch_for_new_files" value="0" />
  <option name="memory_exploit_detection" value="0" />
  <option name="trust_files_in_scan_exception_list" value="0" />
</policy>

<scan_exception_list>
  <path>C:\temp</path>
  <path>C:\stuff</path>
</scan_exception_list>

<exclusion_list>
  <checksum>3fdc391ef0e200af3e4c206e785e1de0</checksum>
  <error_rate>1E-05</error_rate>
  <size>509</size>
</exclusion_list>

<checksum>3fd31ef0e200af3e4c206e785e1de0</checksum>
<error_rate>1E-05</error_rate>
<size>509</size>

Quarantine List and Safe List policy examples

Quarantine List

The Global Quarantine List contains hashes of files to be quarantined as shown in this example:

```
0A5F695900F1FC75070B857C7A55B5BCF2760E46F
```

Safe List

The Global Safe List contains hashes of files to be quarantined as shown in this example:

```
0A5F695900F1FC75070B857C7A55B5BCF2760E46F
```
Threat Protection Policy Overview

Threat Protection policies are divided into the following categories:

- Threat Protection
- Client Firewall
- Web Protection

When you set the Threat Protection policy to Selected, you can then set policies for these client options:

- Actions to take when malicious activity is identified (Block, Report, Block and Report)
  Policies allow you to set the action to take when users attempt to modify or delete Threat Protection system files, registry keys, and processes. The default setting for these policies is Block and Report: Action on Malicious Activity for Files and Folders, Action on Malicious Activity for Registry, and Action on Malicious Activity for Processes.

- Exclusion of specified processes from Threat Protection scans

- Logging locations and debug/verbose logging of certain activities
  Activity logging is enabled by default. Debug logging is disabled by default.

- Client update scheduling
  Client updates ensure that client computers are always protected from the latest threats through content files that include definitions of threats such as viruses and spyware, that are used to detect threats. The Client Update Schedule policy is selected (Enabled) by default. The Client Update Schedule Repeats policy, which determines the frequency of client updates, is set to Daily by default.

The following policies represent the different types of scans included in Threat Protection:

On-Access Protection – When a user accesses files, folders, and programs, the on-access scanner intercepts the operation and scans the item. Default: Selected (Enabled).

On-Demand Protection - Full Scan – Based on a schedule set in policy, the on-demand scanner runs a thorough check of all areas of the computer. Default: Selected (Enabled).

By default, every time Full Scan runs, it scans the following for threats:

- Computer memory for installed rootkits, hidden processes, and other behavior that suggests malware is attempting to hide itself. This scan occurs before all other scans.
- Memory of all running processes.
- All drives on the computer and their subfolders.

By default, the scanner scans all file types, regardless of extension.

On-Demand Protection - Quick Scan – Based on a schedule set in policy, the on-demand scanner runs a quick check of areas of the computer that are most susceptible to threats. Default: Selected (Enabled).

By default, every time Quick Scan runs, it scans the following for threats:

- Memory of all running processes.
- Files that the Windows Registry references.
- Contents of the Windows folder.
• Contents of the Temp folder.

By default, the scanner scans all file types, regardless of extension.

Access Protection – Prevents other computers from making a connection and creating or altering autorun (autorun.inf) files from CDs. The rule prevents spyware and adware distributed on CDs from being executed and automatically blocks and reports such issues. Default: Selected (Enabled).

Exploit Protection – Monitors for application vulnerabilities and keeps buffer overflow exploits from executing arbitrary code on the computer. Default: Selected (Enabled).

Script Scan Protection – Enables scanning JavaScript and VBScript scripts to prevent unwanted scripts from executing. Default: Selected (Enabled).

Actions taken if a threat, unwanted program, or exploit is detected are controlled by policy and include the following:

Full-Scan Threat First Response - Specifies the first action for the scanner to take when a threat is detected. Default: Clean file.

Full-Scan Threat First Response Fails - Specifies the action for the scanner to take when a threat is detected if the first action fails. Default: Delete file.

Full-Scan Unwanted Program First Response - Specifies the first action for the scanner to take when a potentially unwanted program is detected. Default: Clean file.

Full-Scan Unwanted Program First Response Fails - Specifies the action for the scanner to take when an unwanted program is detected if the first action fails. Default: Delete file.

Quick-Scan Threat First Response - Specifies the first action for the scanner to take when a threat is detected. Default: Clean file.

Quick-Scan Threat First Response Fails - Specifies the action for the scanner to take when a threat is detected if the first action fails. Default: Delete file.

Quick-Scan Exploit First Response - Specifies the first action for the scanner to take when a potential exploit is detected. Default: Clean file.

Quick-Scan Exploit First Response Fails - Specifies the action for the scanner to take when an exploit is detected if the first action fails. Default: Delete file.

When the Full-Scan Reputation Service Sensitivity or Quick-Scan Reputation Service Sensitivity policies are enabled, samples are submitted to the Reputation Service lab to determine if they are malware. The sensitivity level is used when determining if a detected sample is malware. The higher the sensitivity level, the higher the number of malware detections. However, allowing more detections might result in more false positive results.

The following values can be set:

Disable - Samples are not submitted to the Reputation Service lab.

Very Low - A detection is made available to Threat Protection when the Reputation Service lab publishes it instead of waiting for the next file update. Average of 10-15 queries per day, per computer.

Low - This setting is the minimum recommendation for laptops or desktops and servers with a strong security footprint. This setting results in an average of 10-15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is greater than the risk of a false positive. This setting is the minimum recommendation for laptops or desktops and servers. Average of 20-25 queries per day, per computer.
**High** - Use this setting for deployment to systems or areas which are regularly infected. This setting results in an average of 20-25 queries per day, per computer.

**Very High** - Dell recommends using this level only for scanning volumes and directories that do not support executing programs or operating systems. Detections found with this level are presumed malicious, but have not been fully tested to determine if they are false positives. Use this setting for on-demand scans on non-operating system volumes. This setting results in an average of 20-25 queries per day, per computer.

For more detail about Threat Protection policies, see [Windows Threat Protection](#).

**Client Firewall Policies**

The Client Firewall is a stateful firewall that checks all incoming and outgoing traffic against its list of rules. If the traffic matches all criteria in a rule, the Client Firewall acts according to the rule, blocking or allowing traffic through the firewall.

Configurable options and rules define how the Client Firewall works. When the master policy, **Client Firewall**, is set to **On**, you can select **View/Edit** in the **Settings and Rules** policy to view or configure an extensive set of Client Firewall options and rules.

Options include which subsets of traffic to block or allow and logging settings, as well as timeout parameters for TCP, UDP, and ICMP connections.

Client firewall rules define specific handling of network traffic. Each rule provides a set of conditions that traffic must meet and an action to allow or block that traffic. When Client Firewall finds traffic that matches a rule’s conditions, it performs the associated action.

Client Firewall uses precedence to apply rules and applies the rule at the top of the firewall rules list.

1. If the traffic meets the conditions of the rule at the top of the list, Client Firewall allows or blocks the traffic. It does not try to apply any other rules in the list.
2. If the traffic does not meet the first rule’s conditions, Client Firewall continues to the next rule in the list until it finds a rule that the traffic matches.
3. If no rule matches, the firewall automatically blocks the traffic.

For a list of Client Firewall rules and their descriptions, see [Client Firewall Settings and Rules](#).

**Web Protection Policies**

Web Protection monitors web browsing and downloads to identify threats and enforce action set by policy when a threat is detected, based on ratings for websites. When you set the master policy, **Web Protection**, to **On**, you can set other policies for Web Protection.

The Reputation Service analyzes each website and assigns a color-coded safety rating based on test results. The color indicates the level of safety for the site:

- **Red** – Malicious
- **Yellow** – Potentially malicious
- **Green** - Safe

Through the following policies, you can assign actions to implement when a user accesses a website or attempts a download, based on website ratings:

- **Rating Action for Red Sites** - Specifies the action to apply to sites that are rated Red. Default: Block.
Manage Policies

_Rating Action for Yellow Sites_ - Specifies the action to apply to sites that are rated Yellow. Default: Warn.

_Rating Action for Unrated Sites_ - Specifies the action to apply to sites that are Unrated. Default: Allow.

_Rating Action for Red Downloads_ - Specifies the action to apply to file downloads that are rated Red. Default: Block.

_Rating Action for Yellow Downloads_ - Specifies the action to apply to file downloads that are rated Yellow. Default: Warn.

_Rating Action for Unrated Downloads_ - Specifies the action to apply to file downloads that are Unrated. Default: Allow.

Configurable actions for website access or download attempts include the following:

**Block** – Prevents users from accessing the site or downloading a file from the site. A message is displayed.

**Allow** – Permits users to access the site or proceed with the download.

**Warn** – Displays a warning to notify users of potential dangers associated with the site or download file. Users must dismiss the warning before ending the web session or proceeding with the download.

To exclude a private IP address or range of addresses from Web Protection content rating actions, specify the IP address or IP address range in the _IP Exclusions for Web Protection_ policy.

To block all phishing pages, without regard to policy values that control content rating actions, select the _Enforcement - Block Phishing Pages for All Sites_ policy.

**Designate a Threat Protection Signature Update Server**

Both an HTTP and FTP signature update server are pre-configured with your Dell Server installation. You can also, optionally, designate an internal signature update server or servers within your network.

Designating a signature update server within your network allows client computers to obtain signature updates without accessing the Internet. Rather than individual clients contacting an external update server, they contact your internal update server, which maintains current signatures through contact with the external signature update server.

To designate a signature update server, follow these steps:

1. As an administrator on the server to be the internal update server, run the appropriate command:

   VSSETUP_86.EXE /SetRelayServerEnable=1
   or
   VSSETUP_64.EXE /SetRelayServerEnable=1

2. Restart the internal update server.


4. In Malware Protection advanced settings, click _Source Sites for Updates_.

5. Click _Add_.

6. Enter a Name for the internal update server.

7. To enable connections to the internal update server, select _Enabled_. To enable later, clear the _Enabled_ check box.
8. In Order, set the sequence in which clients will contact the internal update server in relation to other update servers. Dell recommends that you set the Order for internal update servers to precede the Order for external update servers.

9. Select the type of repository or path to the update server: HTTP repository, FTP repository, UNC path, or Local path.

10. Enter the URL or path to the internal update server.

11. Complete the remaining fields in the form, and click OK.

12. Repeat these steps to designate additional internal update servers.

To revert an internal update server to non-update server status, enter the appropriate command:

```
VSSETUP_86.EXE /SetRelayServerEnable=0
```

or
```
VSSETUP_64.EXE /SetRelayServerEnable=0
```

**Data Guardian**

**Overview of Data Guardian Features and Policies**

This topic provides a brief overview of the Data Guardian key features and policies.

**Protect data in use, in motion, or at rest**

The following are some of the key Data Guardian features that allow you to protect data:

- **Basic File Protection** - allows an enterprise to sweep users’ computers and encrypt a large number of file types (non-Office). Encrypted files are logged and audited.

- **Office document protection** - allows an enterprise to encrypt Office documents and PDFs for Windows or Mac with opt-in mode, Windows or Mac with Force-protected mode, mobile devices, and a Data Guardian web portal.

In addition, Windows and opt-in mode have:

- **Content Based Protection** - Based on content rules, a sweep of users' computers encrypts files that contain specified content like account numbers or Social Security Numbers.

- **TITUS classification**

- **Cloud Encryption**

- **Access Groups** - Administrators can specify groups and only those users can view the encrypted files.

**Control data**

Determine who can access data and revoke access if needed:

- **Registration Access**
- **Key Request**
- **Key Revocation**
- **Key Management**
- **Web Portal**
Monitor data

To detect potential security risks, monitor audit events and create reports to identify who uses the data and how it is used.

- Data Guardian and Audit Events
- Get Started with Data Guardian Audit Events
- View Audit Events (Geolocation)
- Export Events to SIEM Server
- Manage Reports
- View Report
- Add Schedule

Policies

To set policies for these features, see:

- Data Guardian - basic policies
- Advanced Data Guardian

Data Guardian

Data Guardian provides the following:

- Data on the device and data-in-motion is encrypted. To decrypt and view the content, users must have Data Guardian installed on the client. Users can access protected files on Windows, Mac, mobile devices, and a web portal.

- An audit trail of file activity allows you to monitor security. See Data Guardian and Audit Events.

Data Guardian basic policies are available for these populations:

- Cloud Encryption (Mac; v2.3 and earlier for Windows) - Enterprise, Endpoint Groups, and Endpoints
- Protected Office Documents - Enterprise (master switch)
- Content Based Encryption - previously Classification - Enterprise (master switch)
- Mobile Client - Enterprise, Domain, User Groups, and User
- Web Portal - Enterprise, Domain, User Groups, and User
  - Node level policies are only available at the Enterprise level and require a node restart.
  - Lock Account is only available at the User level.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Encryption</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This technology allows for files to be automatically encrypted prior to being uploaded to supported public clouds; this maintains ownership/control of all data encryption keys. The supported public cloud providers are Dropbox, Dropbox for Business, Box, OneDrive, OneDrive for Business, and Google Drive.

<table>
<thead>
<tr>
<th>Cloud Encryption (Mac; 2.3 and earlier for Windows)</th>
<th>Off</th>
<th>On</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong> to enable Cloud Encryption policies. If this policy is <strong>Off</strong>, no Cloud protection takes place, regardless of other policies.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable Access to Restricted File (Windows - v2.3 and earlier)</th>
<th>Not Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies only to Google Drive. <strong>Selected</strong> disables any Google Drive-created shortcuts to the web that Data Guardian cannot encrypt.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable In-App Feedback (Cloud) (Mac; v2.3 and earlier for Windows)</th>
<th>Not Selected</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When selected, an end user can submit feedback and satisfaction ratings to Dell via a link within the client application to a web form.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cloud Storage Protection Providers (Mac; v2.3 and earlier for Windows)</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profiles that Allow, Block, Protect, or Bypass these providers/connections. Protect: Allow the provider/connection, encrypt the files, and send audit events about file/folder activity. Block: Block all access to the provider/connection. Allow: Allow the provider/connection to pass through without encrypting, but audit file/folder activity. Bypass: Bypass the protection of the provider/connection without encrypting or auditing. The format is: ProtectionLevel,ProfileName. ProtectionLevel options: Allow, Protect, Block, Bypass. The Dell Server automatically checks for updated profiles of Cloud storage providers supported with Data Guardian. When available, updated profiles are sent to Data Guardian clients after the administrator commits policy changes. When the Pending Policy Changes value in the Management Console is automatically incremented although an administrator has not modified policy values, at least one updated profile is available. The polling interval for Cloud storage provider profile updates is daily at 12:30 a.m.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dropbox Encrypt Personal Folders (Windows- v2.3 and earlier)</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected encrypts personal cloud storage provider folders.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dropbox Encrypt Personal Folders Message (Windows- v2.3 and earlier)</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message to display when Dropbox Encrypt Personal Folders is set to Not Selected. This message is customizable by the Administrator.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help File Visible (Windows- v2.3 and earlier)</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Selected</strong> allows the registration help file to be visible in the provider folder. More...</td>
<td></td>
</tr>
</tbody>
</table>

| Not Selected hides the help file, therefore, potential file sharers does not be redirected to the registration URL located at https://<yoursecurityserver>.<domain>.com:8443/cloudweb/register. |

See [advanced settings](#)
<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Office Documents</td>
<td>Off</td>
<td>This technology allows for Office documents (Excel, PowerPoint, and Word) to be encrypted at the file level. Encryption travels with the file wherever it goes, inside or outside the network.</td>
</tr>
</tbody>
</table>
| (Windows and Mac)              |                 | **On**  
|                                | Off             | Toggle **On** to provide users with a menu option for protecting Office documents (.docx, .xlsx, .pptx, .docm, .xlsxm, .pptm, and .pdf). **On** also allows you to enable other Protected Office policies. If this policy is **Off**, no Office-protected formatting takes place, regardless of other policies. This policy is available at the Enterprise level. |
| Basic File Protection          | Not Selected    | **Selected**  
| (Windows and Mac)              |                 | When selected, the Basic File Protection Feature is enabled. This feature allows for the key-per-file encryption of line of business files that are not covered within Microsoft Office. |
| Basic File Protection          | String          | **String**  
| Configuration                  |                 | Specifies which process and which extensions are included in Basic File Protection. For Windows, specifies which process and which extensions are included in Basic File Protection. For Mac and mobile devices, these encrypted files are read-only. These encrypted files can be uploaded to the web portal. The following are examples to follow for specific format inclusions: Notepad.exe:txt.csv Wordpad.exe:txt.rtf Word.exe:txt.rtf  
| (Windows and Mac)              |                 | **Note:** Basic File Protection Configuration is supported in Data Guardian v1.6 and later.  
|                                |                 | See Configure Basic File Protection Policies. |
| Block Print Screen             | Selected        | **Selected**  
| (Windows- 2.7 and earlier)     |                 | Selects disables the user’s ability to take screen captures via the Windows Print Screen capability while a protected office document is open. **Note:** To block this option, Data Guardian must be installed and run on the operating system, not a VM or Remote Desktop. |
| File Icon Overlay              | Selected        | **Selected**  
| (Windows)                      |                 | An overlay icon for Windows that indicates a file is protected by Data Guardian.  
| See advanced settings          |                 | |
| Content Based Protection       | Off             | **On**  
| (previously Classification)    |                 | Toggle **On** to provide users with a menu option for protecting files based on content rules. If this policy is **Off**, files are not automatically protected based on content rules. **See Column_options_for_Content_Based_Protection_only__Windows.** |
| (Windows)                      |                 | |
| Content Based Protection Rules | test (default)  | **Selected**  
| (previously Data Classification Rules) | Public | When selected, the selected content rule applies for encrypting files. |
| (Windows)                      | Internal Use    | |
|                                | Restricted      | |

**Manage Policies**
<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mobile Client</strong></td>
<td></td>
<td>This technology allows mobile phones and tablets access to encrypted content on supported public clouds, including Dropbox, Box, Google Drive, OneDrive, and OneDrive for Business.</td>
</tr>
</tbody>
</table>
| Data Guardian               | Off             | Off  
Cloud Protection  
Off  
Office Protected Documents  
Both  
Select one option or Both to use Data Guardian with mobile clients. If this policy is Off, Data Guardian is not enabled for mobile clients, regardless of other policies. |
| Dropbox                     | Allow and Audit | Allow and Audit  
Allow and Protect  
Disallow  
Sets the status for Dropbox usage and protection. |
| Box                         | Allow and Audit | Allow and Audit  
Allow and Protect  
Disallow  
Sets the status for Box usage and protection. |
| Google Drive                | Allow and Audit | Allow and Audit  
Allow and Protect  
Disallow  
Sets the status for Google Drive usage and protection. |
| OneDrive                    | Allow and Audit | Allow and Audit  
Allow and Protect  
Disallow  
Sets the status for OneDrive usage and protection. |
| OneDrive for Business       | Allow and Audit | Allow and Audit  
Allow and Protect  
Disallow  
Sets the status for OneDrive for Business usage and protection. |
| Apply Encryption to Root Data-Store Location | Selected | Selected  
Not Selected  
Selected encrypts personal cloud storage provider folders. |
| Basic File Protection       | Not Selected    | Selected  
Not Selected  
When selected, the Basic File Protection Feature is enabled. |
| Basic File Protection Configuration | String | String  
Specifies which process and which extensions are included in Basic File Protection. For mobile, copy and paste the processes and extensions from the Windows Basic File Protection policy. For Mac and mobile devices, these encrypted files are read-only.  
See Basic File Configuration for Mobile. |
| Geo-Fencing                 |                 |                                                                                                                                               |
| Enable Geo-Fencing          | Not Selected    | Selected  
Not Selected  
Selected allows only users in the region selected in the Geo-Fencing Location policy to access files. |
| Geo-Fencing Location        | US and Canada   | US  
Canada  
US and Canada  
Sets the location in which users can access files.  
The Enable Geo-Fencing policy must be Selected. |

See [advanced settings](#)
### Web Portal
The Web Portal is a web-based client for creating and editing documents protected by Data Guardian.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Permission</td>
<td>Selected</td>
<td>Selected allows users to edit files within the web client.</td>
</tr>
<tr>
<td>External User Edit Permission</td>
<td>Not Selected</td>
<td>Selected allows external users to edit files within the web client.</td>
</tr>
<tr>
<td>Main Title Image (Enterprise only)</td>
<td>Choose File button</td>
<td>Image or logo to display on the login page. The image must be a .jpg of square dimensions with a maximum file size of 25 KB. If the image height and width dimensions are not equal, the displayed image is stretched.</td>
</tr>
<tr>
<td>Masthead (Enterprise only)</td>
<td>Choose File button</td>
<td>Image to display as the masthead on the login page. The image must be a .png file, 26x26 pixels.</td>
</tr>
<tr>
<td>Access Agreement (Enterprise only)</td>
<td>String</td>
<td>Agreement text to be displayed for users to accept before they are allowed to log in.</td>
</tr>
</tbody>
</table>

See [advanced settings](#).

### Settings
This technology enables/disables Data Guardian Mac and Data Guardian Mobile access.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Mac Data Guardian Activation</td>
<td>Not Selected</td>
<td>Selected prevents Mac Data Guardian clients from being activated.</td>
</tr>
<tr>
<td>Allow Mobile Data Guardian Activation</td>
<td>Selected</td>
<td>Selected prevents Mobile Data Guardian clients from being activated.</td>
</tr>
</tbody>
</table>

### Advanced Data Guardian
Advanced Data Guardian policies are available for these populations:

- **Cloud Encryption** (Mac; v2.3 and earlier for Windows) - Enterprise, Endpoint Groups, and Endpoints
- **Protected Office Documents** - Enterprise, Endpoint Groups, and Endpoints (The Protected Office Documents master policy, *Enable Callback Beacon*, and *Callback Beacon URL* policies are available at the Enterprise level only.)
- **Mobile Client** - Enterprise, Domain, User Groups, and User
- **Web Portal**:
  - Node level policies are only available at the Enterprise level and require a node restart.
  - Lock Account is only available at the User level.

See [Data Guardian policy groups](#) to determine which policies to enable.
Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cloud Encryption</strong></td>
<td>Off</td>
<td>This technology allows for files to be automatically encrypted prior to being uploaded to supported public clouds; this maintains ownership/control of all data encryption keys. The supported public cloud providers are Dropbox, Dropbox for Business, Box, SkyDrive, OneDrive for Business, and Google Drive.</td>
</tr>
<tr>
<td>(Mac; v2.3 and earlier for Windows)</td>
<td>On</td>
<td>Toggle On to enable Cloud Encryption policies. If this policy is Off, no Cloud Encryption protection takes place, regardless of other policies.</td>
</tr>
<tr>
<td><strong>iOS Document Handling</strong></td>
<td>Disallow</td>
<td>Allow Disallow Use this policy to allow or disallow iOS clients to open documents with external applications.</td>
</tr>
<tr>
<td>(Windows)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help File Name</strong></td>
<td>1. How to access secure files.html</td>
<td>String Name of the registration help file. The file name format is helpfilename.html.</td>
</tr>
<tr>
<td>(Windows)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help File Contents</strong></td>
<td>HTML</td>
<td>HTML for the registration help file. HTML validation is not performed. The files in this folder have been secured using Data Guardian. To view files in this folder you need to register with the owner of the files. %PRODUCTNAME% and %ACTIVATIONURL% are both replaced by the Windows client based on the activation URL dynamically. The html can be modified to suit your environment.</td>
</tr>
<tr>
<td>(Windows)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Excluded Folders</strong></td>
<td>String</td>
<td>String Folders excluded from encryption, separated by carriage returns. A &quot;!&quot; before the variable means to exclude exactly that directory. Folders without the &quot;!&quot; are partial matches, so everything that starts with the path is excluded.</td>
</tr>
<tr>
<td>(Windows)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Manage Policies

<table>
<thead>
<tr>
<th>Excluded Files (Windows)</th>
<th>String</th>
<th>Files excluded from encryption, separated by carriage returns.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>C3901A99-1A1B-55B4-AE11-891207B1D341.xen desktop.ini thumbs.db creddb.cef <del>* .</del> <em>.</em> .tmp .DDPCE.attr *.lnk</td>
<td></td>
</tr>
<tr>
<td>Server Polling Interval (Windows and Mac)</td>
<td>360 minutes</td>
<td>1-1440 minutes How often, in minutes, the client checks in with the Dell Server for updates. Default is 360 minutes (6 hours).</td>
</tr>
<tr>
<td>Software Update Server URL (Windows)</td>
<td>String</td>
<td>Use this policy if software updates for users is located at an alternate Server URL.</td>
</tr>
<tr>
<td>Obfuscate Filenames (Mac; v2.3 and earlier for Windows)</td>
<td>Extension only</td>
<td>Extension only Select Extension only to display the actual filename with the &quot;.xen&quot; extension.</td>
</tr>
<tr>
<td>Folder Management Enabled (Windows- v2.3 and earlier)</td>
<td>Not Selected</td>
<td>Not available for v2.8 and higher. Selected Not Selected Selected allows management of encryption on a folder-by-folder basis within the sync client folders. For example, if users uploaded files before installing Data Guardian, you can provide temporary Folder Management rights to some users. To provide temporary Folder Management rights to a user: 1. Set this policy for the specific endpoint to Selected. 2. Instruct the user to manually turn on encryption for the pre-existing folder. The files are encrypted when the files sync to the cloud. 3. After the folders are encrypted, set the Folder Management Enabled policy for the endpoint back to Not Selected.</td>
</tr>
</tbody>
</table>

See basic settings

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Office Documents</td>
<td>This technology allows for Office documents (Excel, PowerPoint, and Word) to be encrypted at the file level. Encryption travels with the file wherever it goes, inside or outside the network.</td>
<td></td>
</tr>
</tbody>
</table>
Protected Office Documents
(Basic - Windows and Mac) | Off | On/off
---|---|---
On/off
Toggle On to provide users with a menu option for protecting Office documents (.docx, .xlsx, .pptx, .docm, .xlsm, .pptm, and .pdf). On also allows you to enable other Protected Office policies. If this policy is Off, no Office-protected formatting takes place, regardless of other policies. This policy is available at the Enterprise level.

Folder Exclusions for Basic File Protection
(Windows and Mac) | String |
---|---
String
Listing of folder paths that are excluded from Basic File Protection. See Configure policy to exclude folders.

Protected Office Document Process Protection
(Windows - 2.7 and earlier) | String |
---|---
String
Specifies which process and which extensions to block while a Protected Office Document is open. The following are examples to follow for specific format inclusions:
SnippingTool.exe
mspaint.exe

Force Protected Files Only
(Windows) | Not Selected | Selected/Not Selected
---|---|---
Selected
Selected forces users to save Office files as protected documents. It also enables a sweep on the clients’ internal fixed drives to locate new Office files and change them to Protected mode. It disables the Share option.
If Not Selected, users have some options in determining whether to save a file as protected or unprotected.

Enable Time To Live and Embargo Control
(Windows) | Not Selected | Selected/Not Selected
---|---|---
Selected
Selected allows users to specify dates for when protected Office files are accessible to external users.
### Print Control
(Mac; Windows- v2.7 and earlier)

<table>
<thead>
<tr>
<th>Allowed</th>
<th>Allowed</th>
<th>Watermark Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controls the Print function of protected Office documents (.docx, .xlsx, .pptx, .docm, .xlsm, .pptm, and .pdf):</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Allowed - Print option is enabled for protected Office documents.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Watermark - Print option is enabled for protected Office documents but a watermark with the user's name, domain name, and computer ID displays on each page. Unprotected documents print without the watermark.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Disabled - Print option is enabled. However, if the user clicks Print for a protected Office document or when a protected Office document is open in Acrobat Reader DC, a toaster states that Print is not allowed. In addition, the attempt to print is an audit event. Users can always print unprotected Office documents.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If **Force Protected Files Only** is **Not Selected**, the Print option is available for all unprotected Office documents.

### Export Control
(Windows - v2.7 and earlier)

<table>
<thead>
<tr>
<th>Allowed</th>
<th>Allowed</th>
<th>Watermark Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Office 2013 and higher, controls the Export function of protected Office documents (.docx, .xlsx, .pptx, .docm, .xlsm, .pptm, and .pdf):</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Allowed - This varies based on whether <strong>Force Protected Files Only</strong> is <strong>Selected</strong>. For detailed information, see Set Security Policies to Protect Office Documents.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Watermark - Export is disabled. See Protected Export.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Disabled - Export is disabled for protected Office documents. Users can export unprotected Office documents.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Protected Office Clip Board Unauthorized Text
(Windows - 2.7 and earlier)

Pasting of protected data is not allowed on this computer. Please contact your administrator for assistance.

String to display when a user attempts to paste secure data from a protected document into an unprotected location.

### Protected Office Document Tamper Prompt
(Windows)

The file has been tampered with. Contact the author or your administrator.

String to display if a user encounters an Office-protected document that is identified as having been tampered with.

### Offline Key Generation Escrow Reminder Delay
(Windows)

3 days

1-14 days. 3 days default.

Specifies the number of days the client will wait while not being able to escrow key material prior to warning the end user.

### Offline Key Generation Escrow Reminder Text
(Windows)

Data Guardian has not been able to contact the Dell Server for several days. Please ensure that you are connected to the network. If you are connected to the network, contact your Administrator.

String to display when the end user is warned that the client cannot escrow key material.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protected Office Documents Cover Page Notice</strong> (Windows and Mac)</td>
<td>Enterprise-defined text to be displayed on Office-protected cover pages. Maximum number of characters is 4096. See Set Cover Page Policies. If line breaks are entered as part of the text, they are automatically converted to spaces to ensure the text displays correctly in all Office applications.</td>
</tr>
<tr>
<td><strong>Protected Office Documents Cover Page Corporate Logo</strong> (Windows and Mac)</td>
<td>Image to be displayed on the document cover page. See Set Cover Page Policies. The logo image must be a .jpg of square dimensions with a maximum file size of 25 KB. If the image height and width dimensions are not equal, the displayed image is stretched.</td>
</tr>
<tr>
<td><strong>Protected Office Documents Cover Page Dell Server URL</strong> (Windows and Mac)</td>
<td>Dell Server URL that is displayed on the cover page.</td>
</tr>
</tbody>
</table>
| **Enable Callback Beacon** | Selected inserts a callback beacon into every protected Office file. To use the callback beacon, the following requirements must be met:  
  - The beacon server must be installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the Security Management Server Installation and Migration Guide or Security Management Server Virtual Quick Start Guide and Installation Guide.  
  - An administrator must have enrolled to receive Product Notifications.  
  - The Callback Beacon URL policy is set. |
<p>| <strong>Callback Beacon URL</strong> | Specifies the URL to be used when the callback beacon is inserted into Office-protected files. The URL, for example <a href="http://server.domain.com:8446">http://server.domain.com:8446</a>, must be externally available, hosted on an HTTP server that is installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the Security Management Server Installation and Migration Guide or Security Management Server Virtual Quick Start Guide and Installation Guide. The Enable callback beacon policy must be Selected. |
| <strong>Hidden Audit Trail within Protected Office Document</strong> (Windows and Mac) | Enables a hidden watermark audit trail within a Protected Office Document. For information on decrypting protected documents to view audit data, see Data Guardian in the Recovery Guide. See also web_client and Mobile. |</p>
<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Screen Watermark</td>
<td>Not Selected</td>
<td><em>Selected</em> displays a watermark on the client computer screen when any protected Office file is open.</td>
</tr>
<tr>
<td>Encrypt based on Titus Classification</td>
<td>Not Selected</td>
<td><em>Selected</em> causes the supported files to be converted into Protected Office Documents if a Titus classification is specified.</td>
</tr>
<tr>
<td>Titus Classification Encryption Mapping</td>
<td>String</td>
<td>Requires “Encrypt based on Titus Classification” to be enabled. This policies specifies which classifications, when selected, will have files classified as such automatically converted to Protected Office Documents. Each Classification is separated by a carriage return, semi-colon, or comma. Example: Restricted; Classified. This policy is supported as of Data Guardian v1.6 and later. See <a href="#">Set TITUS classification</a>.</td>
</tr>
<tr>
<td>Allow File Exclusions</td>
<td>Not Selected</td>
<td><em>Selected</em> allows internal users to place files within an Unprotected Documents folder where no data is protected. This applies only when Force Protected Files Only is selected.</td>
</tr>
<tr>
<td>Email Encryption via Outlook</td>
<td>Selected</td>
<td><em>Selected</em> allows users to send emails as Protected by Data Guardian.</td>
</tr>
<tr>
<td>Mobile Client</td>
<td></td>
<td>This technology allows mobile phones and tablets access to encrypted content on supported public clouds, including Dropbox, Box, Google Drive, OneDrive, and OneDrive for Business.</td>
</tr>
<tr>
<td>Enable Callback Beacon</td>
<td>Not Selected</td>
<td><em>Selected</em> inserts a callback beacon into every protected Office file. To use the callback beacon, the following requirements must be met:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The beacon server must be installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the <a href="#">Security Management Server Installation and Migration Guide</a> or <a href="#">Security Management Server Virtual Quick Start Guide and Installation Guide</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An administrator must have enrolled to receive <a href="#">Product Notifications</a>.</td>
</tr>
<tr>
<td>Feature</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Callback Beacon URL</td>
<td>String</td>
<td>Specifies the URL to be used when the callback beacon is inserted into Office-protected files. The URL, for example <a href="http://server.domain.com:8446">http://server.domain.com:8446</a>, must be externally available, hosted on an HTTP server that is installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the Security Management Server Installation and Migration Guide or Security Management Server Virtual Quick Start Guide and Installation Guide. The Enable callback beacon policy must be Selected.</td>
</tr>
<tr>
<td>Hidden Audit Trail within Protected Office Document</td>
<td>Selected</td>
<td>Enables a hidden watermark audit trail within a Protected Office Document. For information on decrypting protected documents to view audit data, see Data Guardian in the Recovery Guide. See also Windows_and_Mac and web_client.</td>
</tr>
<tr>
<td>On Screen Watermark</td>
<td>Not Selected</td>
<td>Selected displays a watermark on the mobile client screen when any protected Office file is open.</td>
</tr>
<tr>
<td>Server Polling Interval</td>
<td>360 minutes</td>
<td>1-1440 minutes How often, in minutes, the client checks in with the Data Guardian for updates. Default is 360 minutes (6 hours).</td>
</tr>
<tr>
<td><strong>Workspace Access</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application pass code (PIN)</td>
<td>4</td>
<td>4 or 6 Required number of characters for Workspace PIN.</td>
</tr>
<tr>
<td>Set maximum failed login attempts</td>
<td>8</td>
<td>4 - 16 Define the number of PIN login failures. Then set the policy for action to take on the Workspace after the failed attempts.</td>
</tr>
<tr>
<td>Set action on maximum failed login attempts</td>
<td>Timeout for 1 minute</td>
<td>Timeout for 1 minute Timeout for 5 minutes Lock Workspace Wipe Workspace Data The action to take after the maximum failed login attempts are reached.</td>
</tr>
<tr>
<td>Set inactivity lock duration</td>
<td>5</td>
<td>2, 5, 20, 30, or 60 minutes Configure the amount of inactivity time that can elapse before the end user must re-enter a PIN.</td>
</tr>
<tr>
<td>Set copy/paste capabilities</td>
<td>Not Selected</td>
<td>Selected allows users to copy and paste outside of the workspace.</td>
</tr>
<tr>
<td>Allow Non-Genuine device OS</td>
<td>Not Selected</td>
<td>Selected allows a jailbroken iOS device or a rooted Android device.</td>
</tr>
<tr>
<td>Protected Office Documents Cover Page Notice</td>
<td>String</td>
<td>Enterprise-defined text to be displayed on Office-protected cover pages. See Set Cover Page Policies.</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Protected Office Documents Cover Page Corporate Logo</td>
<td>Choose File button</td>
<td>Image to be displayed on the document cover page. See Set Cover Page Policies. The logo image must be a .jpg of square dimensions with a maximum file size of 25 KB. If the image height and width dimensions are not equal, the displayed image is stretched.</td>
</tr>
<tr>
<td>Protected Office Documents Cover Page Dell Server URL</td>
<td>String</td>
<td>Dell Server URL that is displayed on the cover page. Note: With mobile, for the URL to work with all file types, it must have http or https prepended.</td>
</tr>
<tr>
<td>Protected Office Document Tamper Prompt</td>
<td></td>
<td>The file being opened appears to have been tampered with and can no longer be validated. Please contact the original author or your administrator. Text to be displayed if a user encounters an Office Protected Document that has been determined was tampered with.</td>
</tr>
</tbody>
</table>

**Web Browser**

Set a default homepage

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.dell.com">http://www.dell.com</a></td>
<td>Homepage default for the Workspace browser.</td>
</tr>
</tbody>
</table>

Pre-configure bookmarks

Pre-configure bookmarks.

See basic settings

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Portal</td>
<td></td>
<td>The Web Portal is a web-based client for creating and editing documents protected by Data Guardian.</td>
</tr>
</tbody>
</table>

Protected Office Documents Cover Page Notice

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Text to be displayed on Protected Office Documents Cover Page. The text in this policy is translatable.</td>
</tr>
</tbody>
</table>

Protected Office Documents Cover Page Corporate Logo

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose File button</td>
<td>Corporate logo to display on the document cover page. The image must be a .jpg of square dimensions with a maximum file size of 25 KB. If the image height and width dimensions are not equal, the displayed image is stretched.</td>
</tr>
</tbody>
</table>

Protected Office Documents Cover Page Dell Server URL

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dell Server URL that is displayed on the Cover Page.</td>
</tr>
</tbody>
</table>

Enable Callback Beacon

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Selected</td>
<td>Selected inserts a callback beacon into every protected Office file. To use the callback beacon, the following requirements must be met:</td>
</tr>
<tr>
<td></td>
<td>• The beacon server must be installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the Security Management Server Installation and Migration Guide or Security Management Server Virtual Quick Start Guide and Installation</td>
</tr>
</tbody>
</table>
### Security Management Server v10.2.7 AdminHelp

#### Callback Beacon URL
- **String**
- Specifies the URL to be used when the callback beacon is inserted into Office-protected files. The URL, for example http://server.domain.com:8446, must be externally available, hosted on an HTTP server that is installed as part of Front End Server/Proxy Mode installation. Port 8446 must be open. For more information, see the Security Management Server Installation and Migration Guide or Security Management Server Virtual Quick Start Guide and Installation Guide. The Enable callback beacon policy must be Selected.

#### Hidden Audit Trail within Protected Office Document
- **Selected**
- Enables a hidden watermark audit trail within a Protected Office Document. For information on decrypting protected documents to view audit data, see the Data Guardian in the Recovery Guide. See also Windows_and_Mac and Mobile.

#### On Screen Watermark
- **Not Selected**
- Selected displays a watermark on the mobile client screen when any protected Office file is open.

#### Basic File Protection
- **Not Selected**
- Selected
- When selected, the Basic File Protection Feature is enabled. This feature allows for the key-per-file encryption of line of business files that are not covered within Microsoft Office.

#### Basic File Protection Configuration
- **String**
- String
- Specifies which process and which extensions are included in Basic File Protection. For Windows, specifies which process and which extensions are included in Basic File Protection. For Mac and mobile devices, these encrypted files are read-only. These encrypted files can be uploaded to the web portal. The following are examples to follow for specific format inclusions:
  - Notepad.exe:txt.csv
  - Wordpad.exe:txt.rtf
  - Word.exe:txt.rtf
- **Note:** Basic File Protection Configuration is supported in Data Guardian v1.6 and later. See Configure Basic File Protection Policies.

See basic settings

### Set Cover Page Policies
For Windows, Mac, mobile, and web portal, you can set policies to customize a cover page for protected Office documents.

- Internal users for all platforms and external users for mobile and web portal - The cover page displays for the following:
- *Protected Office Documents* policies have been enabled, but the user has not yet installed or activated Data Guardian.
- User opens a protected Office document or .pdf from the cloud.
- User downloads a protected Office document or .pdf to a device that does not have Data Guardian installed.

- Unauthorized users - The cover page displays, and the person cannot access the content.

To customize the cover page for protected Office documents, you can use these Advanced Data Guardian policies:

- Protected Office Documents Cover Page Notice
- Protected Office Documents Cover Page Corporate Logo
- Protected Office Documents Cover Page Dell Server URL

See also, Data Guardian Management > Web Portal to add a URL to access the web portal.

### Configure Basic File Protection Policies

With Data Guardian v1.6 and higher, you can configure a large number of file extensions (non-Office) to encrypt and identify the applications to open them. This policy applies at the Enterprise level.

For Windows and Mac, a sweep of users’ computers encrypts those configured file types. For Windows, Mac

This topic includes:

- Supported applications and file types
- Additional applications and file types
- Configure policy for Basic File Protection
- Configure policy to exclude folders (Windows and Mac)
- Unsupported applications and file types
- Use the Recovery Tool

#### Supported applications and file types

This table lists applications and file types that Dell has certified.

<table>
<thead>
<tr>
<th>Supported applications</th>
<th>Supported file extensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell has certified these applications:</td>
<td>.bmp .csv .gif .tif .jpe .jpg .jpeg .png .tmp .rtf .tif .tiff</td>
<td>In the policy configuration field, enter the application, followed by applicable file extensions. As a best practice, only add the essential file extensions to prevent performance issues. .tmp extension Be aware that if you add a .tmp extension, all Temp files are encrypted. Use only if necessary.</td>
</tr>
<tr>
<td>- Notepad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Wordpad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Visio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- MSPaint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add these applications if you want them to open the supported file extensions. For an example, see NoRename.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Word (winword)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Excel</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Additional applications and file types

Many applications and file types should work. However, Dell has not certified all. In addition, enterprise-created applications and file types may work.

You can add other applications and file types, but as a best practice, configure them in a test environment before deploying to your enterprise.

If you test frequently used or essential applications and would like Dell to confirm that and add them to the Supported list or if issues arise, contact Dell support.

Configure policy for Basic File Protection

Overview

With Data Guardian v1.6 and higher, you can configure applications and file types, such as .txt or .png, in addition to Office documents. This policy applies at the Enterprise level. A sweep of users’ computers encrypts those configured file types.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description for Force Protected</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before you enable Basic File Protection (optional but important): Enterprise &gt; Data Guardian &gt; Protected Office Documents &gt; advanced: Folder Exclusions for Basic File Protection &gt; string</td>
<td>You may want to allow users to exclude existing files with that file extension from an encryption sweep, for example: • To prevent files needed by the system from being encrypted • To create a folder where users can place files of that type that do not require security or encrypting</td>
<td>Windows Mac v1.6 and higher</td>
</tr>
<tr>
<td>Enterprise &gt; Data Guardian &gt; Protected Office Documents: Protected Office Documents &gt; On</td>
<td>Windows and Mac For more information, see Configure Basic File Protection Policies. For Mac, it protects files in the Home folder.</td>
<td>Windows Mac v1.6 and higher</td>
</tr>
<tr>
<td>Basic File Protection &gt; check box selected Basic File Protection Configuration &gt; string</td>
<td>Windows and Mac - audit events • For compliance and monitoring purposes, creates audit events.</td>
<td></td>
</tr>
<tr>
<td>Enterprise &gt; Data Guardian &gt; Protected Office Documents &gt; advanced: Allow File Exclusions &gt; check box selected</td>
<td>Users must remove files from the Unprotected Documents folder for these file types to be swept and encrypted. An Unprotected Documents folder is added to the root of each computer’s Documents folder. When users place a Basic File Protection file in that folder, Data Guardian automatically decrypts it.</td>
<td>Windows Mac</td>
</tr>
</tbody>
</table>
To configure additional file types to be encrypted:

1. In the left pane, click Populations > Enterprise, enable the Protected Office Documents policy.

2. In the Data Guardian > Windows technology group, enable the Basic File Protection policy.
   
   Note: This policy applies to the Enterprise population only. Also, if you enable Allow File Exclusions, users must remove files from the Unprotected Documents folder for these file types to be swept and encrypted.

3. In Windows technology group’s Basic File Protection Configuration policy field, enter an application that you want to be encrypted, followed by a colon, for example:
   
   notepad.exe:

4. After the colon, add the file extensions that is encrypted and any processes needed to support that application. Here are some sample configuration strings that Dell has certified. Only add essential extensions to prevent performance issues.

   wordpad.exe:rtf.odt.txt.png.jpg.csv.bmp
   notepad.exe:txt.csv
   visio.exe:vsdx.png.jpg.jpeg.jpe.jfif.gif.tif.tiff.bmp
   mspaint.exe:png.jpg.jpeg.jpe.jfif.gif.tif.tiff.bmp
   sihost.exe:png.jpg.jpeg.jpe.jfif.gif.tif.tiff.bmp
   microsoft.photos.exe:png.jpg.jpeg.jpe.jfif.gif.tif.tiff.bmp

5. For Mobile, copy the extensions from the Windows policy to the Enterprise > Mobile Client > Basic File Protection Configuration policy. The file extensions in the Mobile policy must match Windows.

Basic File Protection policy and operating systems

- **Windows and Mac**: When the policy is enabled, these files are swept and Data Guardian encrypts all local files with those extensions. Files encrypted with Basic File Protection can only be viewed and edited using the application associated with the file extension. Mac requires Force-Protected mode.

- **Web Portal**: If the Edit Permission policy is enabled for web portal, users can edit them.

Some folders are excluded from Windows’ Basic File Protection sweep and files are not encrypted:

- AppData
- Some System folders
- Folders that relate to protected Office documents, such as the Secure Documents folder

6. If applicable, add these workflows to the policy lists:

   - **NoRename** - add this for Office applications to ensure that if users open them, they can only save them as an Office file, not as a Basic File Protection file. Here are some examples:
     
     winword.exe:NoRename.odt.txt.png.jpg.csv.rtf.jpeg.jpe.jfif.gif.tif.tiff.bmp
     excel.exe:NoRename.png.jpg.csv.jpeg.jpe.jfif.gif.tif.tiff.bmp
     powerpnt.exe:NoRename.png.jpg.jpeg.jpe.jfif.gif.tif.tiff.bmp
Note: Do not add Office file extensions to this policy configuration.

- **NoNetwork** – if users log into a network and files hang when users close them, add this to the application to prevent network save.

8. Before deploying Basic File Protection to the enterprise, be sure to test applications and file extensions in a test environment to ensure that the intended file types remain encrypted. Also, you can download procmon (process monitor) to determine file types that might create an issue for that application.

9. Inform users:
   - Which applications and file types your enterprise encrypts
   - Which operating systems can be used and whether files are read only or can be edited
   - Files sent to external users or to devices that do not have Data Guardian installed

**Configure policy to exclude folders for Basic File Protection (Windows and Mac)**

After you enter file types, like .txt or .png, in the Basic File Protection Configuration policy field, a sweep will encrypt those files on the client computers.

You may want to exclude some of those file types, for example:

- To prevent files needed by the system from being encrypted
- To create a folder where users can place files of that type that do not require encrypting

In the Folder Exclusions for Basic File Protection policy, enter the path for a folder on client computers to exclude files from a Basic File Protection sweep.

Note: You cannot exclude the Secure Documents folder.

**Windows example**

Enter the string in one of these formats based on type:

- C:\Program Files, System, or a subfolder in those paths - for files needed by the system
- Variables with a %VALUE% format
- KNOWNFOLDERID - for Windows-specified known-folder ID mappings. For example, enter a string for a uniquely named folder like My Excluded Basic File Types and then tell users to create that folder in their User Profile. Here are examples of supported formats for Known Folder ID mappings:
  - GUID with dashes:
    D0384E7D-BAC3-4797-8F14-CBA229B392B5
  - GUID without dashes:
    D0384E7DBAC347978F14CBA229B392B5
  - GUID with dashes and curly brackets:
    {D0384E7D-BAC3-4797-8F14-CBA229B392B5}

If the computer has more than one user, only the current logged-in user can place files in that folder and have them excluded from the sweep. Any files that another user has placed in that folder will be swept and encrypted.

**Mac example**
Enter the string in this format:

- Variable with a $VALUE format, for example, $HOME/Documents or $HOME/Hidden

**Note:** For Force-protected mode, a sweep occurs in the /Users folder.

**Inform users of the impact or usability**

If you define a unique folder name in the *Folder Exclusions for Basic File Protection* policy so that users can store files of a specific type that should not be encrypted, the policy does not create that folder on the client computers. You must inform users of the folder name and the need to create it.

Users can add subfolders and create names. The content of subfolders is also excluded.

**Note:** If that folder already has files that are encrypted with *Basic File Protection*, those files are not decrypted.

**Unsupported applications and file types**

- Do not add these Office file extensions to the Basic File Configuration policy: .docx, .pptx, .xlsx, .docm, .pptm, .xlsm, .pdf. Basic File Protection does not scan these during a sweep.

- PhotosApp.exe (Windows 8.1)

**Remove a file type**

If you modify the *Folder Exclusions for Basic File Protection* policy to remove a file type, those encrypted files on the client computer are decrypted.

However, if the computer has more than one user, only the current logged-in user has files decrypted. If the logged in user logs out and a second user logs in, the sweep starts again but decrypts only the files of the second logged-in user.

**Use the Recovery Tool**

For more information, see the *Recovery Tool* document > *Data Guardian*.

**Plan for factors in configuration**

You can modify Data Guardian to encrypt additional file types. However, to ensure protection, be aware of the following factors.

<table>
<thead>
<tr>
<th>File extension type or environment</th>
<th>Issue</th>
<th>Options or Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cloud Encryption</strong> enabled (Windows 2.7 and earlier)</td>
<td>In the <em>Basic File Protection Configuration</em> policy, if you add any UWP application and the processes that support the app, all UWP applications are enabled to read these encrypted file types. Edge is a UWP application. File extensions added to the policy, such as .txt or .png, are encrypted. However, if users use Edge to upload these encrypted files to a cloud storage provider, the file is decrypted.</td>
<td>Options to avoid Edge decrypting files on upload:</td>
</tr>
</tbody>
</table>
| **Windows 8.1 - 10 and higher** | | - Do not add UWP apps to the configuration field.  
  - If you add a UWP application, block Edge through GPO or ensure that it is not installed on computers.  
  - Consider which UWP applications you want users to have encrypted. However, test all UWP applications before deploying Basic File Protection to the enterprise to ensure that the intended file types remain encrypted. |
| **Universal Windows Platform (UWP) application** added to *Basic File Protection Configuration* policy (See below for steps to add a UWP application.) | | |
| **These applications are supported and can open a .bmp file:** | **.bmp files require additional configuration in the *Basic File Protection Configuration* policy.** | Here is an example: microsoft.photos.exe.bmp  
DllHost.exe.bmp  
sihost.exe.bmp |
To add a Universal Windows Platform (UWP) application

1. In the Basic File Protection Configuration policy, enter the UWP application name.
2. Also enter the following process names:
   - RuntimeBroker.exe
   - sihost.exe

   **Note:** For Windows 8, if you want to add Photo Previewer as a UWP application to the Basic File Protection Configuration policy, you must also add the DLLHost.exe process.
3. To add the file extensions that each .exe will encrypt, follow the examples in the policy.

Use Data Guardian in Opt-in Mode (Windows or Mac)

With opt-in mode, users have some options in protecting Office documents. Other features, like Content Based Protection (previously Data Classification) and TITUS classification, involve a sweep.

When you enable encryption for these files in Windows or Mac, you can also set policies for users to view the encrypted files in mobile devices or the web portal. See Set Policies to Protect Office Documents in Mobile Devices or Set Policies to Protect Documents on the web client.

- Set opt-in policies for internal users
- Determine file types to protect
- File menu options
- Configure Access Groups
- Legacy policies for Data Guardian

Set opt-in policies for internal users

To set opt-in policies for Office and other file types:

1. Log in to the Management Console.
2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected Office Documents policy group.
3. Set Protected Office Documents to On.

   **Note:** You must enable the policy if you want to use any of the policies in the Protected Office Documents policy group.
4. Set additional policies based on security requirements.

Determine file types to protect

For Windows and Mac, users have the option to determine which Office files, .docx, .pptx, .xlsx, .docm, .pptm, .xslm, or .pdf, to protect.

This table lists policies required for enabling protected Office documents in Opt-in mode.
If the *Protected Office Documents* policy is *Off*, no Office-protected formatting takes place, regardless of other policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description for Opt-in mode</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows and Mac</strong>&lt;br&gt;Enterprise &gt; Data Guardian &gt; Protected Office Documents:&lt;br&gt;Protected Office Documents &gt; On</td>
<td><strong>Windows and Mac - options for encrypting a file:</strong>&lt;br&gt;  - Applies to the Enterprise population.&lt;br&gt;  - A Secure Documents folder is added to the root of each client’s Documents folder. Office files added to that folder are encrypted.&lt;br&gt;  - When users right-click an Office file, a Protect menu option displays.</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Mac&lt;br&gt;Enterprise &gt; Data Guardian &gt; Protected Office Documents &gt; Settings:&lt;br&gt;Allow Mac Data Guardian Activation &gt; check box selected</td>
<td><strong>Windows - additional option for encrypting a file:</strong>&lt;br&gt;  - File menu for Office documents has a Protected Save As option. See File_menu_options.</td>
<td></td>
</tr>
<tr>
<td>Windows and Mac - audit events</td>
<td>- For compliance and monitoring purposes, creates audit events.</td>
<td></td>
</tr>
</tbody>
</table>

**Protected Office Documents - additional policies**

If your enterprise enables encryption for protected Office documents and PDFs, you can select these additional policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover page for protected Office documents&lt;br&gt;Data Guardian &gt; Protected Office Documents &gt; advanced:&lt;br&gt;  - Protected Office Documents Cover Page Notice&lt;br&gt;  - Protected Office Documents Cover Page Corporate Logo&lt;br&gt;  - Protected Office Documents Cover Page Dell Server URL</td>
<td>See Set_Cover_Page_Policies.</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Additional policies for Windows and Mac:&lt;br&gt;Data Guardian &gt; Protected Office Documents &gt; advanced:&lt;br&gt;  - Protected Office Document Tamper Prompt&lt;br&gt;  - Hidden Audit Trail within Protected Office Document</td>
<td>Tampering&lt;br&gt;  - For compliance and monitoring purposes, creates audit events.</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Additional policies for Windows:&lt;br&gt;Data Guardian &gt; Protected Office Documents:&lt;br&gt;  - File Icon Overlay</td>
<td></td>
<td>Windows</td>
</tr>
<tr>
<td>Additional policies for Windows:&lt;br&gt;Data Guardian &gt; Protected Office Documents &gt; advanced:&lt;br&gt;  - Enable Time To Live and Embargo Control&lt;br&gt;  - Offline Key Generation Escrow Reminder Delay&lt;br&gt;  - Offline Key Generation Escrow Reminder Text</td>
<td></td>
<td>Windows</td>
</tr>
</tbody>
</table>
Content Based Protection policies for Windows in Opt-in mode:

- **Content Based Protection** (previously Data Classification)
- **Content Based Protection Rules**

Enforce encryption on sensitive data based on content and a set of rules. Content-based rules can be set at the Enterprise, Endpoint Groups, or Endpoints populations.

See [Configure Content Based Protection for Data Guardian's Opt-in mode](#).

Windows
- For compliance and monitoring purposes, creates audit events.

Callback Beacon policies:

- **Enable Callback Beacon**
- **Callback Beacon URL**

Inserts a callback beacon into every protected Office file.

Windows and Mac - audit events
- For compliance and monitoring purposes, creates audit events.

TITUS Classification policies for Windows:

- **Encrypt based on Titus Classification**
- **Titus Classification Encryption Mapping**

Provides another way for users to protect Office documents and PDFs. When you configure a TITUS classification for Data Guardian, users can right-click a file and select that TITUS classification to have the Office file or PDF encrypted.

See [Set TITUS classification (Opt-in mode)](#).

Windows v1.6 and higher

Outlook email policies Windows in Opt-in mode:

- **Email Encryption via Outlook**

A allows users to send emails as Protected by Data Guardian.

Windows
- For compliance and monitoring purposes, creates audit events.

Basic File Protection

With Data Guardian v1.6 and higher, you can configure applications and file types, such as .txt or .png, in addition to Office documents. This policy applies at the Enterprise level. A sweep of users’ computers encrypts those configured file types.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description for Opt-in</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enterprise &gt; Data Guardian &gt; Protected Office Documents:</strong> Protected Office Documents &gt; On Basic File Protection &gt; check box selected Basic File Protection Configuration &gt; string</td>
<td>Windows and Mac Applies to the Enterprise population. For more information, see <a href="#">Configure Basic File Protection Policies</a>. For Mac, it protects files in Home folder. Windows and Mac - audit events - For compliance and monitoring purposes, creates audit events.</td>
<td>Windows Mac v1.6 and higher</td>
</tr>
<tr>
<td>Before you enable Basic File Protection (optional but important): Enterprise &gt; Data Guardian &gt; Protected Office Documents &gt; advanced: Folder Exclusions for Basic File Protection &gt; string</td>
<td>You may want to allow users to exclude existing files with that file extension from an encryption sweep, for example: - To prevent files needed by the system from being encrypted - To create a folder where users can place files of that type that do not require security or encrypting Windows and Mac: See <a href="#">Configure_policy_to_exclude_folders</a>. Note: You must inform users to create this folder and placing existing files there before you enable Basic File Protection.</td>
<td>Windows Mac v1.6 and higher</td>
</tr>
</tbody>
</table>

Return to [list](#)

File menu options for protected Office documents in Opt-in mode - Windows
Manage Policies

For Office-protected documents, Data Guardian adds a Protected Save As option to the File menu list. This table also lists the behavior of other File menu options.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policy for Opt-in mode:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Protected Office Documents</td>
</tr>
<tr>
<td></td>
<td>Unprotected Office documents</td>
</tr>
<tr>
<td>Open</td>
<td>Files open as usual.</td>
</tr>
<tr>
<td>Save</td>
<td>User clicks Save on an existing protected file: The file is saved as protected.</td>
</tr>
<tr>
<td></td>
<td>If the file is in read-only mode, the Save As window opens. The only option in the Save as type field is Protected (Documents, Presentation, or Workbook).</td>
</tr>
<tr>
<td></td>
<td>User opens and saves a .xen file - the only option in the Save as type field is Protected. The .xen file is removed from the cloud.</td>
</tr>
<tr>
<td></td>
<td>User clicks Save on an existing unprotected file: The file is saved as unprotected.</td>
</tr>
<tr>
<td>Save As</td>
<td>Enabled for user - saves as unprotected.</td>
</tr>
<tr>
<td>Protected Save As</td>
<td>Enabled for user - saves as unprotected.</td>
</tr>
<tr>
<td></td>
<td>Enabled for user - saves as unprotected.</td>
</tr>
<tr>
<td></td>
<td>Enabled for user - saves as unprotected.</td>
</tr>
<tr>
<td></td>
<td>Enabled for user - saves as unprotected.</td>
</tr>
</tbody>
</table>

Configure Access Groups

Data Guardian's Access Groups (formerly Circle of Trust) enhance security by creating user groups that can collaborate on encrypted data. Users outside a group cannot access or view the data unless the owner of the file grants access. Access Groups can include internal and external users. You can use Access Groups with Windows, Mac, mobile, and web portal.

To plan for and implement this feature, see Configure Access Groups.

Legacy policies for Data Guardian

For Windows and Data Guardian v2.4 and higher or Mac Data Guardian v2.9 and higher, Cloud Encryption protection has been disabled to prevent compatibility issues with newer functions of cloud service providers. If your enterprise has earlier versions, see Use Data Guardian with Cloud Encryption.

For Data Guardian v2.8 and higher, some Data Loss Prevention (DLP) features focus on Data Guardian's mobile clients and web portal. These policies no longer apply to Data Guardian v2.8 and higher.

<table>
<thead>
<tr>
<th>Legacy Data Guardian policies</th>
<th>Legacy Advanced Data Guardian policies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Print Screen</td>
<td>Print Control</td>
</tr>
<tr>
<td></td>
<td>Export Control</td>
</tr>
<tr>
<td></td>
<td>Protected Office Document Process Protection</td>
</tr>
<tr>
<td></td>
<td>Protected Office Clip Board Unauthorized Text</td>
</tr>
<tr>
<td></td>
<td>On Screen Watermark</td>
</tr>
</tbody>
</table>

For Data Guardian v2.7 and earlier, see Legacy Policies for Data Guardian's Opt-in Mode.

Use Data Guardian in Force-Protected Mode (Windows or Mac)
Data Guardian’s Force-Protected mode provides a higher level of security than Opt-in mode.

When you enable encryption for these files in Windows or Mac, you can also set policies for users to view the encrypted files in mobile devices or the web portal. See Set Policies to Protect Office Documents in Mobile Devices or Set Policies to Protect Documents on the web client.

Set Force-Protected policies for internal users

To set Force-Protected policies for Office and other file types:

1. Log in to the Management Console.

2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected Office Documents policy group.

3. Set Protected Office Documents to On.

   **Note:** You must enable the policy if you want to use any of the policies in the Protected Office Documents policy group.

4. At the Enterprise, Endpoint Groups, or Endpoints level, click Show advanced settings and select the Force Protected Files Only check box.

5. For Mac, in the Data Guardian technology group, click Settings and ensure the Allow Mac Data Guardian Activation check box is selected.

6. Based on security requirements, set additional policies at the Enterprise, Endpoint Groups, or Endpoints levels.

   For Endpoint Groups or Endpoints, click an option to access the Detail page’s Security Policies tab.

**Determine file types to protect**

For Windows and Mac, a sweep of users’ computers encrypts all .docx, .pptx, .xlsx, .docm, .pptm, .xlsm, or .pdf documents to ensure protection.

This table lists policies required for enabling protected Office documents in Opt-in mode.

If the Protected Office Documents policy is Off, no Office-protected formatting takes place, regardless of other policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description for Force Protected</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise &gt; Data Guardian &gt; Protected Office Documents: Protected Office Documents &gt; On Enterprise, Endpoint Groups, or Endpoints &gt; Data Guardian &gt; Protected Office Documents &gt; advanced: Force Protected Files Only &gt; check box selected For Mac: Enterprise &gt; Data Guardian &gt; Protected Office Documents &gt; Settings: Allow Mac Data Guardian Activation &gt; check box selected</td>
<td>A sweep of users’ computers encrypts all Office documents. Windows On Windows, for Data Guardian to sweep the Office documents, the user must log in and be connected to the network. Sweep ignores network file share, optical, and removable drives. Mac Mac protects files in the Home folder. Windows and Mac - audit events • For compliance and monitoring purposes, creates audit events.</td>
<td>Windows Mac</td>
</tr>
</tbody>
</table>

Protected Office Documents - additional policies for Force-Protected mode
If your enterprise enables encryption for protected Office documents and PDFs, you can select these additional policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Description for Force Protected</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow File Exclusions</td>
<td>check box selected</td>
<td>Windows and Mac</td>
</tr>
<tr>
<td>Windows and Mac</td>
<td>For internal users, an Unprotected Documents folder is added to the root of each computer's Documents folder. When users place an Office document in that folder, Data Guardian automatically decrypts it.</td>
<td></td>
</tr>
<tr>
<td>Set Cover Page Policies</td>
<td>Windows and Mac</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Windows and Mac</td>
<td>For compliance and monitoring purposes, creates audit events.</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Windows and Mac</td>
<td>For compliance and monitoring purposes, creates audit events.</td>
<td>Windows Mac</td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows and Mac</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

File menu options for protected Office documents in Force-Protected mode

These options display for Force-Protected mode in Windows.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policies for Force-Protected mode:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Protected Office Documents</td>
</tr>
<tr>
<td>Users can select Open for an unprotected document in these locations. The document opens in Edit mode.</td>
<td></td>
</tr>
</tbody>
</table>
• Excluded folder if you enable that policy.
• *Unprotected Documents* folder at the root of each computer’s *Documents* folder if you enable that policy.

**Save**
- User clicks *Save*: the file is protected.
- If the file is in read-only mode, the *Save As* window opens. The only option in the *Save as type* field is *Protected (Documents, Presentation, or Workbook)*.
- User opens and saves a .xen file - the only option in the *Save as type* field is *Protected*. The .xen file is removed from the cloud.

**Save As**
- Windows: Data Guardian saves the file as unprotected but if the file is in a local folder, it gets swept and encrypted.

**Configure Access Groups**

Data Guardian’s *Access Groups* (formerly *Circle of Trust*) enhance security by creating user groups that can collaborate on encrypted data. Users outside a group cannot access or view the data unless the owner of the file grants access. Access Groups can include internal and external users. You can use *Access Groups* with Windows, Mac, mobile, and web portal.

To plan for and implement this feature, see Configure Access Groups.

**Legacy policies for Data Guardian**

For Windows and Data Guardian v2.4 and higher or Mac Data Guardian v2.9 and higher, Cloud Encryption protection has been disabled to prevent compatibility issues with newer functions of cloud service providers. If your enterprise has earlier versions, see Use Data Guardian with Cloud Encryption.

For Data Guardian v2.8 and higher, some Data Loss Prevention (DLP) features focus on Data Guardian’s mobile clients and web portal. These policies no longer apply to Data Guardian v2.8 and higher.

### Legacy Data Guardian policies

<table>
<thead>
<tr>
<th>Block Print Screen</th>
<th>Print Control</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Export Control</td>
</tr>
<tr>
<td></td>
<td>Protected Office Document Process Protection</td>
</tr>
<tr>
<td></td>
<td>Protected Office Clip Board Unauthorized Text</td>
</tr>
<tr>
<td></td>
<td>On Screen Watermark</td>
</tr>
</tbody>
</table>

For Data Guardian v2.7 and earlier, see Legacy Policies for Data Guardian’s Forcde-Protected Mode.

Return to Data Guardian.

**Legacy Policies for Data Guardian’s Opt-in Mode**

For Data Guardian v2.8 and higher, some Data Loss Prevention (DLP) features focus on Data Guardian’s mobile clients and web portal.

For Data Guardian v2.7 and earlier, you can use these policies and features.

**Windows: Additional Office menu options for Data Guardian v2.7 and earlier**

For Data Guardian v2.7 and earlier, this table provides an overview of additional Protected Office policy settings and what displays in the Office *File* menu. These do not apply to Data Guardian v2.8 and higher.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policy enabled (some protection options for user):</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Protected Office Documents</td>
</tr>
</tbody>
</table>
### Manage Policies

<table>
<thead>
<tr>
<th>Protected Office documents</th>
<th>Unprotected Office documents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print</strong></td>
<td></td>
</tr>
<tr>
<td>Enabled for user</td>
<td>Enabled for user</td>
</tr>
<tr>
<td>For Office-protected documents, the <strong>Print Control</strong> policy determines how this function behaves.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Export (Office 2013 and higher)</strong></th>
<th><strong>Office 2013/2016 and Export Control policy:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled for user</td>
<td><strong>Allowed:</strong> Enabled for user</td>
</tr>
<tr>
<td></td>
<td><strong>Watermark:</strong> Export is disabled. See <strong>Protected Export</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Disabled:</strong> Disabled for user</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Protected Export (Office 2013 and higher)</strong></th>
<th><strong>Office 2013/2016 and Export Control policy:</strong></th>
</tr>
</thead>
</table>
| This option displays in the File menu only if the Export Control policy is set to Watermark. | **Watermark:** The user can export only to a PDF, but a watermark with their name, domain name, and computer ID displays on each page.  
**Note:** Export is disabled for user. |

<table>
<thead>
<tr>
<th><strong>Share (Office 2013 and higher)</strong></th>
<th><strong>Enabled for protected Office documents</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled for protected Office documents</td>
<td>Enabled for unprotected documents</td>
</tr>
</tbody>
</table>

---

**Windows: Additional Office menu options on Windows for Data Guardian v2.7 and earlier**

For Data Guardian v2.7 and earlier, this table lists other menu options for Office. These do not apply to Data Guardian v2.8 and higher.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policy enabled (some protection options for user): Protected Office Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy/Paste (Office Protected Clip Board policy)</strong></td>
<td>Copy/Paste only to a protected Office document or protected .pdf. However, no unprotected PDFs can be open in Adobe Acrobat Reader DC.</td>
</tr>
</tbody>
</table>
| **Screen Sketch (previously Snipping Tool)** | Windows 10 RS5 and higher - In the **Protected Office Document Process Protected** policy enter this .exe to block this app since users could capture images of protected documents or content.  
**Note:** This policy cannot block the Action Center tile that directly launches the screen-clipping Windows feature. |
| **Protected Office Document Process Protection - example: Snipping Tool** | Windows 10 RS4 and earlier - In the **Protected Office Document Process Protected** policy enter SnippingTool.exe to block it.  
Windows 10 RS5 and higher |

---

**Windows: Additional policies**

Block Print Screen - For Windows and protected Office documents, disables the user's ability to take screen captures via the Windows Print Screen capability while a protected office document is open.

Return to [Data Guardian](#).

---

**Legacy Policies for Data Guardian’s Force-Protected Mode**

For Data Guardian v2.8 and higher, some Data Loss Prevention (DLP) features focus on Data Guardian's mobile clients and web portal.
For Data Guardian v2.7 and earlier, you can use these policies and features.

### Windows: Additional Office menu options for Data Guardian v2.7 and earlier

For Data Guardian v2.7 and earlier, this table provides an overview of additional Protected Office policy settings and what displays in the Office File menu. These do not apply to Data Guardian v2.8 and higher.

With Force Protected enabled, the user is forced to save any Office document as Protected.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policies enabled (higher security):</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Enabled for user</td>
<td>v2.7 and earlier</td>
</tr>
<tr>
<td></td>
<td>For Office-protected documents, the Print Control policy determines how this function behaves.</td>
<td></td>
</tr>
<tr>
<td>Export (Office 2013 and higher)</td>
<td>Office 2013/2016 and Export Control policy:</td>
<td>v2.7 and earlier</td>
</tr>
<tr>
<td></td>
<td>• Allowed: Export option is enabled for user. However, with Force Protected enabled and a higher level of security, Dell recommends setting this policy to Watermark or Disabled. With Allowed, users can save as another file type, which could leave a document unprotected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Watermark: Export is disabled. See Protected Export.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Disabled: Disabled for user</td>
<td></td>
</tr>
<tr>
<td>Protected Export (Office 2013 and higher)</td>
<td>Office 2013/2016 and Export Control policy:</td>
<td>v2.7 and earlier</td>
</tr>
<tr>
<td></td>
<td>• Watermark: The user can export only to a PDF, but a watermark with their name, domain name, and computer ID displays on each page. Note: Export is disabled for the user</td>
<td></td>
</tr>
<tr>
<td>Share (Office 2013 and higher)</td>
<td>Disabled for user</td>
<td>v2.7 and earlier</td>
</tr>
</tbody>
</table>

### Windows: Additional Office menu options on Windows for Data Guardian v2.7 and earlier

For Data Guardian v2.7 and earlier, this table lists other menu options for Office. These do not apply to Data Guardian v2.8 and higher.

With Force Protected enabled, the user is forced to save any Office document as Protected.

<table>
<thead>
<tr>
<th>File menu option for Office documents</th>
<th>Policies enabled (higher security):</th>
<th>Version availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy/Paste (Office Protected Clip Board policy)</td>
<td>Copy/Paste only to a protected Office document or protected .pdf. However, no unprotected PDFs can be open in Adobe Acrobat Reader DC.</td>
<td>v2.7 and earlier</td>
</tr>
<tr>
<td>Protected Office Document Process Protection - example: Snipping Tool</td>
<td>With Force Protected enabled, if you block the PrtScr button, this may also block the ability for users to print screens with touch screen or tablets.</td>
<td>v2.7 and earlier</td>
</tr>
</tbody>
</table>

### Windows: Additional policies

Block Print Screen - For Windows and protected Office documents, disables the user’s ability to take screen captures via the Windows Print Screen capability while a protected office document is open.
Set Policies to Protect Documents in Mobile Devices

For enhanced security on Office documents (.docx, .pptx, .xlsx, .docm, .pptm, .xlsm, or .pdf), you can implement Data Guardian's Protected Office mode. Protected Office documents are uploaded to the cloud, not as .xen files, but with their file extensions (for example, .docx or .pdf). However, the Office documents are encrypted.

Basic File Protection policies allow you to configure additional file extensions to be encrypted. Copy the extensions from the Windows policy to the mobile's Basic File Protection Configuration policy. Users can open, edit, and save encrypted files.

Set Protected Office Document Policies

To set Protected-mode policies on Office documents:

1. Log in to the Management Console.
2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected Office Documents policy group.
3. Toggle the Protected Office Documents policy to On.
   The Force Protected files only policy is not available for mobile.
4. In the Data Guardian technology group, click Settings.
5. Ensure the Allow Mobile Data Guardian Activation check box is selected.
6. Set additional Protected Office policies at the Enterprise, Domains, User Groups, or Users levels.
   For domains, user groups, or users, click an option to access the Detail page's Security Policies tab.

Set Policies to Protect Documents on the Web Portal

For enhanced security on Office documents (.docx, .pptx, .xlsx, .docm, .pptm, .xlsm, or .pdf), you can implement Data Guardian's Protected Office mode for internal users.

Users can open a protected .pdf file with Adobe Acrobat Reader DC or Microsoft Word.

If additional file extensions are set through the Basic File Protection Configuration policy on a Windows client, users can upload those encrypted files on the web portal. If an editing policy is enabled, users can edit them.

With OneDrive for Business, users can connect to the cloud storage provider to download files directly from the cloud to the web portal.

Set Protected Office Document Policies

To set Protected-mode policies on Office documents:

1. Log in to the Management Console.
2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected Office Documents policy group.
3. Toggle the Protected Office Documents policy to On.
4. In the Web Portal policy group or Global Settings, set additional policies at the Enterprise, Domains, User Groups, or Users levels. Some polices are set at the Enterprise (node level) only.

For domains, user groups, or users, click an option to access the Detail page’s Security Policies tab.

**Configure Content Based Protection for Data Guardian’s Opt-in mode**

In Windows for Office documents and PDFs, use the Content Based Protection Rules policy to set rules that enforce encryption on sensitive data. Data Guardian sweeps users' computers when you set the rules and if you modify the rules.

**Note:** Users also have the option to right-click a file that has been analyzed by Content Based Protection and select Protect File.

You can set content-based rules at the Enterprise, Endpoint Groups, or Endpoints populations. Dell recommends that IT best practices are followed during the deployment. This includes, but is not limited to, controlled test environments for initial tests and staggered deployments to users.

Initially, in Actions, do not select the Encrypt check box for any rule. View the audit event reports to see the amount of data returned and the number of endpoints affected. Then modify your rules. To store a large amount of data, see Export Dell Data Guardian Audit Events to SIEM a Server.

To configure the Content Based Protection Rules policy:

1. In the Data Guardian technology group, set these policies to On:
   - Protected Office Documents
   - Content Based Protection (previously Classification)

2. Click Edit Rules. Edit and delete icons display for each rule category. An Elements button displays at the bottom.

3. Configure the rule name, priority, rules, elements, and actions:
   - Modify a Content-Based Rule
   - Content-Based Rule Name and Priority
   - View Audit Event Reports

4. Each time you add or modify a rule, you must click Save beneath the Content Based Protection Rules policy.

**Note:** If you navigate away from this page without clicking Save at the bottom, your changes are not saved.

5. When finished, click Save in the upper-right and commit the policy.

The sweep for Content Based Protection does not include folders for your cloud storage provider. Also, if a file is already encrypted, the sweep does not rescan it to protect it based on the content rule.

**Modify a Content-Based Rule**

The Content Based Protection Rules policy allows you to modify:

- **Content-Based Rule Name and Priority** - The policy lists sample rule names in the Categories list with default priorities that you can modify:
  - Restricted - priority 3, the highest
Internal Use - priority 2

Public - priority 1, the lowest. The lowest priority displays \textit{(default)} after the rule name, and no rules or actions apply.

**Important:** Optionally, you can delete the rules in the Categories list, but the policy requires a minimum number. See Delete.

- **Actions:**
  - **Encrypt** - If you select the Encrypt check box for a non-default rule in the Categories list, the system encrypts the files. In addition, Reports can list which files were encrypted based on content rules. If you select Encrypt and the system sweeps an endpoint and encrypts, the files remain encrypted.
  - **Audit** - By default when the Content Based Protection policy is enabled, the Audit action applies to all files. You can view these in Audit Events and Reports. The report displays the first 2000 audit events. Before deploying, you can configure the rules without selecting the Encrypt option and then generate an audit report to determine the impact on endpoints and then further modify the rules.
  - **Rules** - For configured rules, the system will sweep and detect them when a user saves the file. If the Encrypt check box is selected, the system encrypts the files.
  - **Elements** - Options for configuring a rule, such as Credit Card number, US Name, Social Security Number, or Tags.

**Content-Based Rule Name and Priority**

To modify:

1. See Configuration overview.
2. Select a non-default rule name in the Categories list, and click the Edit icon.
3. Optionally, modify the rule name.
4. Modify the priority:
   - The Priority label lists the range of numbers based on your number of rules in the Categories list.
   - The largest number is the highest priority.
   - By default, Public is set to 1, the lowest priority. Whichever rule is set to priority 1 is listed with the \textit{(default)} label and has no Encrypt option and no rules to modify. If you configure rules for a name with a higher priority but then change the priority to 1, those rules are ignored.
5. To remove a rule name, select one and click the Delete icon (X). The range of priorities will also decrease.

**Important:** The policy requires a minimum number of rule names in the Categories lists.

- For files to be encrypted, this policy requires a minimum of two rule names and one Encrypt check box selected.
- For the policy to function and create audit events, this policy requires a minimum of one rule name in the Categories list.
6. In Edit Rule, click Save.
7. Below the Content Based Protection Rules policy, click Save.
Actions

To modify:

1. See Configuration overview.
2. Click the icon to expand a non-default rule name.
3. Select the Encrypt check box if you want the audit report to display files that have met the criteria for encryption.
4. Below the Content Based Protection Rules policy, click Save.

Return to top

Rules

To modify:

1. See Configuration overview.
2. Click the icon to expand a non-default rule name in the Categories list.
3. Click + to add a rule.
4. In the Rule field that displays, select one or more check boxes for that rule and modify the number if needed. Incremented numbers mean that a file must contain that element, such as U.S. Address or Social Security Number, the specified number of times or higher in order to encrypt the file. For example, if your file lists a sample U.S. Address, you may not want the file to be encrypted. Therefore, you could set this number to 2 for an encryption.
5. Click + to add and configure more rules for that rule name. Rules are or’d together.
6. Below the Content Based Protection Rules policy, click Save.

Return to top

Elements

To view Elements:

1. See Configuration overview.
2. Select a non-default rule name in the Categories list.
3. Click the Elements button at the bottom.
4. On the Elements window, select an element.
5. Do not modify the Content Identifier or Content Type.
6. See the table below.
7. When finished with the Elements window, click Save.
8. Below the Content Based Protection Rules policy, click Save.

For elements that you can modify, if you use them in multiple rule names be aware that future changes impact all rule names that use that element.

<table>
<thead>
<tr>
<th>Content Based Protection Elements</th>
<th>Description</th>
</tr>
</thead>
</table>

289
Predefined Elements:
- Credit Card
- Email (IPv4 and IPv6 IP addresses are recognized.)
- IP Address
- Social Security Number
- US Address
- US Date
- US Name
- US Phone Number

Do not modify these elements, except for US Name. For US Name, use these fields: First Names, Last Names, Common Words.

You cannot delete these elements.

Keywords elements

In the Keywords field, type any key words that you want the system to recognize when encrypting files for that rule name. The format is [object Object]. Click Save. Click X to delete. See Add_an_Enterprise-Specific_Rule_Name_or_Tag_Element.

Tags elements

Public, Internal Use, Confidential, Restricted
Select the tag element that corresponds to the rule name, for example, with the Restricted rule name, select Restricted Tag.
In the Tag field, a default tag displays. The system recognizes that tag when encrypting content based on that rule.
For Tag elements, do not enter content in the Regex field. Click X to delete.
Note: If end users want to use the Tag option in Office documents to trigger a content rule, inform them of the content in the Tag field. End users must match the case. See Add_an_Enterprise-Specific_Rule_Name_or_Tag_Element.

Custom Regex element

The best practice is not to modify the Regex for predefined elements or Tag elements. Use the Custom Regex element or create a new Regex element. See Add_an_Enterprise-Specific_Rule_Name_or_Tag_Element.

9. When finished with the Elements window, click Save.

10. Below the Content Based Protection Rules policy, click Save.

Add an Enterprise-Specific Rule Name or Tag Element

Create a Rule Name

You can create an additional rule or modify the names of existing ones.

To create a new rule name:

1. See Configuration_overview.
2. In the Content Based Protection Rules policy, click the add icon (+) next to Categories.
3. In the Add Rule window, enter a name for the rule.
4. Enter a priority. A number displays to indicate the range of rules in your list. See Content-Based_Rule_Name and Priority.
5. Click Add.
6. Below the Content Based Protection Rules policy, click Save.

Create an Element

To create an element:

1. See Configuration_overview.
2. In the Elements window, click the add icon (+) next to Elements.
3. In the Content Identifier field, enter a unique identifier.
4. Select a Content Type.
   Note: Select the KeywordContent for any Keywords elements; the FileTagMetadataContent for any Tag elements, and the CustomRegexContent for any Regex elements.
5. Click Add.
6. Below the Content Based Protection Rules policy, click Save.
7. Modify the Element when it displays in the Element window.

After you create an element, you can add it as a new rule.

For Regex, the best practice is to create a new element with a Content Identifier such as MyEnterprise Custom Regex or Custom Regex for Internal Use. Any Custom Regex would use the Content Type Custom Regex. However, do not use Custom Regex for predefined or Tags elements.

Note: Content Based Protection uses the .NET regex engine.

View Audit Event Reports

Any documents that are impacted by Content Based Protection rules can display in Audit Events and Reports. If you select the Encrypt check box in policy, the report can also display which files were encrypted based on these rules.

You can set filters on the columns to view the essential data in the report.

Set TITUS classification (Opt-in mode)

For Data Guardian 1.6 and later, you can use the Titus Classification Encryption Mapping policy to set one or more TITUS classifications to encrypt unprotected Office documents (.docx, .pptx, .xlsx, .docm, .pptm, .xlsm, or .pdf) for Windows.

TITUS classification in a Data Guardian environment with Opt-in mode provides another way for users to protect Office documents. When a user right-clicks and selects a TITUS classification that you have configured, Data Guardian converts it to a protected Office document.

Currently, TITUS classification applies only to Office documents and PDFs, not additional file extensions set in the Basic File Protection policy.

In the policy, you can also add keywords.

Configure TITUS to encrypt files

TITUS server

The TITUS server administrator must set the TITUS Classification levels on the TITUS server.

Here are some examples.

<table>
<thead>
<tr>
<th>TITUS Classification level</th>
<th>TITUS Classification Encryption mapping policy - formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>t_class_1</td>
</tr>
<tr>
<td>Internal</td>
<td>t_class_2</td>
</tr>
</tbody>
</table>
Manage Policies

<table>
<thead>
<tr>
<th>Confidential</th>
<th>t_class_3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restricted</td>
<td>t_class_4</td>
</tr>
</tbody>
</table>

For more information, see the *TITUS Administration Guide*.

**Management Console**

Configure the policy on the Management Console:

1. From the TITUS server administrator, obtain the format for each TITUS classification level.
2. In the *Management Console > Protected Office Documents* policy group, enable these policies:
   - *Protected Office Documents*
   - *Advanced: Encrypt based on Titus Classification*

   Do not select the *Force Protected Files Only* policy.

3. In the *Titus Classification Encryption Mapping* policy field, enter the formatting. For example, for Data Guardian to encrypt a *Restricted* TITUS classification, enter *Set classification to t_class_4*.

4. Separate each classification by a carriage return, semi-colon, or comma, for example, t_class_1, t_class_2.

5. Optionally, obtain keywords for sensitive data from the TITUS administrator. For example, TITUS can scan a document for sensitive data, like Social Security Numbers. If you enter a keyword for that in this policy field and TITUS detects it, that document is protected as Restricted regardless of which TITUS option the user selects. For more information, see *Actions* in the *TITUS Administration Guide*.

**Configure TITUS to encrypt macro-enabled documents**

To use TITUS classification with Data Guardian and macro-enabled documents (.docm, .pptm, .xlsm) requires additional configuration.

1. In the TITUS Administration Console, select the *Configurations* tab.
2. Select the current enabled configuration from the list and click *Edit*.
3. In the left pane, click *Adapters*.
4. In the Adapter column, click *OPC Document Properties*.
5. Click *Edit*.
7. Click *Save*.

**Use Data Guardian with Cloud Encryption**

Data Guardian with Cloud Encryption with:

- Mobile
- Web portal

The Dell Server automatically updates profiles of cloud storage providers. For more information, see *Cloud Profile Update*. 
For Windows 2.4 and higher or Mac 2.9 and higher, Data Guardian's Cloud Encryption protection has been disabled to prevent compatibility issues with newer functions of cloud service providers. To view .xen files already protected with Cloud Encryption, use Data Guardian's Mobile app or web portal.

Windows 2.3 and earlier or Mac 2.8 and earlier

Determine which Data Guardian policy groups you want to enable:

<table>
<thead>
<tr>
<th>Data Guardian Policy Groups</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Office Documents is On Cloud Encryption is Off</td>
<td>Office documents are protected based on policies. No DDG VDisk virtual drive is created. Non-Office documents are not impacted. If Force Protected Files Only is selected, an Unprotected folder is added to the root of the user's Documents folder.</td>
<td>N/A</td>
</tr>
<tr>
<td>Cloud Encryption is On Protected Office Documents is Off</td>
<td>Office and non-Office documents are protected as .xen files based on policies set. A DDG VDisk virtual drive displays in the client’s Windows Explorer.</td>
<td>Office and non-Office documents are protected as .xen files based on policies set.</td>
</tr>
<tr>
<td>Both are On</td>
<td>Non-Office documents are protected as .xen files if in the DDG VDisk virtual drive. A DDG VDisk virtual drive displays in the client’s Windows Explorer. Office documents have different levels of security based on policy. If protected, the Office document retains its extension in the cloud but unauthorized users cannot access it. Additional policies impact Office documents.</td>
<td>Non-Office documents are protected as .xen files. Office documents are protected based on Protected Office policies.</td>
</tr>
<tr>
<td>Neither is On</td>
<td>Files are not protected. If opened, content displays in cleartext.</td>
<td>Files are not protected. If opened, content displays in cleartext.</td>
</tr>
</tbody>
</table>

Enable Both Cloud Encryption and Protected Office Documents (Windows 2.3 and earlier)

If you enable both policy groups, Protected Office documents differ from non-Office documents in some areas:

- If the Cloud Storage Protection Providers policy is set to Allow and does not encrypt non-Office files, protected Office documents still maintain any protection status.
- If the Excluded Folders policy excludes a particular folder from encryption, protected Office documents still maintain any protection status if copied to those folders.

Cloud Profile Update

The Security Management Server can automatically check for updated profiles of cloud storage providers supported with Data Guardian.

Note: For Windows, this applies to Data Guardian v2.3 and previous.

To configure Dell Server to automatically check for updated profiles, follow these steps:

1. Navigate to <Security Server install dir>\conf\ and open the application.properties file.
2. Locate cloud.profile.updater.enabled and set the value to true.

When update is enabled and updated profiles are available, the profiles are sent to Data Guardian clients after the administrator commits policy changes. When the Pending Policy Changes value in the
Management Console is automatically incremented although an administrator has not modified policy values, at least one updated profile is available.

The polling interval for cloud storage provider profile updates is daily at 12:30 a.m.

**Configure Access Groups**

Data Guardian's *Access Groups* (formerly *Circle of Trust*) enhance security by creating user groups that can collaborate on encrypted data. Users outside a group cannot access or view the data unless the owner of the file grants access. Access Groups can include internal and external users. You can use *Access Groups* with Windows, Mac, mobile, and web portal.

Data Guardian encrypted files:

- Internal users within an access group have access to encrypted data.
- Internal users outside an access group or external users do not have access but can request access.

**Important:** Currently, if you enable *Access Groups* in the Management Console, you cannot disable it.

To configure access groups, complete the following:

- **Set up Access Groups**
- Determine whether the enterprise already has Data Guardian installed. Implementation will be easier if you have a brief transition period where you allow users with shared files to prepare a plan for shared files. Do one of these:
  - **Enterprise does not yet have Data Guardian** - Transition time differs based on Force-Protected or Opt-in mode. Instruct users to process shared files.
  - **Enterprise has Data Guardian Installed** - Instruct users to process shared, encrypted files.
- **Configure Access Groups**
- **Disable Auto access for swept files**

**Set up Access Groups**

Analyze which users to include within each access group based on which users need to share or collaborate on documents. You can create groups before or after enabling *Access Groups* in the Management Console.

To set up groups, see **Add a User Group**.

**For Access Groups**, you can configure the following:

- Import existing AD groups, for example, an accounting or legal group that shares files.
- Select *ADMIN-DEFINED User Groups* for cross-functional teams of managed users and any external users that share or collaborate on files.

  **Note:** When defining new groups, be sure to use descriptive names. On the client side, users will be selecting some of these groups.

- **After you add the user group, you can select that group, select the Details and Action tab, and enable Access Groups for a single group or a combination of groups.**

Also consider the following:
• Develop a plan for adding and removing users from a group if internal users join or leave the enterprise.

• As a best practice, stagger deployment of Access Groups to user groups.

**Note:** Access groups should be specific groups within the enterprise, not the entire enterprise.

**Enterprise does not yet have Data Guardian**

If you do not yet have Data Guardian installed, develop a plan for implementing access groups and creating a smooth transition for users who have shared files.

**Determine a transitional time range for deployment**

Initially, enable Access Groups and Auto access for swept files for a transitional period. This should be a brief time but long enough for user files to be swept. In the transitional period, allow enough time for the following:

• Determine or estimate the quantity of documents that users have. Allow enough time for Data Guardian to sweep unprotected files. A sweep occurs with the following:
  • If you enable Force-Protected mode (Office documents and PDFs) or Basic File Protection (additional file types), all those unprotected files are swept.
  • Opt-in mode - A sweep only occurs for Content Based Protection (Windows only), TITUS Classification (Windows only), or Basic File Protection (additional file types).

• Users must log in to their computers while Access Groups and Auto access for swept files are enabled. Be sure to allow for users who are out of the office or on vacation.

**Instruct users to process shared files**

Inform internal users who will be in their access group and allow them to process shared files to ensure a smooth transition. Inform them that this effort will minimize their having to request access to shared files later.

• After Access Groups is enabled, a sweep occurs for Windows and Mac files. See [Disable_Auto_access_for_swept_files](#). If files are shared by multiple users, the first computer to be swept gives ownership of any shared files to the owner of that computer, not the original author.
  • All internal users within the same access group will have access to the file.
  • If the original author of the file is not in the access group with the user whose computer was first swept, the author must request access or request that the administrator change ownership of the file.
  • External users’ unprotected shared files are not swept.

• If Auto access will be temporarily enabled, instruct users that any internal user outside their access group who has a copy of the file has permanent access to the key. In some cases, the key cannot be revoked later. See [Disable_Auto_access_for_swept_files](#).

**Note:** After Auto access is disabled, for those outside an access group, the internal user can grant access or users outside the access group can request access if they receive an encrypted file. You can revoke the key access in the Management Console if needed.

**Enterprise has Data Guardian Installed**
If you have Data Guardian installed, develop a plan for implementing access groups and creating a smooth transition for users who have shared files.

**Determine a transitional time range for deployment**

Initially, enable *Access Groups* and *Auto access for swept files* for a transitional period. This should be a brief time but owners of a protected, shared file should plan for any impact to that file.

**Instruct users to process shared files**

Inform internal users who will be in their access group and allow them to process shared files to ensure a smooth transition.

- During the Auto-access transitional period, all internal users within the same access group have access to the shared, protected files.

- If Auto access will be temporarily enabled, instruct users that any internal user outside their access group who has a copy of the file and opens it has permanent access to the key. In some cases, the key cannot be revoked later. See [Disable Auto access for swept files](#).

- If a user does not open a file and auto access is disabled, they lose access.

- If an internal user already granted access to an external user, the external user will not lose access.

- When a file is created after *Access Groups* is enabled, all users within that access group have access to the file.
  - If a user is removed from the access group, the user no longer has access to the files.
  - If the owner of the file is removed from the access group, others who shared access still have access.

For detailed information on the impact, see [Disable Auto access for swept files](#).

**Configure Access Groups**

IT best practices should be followed during deployment. This includes, but is not limited to, controlled test environments for initial tests, and staggered deployments to users.


   **Important:** Currently, if you enable Access Groups, you cannot disable it.

2. If you have not yet created user groups for this feature, see [Add a User Group](#).

3. In User Groups, select a group.

4. On User Group Detail, select the *Details and Action* tab.

5. Click the check box for *Access Group Enabled*.

   **Note:** You can also modify the group members, remove the group, or clear the *Access Group* check box.

With Access Groups enabled, the *Protected File Access* screen allows internal users to select one or more access groups or add an individual when sharing a protected file. External users who own a document can share it with individual users but not access groups. This is available on Windows, Mac, mobile, and web portal. For more information, see the *Data Guardian User Guide*. 

**Disable Auto access for swept files (Windows and Mac)**

296
If you have a transitional period, when it is complete, clear the Auto access for swept files check box.

Be aware of the following for an enterprise that already had Data Guardian installed on Windows or Mac.

**Internal users in access groups**

<table>
<thead>
<tr>
<th>Force-protected mode</th>
<th>Pre-existing encrypted files created before Access Groups</th>
<th>New files created after were enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force-protected mode - files that Data Guardian swept</td>
<td>Internal users within the access group do not have automatic access.</td>
<td>Internal users within the access group have access.</td>
</tr>
<tr>
<td>• Force-Protected sweep (Office documents, PDFs)</td>
<td>• Owner of the file can grant protected access.</td>
<td>• If someone is removed from access.</td>
</tr>
<tr>
<td>• Basic File Protection sweep (additional file types)</td>
<td>• Users with a protected file can request access.</td>
<td>• If the owner of a file leaves the access group, they still have access.</td>
</tr>
</tbody>
</table>

In the Management Console, if needed, you can revoke key access that has been granted.

**Opt-in mode**

<table>
<thead>
<tr>
<th>Opt-in mode - files that Data Guardian swept</th>
<th>Same as above.</th>
<th>Same as above.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Secure documents folder sweep</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Basic File Protection sweep (additional file types)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• TITUS classification (Windows)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Content Based Protection (Windows)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Opt-in mode - files protected through:

<table>
<thead>
<tr>
<th>Internal users within the access group do not have automatic access.</th>
<th>Owner of the file can grant protected access.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Protected Save As</td>
<td>Users with a protected file can request access.</td>
</tr>
<tr>
<td>• Right-click protect</td>
<td></td>
</tr>
<tr>
<td>• Basic File Protection - direct save</td>
<td></td>
</tr>
<tr>
<td>• Protected messages</td>
<td></td>
</tr>
</tbody>
</table>

In the Management Console, if needed, you can revoke key access that has been granted.

**Internal users not in the access group and external users**

<table>
<thead>
<tr>
<th>Force-protected mode</th>
<th>Files created before Access Groups were enabled</th>
<th>New files created after were enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force-protected mode - files that Data Guardian swept</td>
<td>Internal users outside the access group and external users do not have automatic access.</td>
<td>Internal users outside the access group and external users do not have automatic access.</td>
</tr>
<tr>
<td>• Force-Protected sweep (Office documents, PDFs)</td>
<td>• Owner of the file can grant protected access.</td>
<td>• Owner of the file can grant protected access.</td>
</tr>
<tr>
<td>• Basic File Protection sweep (additional file types)</td>
<td>• Users with a protected file can request access.</td>
<td>• Users with a protected file can request access.</td>
</tr>
</tbody>
</table>

Note: Sweeping only applies to internal users. External users' computers are not swept.

In the Management Console, if needed, you can revoke key access that has been granted.

Note: During the transitional period when Auto access for swept files was enabled, if a user within the access group opened the file, that user has permanent access, and you cannot revoke key access.
Manage Policies

Opt-in mode

<table>
<thead>
<tr>
<th>Opt-in mode - files that Data Guardian swept</th>
<th>Internal users outside the access group and external users: Same as above.</th>
<th>Internal users outside the access group and external users: Same as above.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure documents folder sweep</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic File Protection sweep (additional file types)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TITUS classification (Windows)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content Based Protection (Windows)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Sweeping only applies to internal users. External users' computers are not swept.

<table>
<thead>
<tr>
<th>Opt-in mode files protected through:</th>
<th>Internal users outside the access group and external users: Same as above.</th>
<th>Internal users outside the access group and external users: Same as above.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Save As</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right-click protect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic File Protection - direct save</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Protected messages</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Change the owner of a file

*After enabling Access Groups, if another user was designated as the owner of a shared, encrypted document, you can change the owner. See [Key Management](#).*

Return to top

Removable Media Encryption

A note about Removable Media policies: Mac Media Encryption policies are device-based policies. This is different behavior than Windows Media Encryption, which are user-based.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Media Encryption</td>
<td>Off</td>
<td>This policy must be selected to use all other removable media policies. Not Selected means that no encryption of removable media takes place, regardless of other policy values.</td>
</tr>
<tr>
<td>EMS Scan External Media</td>
<td>Not Selected</td>
<td>Selected allows removable media to be scanned every time it is inserted. When this policy is Not Selected and the Windows Media Encryption policy is Selected, only new and changed files are encrypted. More... A scan occurs at every insertion so that any files</td>
</tr>
</tbody>
</table>
added to the removable media without authenticating can be caught. Files can be added to the media if authentication is declined, but encrypted data cannot be accessed. The files added are not encrypted in this case, so the next time the media is authenticated (to work with encrypted data), any files that may have been added are scanned and encrypted.

| EMS Access to unShielded Media | Read Only | Block, Read Only, Full Access
This policy interacts with the Port Control System - Class: Storage > Subclass Storage: External Drive Control policy. If you intend to set this policy to Full Access, ensure that Subclass Storage: External Drive Control is not set to Read Only or Blocked.
More...
When this policy is set to Block Access, you have no access to media unless it is encrypted. Choosing either Read-Only or Full Access allows you to decide what media to encrypt.
If you choose not to encrypt removable media and this policy is set to Full Access, you have full read/write access to media.
If you choose not to encrypt media and this policy is set to Read-Only, you can read or delete existing files on the unencrypted removable storage, but files cannot be edited on, or added to, the media.

| EMS Block Access to UnShieldable Media | Selected | Block access to any removable media that is less than 55 MB and thus has insufficient storage capacity to host Encryption External Media (such as a 1.44MB floppy disk).
More...
All access is blocked if Windows Media Encryption and this policy are both Selected. If Windows Media Encryption is Selected, but this policy is Not Selected, data can be read from the unencryptable media, but write access to the media is blocked.
If Windows Media Encryption is Off, then this policy has no effect and access to unencryptable media is not impacted.

See advanced settings

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mac Media Encryption | Off | Toggle On to enable Mac Removable Media Encryption policies. If this policy is toggled to OFF, no Mac Removable Media Encryption takes place, regardless of other policies.
HFS Plus is supported and must be enabled. For instructions to enable HFS Plus, see the Encryption Enterprise for Mac Administrator Guide. |
Media containing Time Machine backups are not supported. However, media recognized by computers as Time Machine backup destinations are automatically whitelisted, to allow backups to continue. All other removable media with Time Machine backups are handled based on EMS Access to unShielded Media and EMS Block Access to UnShieldable Media policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMS Scan External Media</td>
<td>Not Selected</td>
<td>Selected allows removable media to be scanned every time it is inserted. When this policy is Not Selected and the Windows Media Encryption policy is Selected, only new and changed files are encrypted. More... A scan occurs at every insertion so that any files added to the removable media without authenticating can be caught. Files can be added to the media if authentication is declined, but encrypted data cannot be accessed. The files added are not encrypted in this case, so the next time the media is authenticated (to work with encrypted data), any files that may have been added are scanned and encrypted.</td>
</tr>
<tr>
<td>EMS Access to unShielded Media</td>
<td>Read Only</td>
<td>Block, Read Only, Full Access When this policy is set to Block Access, you have no access to removable media unless it is encrypted. Choosing either Read-Only or Full Access allows you to decide what media to encrypt. If you choose not to encrypt removable storage and this policy is set to Full Access, you have full read/write access to removable media. If you choose not to encrypt removable media and this policy is set to Read-Only, you cannot read or delete existing files on the unencrypted media, but no files can be edited on, or added to, the media unless it is encrypted.</td>
</tr>
<tr>
<td>EMS Block Access to UnShieldable Media</td>
<td>Selected</td>
<td>Block access to any removable media that is less than 55 MB and thus has insufficient storage capacity to host Encryption External Media (such as a 1.44MB floppy disk). All access is blocked if EMS Encrypt External Media and this policy are both selected. If EMS Encrypt External Media is True, but this policy is False, data can be read from the unencryptable media, but write access to the media is blocked. If EMS Encrypt External Media is False, then this policy has no effect and access to unencryptable media is not impacted.</td>
</tr>
</tbody>
</table>

See advanced settings

Policy | Default Setting | Description
---|---|---
Media Encryption Settings
This technology allows definition of what media encryption events to retain in logs.
Event Retention

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Retention Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>security, fail</td>
<td>30 days</td>
</tr>
<tr>
<td>security, success</td>
<td>30 days</td>
</tr>
<tr>
<td>application, error</td>
<td>30 days</td>
</tr>
<tr>
<td>application, warn</td>
<td>15 days</td>
</tr>
<tr>
<td>application, info</td>
<td>5 days</td>
</tr>
<tr>
<td>application, debug</td>
<td>5 days</td>
</tr>
</tbody>
</table>

Defines the amount of time (in days) that Encryption External Media, and PCS event types are maintained in the event log. Each event type is defined by category and level. You may set different retention times for each event level in each category. The Security category represents events related to user authentication, authorization, or encryption. This includes events for Dell-encrypting devices, updating security policies, or failed authentication attempts. Security events are further differentiated by a fail or success indicating the outcome of the event. The Application category (application type event, rather than a security type event) represents events related to general application actions. These events are further differentiated by a set of severity levels - error, warn, info, and debug. You should use longer retention times for more severe levels.

Removable Media Policies that Require Logoff

- Windows Media Encryption
- EMS Scan External Media
- EMS Encryption Algorithm
- EMS Exclude CD/DVD Encryption
- EMS Data Encryption Key

Advanced Removable Media Encryption

A note about Removable Media Encryption policies: Mac Media Encryption policies are device-based policies. This is different behavior than Windows Media Encryption, which are user-based.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Media Encryption      | Off             | This technology works on Windows computers using Dell Encryption External Media to encrypt data on removable devices, which can be accessed using a user-defined password. These policies allow configuration of the Encryption External Media password requirements and the removable media allowed.

This policy must be selected to use all other removable media policies. Not Selected means that no encryption of removable media takes place, regardless of other policy values.
<table>
<thead>
<tr>
<th>Policy</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMS Exclude CD/DVD Encryption</td>
<td>Not Selected</td>
<td>False encrypts CD/DVD devices. This policy applies to 5.4.x Windows Encryption clients only. More... If a user chooses not to encrypt media and this policy is set to True, they are able to read or delete existing files on the media that are not encrypted, but the client does not allow any files to be edited on or added to the media unless it is Dell-encrypted.</td>
</tr>
<tr>
<td>EMS Allow Read-access to unShielded Media (5.4.x Only)</td>
<td>Selected</td>
<td>AES 256, AES 128, 3DES Encryption algorithm used to encrypt removable media. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.</td>
</tr>
<tr>
<td>EMS Encryption Algorithm</td>
<td>AES256</td>
<td>Common, User, User Roaming Choose a key to be used by the Encryption client to encrypt all data encrypted by the Encryption External Media. More... You cannot save a policy where this policy has the same value as either User Data Encryption Key policy or Application Data Encryption Key policy, the error message Policy Constraint Violation: The value for EMS Data Encryption Key conflicts with User Data Encryption Key and/or Application Data Encryption Key will display.</td>
</tr>
<tr>
<td>EMS Data Encryption Key</td>
<td>User Roaming</td>
<td>Disabled, Local, Roaming Local automatic authentication allows the encrypted media to be automatically authenticated when inserted in the originally encrypting computer when the owner of that media is logged in. When automatic authentication is Disabled, users must always manually authenticate to access encrypted media. Not selecting Roaming automatic authentication helps to prevent users from forgetting their password when they take the media home or share it with a colleague. Not selecting Roaming automatic authentication also promotes a sense of awareness from a security perspective for users that the data being written to that media is protected.</td>
</tr>
<tr>
<td>EMS Automatic Authentication</td>
<td>Disabled</td>
<td>Selected allows the user to access encrypted data on removable media whether the endpoint is Dell-encrypted or not. More... When this policy is False, the user can work with encrypted data when logged on to any Dell-encrypted endpoint. The user cannot work with encrypted data using any device that is not Dell-encrypted.</td>
</tr>
<tr>
<td>EMS Access Encrypted Data on unShielded Device</td>
<td>Selected</td>
<td>String - Maximum of 150 devices with a maximum of 500 characters per PNPDeviceID. Maximum of 2048 total characters allowed. “Space” and “Enter” characters count in the total characters used. This policy allows the specification of removable media devices to exclude from encryption [using the device’s Plug and Play device identifier (PNPDeviceID)], thereby allowing users full access to the specified removable media devices. More... This policy is available on an Enterprise, Domain, Group, and User level. Local settings override inherited settings. If a user is in more than one group, all EMS Device Whitelist entries, across all Groups, apply. This policy is particularly useful when using removable media devices which provide hardware encryption. However, this policy should be used with caution. This policy does not check whether external media devices on this list provide hardware encryption. Whitelisting removable storage devices that do not have hardware encryption do not have enforced security and are not protected. For example, the Kingston® DataTraveler® Vault Privacy model enforces that encryption is enabled to use the device. However, the Kingston DataTraveler Vault model has an unsecured partition and a secured partition. Because it is the same physical removable media device with only one PNPDeviceID, the two partitions cannot be distinguished, meaning that whitelisting this particular device would allow unencrypted data to leave the endpoint. Additionally, if a removable media device is encrypted and is subsequently added to the EMS Device Whitelist policy, it remains encrypted and requires a reformat of the device to remove encryption. The following is an example of a PNPDeviceID, which contains the manufacturer identifier, product identifier, revision, and hardware serial number:</td>
</tr>
</tbody>
</table>
To whitelist a removable media device, provide a string value that matches portions of the device’s PNPDeviceID. Multiple device PNPDeviceIDs are allowed. For example, to whitelist all Kingston DataTraveler Vault Privacy models, input the string:

**PROD_DTVAULT_PRIVACY**

To whitelist both models of Kingston DataTraveler, the Vault and Vault Privacy models, input the string:

**PROD_DTVAULT_PRIVACY; PROD_DT_VAULT**

Space characters are considered part of the substring to match to a PNPDeviceID. Using the previous PNPDeviceID as an example, a space before and after the semicolon would cause neither of the substrings to be matched, because the space character is not part of the PNPDeviceID.

**Instructions...**

To find the PNPDeviceID for removable media:

1. Insert the removable media device into an encrypted computer.
2. Open the **EMSService.log** in `C:\Programdata\Dell\Dell Data Protection\Encryption\EMS`.
3. Find PNPDeviceID=

For example:

```
14.03.18 18:50:06.834 [I] [Volume "F:\"] PnPDeviceID = USBSTOR\DISK&VEN_KINGSTON&VEN_DS046\&PROD_DTVAULT_PRIVACY\REV_194\07005B831A\0000464800
```

**VEN=Vendor; Green highlighted text is for the vendor to be excluded**

**PROD=Product/Model Name; Adding text highlighted blue also excludes all of Seagate’s USB drives**

**REV=Firmware Revision; Adding text highlighted gray also excludes the specific model being used**

**Serial number (in this example); Adding text highlighted yellow excludes just this device**

OR

To find the PNPDeviceID for removable media on Windows 7 or later:

1. Insert the removable media device.
2. Open the Control Panel and go to Administrative Tools > Computer Management.
3. Select the Hardware tab, select the drive, and click Properties.

The PNPDeviceID is displayed in **Value** .

Available Delimiters:

- Tabs
- Commas
- Semicolons
- Hex character 0x1E (Record separator character)

<table>
<thead>
<tr>
<th>EMS Alpha Characters Required in Password</th>
<th>Selected</th>
<th>Selected requires one or more letters in the password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMS Mixed Case Required in Password</td>
<td>Selected</td>
<td>Selected requires at least one uppercase and one lowercase letter in the password.</td>
</tr>
<tr>
<td>EMS Number of Characters Required in Password</td>
<td>8</td>
<td>1-40 characters Minimum number of characters required in the password.</td>
</tr>
<tr>
<td>EMS Numeric Characters Required in Password</td>
<td>Selected</td>
<td>Selected requires one or more numeric characters in the password.</td>
</tr>
<tr>
<td>Feature</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EMS Password Attempts Allowed</td>
<td>3</td>
<td>Number of times the user can attempt to enter the correct password.</td>
</tr>
<tr>
<td>EMS Special Characters Required in Password</td>
<td>Not Selected</td>
<td>Selected requires one or more special characters in the password.</td>
</tr>
<tr>
<td>EMS Access and Device Code Length</td>
<td>16</td>
<td>Number of characters access and device codes have. 32 characters is the most secure, while 8 is the easiest to enter.</td>
</tr>
<tr>
<td>EMS Access Code Attempts Allowed</td>
<td>3</td>
<td>Number of times the user can attempt to enter the access code.</td>
</tr>
</tbody>
</table>
| EMS Access Code Failure Action               | Apply Cooldown | Action to take following unsuccessful EMS Access Code Attempts Allowed:  
  • Apply Cooldown to allow another round of attempts following the specified cooldown period (EMS Cooldown Time Delay and EMS Cooldown Time Increment policies)  
  • Wipe Encryption Keys to delete the encryption keys on the removable storage, making the encrypted data inaccessible until the owner takes the media to an encrypted computer for which he has a login. |
| EMS Access Code Required Message             | String Authentication Failed. Please contact your system administrator. | Message that displays when a user needs to contact you for an access code (after authentication failure). |
| EMS Cooldown Time Delay                      | 30    | Number of seconds the user must wait before attempting to enter the access code after failing the specified number of times. |
| EMS Cooldown Time Increment                  | 20    | Incremental time to add to the cooldown time each time the user fails to enter the correct access code in the specified number of attempts. |
| EMS Access Code Failed Message               | String You are not authorized to use this media. Please contact your system administrator. | Message that displays following unsuccessful Access Code Attempts Allowed. |
| EMS Encryption Rules                         | Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. A total of 2048 characters are allowed. "Space" and "Enter" characters used to add lines between rows count as characters used. Any rules exceeding the 2048 limit are ignored. See Encryption Rules for information. | Storage devices which incorporate multi-interface connections, such as Firewire, USB, eSATA, etc. may require the use of both EMS and encryption rules to encrypt the endpoint. This is necessary due to differences in how the Windows operating system handles storage devices based on interface type. To ensure encrypting an iPod via EMS does not make the device unusable, use the following rules:  
  -R:\Calendars  
  -R:\Contacts  
  -R:\iPod_Control  

You can also force encryption of specific file types in the directories above. Adding the following rules will ensure that ppt, pptx, doc, docx, xls, and xlsx files are encrypted in the directories excluded from encryption via the previous rules:
   ^R:\Calendars
   ppt.doc
   xls.pptx
   .docx.xlsx
   ^R:\Contacts
   ppt
   .doc.xlsx
   .pptx.docx
   xlsx
   ^R:\iPod_Control
   ppt.doc
   xls.pptx
   .docx.xlsx
   ^R:\Notes
   ppt.doc
   xls.pptx
   .docx.xlsx
   ^R:\Photos
   ppt.doc
   xls.pptx
   .docx.xlsx
   .xlsx

Replacing these five rules with the following rule will force encryption of ppt, pptx, doc, docx, xls, and xlsx files in any directory on the iPod, including Calendars, Contacts, iPod_Control, Notes, and Photos:
   ^R:\;ppt.doc.xls
   .pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for all removable devices - not just an iPod. Use care when defining rules to exclude an iPod from encryption.
These rules have been tested against the following iPods:
   iPod Video 30gb fifth generation
   iPod Nano 2gb second generation
   iPod Mini 4gb second generation
Dell does not recommend the use of the iPod Shuffle, as unexpected results may occur.
As iPods change, this information could also change, so caution is advised when allowing the use of iPods on EMS-enabled computers.
Because folder names on iPods are dependent on the model of the iPod, Dell recommends creating an exclusion encryption policy which covers all folder names, across all iPod models.

---

**Mac Media Encryption**

This technology works on Mac computers using Dell Encryption External Media to encrypt data on removable devices, which can be accessed using a user-defined password. These policies allow configuration of the Encryption External Media password requirements and the removable media allowed.

<table>
<thead>
<tr>
<th>Mac Media Encryption</th>
<th>Off</th>
<th>Toggle On to enable Mac Removable Media Encryption policies. If this policy is toggled to OFF, no Mac Removable Media Encryption takes place, regardless of other policies.</th>
</tr>
</thead>
</table>
| EMS Encryption Algorithm | AES256 | AES 256, AES 128, 3DES
Encryption algorithm used to encrypt removable storage.
Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES. |

---

See [basic settings](#)
<table>
<thead>
<tr>
<th>EMS Data Encryption Key</th>
<th>User Roaming</th>
<th>Common, User, User Roaming. Although Common is available, it is not implemented in this release. Choose a key to be used by the Encryption client to encrypt all data encrypted by the Encryption External Media.</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMS Alpha Characters Required in Password</td>
<td>Selected</td>
<td>Selected requires one or more letters in the password.</td>
</tr>
<tr>
<td>EMS Mixed Case Required in Password</td>
<td>Selected</td>
<td>Selected requires at least one uppercase and one lowercase letter in the password.</td>
</tr>
<tr>
<td>EMS Number of Characters Required in Password</td>
<td>8</td>
<td>1-40 characters Minimum number of characters required in the password.</td>
</tr>
<tr>
<td>EMS Numeric Characters Required in Password</td>
<td>Selected</td>
<td>Selected requires one or more numeric characters in the password.</td>
</tr>
<tr>
<td>EMS Password Attempts Allowed</td>
<td>3</td>
<td>1-10 Number of times the user can attempt to enter the correct password.</td>
</tr>
<tr>
<td>EMS Special Characters Required in Password</td>
<td>Not Selected</td>
<td>Selected requires one or more special characters in the password.</td>
</tr>
<tr>
<td>EMS Access and Device Code Length</td>
<td>16</td>
<td>8, 32 Number of characters access and device codes have. 32 characters is the most secure, while 8 is the easiest to enter.</td>
</tr>
<tr>
<td>EMS Access Code Attempts Allowed</td>
<td>3</td>
<td>1-10 Number of times the user can attempt to enter the access code.</td>
</tr>
<tr>
<td>EMS Access Code Failure Action</td>
<td>Apply Cooldown</td>
<td>Apply Cooldown, Wipe Encryption Keys Action to take following unsuccessful Access Code Attempts Allowed: • Apply Cooldown to allow another round of attempts following the specified cooldown period (Cooldown Time Delay and Cooldown Time Increment policies) • Wipe Encryption Keys to have the Encryption client delete the encryption keys on the removable storage, making the encrypted data inaccessible until the owner takes the media to a Dell-encrypted computer for which he has a login.</td>
</tr>
<tr>
<td>EMS Access Code Required Message</td>
<td>String</td>
<td>String - 5-512 characters - Authentication Failed: Please contact your system administrator. Message that displays when a user needs to contact you for an access code (after authentication failure). More... Message policies must have non-blank values. “Space” and “Enter” characters used to add lines between rows count as characters used. Messages over the 512 character limit are truncated on the client. Optionally customize the second sentence of the message to include specific instructions about how to contact a help desk or security administrator for authentication failures.</td>
</tr>
<tr>
<td>EMS Cooldown Time Delay</td>
<td>30</td>
<td>0-5000 seconds Number of seconds the user must wait between the first and second rounds of access code entry attempts.</td>
</tr>
<tr>
<td>EMS Cooldown Time Increment</td>
<td>20</td>
<td>0-5000 seconds Incremental time to add to the previous cooldown time after each unsuccessful round of access code entry attempts.</td>
</tr>
<tr>
<td>EMS Access Code Failed Message</td>
<td>String</td>
<td>String - 5-512 characters - You are not authorized to use this media. Please contact your system administrator. Message that displays following unsuccessful Access Code Attempts Allowed. More... Message policies must have non-blank values. “Space” and “Enter” characters used to add lines between rows count as characters used. Messages over the 512 character limit are truncated on the client. Optionally customize the message to include specific instructions about how to contact the help desk or security administrator.</td>
</tr>
<tr>
<td>EMS Encryption Rules</td>
<td></td>
<td>Encryption rules to be used to encrypt/not encrypt certain drives, directories, and folders. A total of 2048 characters are allowed. “Space” and “Enter” characters used to add lines between rows count as characters used. Any rules exceeding the 2048 limit are ignored.</td>
</tr>
</tbody>
</table>
See **Encryption Rules** for information.

More:

Storage devices which incorporate multi-interface connections, such as Firewire, USB, eSATA, etc. may require the use of both EMS and encryption rules to encrypt the endpoint. This is necessary due to differences in how the Windows operating system handles storage devices based on interface type.

To ensure encrypting an iPod via EMS does not make the device unusable, use the following rules:

- \R\:Calendars
- \R\:Contacts
- \R\:iPod\_Control
- \R\:Notes
- \R\:Photos

You can also force encryption of specific file types in the directories above. Adding the following rules will ensure that ppt, pptx, doc, docx, xls, and xlsx files are encrypted in the directories excluded from encryption via the previous rules:

- \R\:Calendars
  - ppt.doc
  - xls.pptx
  - .docx.xlsx
- \R\:Contacts
  - ppt
  - .doc.xls
  - pptx.docx
  - xlsx
- \R\:iPod\_Control
  - ppt.doc
  - xls.pptx
  - .docx.xlsx
- \R\:Notes
  - ppt.doc
  - xls.pptx
  - .docx.xlsx
- \R\:Photos
  - ppt.doc
  - xls.pptx
  - .docx.xlsx

Replacing these five rules with the following rule will force encryption of ppt, pptx, doc, docx, xls, and xlsx files in any directory on the iPod, including Calendars, Contacts, iPod\_Control, Notes, and Photos:

- \R\:\;ppt.doc.xls
  - pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for all removable devices - not just an iPod. Use care when defining rules to exclude an iPod from encryption.

These rules have been tested against the following iPods:

- iPod Video 30gb fifth generation
- iPod Nano 2gb second generation
- iPod Mini 4gb second generation

Dell does not recommend the use of the iPod Shuffle, as unexpected results may occur.

As iPods change, this information could also change, so caution is advised when allowing the use of iPods on EMS-enabled computers.

Because folder names on iPods are dependent on the model of the iPod, Dell recommends creating an exclusion encryption policy which covers all folder names, across all iPod models.

<table>
<thead>
<tr>
<th>EMS Automatic Authentication</th>
<th>Local</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled, Enable Local, Enable Roaming</td>
<td></td>
</tr>
</tbody>
</table>

Local automatic authentication allows the Dell-encrypted media to be automatically authenticated when inserted in the originally encrypting computer when the owner of that media is logged in. When the User Roaming key is applied.
Manage Policies

308

to Encryption External Media, Roaming Automatic Authentication allows Dell-encrypted media to be automatically authenticated when it is inserted in any Dell-encrypted computer the media owner is logged into. When automatic authentication is disabled, users must always manually authenticate to access Dell-encrypted media.

Disabling Roaming Authentication helps to prevent users from forgetting their password when they take the media home or share it with a colleague. Disabling Roaming Authentication also promotes a sense of awareness from a security perspective for users that the data being written to that media is protected.

EMS Access Encrypted Data on unShielded Device

Selected

Selected allows the user to access encrypted data on removable storage whether the endpoint is encrypted or not. When this policy is Not Selected, the user can work with encrypted data when logged on to any encrypted endpoint. The user cannot work with encrypted data using any unencrypted device.

EMS Device Whitelist

String - Maximum of 150 devices with a maximum of 500 characters per PNPDeviceID. Maximum of 2048 total characters allowed. "Space" and "Enter" characters count in the total characters used.

This policy allows the specification of removable media devices to exclude from encryption [using the device’s Plug and Play device identifier (PNPDeviceID)], thereby allowing users full access to the specified removable media devices.

More...

This policy is available on an Enterprise, Domain, Group, and User level. Local settings override inherited settings. If a user is in more than one group, all EMS Device Whitelist entries, across all Groups, apply.

This policy is particularly useful when using removable media devices which provide hardware encryption. However, this policy should be used with caution. This policy does not check whether external media devices on this list provide hardware encryption. Whitelisting removable storage devices that do not have hardware encryption do not have enforced security and are not protected.

For example, the Kingston® DataTraveler® Vault Privacy model enforces that encryption is enabled to use the device. However, the Kingston DataTraveler Vault model has an unsecured partition and a secured partition. Because it is the same physical removable media device with only one PNPDeviceID, the two partitions cannot be distinguished, meaning that whitelisting this particular device would allow unencrypted data to leave the endpoint.

Additionally, if a removable media device is encrypted and is subsequently added to the EMS Device Whitelist policy, it remains encrypted and requires a reformat of the device to remove encryption.

The following is an example of a PNPDeviceID, which contains the manufacturer identifier, product identifier, revision, and hardware serial number:

USBSTOR\DISK&VEN_KINGSTON\&PROD_DTVault_Privacy\&REV_194\07005B831A00048-4\00

To whitelist a removable media device, provide a string value that matches portions of the device’s PNPDeviceID. Multiple device PNPDeviceIDs are allowed. For example, to whitelist all Kingston DataTraveler Vault Privacy models, input the string:

PROD_DTVault_Privacy

To whitelist both models of Kingston DataTraveler, the Vault and Vault Privacy models, input the string:

PROD_DTVault_Privacy;
PROD_DT_Vault

Space characters are considered part of the substring to match to a PNPDeviceID. Using the previous PNPDeviceID as an example, a space before and after the semicolon would cause neither of the substrings to be matched, because the space character is not part of the PNPDeviceID.

Instructions...

1. Insert removable media.
2. Open System Profiler.
3. Under Hardware, select the device and find the Product ID and Vendor
ID, as follows:
Capacity: 2.06 GB (2,055,019,008 bytes)
Removable Media: Yes
Detachable Drive: Yes
BSD Name: disk2
Product ID: 0x5406
Vendor ID: 0x0781 (SanDisk Corporation)
Version: 0.10
Serial Number: 0000188C36725BC8
Speed: Up to 480 Mb/sec
Manufacturer: SanDisk
Location ID: 0x24100000
Current Available (mA): 500
Current Required (mA): 200
Partition Map Type: MBR (Master Boot Record)
S.M.A.R.T. status: Not Supported

4. The following whitelist rules can be used:
   USBVendorName=abc
   USBVendorNum=0x02
   USBVendorNum=2,USBProductNum=3
   USBVendorNum=2,USBProdName=abc

   For this example, add the following key/pair string to the EMS Device Whitelist policy, as shown below:
   "USBVendorNum=0x0781,USBProductNum=0x05406"
   (including quotes)

5. When satisfied with the EMS Device Whitelist rules, save and commit the policy.

<table>
<thead>
<tr>
<th>EMS Trust for Unsupported File Systems</th>
<th>Ignore</th>
<th>Ignore, Provisioning Rejected, Unshieldable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Specifies how media are handled when formatted by file systems that are not supported with Encryption External Media.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restricted user list for access to unencrypted media</th>
<th>Dictionary</th>
<th>Users matching this dictionary are restricted from unencrypted media use. Example:</th>
<th>&lt;key&gt;AccessUnencryptedMediaRestrictionUsers&lt;/key&gt;</th>
<th>&lt;dict&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>&lt;key&gt;dsAttrTypeStandard:AuthenticationAuthority&lt;/key&gt;</td>
<td>&lt;array&gt;</td>
<td>&lt;string&gt;Kerberosv5;&lt;/string&gt;<a href="mailto:username1@domainName.com">username1@domainName.com</a>;domainName.com*&lt;/string&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;array&gt;</td>
<td>&lt;string&gt;Kerberosv5;&lt;/string&gt;@domainName.org;domainName.org&lt;/string&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/array&gt;</td>
<td>&lt;/dict&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restrict Access to Unencrypted Media</th>
<th>Full</th>
<th>Full, Read Only, Block</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Specify how media encrypted with Encryption External Media is handled for users matching unencrypted media restriction.</td>
</tr>
</tbody>
</table>

See [basic settings](#).

### Removable Media Policies that Require Logoff

- Windows Media Encryption
- EMS Scan External Media
- EMS Encryption Algorithm
- EMS Exclude CD/DVD Encryption
- EMS Data Encryption Key

### Mac Encryption
### Mac Encryption

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Volume Encryption</td>
<td>On</td>
<td>This technology allows the use of either Mac FileVault full disk encryption or Dell’s proprietary Dell Volume Encryption. On/Off Toggle ON to enable Dell Volume Encryption policies. If this policy is toggled to OFF, no Dell Volume Encryption takes place, regardless of other policies.</td>
</tr>
<tr>
<td>Encrypt Using FileVault for Mac</td>
<td>Not Selected</td>
<td>If selected, FileVault is enabled to encrypt all volumes including System Volumes and Fusion Drives.</td>
</tr>
<tr>
<td>Workstation Scan Priority</td>
<td>Normal</td>
<td>Specifies the relative priority of encrypted folder scanning. Highest and Highest prioritize scanning speed over computer responsiveness, Low and Lowest prioritize computer responsiveness over scanning speed and favor other resource-intensive activities, and Normal balances the two. The Encryption client checks for a changed Workstation Scan Priority before processing the next file. This policy applies to Dell Encryption, not FileVault encryption.</td>
</tr>
</tbody>
</table>

See [advanced settings](#).

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac Global Settings</td>
<td>All Fixed Volumes</td>
<td>This technology defines Mac encryption behavior, including targeted volumes, polling intervals, and restart policies. System Volume Only All Fixed Volumes The System Volume Only setting secures only the currently running system volume.</td>
</tr>
<tr>
<td>Volumes Targeted for Encryption</td>
<td>All Fixed Volumes</td>
<td>String - maximum of 1500 characters List fully qualified Policy Proxy hostnames, or IP addresses, separated by carriage returns. More... Once the Encryption client finds a valid entry, the remainder of the entries are ignored. Entries are processed in the following order: 1. GKConnections Override (this registry entry overrides all other entries) 2. GKConnections (this registry entry is set automatically by the Encryption client, based on the this policy) 3. GK</td>
</tr>
<tr>
<td>Policy Proxy Connections</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This policy works in conjunction with the Policy Proxy Polling Interval policy. You cannot specify ports in this policy. The Encryption client communicates with Policy Proxies using the GKPORT specified during client installation (the default is 8000). Inherited values for this policy accumulate. For the Encryption client to connect to a Policy Proxy specified in this policy, it must be in the same group as the Policy Proxy specified during client installation. Because the Shield supports up to 255 users per endpoint, this policy is available only at the Enterprise level.

<table>
<thead>
<tr>
<th>Policy Proxy Polling Interval</th>
<th>360</th>
<th>1-1440 minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The interval that the Encryption client attempts to poll Policy Proxy for policy updates, and send inventory information to Policy Proxy. Setting the Policy Proxy Polling Interval below 60 minutes is not recommended, due to potential degradation of performance. The Encryption client also attempts to poll Policy Proxy each time a user logs on.</td>
</tr>
</tbody>
</table>

| Force Restart on Policy Updates | Selected | If this policy is set to Selected, the Encryption client will force a computer restart after the specified delay upon receiving a policy update requiring a restart. The delay is specified by the Length of Each Restart Delay and Number of Restart Delays Allowed policies. If this policy is set to Not Selected, the Encryption client will neither force nor prompt for a restart. The policy requiring the restart will take effect the next time the user restarts their computer. |

| Length of Each Restart Delay | 15 | If Force Restart on Policy Updates is set to Selected, this value is the number of minutes the user can delay the restart before another restart prompt is displayed. If Force Restart on Policy Updates is set to Not Selected, this policy is ignored. The Encryption client displays the restart prompt for five minutes each time. If the user does not respond to the prompt, the prompt is dismissed and next delay begins. If the five-minute timer expires and no restart delays remain, the computer restarts immediately. **Tip:** Calculate the maximum possible delay as follows (a maximum delay would involve the user responding to each delay prompt immediately prior to the 5-minute mark): (Number of Reboot Delays Allowed x Length of Each Reboot Delay) + (5 minutes x [Number of Reboot Delays Allowed + 1]). |

| Number of Restart Delays Allowed | 3 | If Force Restart on Policy Update is set to Selected, this value is the number of times the user can delay the restart. If this policy is set to "0", the Encryption client prompts the user to restart immediately and forces the restart if the user does not acknowledge the prompt within five minutes. |
Advanced Mac Encryption

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Volume Encryption</td>
<td>On</td>
<td>This technology allows the use of either Mac FileVault full disk encryption or Dell's proprietary Dell Volume Encryption.</td>
</tr>
<tr>
<td>Workstation Scan Priority</td>
<td>Normal</td>
<td>Specifies the relative Mac priority of encrypted folder scanning. High and Highest prioritize scanning speed over computer responsiveness, Low and Lowest prioritize computer responsiveness over scanning speed and favor other resource-intensive activities, and Normal balances the two. The Encryption client checks for a changed Workstation Scan Priority before processing the next file.</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>AES256</td>
<td>Encryption algorithm used to encrypt data at the endpoint (all users) level. Encryption algorithms in order of speed, fastest first, are AES 128, AES 256. NOTE: This policy applies to Dell Encryption, not FileVault encryption.</td>
</tr>
<tr>
<td>Firmware Password Mode</td>
<td>Required</td>
<td>Specify if the firmware password in older hardware is optional or required for Dell Volume Encryption.</td>
</tr>
<tr>
<td>FileVault 2 Policy Conflict Behavior</td>
<td>Ignore</td>
<td>Ignore, Report, Convert Specify behavior when volume is Dell encrypted and policy is for FV2 encryption. Ignore – Default behavior, Dell encrypted volumes are reported as protected if the policy requires FV2 encryption. Report – Conflicted volumes are reported as unprotected. Convert – Dell encrypted volumes are converted to FV2 volumes and reported as unprotected while converting.</td>
</tr>
</tbody>
</table>

See [basic settings](#).

Mac Global Settings

This technology defines Mac encryption behavior, including targeted volumes, polling intervals, and restart policies.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Password Delay</td>
<td>300</td>
<td>Limits the maximum delay in seconds that can be set in the system preferences “max password delay after screen saver or sleep” of the Security panel.</td>
</tr>
</tbody>
</table>
### Delay Authentication

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Selected</td>
<td>If Selected, users are not prompted to activate or authenticate to the Dell Server until required, such as to use media encrypted with Encryption External Media.</td>
</tr>
</tbody>
</table>

### No Auth User List

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dictionary      | Users matching this dictionary are not required to activate or authenticate to the Dell Server. Example:  
<key>NoAuthenticateUsers</key>  
<dict>  
<key>dsAttrTypeStandard:AuthenticationAuthority</key>  
<string>;Kerberosv5;;@students.school.edu;students.school.edu</string>  
</dict> |

### FileVault 2 PBA User List

<table>
<thead>
<tr>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dictionary      | Users matching this dictionary are allowed to add themselves to FileVault Preboot Authentication. Example:  
<key>FV2PBAUsers</key>  
<dict>  
<key>dsAttrTypeStandard:AuthenticationAuthority</key>  
<string>;Kerberosv5;;*@students.school.edu;students.school.edu*</string>  
</dict> |

### Port Control

#### Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows Port Control</strong></td>
<td></td>
<td>This technology allows for control of all the physical ports on a Windows computer (disable/enable/bypass), and can be customized by port type.</td>
</tr>
<tr>
<td>Windows Port Control</td>
<td>Disabled</td>
<td>Enable or Disable all Port Control System policies. If this policy is set to Disable, no Port Control System policies are applied, regardless of other Port Control System policies. All PCS policies require a reboot before the policy takes effect.</td>
</tr>
<tr>
<td>Port: Express Card Slot</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass ports exposed through the Express Card Slot.</td>
</tr>
<tr>
<td>Port: USB</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to external USB ports. USB port-level blocking and HID class-level blocking is only honored if we can identify the computer chassis as a laptop/notebook form-factor. We rely on the computer's BIOS for the identification of the chassis.</td>
</tr>
<tr>
<td>Port: eSATA</td>
<td>Enabled</td>
<td>Enable, Disable, or Bypass port access to external SATA ports.</td>
</tr>
<tr>
<td>Class: Storage</td>
<td>Enabled</td>
<td>PARENT to the next 3 policies. Set this policy to Enabled to use the next 3 Subclass Storage policies. Setting this policy to Disabled disables all 3 Subclass Storage policies - no matter what their value.</td>
</tr>
</tbody>
</table>
### Windows Device Control
This technology allows for control of all the devices on a Windows computer (disable/enable), and can be customized by device type.

<table>
<thead>
<tr>
<th>Class: Windows Portable Device (WPD)</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARENT to the next policy. Set this policy to Enabled to use the Subclass Windows Portable Device (WPD): Storage policy. Setting this policy to Disabled disables the Subclass Windows Portable Device (WPD): Storage policy - no matter what its value. Control access to all Windows Portable Devices.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subclass Windows Portable Device (WPD): Storage</th>
<th>Full Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHILD of Class: Windows Portable Device (WPD). Class: Windows Portable Device (WPD) must be set to Enabled to use this policy. Full Access: Port does not have read/write data restrictions applied. Read Only: Allows read capability. Write data is disabled. Blocked: Port is blocked from read/write capability.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class: Human Interface Device (HID)</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control access to all Human Interface Devices (keyboards, mice). USB port-level blocking and HID class-level blocking is only honored if we can identify the computer chassis as a laptop/notebook form-factor. We rely on the computer’s BIOS for the identification of the chassis.</td>
<td></td>
</tr>
</tbody>
</table>

See [advanced settings](#)

### Advanced Port Control
Policy descriptions also display in tooltips in the Management Console. In this table, master policies are in bold font.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Port Control</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. This policy interacts with EMS Access to unShielded Media policy. If you intend to have Full Access to media, also set this policy to Full Access to ensure that the media is not set to read only and the port is not blocked. Full Access: External Drive port does not have read/write data restrictions applied Read Only: Allows read capability. Write data is disabled Blocked: Port is blocked from read/write capability This policy is endpoint-based and cannot be overridden by user policy.</td>
<td></td>
</tr>
<tr>
<td>Subclass Storage: External Drive Control</td>
<td>Full Access</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. This policy interacts with EMS Access to unShielded Media policy. If you intend to have Full Access to media, also set this policy to Full Access to ensure that the media is not set to read only and the port is not blocked. Full Access: External Drive port does not have read/write data restrictions applied Read Only: Allows read capability. Write data is disabled Blocked: Port is blocked from read/write capability This policy is endpoint-based and cannot be overridden by user policy.</td>
</tr>
</tbody>
</table>
### Optical Drive Control

<table>
<thead>
<tr>
<th>Child of Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>Subclass Storage: Optical Drive Control</td>
</tr>
<tr>
<td>UDF Only</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. Full Access: Optical Drive port does not have read/write data restrictions applied. UDF Only: Blocks all data writes that are not in the UDF format (CD/DVD burning, ISO burning). Read data is enabled. Read Only: Allows read capability. Write data is disabled. Blocked: Port is blocked from read/write capability. This policy is endpoint-based and cannot be overridden by user policy. Universal Disk Format (UDF) is an implementation of the specification known as ISO/IEC 13346 and ECMA-167 and is an open vendor-neutral file system for computer data storage for a broad range of media. To encrypt data written to CD/DVD media: Set EMS Encrypt External Media = True, EMS Exclude CD/DVD Encryption = False, and Storage Class: Optical Drive Control = UDF Only.</td>
</tr>
</tbody>
</table>

### Floppy Drive Control

<table>
<thead>
<tr>
<th>Child of Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>Subclass Storage: Floppy Drive Control</td>
</tr>
<tr>
<td>Read Only</td>
<td>CHILD of Class: Storage. Class: Storage must be set to Enabled to use this policy. Full Access: Floppy Drive port does not have read/write data restrictions applied. Read Only: Allows read capability. Write data is disabled. Blocked: Port is blocked from read/write capability. This policy is endpoint-based and cannot be overridden by user policy.</td>
</tr>
</tbody>
</table>

#### Port Settings

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Enabled/Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCMCIA</td>
<td>Enabled</td>
</tr>
<tr>
<td>Firewire (1394)</td>
<td>Enabled</td>
</tr>
<tr>
<td>SD</td>
<td>Enabled</td>
</tr>
<tr>
<td>Memory Transfer Device (MTD)</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

See [basic settings](#).

### Windows Device Control

This technology allows for control of all the devices on a Windows computer (disable/enable), and can be customized by device type.

<table>
<thead>
<tr>
<th>Child of Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td>Class: Other</td>
</tr>
<tr>
<td>Enabled</td>
<td>Control access to all devices not covered by other Classes.</td>
</tr>
</tbody>
</table>

See [basic settings](#).

### Global Settings

Global Settings policies are available at the Enterprise, Endpoint Groups, and Endpoints levels. All Global Settings policies are endpoint-based, meaning the policies follow the endpoint, not the user.

Audit Control policies are available at the Enterprise, Endpoint Groups, Endpoints, User Groups, and Users levels.
Policy descriptions also display in tooltips in the Management Console.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings</strong></td>
<td></td>
<td>This technology allows control over general settings such as polling intervals, support dialogs, in-app feedback, auto updates, data auditing, and client retention periods.</td>
</tr>
<tr>
<td><strong>Device Lease Period</strong></td>
<td>30</td>
<td>Defines the period of inactivity (in days) before any activated entity (a user, endpoint, or policy proxy) is automatically removed from management. The inactivity period is based on the number of days since the Dell Server last received inventory information from the activated entity. Once removed, the entity is no longer included in reports, statistics, and other administrative views. If the activated entity communicates with the Dell Server after the inactivity period has expired, it returns to being in a managed state. The Dell Server always keeps encryption keys in escrow, even for removed endpoints. This ensures recoverability of data through various workflows, such as re-activation and forensic analysis.</td>
</tr>
<tr>
<td><strong>Enable In-App Feedback</strong></td>
<td>Not selected</td>
<td>When selected, a user can submit feedback and satisfaction ratings to Dell via a link within the application to a web form.</td>
</tr>
<tr>
<td><strong>Server Polling Interval</strong></td>
<td>360 minutes</td>
<td>1-1440 minutes How often in minutes the SED client attempts to contact the Dell Server for updates.</td>
</tr>
<tr>
<td><strong>Custom Support Dialog</strong></td>
<td>String</td>
<td>Customizable text that provides information for users to contact IT support for the organization. This allows a maximum of 10,000 characters, which can be four lines with a maximum of 2500 characters each. The text cannot contain line feeds, Enters, or similar characters unless they are escaped. If an administrator enters an invalid character (non-JS0N format), this may cause Data Guardian clients to stop activating. For user experience on Windows devices, a maximum of 2000 characters is recommended; for Mobile devices and Mac, a maximum of 1000 characters is recommended.</td>
</tr>
<tr>
<td><strong>Dell Data Security Auto Updates</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Enable Software Auto Updates</strong></td>
<td>Not selected</td>
<td>Selected enables the client update agent to automatically check for updates to Dell security software. If this policy is not selected, no Dell Auto Updates take place, regardless of other policies. If this policy is set, the Update Staging Location must have a network location in its value.</td>
</tr>
<tr>
<td><strong>Update Staging Location</strong></td>
<td>String</td>
<td>Network location (UNC) where Dell Server stages Dell update packages. If a network location is not specified in this policy, the Enable Software Auto Updates policy should not be published.</td>
</tr>
</tbody>
</table>

316
### Security Management Server v10.2.7 AdminHelp

#### See [advanced settings](#)

<table>
<thead>
<tr>
<th>Audit Control Policies</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Guardian Audit Data Enabled</td>
<td>Selected</td>
<td>Selected enables Audit Control policies. If this policy is not selected, no Audit Control takes place, regardless of other policies. It also enables the collection of audit data from Data Guardian clients.</td>
</tr>
<tr>
<td>Data Guardian Geo Location Audit Data</td>
<td>Selected</td>
<td>Selected includes geo tracking location data in audit data. For Windows, this policy is supported on v8.1 and higher.</td>
</tr>
<tr>
<td>Client Retention Period</td>
<td>30 days</td>
<td>1-365 days. 30 days default. Specifies the number of days that the client will hold on to audit data without transmission.</td>
</tr>
<tr>
<td>Client Retention Storage</td>
<td>512 Megabytes of storage space</td>
<td>Specifies the maximum storage space used by the client for audit data without transmission.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web Portal Audit Control Policies</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Guardian Audit Data Enabled</td>
<td>Selected</td>
<td>Selected enables Web Portal Audit policies. If this policy is not selected, no Audit Control takes place, regardless of other policies. It also enables the collection of audit data from Data Guardian clients.</td>
</tr>
<tr>
<td>Data Guardian Geo Location Audit Data</td>
<td>Selected</td>
<td>Selected includes geo tracking location data in audit data. For Windows, this policy is supported on v8.1 and higher.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mobile Audit Control</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Guardian Audit Data Enabled</td>
<td>Selected</td>
<td>Selected enables Audit Control policies. If this policy is not selected, no Audit Control takes place, regardless of other policies. It also enables the collection of audit data from Data Guardian clients.</td>
</tr>
</tbody>
</table>

See [advanced settings](#)

### Advanced Global Settings

Global Settings policies are available at the Enterprise, Endpoint Groups, and Endpoints levels. All Global Settings policies are endpoint-based, meaning the policies follow the endpoint, not the user.

Audit Control policies are available at the Enterprise, Endpoint Groups, Endpoints, User Groups, and Users levels.

Policy descriptions also display in tooltips in the Management Console.
## Settings
This technology allows control over general settings such as polling intervals, support dialogs, in-app feedback, auto updates, data auditing, and client retention periods.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDP Auto Updates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Check Period</td>
<td>10080</td>
<td>1-43200 minutes (30 days) The period in minutes between checks for updates.</td>
</tr>
<tr>
<td>See <a href="#">basic settings</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mobile Audit Control</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Data Guardian Geo Location Audit Data | Selected | Selected Not Selected
Selected includes geo tracking location data in audit data. |
| See [basic settings](#) |